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Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, organizing, and managing IT
infrastructure data. It enables you to create TQL queries that retrieve business service data from the
CMDB. TQL queries also help you display the data in a visual representation that facilitates data
monitoring and managing.

This section includes the following topics:

« "Topology Query Language" below

e "The Roles of TQL" below

Topology Query Language

TQL extends the standard SQL language by adding two important capabilities:

« TQL enables you to draw conceptual relationships between configuration items (Cls), which
represent their actual interdependencies. Using predefined operators, the different types of
interconnections (relationships) that exist between Cls can be established, and consequently the
infrastructure design and performance are more accurately represented. This representation serves
as a basis and a model for the discovery, arrangement, query, and management of complex
infrastructures.

« TQL includes a graphical aspect, consisting of visual symbols and syntax, that represents the
resources and their interconnections. This visualization of an IT infrastructure simplifies the
understanding, monitoring, and managing of the IT business operations.

The Roles of TQL

TQL plays several roles:

« Builds a business service model that defines and delineates the interconnection between IT assets
that function together as business services. The business service model guides the discovery and
identification of these business services, from the ever-increasing number and complexity of
infrastructure resources. After the resources that comprise the business services are discovered,
the business service model structures the way they are organized and managed in the CMDB.

« Constantly searches the CMDB for changes that occur in the state of managed resources. When
such changes are detected, the relevant subsystems are informed and updated.
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« Creates queries that retrieve business service data from the CMDB, and displays the datain a
visual representation that facilitates data monitoring and managing.

Creating TQL Queries in the UCMDB Managers

The following managers enable you to create TQL queries that retrieve specific data from the CMDB
and to display that data:

« Impact Analysis Manager. An Impact rule simulates how infrastructure changes can impact your
system and enables you to determine the true origin of a problem and its business impact. During
rule creation, you define the base TQL query type, which can be a new query or an existing query.
For details, see "Impact Analysis Manager" on page 462.

« Enrichment Manager. An Enrichment rule enables enlarging the CMDB, deleting Cl instances
from the CMDB, or updating the attributes of a Cl that already exists in the CMDB. During rule
creation, you define the base TQL query type, which can be a new query or an existing query. For
details, see "Enrichment Manager" on page 527.

« Modeling Studio. You can build a new TQL query using the TQL Query Editor or you can build a
new query while defining a new view, template, or perspective using the Pattern View Editor. You
can also define the topology report settings for any view in the Pattern View Editor. For details, see
"Modeling Studio" on page 251.

Viewing TQL Query Results

You view the resulting data in a visual representation in IT Universe Manager. The queries define the
structure of the resulting topology map. The view displays only those Cls and relationships that meet
the query definition. You can also view the results of a query by clicking the Preview (£ button on the

toolbar to open a preview display identical to IT Universe Manager. For more details about IT Universe
Manager, see "IT Universe Manager" on page 180.

TQL Query Types and Priorities

When you define a TQL query, you define the type of the TQL query in the Type field of the Query
Definition Properties dialog box. The following query types are available:
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« View. TQL queries used as the basis for pattern views.

« Integration. TQL queries used for integrations.

« Discovery. TQL queries used as the basis for DFM patterns.
o Template. TQL queries used as the basis for templates.

« Perspective. TQL queries used as the basis for perspectives.

« Impact Analysis. TQL queries used as the basis for Impact rules. This is the default type for
queries created in Impact Analysis Manager.

o Enrichment. TQL queries used as the basis for Enrichment rules. This is the default type for
queries created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies (such as views, templates,
and so on).

If a query imported though an integration is not assigned a type, it is considered a hidden query and
does not appear in the query list in the Modeling Studio. To display hidden queries in the query list,
change the setting for hidden queries under General in the User Preferences dialog box. For details, see
"User Preferences Dialog Box" on page 92.

You can also set the priority level of a TQL query, which determines how often the query is rerun
automatically to include updated information. The following priorities are available:

o Low. The TQL query is refreshed every 2 minutes.

o Medium. The TQL query is refreshed every 30 seconds.
« High. The TQL query is refreshed every 10 seconds.

« Express. The TQL query is refreshed continuously.

« Not Active. The TQL query is inactive.

Note: The above refresh times are average values.

If you set the priority of a TQL query to Not Active, the query becomes inactive and is not run
automatically; however, it can be used for manually building a view.

Base Queries

You can select a base query for a TQL query in the Query Definition Properties dialog box. In this case,
the base query is first applied to the entire IT Universe, generating results. The new query is then
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applied to that subset of the universe, further refining the results. Selecting a base query enables you to
filter the query results more finely and generate results more quickly in certain cases.

The base query you select must be both active and persistent for your new query to be active. If the
base query is not active and persistent, the new query is automatically assigned a priority of Not
Active.

TQL Query Thread Pool

Each TQL query is calculated in a separate thread, taken from a thread pool. If there are many TQL
queries being calculated, you can increase the thread pool size to improve performance. Edit the TQL
Threads Pool Size setting in the Infrastructure Settings Manager. The pool size can be any integer
value between 1 and 64. If no value is entered, the pool size is automatically set to be the number of
CPU cores divided by the number of customers (if this number is smaller than 4, it is set to a minimum
of 4 threads).

Compound Relationship

A compound relationship represents a path in the topological graph. You use a compound relationship
to define the allowed steps in the path between the source and the target Cls.

Each row represents one of the allowed steps in the path leading from the source Cl to the target Cl in

the topology map.
Source | Relationship | Target
IpSubnet Membership % Mocle
% Mode Containment @ lpAddress

For an example of a compound definition, see "How to Define a Compound Relationship — Scenario” on
page 26. For details on defining compound relationships, see "Add/Edit Compound Relationship Dialog
Box" on page 47.

Join Relationship

A join relationship is a logical connection that represents the relationship between two Cls (and which
appears only in the topology map containing the TQL query results). It does not exist in the CMDB. A
join relationship is created by defining an attribute for each query node, whose values are used for
comparison.

The TQL results retrieve all Cls whose attribute values meet the conditions defined in the join definition.
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For example, you can create a join definition that links all node Cls connected to IP Address Cls
whose Created By attribute values are equal (see the example below).

Hode | Operator | IpAddress
Created By Equal Created By

Each join definition represents one condition defined for the join relationship.
Note: You can define multiple conditions.

For an example of a join definition, see "How to Define a Join Relationship — Scenario” on page 29. For
details on defining join relationships, see "Add/Edit Join Relationship Dialog Box" on page 50.

Query Node Conditions

You can add conditions to the query nodes and relationships of a TQL query in the Query Node
Properties dialog box. The conditions filter the query results by retrieving only Cls and relationships that
match the conditions defined in the query. There are several types of conditions you can define:

« Attributes. Conditions based on CI property values.

« Cardinality. Conditions based on the number of related query nodes.

« Qualifiers. Conditions based on Cl type qualifiers.

« Element type. Conditions based on Cl subtypes. See below for details.

« ldentity. Conditions based on Cl element IDs.

Each one has a separate tab in the dialog box. For details, see "Query Node/Relationship Properties
Dialog Box" on page 72.

When you define an attribute condition using the attribute name CI Type, the condition is converted to a
complex type condition when you save the query. The condition disappears from the Attribute tab and
appears in the Element Type tab. For Enrichment and Impact type queries, the condition disappears
from the Attribute tab in Enrichment Manager or Impact Analysis Manager, and you need to open the
query in Modeling Studio to edit it in the Element Type tab.

Note: If you define an attribute condition that is not supported for the selected data, the condition
is ignored during the TQL query calculation.
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Element Type Conditions

The Element type conditions enable you to specify the subtypes of a query node that should appear in
the query results. There are two options for defining this condition:

« Simple Type Condition. The simple type condition enables you to either include all subtypes of
the selected query node in the query results, or to exclude all of them.

« Complex Type Condition. The complex type condition enables you to select the specific
subtypes of the query node to be included in the query results. For details, see "Complex Type
Condition" on the next page.

Element Layout

You can specify the attributes to include in the query results for each query node or relationshipina
TQL query in the Element Layout tab of the Query Node Properties dialog box. Select the Select
attributes for layout radio button and then select a CIT or relationship in the CIT pane. If you select
Specific Attributes for the Attributes condition, only the attributes you move to the Specific Attributes
pane are included in the query results for that element. If you select All for the Attributes condition, all
of the available attributes are included in the query results for that element. In this case, you can select
Exclude specific attributes and move selected attributes to the Excluded Attributes pane.

There is also an option to select attributes by qualifiers. If you select qualifiers in the Attributes with
the following qualifiers field, all attributes that have the selected qualifiers are included in the query
results for that element, in addition to the attributes selected in the Specific Attributes pane. In this
case too, you can exclude selected attributes by moving them to the Excluded Attributes pane.

By default, the attribute settings you select for a CIT are automatically applied to its descendant CITs
in the query results; however, the settings are not visible in the Element Layout tab of the dialog box.
For example, if you select specific attributes to be included for the Database CIT, the same attributes
are included for the Oracle CIT (a child CIT of Database), but if you select Oracle in the CIT pane, the
Attributes condition displayed is None (the default condition).

You can then make an attributes condition selection for the child CITs themselves. If the parent CIT
has All selected as the attributes condition, then the Specific Attributes option is disabled for the child
CITs. If the parent CIT has Specific Attributes selected as the attributes condition, you can select All
or Specific Attributes for the child CIT. If you select Specific Attributes, you can add more attributes
by moving them to the Specific Attributes pane. These are included in the query results along with the
attributes inherited from the parent CIT's setting. Similarly, you can select attributes from the parent
CIT's setting to exclude for the child CIT, by moving them to the Excluded Attributes pane. If the parent
CIT has qualifiers selected to determine the attribute selection, these are also inherited by the child
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CIT. If you select additional qualifiers to filter the child CIT's attribute selection, the combined set of
selected qualifiers is used to filter the attribute selection for the child CIT.

When you change the type of a query node or relationship using the Change Query Node/Relationship
Type dialog box, the attributes selection for that element is lost.

If you import a package with a query that includes an attributes selection that is invalid for the selected
query node, or if you make an invalid attributes selection using the JMX console, the query can be
saved successfully and a warning appears in the log.

Note: The layout selection is not visible in the query results in the user interface. To view the
query results with the selected attributes, access the JMX console, select TQL services, and
invoke the calculateTqlAdHoc method.

For details on the Element Layout tab, see "Element Layout Tab" on page 82.

Complex Type Condition

The complex type condition enables you to select the specific subtypes of the query node to be
included in the query results. A Cl type tree appears with all the subtypes of the selected query node.
By default, instances of all the displayed subtypes are included in the query results. For each subtype,
you can select Exclude <subtype> from the query which excludes instances of that subtype from
the query results. If you select the Apply this condition recursively on all subtypes check box,
instances of the subtype and all of its descendants are excluded from the results.

If you select a subtype from the tree and you select Include <subtype> in the query without selecting
the Apply this condition recursively on all subtypes check box, only instances of the specified
subtype are included, but not instances of its descendants.

For both the Include and Exclude options, there is a further selection in the Conditions pane. If you
select By ClI type, all instances of the specified subtype are then included or excluded from the results.
If you select By qualifiers and then select qualifiers from the pop-up list, only the instances of the
selected subtype with the selected qualifiers are included or excluded from the query results.

For example, suppose CIT_B and CIT_C are subtypes of CIT_A, and CIT_A and CIT_B have qualifier
Q1. The following are some of the possible configurations of options:

« Select Exclude for CIT_A and all of its descendants. No CITs are included.
« Select Exclude for CIT_A without its descendants. Only CIT_B and CIT_C are included.

« Select Exclude for CIT_A and all of its descendants with qualifier Q1. Only CIT_C is
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included.

Note:

o ltis possible to apply the Exclude option to the root of the tree (that is, the Cl type of the
original query node). If the Apply this condition recursively on all subtypes check box is
selected, no Cls are included in the results. If the check box is not selected, instances of the
root Cl type are excluded, but instances of its descendants are included.

o The Element Type Conditions feature is only available in the Modeling Studio. If you define a
complex type condition in the Modeling Studio, and then modify the TQL query in Enrichment
Manager or Impact Analysis Manager, the condition may be overwritten and will no longer be
in effect. If the complex condition is equivalent to a simple condition, you can edit the TQL
query from the Qualifier tab of Enrichment Manager or Impact Analysis Manager.

o If you want to define a qualifier condition on a query node as using the functionality of previous
UCMDB versions, select Customize subtypes and select the root query node in the CI
types tree. Then select the Include option, select By qualifiers, and select the required
qualifiers. Similarly, when accessing a TQL query with qualifier conditions defined in a
previous UCMDB version or in Enrichment Manager or Impact Analysis Manager, the
condition appears in the Customize subtypes section of the Element Type tab, using the
Include and By qualifiers options.

o Itis sometimes possible to define an attribute condition (using the Cl Type attribute) that
generates the same results as a complex type condition. However, the complex type
condition ensures better performance. In such cases, UCMDB automatically optimizes the
query calculation by substituting an equivalent complex type condition for the simple one. If
the query is active, you will see the complex conditions in the TQL definition the next time you
open it.

For details on defining a complex type condition, see "How to Define a Complex Type Condition -
Scenario" on page 31.

Subgraph Definition

A subgraph definition enables you to create a graph that represents additional TQL query data related to
a specific Cl. The DFM job searches for the results from both the TQL query and the subgraph
definitions. The query recursively retrieves all related Cls for a defined depth matching the definition of
the subgraph. For details on defining subgraph definitions, see "Subgraph Definition Dialog Box" on
page 90.
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In the graph, you can define the relationship that is connected to a specific query node. For example, if
one of the query nodes is of type node, you can specify different relationships for Windows, router, and
IP Address. You can also define attribute conditions for query nodes. For details, see "Subgraph
Condition Definition Dialog Box" on page 88.

DFM jobs retrieve data that meets the criteria defined in the subgraph.

For an example of a subgraph definition, see "How to Create a Subgraph Definition — Scenario" on page
31.

The Use Update Value Policy Qualifier

This qualifier is used to mark attributes that enable minor deviations to their value. For example, there is
probably no need to report a small disk size change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, Universal CMDB checks the new value
against the old value. This check is performed on the server as part of the record update. If the
difference between the two values is smaller than the allowed deviation, an update is not performed
(the action is considered a false update).

When the qualifier is selected, the Insensitive Value Deviation parameter applies. Enter a value in the
box and select Percent or Absolute Value from the drop-down list.

When Percent is selected, the Insensitive Value Deviation must be between 0 and 100. Deviations of a
smaller percentage than this value are considered false updates.

When Absolute Value is selected, the following rules apply:

« For numeric attributes, the Insensitive Value Deviation must be of the same type as the attribute

« Fordate attributes, the Insensitive Value Deviation must be an integer, and denotes the deviation in
milliseconds

Deviations smaller than this value are considered false updates.

By default, Use Update Value Policy is enabled for the following numeric or date attributes only:

o CIT: Node
o MemorySize
o SwapMemorySize
These attributes also include comparable and static qualifiers.

. CIT:CPU
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o CpuClockSpeed
o CIT: Filesystem

o Disk_size

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Managers > Administration > Infrastructure Settings
Manager). Locate the Allow Volatility option. Change the value to False.

How to Define a TQL Query

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating Impact rules, Enrichment
rules, Views, Templates, and Perspectives.

This task includes the following steps:

« "Create a TQL Query" below

"Add Query Nodes and Relationships to the Query" below

"Set the Query Properties" below

—_

Create a TQL Query

In the Modeling Studio, select New > Query to open the TQL Query Editor. For details, see "TQL
Query Editor" on page 346.

2. Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The TQL query nodes represent
the CITs, as defined in the Cl Type Manager, and the relationships represent the connections
between them. Relationships are defined one at a time for each pair of TQL query nodes in the
query. For details, see "How to Add Query Nodes and Relationships to a TQL Query" on the next

page.

Note: You can also define a self-relationship from a query node to itself.

3. Set the Query Properties
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Click the Query Definition Properties £ button to open the Query Definition Properties dialog

box. Set the query type, scope, priority, and other properties. For details, see "Query/View
Definition Properties Dialog Box" on page 332.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is dependent on the other. The
following example displays two nodes, an IP Service Endpoint, and a Client Port, which are
linked to one another via a client/server connection. The TQL query results must comply with
the direction of the arrows.

=

Unix *

g
- J

Windows

ontainment_1

|
ontainment ! A
ﬂ jComposition_1 M
1y %

i
IpAddress i Address_1
b
. %

Client
IpSenvice

i Frocess
Endpoint Server

Composition

Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations — Topology Query Language" on page 93.

How to Add Query Nodes and Relationships to a
TQL Query

This section explains how to add query nodes and relationships to a TQL query. It is relevant for Impact
Analysis Manager, Enrichment Manager, and the Modeling Studio.

Note: For TQL queries to be valid, they must comply with certain restrictions. For details, see
"Troubleshooting and Limitations — Topology Query Language" on page 93.

To add query nodes and relationships to a TQL query:
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1. InImpact Analysis Manager or Enrichment Manager, select the required query from the tree in the

left pane or click the New |;| button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select Queries as the Resource
Type, and select the required query from the tree or click New > Query to create a new one.

2. InlImpact Analysis Manager or Enrichment Manager, click and drag one or more required TQL
query nodes from the tree displayed in the Cl Type Selector, onto the editing pane. In the Modeling
Studio, select the Cl Types tab in the left pane and drag the required TQL query nodes from the
tree onto the editing pane. These are the TQL query nodes that are included in the query.

If you want the query to run over federated Cls also, right-click a query node and select Set
Integration Points. In the Select Integration Points dialog box, select the integration points for the
external data sources to use. For details, see "Select Integration Points Dialog Box" on page 338.

3. To add a relationship between two query nodes, do one of the following:

o Select the required TQL query nodes by holding the CTRL key and clicking the TQL query
nodes, right-click and select Add Relationship. The Add Relationship dialog box opens.
Select the required relationship. For details, see "Add/Edit Relationship Dialog Box" on page
53.

o Click the Create Relationship I% icon and draw a line between the required query nodes. The
Select Relationship Type dialog box opens. Select the required relationship type. For details,
see "Select Relationship Type Dialog Box" on page 87.

4. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Compound Relationship — Scenario

This section describes how to define the allowed steps that form a compound relationship between an
IP Subnet Cl and an IP Address CI.

| Note: To reach the required result, you must implement each one of the following steps.
To define a compound relationship between an IP Subnet Cl and an IP Address ClI:

1. Create a TQL query of type view and drag the following query nodes onto the editing pane:
o |P Subnet

o |P Address
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2. Select both of the IP Subnet and IP Address query nodes, right-click and select Add
Compound Relationship to open the Add Compound Relationship dialog box.

3. Click the Add ™ button. In Enrichment Manager and Impact Analysis Manager, the Add Triplet

dialog box opens. In the Modeling Studio, a row is added to the table.
Make the following selections:

o From the Source list, select IP Subnet.

(e}

From the Target list, select Node.

(e}

From the Relationship list, select Membership.

o

Select the required Relationship Direction.
In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

4. Click the Add = button again and make the following selections:

o

From the Source list, select Node.

(e}

From the Target list, select IP Address.

o

From the Relationship list, select Containment.

e}

Select the required Relationship Direction.
In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The following shows an example of compound definitions following the changes:

Source | Relationship | Target
IpSubnet Membership % MNode
% Modle Containmert @ lpAddress

5. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

rrp ] Mindual- Compound ==
AL« =

IpAddress IpSubnet

6. Create a view based on your TQL query and save it.

7. Gotothe required view in IT Universe Manager to view the results. If you did not select the Show
full path between source and target Cls option, then the results display the names of the
relationships that link the Cls as Virtual-Compound rather than the actual names of the
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relationships. See the illustration below:

Wirtual - Compao
und
Campo

192.168.168.1

You can double-click the Virtual - Compound relationship in IT Universe Manager to open the Link
Map, which displays the Cls and relationships that comprise the allowed steps used to link the IP
Subnet and IP Address Cls.

192165.1658.0

Membershig

Y
%

labimd corml 5

Containment

@

192.168.0.1

In the example above, the 192.168.168.0 (IP Subnet) Cl is linked to the 192.168.0.1 (IP Address)
ClI through the labm1cem15 (Node) Cl.

If you selected the Show full path between source and target Cls option, then the results in IT
Universe Manager display the actual names of the relationships that link the Cls and the full path
between the source and target Cls. See the illustration below:
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182168.1658.0

Memhbership

Cantainment
Containfnent

TR T )

192.168.168.1 165968182 182.168.01

How to Define a Join Relationship — Scenario

This section explains how to define a join relationship that links Node Cls to IP Address Cls whose
Created by attribute values are equal.

| Note: To reach the required result, you must implement each one of the following steps.

To define a join relationship that links all IP Address and Node Cls whose Created by
attribute values are equal:

1. Create a TQL query and drag the following query nodes from the Cl Types selector onto the editing
pane:

o Node
o |P Address

2. Select both of the Node and IP Address query nodes, right-click and select Add Join
Relationship to open the Add Join Relationship dialog box.

3. Click the Add | button to add a row to the table and do the following:
o Inthe Node attribute box, select Created by.
o Inthe Operator box, select Equal.

o Inthe IpAddress attribute box, select Created by.
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In Enrichment Manager and Impact Analysis Manager, you make these selections in the Join
Relationship Condition dialog box.

The Join Definition area now looks like this:

Hode | Operator IpAddress
Created By Equal Created By

4. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

(N

Maode

Wirtual - Join

"

IpAddress

How to Define an Attribute Condition — Scenario

This task describes how to define an attribute condition to select the Node Cls that were created or
updated over the past week.

1. Inthe Modeling Studio, Enrichment Manager, or Impact Analysis Manager, open a TQL query,
view, Enrichment rule, or Impact Analysis rule containing a Node CI.

2. Right-click the Node Cl and select Query Node Properties.

3. Inthe Query Node Properties dialog box in the Attributes tab, click the Add =/ button to add a

condition.
4. Forthe Attribute name, select Create Time - (date) from the drop-down list.
5. Forthe Operator, select Changed during [Hour(s)] from the drop-down list.
6. Forthe Value, enter7.

7. Click OK to save the attribute condition.
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How to Define a Complex Type Condition - Scenario

This section describes how to define a complex type condition in the Query Node Properties dialog box.
In this example, you add subtype conditions to a Node query node in a TQL query.

To define a complex type condition:

1. Create a TQL query and drag a query node of type Node onto the editing pane.

2. Right-click the query node and select Query Node Properties. The Query Node Properties dialog
box opens.

3. Select the Element Type tab and select Customize subtypes.

4. Inthe Cl Types pane, select Computer, and in the Conditions pane, select Exclude
<Computer> from the query. Select the Apply this condition recursively on all subtypes of
<Computer> check box. This excludes all Cls of type Computer and its descendants in the query
results.

5. Inthe Cl Types pane, select Unix, and in the Conditions pane, select Include <Unix> in the
query. This includes all Unix Cls in the query results.

6. Inthe Cl Types pane, select IBM Frame, and in the Conditions pane, select Include <IBM
Frame> in the query. Then select By qualifiers and select the CONTAINER qualifier. This
includes all IBM Frame Cls with the CONTAINER qualifier in the query results.

7. Inthe Cl Types pane, select Firewall, and in the Conditions pane, select Exclude <Firewall>
from the query. Select By qualifiers and select the HIDDEN_CLASS and MAJOR_APP
qualifiers. This excludes all Firewall Cls with the HIDDEN_CLASS and MAJOR_APP qualifiers
from the query results.

8. Click OK to save your conditions and exit the dialog box.

How to Create a Subgraph Definition — Scenario

This section describes how to create a subgraph definition. In this example, the TQL query results
retrieve all Cls that are connected to a Business Service Cl by a Containment relationship up to a
depth of 3.

Note: To reach the required result, you must implement each one of the following steps.

To create this sample subgraph definition:
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1. Create a TQL query and drag a query node of type Business Service onto the editing pane.

2. Right-click the Business Service query node and select Subgraph Definition to open the
Subgraph Definition dialog box.

3. Click the Add = button. In Enrichment Manager and Impact Analysis Manager, the Add Triplet

dialog box opens. In the Modeling Studio, a row is added to the table. Make the following
selections:

o From the Source drop-down list, select Managed Object.
o From the Target drop-down list, select Managed Obiject.
o From the Relationship drop-down list, select Containment.
o Set the direction of the relationship as left to right.
In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The Subgraph Definition dialog box now looks like this:

Source | Relaticnship | Target Relaticnship Direction

IManaged Object Containment Managed Object —

4. Setthe Depth setting to 3.
5. Click OK in the Subgraph Definition dialog box.

Go to the required view in IT Universe Manager to view the results.
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The results show the Business Service Cl aaa and all of the Cls linked to it in succession by

Containment relationships down to three levels.

Shortcut Menu Options

This section includes a list of TQL query shortcut menu options:

Ul Element (A-Z) Description

Add Calculated Enables you to create a calculated relationship.

Relationshi
P « For details on how to create a calculated relationship, see "Triplets Page"

on page 511.

« Fordetails about Impact Modeling, see "Using Calculated Relationships

on page 98.
Add Compound Enables you to define the connection between two query nodes using a
Relationship compound relationship.
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Ul Element (A-Z)

Add Join
Relationship

Add Related Query
Node Wizard

Add Relationship

Add to Hierarchy

Add to Model
Output

Change Query
Node/Relationship

Type

Clear

Description

For details, see "Add/Edit Compound Relationship Dialog Box" on page 47.

Enables you to define join relationships. You create them by defining an
attribute for each query node. These query node values are used for
comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box" on page 50.

Displays the Add Related Query Node Wizard which enables you to build a
TQL query. For details, see "Add Related Query Node Wizard" on page 55.

Enables you to create a relationship for your query nodes by selecting it from
a predefined list. Displays the Add Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on page 53.

Note: In Enrichment Manager, this option adds an Enrichment
relationship to the rule when working in Enrichment mode. Applicable
for regular and Enrichment query nodes. For details, see "Enrichment
Manager" on page 527. Added relationships are denoted by an added E

indicator.

Adds the selected query node to the hierarchy as a separate query node.

Note: Only relevant for the Modeling Studio.

Designates the selected query node as output for the pattern-based model.

Note: Only relevant for pattern-based models in the Modeling Studio.

Displays the Change Query Node Type dialog box. Enables you to change
the CI type of the query node after you have created it. For details, see
"Change Query Node/Relationship Type Dialog Box" on page 287.

Note: Only relevant for the Modeling Studio.

Available by right-clicking a query node or relationship when working in
Enrichment mode in the Enrichment Manager. Clears the query
node/relationship's Enrichment rule definition. For details, see "Enrichment
Manager" on page 527.

Appears only if you have updated or deleted a query node/relationship using
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Ul Element (A-2)

Copy/Paste

Define Impacted

Delete

Delete
Relationship/Query
Node

Description

an Enrichment rule.

Note: Only relevant for Enrichment Manager.

Copy/paste an existing TQL query node/relationship in the same query or into
another TQL query.

The copied TQL query node/relationship includes all TQL definitions.

You can copy and paste relationships provided that the TQL query nodes to
which the relationships are connected are also selected. A relationship on its
own cannot be copied without its connecting TQL query nodes.

You can select multiple TQL query nodes/relationships as well.

Note: The Copy and Paste options are only available in the Modeling
Studio. The Paste option is available only after using the Copy option to
copy an existing TQL query node/relationship.

Defines which query node in the TQL query is the trigger Impact Analysis
query node and which query nodes are impacted by the changes that occurin
the system. For details, see "Impacted Query Nodes Dialog Box" on page
474.

Note: Only relevant for Impact Analysis Manager.
Deletes the selected query node/relationship/Cl.

Note: This option is not available for calculated relationships.

Available by right-clicking a query node or relationship when working in
Enrichment mode.

Creates a specific Enrichment rule that is designed to delete
Cls/relationships from the CMDB. Applicable to regular query nodes and
relationships only. You can use this option, for example, for removing
unnecessary data from the CMDB. For details, see "Enrichment Manager" on
page 527.

Deleted query nodes and relationships are denoted by a removed [l indicator.

Note: Only relevant for Enrichment Manager.
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Ul Element (A-2) Description

Edit Relationship Displays the Refine Relationship Type dialog box. For details, see "Refine
Query Node Type Dialog Box" on page 86.

Note:

« Not relevant in the Modeling Studio.

« This option appears only when the selected relationship has

descendants.
Hide Element in When this option is selected, a Hidden in Query Results indicator &
Query Results appears to the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in the
topology map. This can be useful when certain relationships or TQL query
nodes are required to build the query but are not needed in the results. At
least one query node must be visible for the view to be valid.

Note: Only relevant for the Modeling Studio.

Hide Element in Hides the selected virtual-compound relationship when viewing the results of

View Results an Automated Service Map in the UCMDB Browser (based on the Service
template perspective being applied on top of the service's Business Element
Cl), as long as the Cls linked by the virtual-compound relationship are not
linked by any other relationship.

Note:

« This option appears only when you are creating or editing the
perspective on which a service model is based. Only relevant for the
Modeling Studio.

« Ifthe Hide Element in Query Results option is selected for a node,
this option will not be available, since the node and all of its
relationships will not appear.

Query Displays the Query Node/Relationship Properties dialog box, enabling you to

Node/Relationship = define the attribute conditions for the selected TQL query node/relationship.

Properties For details, see "Query Node/Relationship Properties Dialog Box" on page
72.

Note: This option is not available for calculated relationships.
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Ul Element (A-2)

Refine Query Node

Type

Remove Subgraph

Reset Impacted

Reset Inner
Relationship

Select All

Set As Contact
Query Node

Set Integration
Points

Show Element in
Query Results

Show Element in
View Results

HPE Universal CMDB (10.31)

Description

Displays the Refine Query Node Type dialog box. Enables you to change the
Cl type of the query node after you have created it. For details, see "Refine
Query Node Type Dialog Box" on page 86.

Note: This option only appears if a child of the Cl type exists. Only
relevant for Impact Analysis Manager and Enrichment Manager.

Only appears if you have defined a subgraph definition. For details, see
"Subgraph Definition Dialog Box" on page 90.

Removes the Define Impacted definition applied to that query node. For
details on the Define Impacted definition, see "Impacted Query Nodes Dialog
Box" on page 474.

| Note: Only relevant for Impact Analysis Manager.

Redraws a self-referential relationship in the Topology map as a square for
ease of viewing.

| Note: Only relevant for self-referential relationships that are not square.
Selects all query nodes and relationships in the TQL query.
| Note: Only relevant for the Modeling Studio.

Designates the selected query node as a contact query node for the
perspective.

| Note: Only relevant for perspectives in the Modeling Studio.

Opens the Select Integration Points dialog box which enables you to select
the required data sources for a TQL query node.

| Note: Only relevant for the Modeling Studio.

When this option is selected, the results pertaining to the TQL query node are
displayed in the topology map.

| Note: Only relevant for the Modeling Studio.

Displays the selected virtual-compound relationship when viewing the results
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Ul Element (A-2) Description

of an Automated Service Map in the UCMDB Browser (based on the
Service_template perspective being applied on top of the service's Business
Element CI).

Note:

« This option appears only when you are creating or editing the
perspective on which a service model is based. Only relevant for the
Modeling Studio.

« Ifthe Show Element in Query Results option is selected for a
node, this option will not be available, since the node and all of its
relationships are already displayed.

Show Element Displays the Cl Instances dialog box which displays all the instances found

instances for each query node in a table. For details, see "Cl Instances Dialog Box" on
page 65.

Show Node Opens the Template Parameter Values dialog box, which enables you to set

Parameters the values of the query node's parameters.

Note: Only relevant for template-based views in the Modeling Studio.

Subgraph Displays the Subgraph Definition dialog box, where you can create a graph
Definition that represents additional TQL query data related to a specific query node.
For details, see "Subgraph Definition Dialog Box" on page 90.

Update Use an Enrichment rule to update the value of Cl attributes in the CMDB, or
Relationship/Query to add data to attributes that currently do not have values. Opens the Query
Node Node Definition - Attributes dialog box. For details, see "Query

Node/Relationship Definition Dialog Box" on page 551. This is applicable for
both regular and Enrichment query nodes.

Updated query nodes are denoted by an updated L] indicator.

| Note: Only relevant for Enrichment Manager.

Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions in various dialog boxes, such
as the Subgraph Condition dialog box, Impact Rules Definition dialog box, or the Query
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Node/Relationship Properties dialog box.

Operator Description

Changed during (Displayed only when you select an attribute of type Date.) Displays only
the instances that changed during the period specified in the Value box.

Equal Checks whether the attribute value is equal to the value specified in the
Value box.
Equal ignore case Checks whether the attribute value is equal to the value specified in the

Value box regardless of the case.

Note: When working with Microsoft SQL Server, this option is
identical to Equal.

Greater Checks whether the attribute value is greater than the value specified in
the Value box.

Note: When comparing attributes of type string, the comparison is
based on the ASCII values of the string characters.

Greater than or equal = Checks whether the attribute value is greater than or equal to the value
specified in the Value box.

In Displays only the instances where this attribute value equals one of the
selected values. For example, for Cls that have a Change state that
equals Plan and New, select the operator In from the Operator list and
select both Plan and New from the Value box.

In ignore case Displays only the instances where this attribute value equals one of the
selected values, regardless of the case.

Note: When working with Microsoft SQL Server, this option is

identical to In.
Is null Checks whether the attribute value is null.
Less Checks whether the attribute value is less than the value specified in the
Value box.

Note: When comparing attributes of type string, the comparison is
based on the ASCII values of the string characters.
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Operator Description

Less than or equal Checks whether the attribute value is less than or equal to the value
specified in the Value box.

Like Uses a wildcard (%). Use Like when you are not sure of the complete
name for which you are searching.

Like ignore case Uses awildcard (%). Use Like ignore case when you are not sure of the
complete name for which you are searching. The case of the string is
ignored.

Note: When working with Microsoft SQL Server, this option is
identical to Like.

Not equal Checks whether the attribute value is not equal to the value specified in
the Value box.

Occurs after (Displayed when you select a date type attribute.) Displays only the
instances that occurred after the period specified in the Value box.

Occurs within (Displayed when you select a date type attribute.) Displays only the
instances that occurred within the period specified in the Value box.

Unchanged during (Displayed when you select a date type attribute.) Displays only the
instances that did not change during the period specified in the Value box.

Note:

« Forthe Not equal operator, query results do not include data from the CI instances that are not
assigned a value. For example, a system contains three nodes: Node1 is assigned the value A,
Node2 is assigned the value B, and Node3 is not assigned a value. If you create a query to
retrieve all nodes that are Not equal to A, the results of your query include Node2 only,
because Node3 is not assigned a value.

« Universal CMDB supports both Microsoft SQL Server and Oracle Server databases. Microsoft
SQL Server is not case sensitive by default (unlike Oracle database which is case sensitive).
Consequently, if you are using Microsoft SQL Server, the Equal operator retrieves the same
query results as the Equal ignore case operator. For example, if you select the attribute City,
the operator Equal, and type NEW YORK in the Value comparison box, case differences are
ignored and query results include NEW YORK, New York and new york.

HPE Universal CMDB (10.31) Page 40 of 572



Modeling Guide

Chapter 1: Topology Query Language

TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

« "Pattern Statistics Log" below

« "Audit Short/Detailed Log (TQL Perspective)" on the next page

« "Incremental Statistics Log" on the next page

« "Incremental Splitter Log" on page 43

« "Incremental Detailed Log" on page 43

Pattern Statistics Log

The log name is cmdb.pattern.statistics.log.

Log File Description
Purpose General calculation data for each TQL query, updated at predefined
intervals.
Information Level The following information is given for each TQL query:
e name

average, minimum, and maximum calculation times
number of calculations

last calculation time

o result size
Error Level Not available.
Debug Level Not available.

Basic Troubleshooting .

HPE Universal CMDB (10.31)

Verify that a specific TQL query was updated.
Evaluate a TQL query's calculation time.

Evaluate a TQL query's result size.
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Audit Short/Detailed Log (TQL Perspective)

The log name is cmdb.audit.short.log.

Log File Description
Purpose CMDB state changes, Cl Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.

Information Level Not available.
Error Level Not available.
Debug Level « Final calculation for TQL queries is logged.

« Ifthe final TQL query calculation is unchanged from the previous
calculation, this is noted.

« Ifthe final TQL query calculation is changed from the previous
calculation, results of the Cls and relationships are recorded in the
detailed log. The number of Cls and relationships are recorded in the
short log.

Basic Troubleshooting = « Use this log to verify which notifications are published by the TQL
query subsystem.

« Check the section at the end of each result. This section includes
added, removed, and updated Cls and relationships.

« Track the CIT changes and see if the query results also change. You
can thus correlate the CIT changes to the results of the query
calculations.

Incremental Statistics Log

The log name is cmdb.incremental.statistics.log.

Log File Description

Purpose Traces the calculation procedure, full orincremental, of every query.
Information Not available.

Level
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Log File Description
Error Level Not available.
Debug Level « Gives the date, time, query name, and whether an incremental statistic

calculation was performed (yes/no).

« If anincremental statistic calculation was not performed, states the reason,
the number of subcalculations (relevant for incremental calculations only), and
the complete calculation time.

Basic Monitors the calculation process.
Troubleshooting . ) . I .
If a specific query calculation takes a long time, check if it is a full orincremental
calculation:
« If full, check whether a full calculation is necessary.

« Ifincremental, check how many subcalculations have been performed.

Incremental Splitter Log

The log name is cmdb.incremental.splitter.log.

Log File Description

Purpose Monitors the incremental splitter result made during an incremental calculation.
Information Not available.

Level

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph created by the

incremental splitter.

Basic If the TQL result calculated by the incremental calculator is wrong, verify that the
Troubleshooting | splitter result is correct.

Incremental Detailed Log

The log name is cmdb.incremental.detailed.log.
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Log File Description

Purpose Monitors the incremental calculation process.
Information Level = Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:
« the trigger query node
« the number of elements classified to the trigger query node

« Whether the subcalculation step is driven by new elements added to the
model or by existing elements

« the calculated query graph

Basic Follows the basic steps of an incremental calculation.
Troubleshooting

Topology Query Language User Interface

This section includes (in alphabetical order):

Add/Edit Calculated Relationship Dialog Box

Add/Edit Compound Relationship Dialog Box

Add/Edit Join Relationship Dialog Box

Add/Edit Relationship Dialog Box

Add Related Query Node Wizard

Add Triplet Dialog Box

Cl Instances Dialog Box

Conditions Preview Dialog Box

Element Layout Preview Dialog Box

Filter Cl Instances Dialog Box

Join Relationship Condition Dialog Box

Layout Settings Dialog Box
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Query Node/Relationship Properties Dialog Box ... ... ... .. 72
Refine Query Node Type Dialog BOX ... ... .. 86
Select Relationship Type Dialog BoX ... ... 87
Subgraph Condition Definition Dialog Box .. ... ... ... 88
Subgraph Definition Dialog BoxX ... .. 90
User Preferences Dialog BoX . ... o 92

Add/Edit Calculated Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a calculated
relationship from the Cl Type model.

To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

access
Right-click the required query node in the editing pane in Enrichment Manager, Impact

Analysis Manager, or the Modeling Studio and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Calculated Relationship option.

To access in Adapter Management in Data Flow Management (DFM):
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query | button to the right of
the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Calculated Relationship.

Relevant | . "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer Reference
Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

o "How to Create a Perspective" on page 272
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See also | « "Using Calculated Relationships" on page 98

« "CIl Type Relationships" on page 485

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element  Description

=) Expand All. Expands all the folders in the tree.

e Collapse All. Collapses all the folders in the tree.

Tree View Tree View. Enables you to select the display format of the calculated relationship
& tree. The following options are available:

« by Display label
« by Class name

« by Legacy class name

<Calculated Select the calculated relationship that defines the connection between two query
relationship nodes.
tree>

Relationship The direction of the relationship that indicates which query node is dependent on the
Direction other.

Relationship The name of the calculated relationship.
Name

Relationship Select an option to define how to handle relationships between identical query nodes
Restrictions  or self relationships in the query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships Only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

« Allow Non Self Relationships Only. Self-relationships do not appear in the
query results.
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Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a compound
relationship.

To access To access in Enrichment Manager, Impact Analysis Manager, and the
Modeling Studio:

Right-click the required query nodes in the editing pane in Enrichment
Manager, Impact Analysis Manager, or the Modeling Studio and select
Add Compound Relationship.

Note: If you are using Enrichment Manager, select Query mode at
the top of the editing pane to display the Add Compound
Relationship option.

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |§| button
to the right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Compound
Relationship.

Important You can create as many compound definitions as necessary.
information

Relevant tasks « "How to Define an Impact Rule — Workflow" on page 463
« "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB
Developer Reference Guide

« "How to Create a Pattern View" on page 269

« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272
See also « "Compound Relationship" on page 18

« "How to Define a Compound Relationship — Scenario" on page 26
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User interface elements are described below:

Ul Element
(A-Z)

=+

Max steps

Min steps

Relationship

Relationship
Direction

Relationship
Name

Relationship
Restrictions

Description
Add. Adds a compound definition.

In Impact Analysis Manager, Enrichment Manager, and the Input Query Editorin
DFM, it opens the Add Triplet dialog box. In the Modeling Studio, it enters a default
compound definition in the table. Click the Edit buttons to edit the definition
components.

Delete. Deletes the selected compound definition.

Condition. Enables you to edit the selected compound definition.

In Impact Analysis Manager, Enrichment Manager, and the Input Query Editorin
DFM, it opens the Edit Triplet dialog box. In the Modeling Studio, it opens the
Compound Relationship Condition Definition dialog box.

The longest path allowed between the two Cls in the CMDB to be included in the
discovery process.

Default: 5

The shortest path allowed between the two Cls in the CMDB to be included in the
discovery process.

Default: 1
The relationship connecting the two query nodes.

The direction of the relationship that indicates which query node is dependent on
the other.

The name of the compound relationship.

Select an option to define how to handle relationships between identical query
nodes or self relationships in the query results. A self relationship is a relationship
that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

« Allow All Relationships. All relationships appear in the query results.
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Ul Element
(A-Z)

Show
element in
query results

Show full
path between
source and
target Cls

Source

Stop at first
compound
level

HPE Universal CMDB (10.31)

Description

« Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the
query results.

Select Show element in query results to include query results relating to a join or
compound relationship. By default, this option is selected. When the check box is
cleared, a Hidden in Query Results indicator & appears to the left of the
relationship's name in the editing pane, denoting that any query results pertaining to
the relationship are not displayed in the topology map.

(W

Mode

Wirtual - Jain

=

IpAddress

If you select this option, then the query results display the actual names of the
relationships that link the Cls and the full path between the source and target Cls.

The required source query node.

Select this option if you want the system to stop looking for TQL query results once
it reaches the first target in the path.

In the following sample compound link definition, Depth is defined as 10 and Stop
at first compound level is selected.
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Ul Element

(A-Z) Description
The TQL query results include the Target 1, Target 3, and Target 4 because they
are all at level 1 (the first Cl found in the path). Target 2 is not included in the TQL
results because it is at level 2 (the second Cl found in the path).

Target The required target query node.

Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Join
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Join Relationship option.

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query <"/ putton to the right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Join Relationship.

Important When you access the dialog box from the Modeling Studio, you select the attributes
information and operator within the dialog box itself. When you access the dialog box from Impact
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Analysis Manager or Enrichment Manager, you select the attributes and operator from
the Join Relationship Condition dialog box.

Note: You cannot select attributes of type list for a join relationship condition.

Relevant o "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

o "How to Create a Pattern View" on page 269

« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272
See also « "Join Relationship" on page 18

« "How to Define a Join Relationship — Scenario" on page 29

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

Add. Enables you to define a join definition. In Impact Analysis Manager,
Enrichment Manager and the Input Query Editor in DFM, it opens the Join
Relationship Condition dialog box. In the Modeling Studio, it adds the selected
attributes and operator to the list.

% Delete. Deletes the selected join definition.

2] Edit. Enables you to edit the join definition. Opens the Join Relationship Condition
dialog box.

Note: This option is not relevant in the Modeling Studio.

<Query Select an attribute for the <end_1> query node.

node1

Attribute> Note: This option is only available in the Modeling Studio.

box

<Query Select an attribute for the <end_2> query node.
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Ul Element
(A-Z)
node2

Attribute>
box

<Selected
query
node1>

column

<Selected

query
node2>

column

AND

Operator
box

Operator
column

Relationship
Direction

Relationship
Name

Relationship
Restrictions

HPE Universal CMDB (10.31)

Description

Note: This option is only available in the Modeling Studio.

A selected query node. The first attribute applies to <end_1>.

A selected query node. The second attribute applies to <end_2>.

All join definitions are linked by the And operator.

| Note: This is not relevant in the Modeling Studio.

Select an operator. For details on the available operators, see "Join Relationship
Condition Dialog Box" on page 70.

| Note: This option is only available in the Modeling Studio.

The operator selected in the Join Relationship Condition dialog box. For details
about operator definitions, see "Attribute Operator Definitions" on page 38.

The direction of the relationship that indicates which query node is dependent on the
other.

The name of the join relationship.

Select an option to define how to handle relationships between identical query nodes
or self relationships in the query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that
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Ul Element
(A-Z) Description

leads to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the

query results.
Show Select Show relationship in query results to include query results relating to a
relationship  join or compound relationship. By default, this option is selected. When the check
in query box is cleared, a Hidden in Query Results indicator & appears to the left of the
results relationship's name in the editing pane. Any query results pertaining to the

relationship are not displayed in the topology map.

(N

Mode

Yirtual - Join

-Q—E—)‘

E

IpAddress

Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes in a TQL query.

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio, do one of the following:

« Right-click the required query node in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Relationship.

« Click the Create Relationship [% putton and draw a line between the required
query nodes. The Select Relationship Type dialog box opens. Select Regular
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.
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2.

3.

In the Adapter Definition tab, click the Edit Input Query |é| button to the right
of the Input Query box to open the Input Query Editor.

Right-click the required query node and select Add Relationship.

Important This option does not appear when two selected query nodes (or a single selected

information = query node) do not have a valid relationship between them.

Relevant o
tasks
See also .

"How to Define an Impact Rule — Workflow" on page 463
"How to Define an Enrichment Rule — Scenario" on page 529
"How to Define a TQL Query" on page 24

"Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

"How to Create a Pattern View" on page 269
"How to Create a Template" on page 270

"How to Create a Perspective" on page 272

"How to Add Query Nodes and Relationships to a TQL Query" on page 25

"Cl Type Relationships" on page 485

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2)

B
e

Tree View

<Relationship
tree>

Relationship

Description

Expand All. Expands all the folders in the relationship tree.
Collapse All. Collapses all the folders in the relationship tree.

Tree View. Enables you to select the display format of the relationship tree. The
following options are available:

« by Display label
« by Class name

« by Legacy class hame

Select the relationship that defines the connection between two query nodes.

The direction of the relationship that indicates which query node is dependent on
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Ul Element
(A-Z) Description
Direction the other.

Relationship = The name of the relationship.
Name

Relationship = Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a relationship
that leads from a query node to itself.

Note: This list appears only when you select one query node or two identical
query nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the
query results.

Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access  Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

In the editing pane, right-click the required query node and select Add Related Query
Node Wizard.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Add Related Query Node option.

To access in Universal Discovery in DFM:
1. Select ajob in the Discovery Modules pane.

2. Select a Trigger Query in the Properties tab. Click the Open the Query Editor &
button to open the Trigger Query Editor.

3. Right-click the required query node and select Add Related Query Node
Wizard.
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Important
information

Relevant
tasks

Wizard
map

See also

Related Q

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |@ button to the right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Related Query Node.

If the TQL query is empty, drag the required TQL query nodes on to the editing pane
from the tree displayed in the Cl Type Selector or the Cl Types tab of the left pane.

« "How to Define an Impact Rule — Workflow" on page 463
« "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269

« "How to Create a Template" on page 270

o "How to Create a Perspective" on page 272
The Add Related Query Node Wizard contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

"Topology Query Language (TQL) Overview" on page 15

uery Node Type Page

This wizard page enables you to add a query node to the TQL query.

Important
information

Wizard
map

HPE Universal C

If the TQL query is empty, drag the required TQL query node on to the editing pane
from the tree displayed in the Configuration Iltem Types pane.

For general information on the Add Related Query Node Wizard, see "Add Related
Query Node Wizard" on the previous page.

The "Add Related Query Node Wizard" contains:

"Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z)

65
[e2]

Tree View

E

<query
node> is
required

<TQL
Query
Node
hierarchy
tree>

Element
name

Description
Expand All. Expands all the folders in the tree.
Collapse All. Collapses all the folders in the tree.
Tree View.Enables you to select the display format of the Cl type tree. The following
options are available:
« by Display label
« by Class name

« by Legacy class name

Note: This feature is only available in the Modeling Studio.

Define the relationship cardinality. For details, see "Query Node/Relationship
Properties Dialog Box" on page 72.

« Select the <query node> is required check box for each query node to include a
minimum of one instance of the query node at the other end of the relationship in the
query results. Selecting the check box gives the relationship a cardinality value of
1.%

« Clearthe <query node> is required check box to give the relationship a
cardinality value of 0..*.

Select the required query node. The query node you select appears in the Element
name box.

This list only includes the query nodes of the ClI type that have valid relationships to the
selected (source) query node.

To the right of each query node, the number of Cl instances that exist in the CMDB for
that Cl type is displayed. The number of instances is only updated after you close the
Add Related Query Node Wizard and open it again.

Note: The first query node in the hierarchy tree is selected by default.

(Optional) Contains the name of the selected query node. By default, the Cl type is
assigned as the element's name.
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Ul

Element

(A-Z) Description
You can rename a TQL query node in the Element name box giving it a unique label.
This can be helpful when there is more than one query node of the same Cl type in the
TQL query.

Show Select this check box to display only the CITs of which there are instances in the

only CITs CMDB. If this box is not selected, the tree includes all CITs with a valid link to the
with source query node.

instances
Note: The Show only CITs with instances check box is selected by default.

Relationship Type Page

This wizard page enables you to add a relationship to a TQL query.

Wizard The "Add Related Query Node Wizard" contains:

ma
P "Related Query Node Type Page" > "Relationship Type Page" > "Related Query Node

Properties Page" > "Related Query Node Instances Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
Tree View Tree View. Enables you to select the display format of the Relationship tree. The

following options are available:
« by Display label
« by Class name

« by Legacy class name

Note: This feature is only available in the Modeling Studio.

<TQL Query Select the required relationship.
Relationship
hierarchy tree>

Relationship Select the required relationship direction. The direction indicates which query
Direction node is dependent on the other.
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Ul Element (A-
Z) Description
Relationship The name of the relationship.
Name
Note: This feature is only available in the Modeling Studio.
Relationship Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a
relationship that leads from a query node to itself.
| Note: This feature is only available in the Modeling Studio.
Relationship A valid relationship that defines the connection between the selected query
Type nodes. The box displays the relationship you selected in the relationship
hierarchy tree.
Note: This feature is only available in Enrichment Manager and Impact
Analysis Manager.
Show only Display only the relationships of which there are instances in the CMDB. If this
relationships box is not selected, the tree includes all valid relationships between the selected

with instances  query nodes.

Related Query Node Properties Page

This wizard page enables you to create an expression that restricts the number of query nodes that
appear in the query by adding an attribute condition to a query node or relationship.

Important Each row represents an attribute condition that you specify. Use the And/Or column
information and the Brackets columns to link multiple conditions. In this way, you can construct a
more precise logical statement to generate the required results.

When you access the wizard from the Modeling Studio, this wizard page has three
tabs: Attribute, Element Type, and Element Layout. The Attribute tab includes the
elements described below. For details on the Element Type tab, see "Element Type
Tab" on page 80. For details on the Element Layout tab, see "Element Layout Tab"
on page 82.

Wizard The "Add Related Query Node Wizard" contains:

ma
P "Related Query Node Type Page" > "Relationship Type Page" > "Related Query

Node Properties Page" > "Related Query Node Instances Page"
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User interface elements are described below:

ul
Element
(A-Z) Description

& Add. Adds an attribute condition row. Select the attribute name, operator, and value to

define the attribute condition.

e Delete. Deletes the selected attribute condition.
|E| Up. Moves a selected row up.
|£| Down. Moves a selected row down.

(=X Show Criteria. Displays the criteria of the selected condition in a pop-up dialog box.

And/Or  Click inside the And/Or field and select either And or Or to link multiple conditions.

Attribute Choose an attribute from the list.
name

Brackets Click inside the Brackets box to display a list of brackets you can use to build more
L complex, logical statements.

Criteria | Contains the attribute condition definition as defined in the Cl Instances Dialog Box.

Include  Display both the selected Cl and its children in the topology map.

subtypes
Note: This check box is only available in the Enrichment Manager and Impact
Analysis Manager.

NOT Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances
that were not assigned a value. For example, your system contains three nodes:
Node1 is assigned the value A, Node2 is assigned the value B and Node3 is not
assigned a value. You create a query to retrieve all nodes that are equal to A and
select NOT; the results of your query only include Node2 because Node3 is not
assigned a value.

Operator = Select the required operator. For details, see "Attribute Operator Definitions" on page 38.

Show Select Show element in query results to display the selected TQL query node in the
element | editing pane. When the check box is cleared, a Hidden in Query Results indicator @
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ul
Element
(A-Z) Description

in query appears to the right of the selected TQL query node in the editing pane.
results

i

Ipaddres,
ontainment

(&% | membershipl
éd——_;
Ll

Windows o
Iastnet

Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required to
build the query but are not needed in the results. For example, Windows are connected
to the network by defining specific IP Addresses, but in any query results you may want
to view the IP Address elements only and not the Windows elements.

Value Enter or select the value of the attribute. The Value options vary according to the
attribute type you select.

Related Query Node Instances Page

This wizard page displays all the instances found for the selected TQL query node in a table.

Important The columns displayed in the report vary according to the Cl type selected.

information . . ) .
By default, only columns corresponding to attributes that have been defined with the

Asset Data, Managed, and Comparable attribute qualifiers in the Cl Type Manager
are displayed as columns in the dialog box. For details, see "Attributes Page" on page
505.

If required, you can click the Display Hidden Columns button to display the
attributes that are defined as Visible but not Static. For details on Static attributes,
see "Attributes Page" on page 505.

Note: Forinformation on the elements included in the Related Query Node
Instances page, see "Cl Instances Dialog Box" on page 65.

Wizard The "Add Related Query Node Wizard" contains:
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map "Related Query Node Type Page" > "Relationship Type Page" > "Related Query
Node Properties Page" > "Related Query Node Instances Page"

Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the topology graph leading from the
source Cl to the target Cl when creating a subgraph definition, a compound relationship, or a calculated
relationship.

To access In Enrichment Manager, Impact Analysis Manager, or the Input Query Editorin DFM:

« Inthe Add Compound Relationship dialog box, click the Add [ button. For
details, see "Add/Edit Compound Relationship Dialog Box" on page 47.

« Inthe Subgraph Definition dialog box, click Add =] For details, see "Subgraph
Definition Dialog Box" on page 90.

In Cl Type Manager, select Calculated Relationships from the drop-down list in the
Cl Types pane. In the editing pane, select the Triplets page and then click Add =]

Important Select the query nodes and relationships to be included in the topology graph.

information
Note: The Condition fields are displayed only when you access the Add Triplet
dialog box from the Subgraph Definition dialog box.
Relevant « "How to Define an Impact Rule — Workflow" on page 463
k
tasks o "How to Define an Enrichment Rule — Scenario” on page 529
« "How to Define a TQL Query" on page 24
« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide
« "How to Create a Pattern View" on page 269
o "How to Create a Template" on page 270
« "How to Create a Perspective" on page 272
See also « "Compound Relationship" on page 18

« "How to Define a Compound Relationship — Scenario" on page 26

« "Subgraph Definition" on page 22

User interface elements are described below:
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Ul Element
(A-Z)

(2]

Relationship

Relationship
Direction

Source

Target

Description

Condition. Enables you to define attribute conditions for the source and target query
nodes you selected. When the Add Triplet dialog box is opened from the Subgraph
Definition dialog box, it opens the Subgraph Condition Definition dialog box. When
the Add Triplet dialog box is opened from the Add Compound Relationship dialog
box, it opens the Compound Relationship Condition Definition dialog box.

The Condition button is enabled only after you select a query node from the Source
or Target lists.

Note: You cannot define attribute conditions for the source and target query
nodes in the Cl Type Manager.

Select an available relationship connecting the two query nodes. The list of available
relationships appears only after defining both query nodes.

Select the required direction. Setting different relationship directions can achieve
different query results. For an example, see "Setting Different Relationship
Directions for Compound Definitions" below.

Note: The Relationship list remains empty until you have selected a source and
target.

Select the required source query node.

Select the required target query node.

Setting Different Relationship Directions for Compound Definitions

You can achieve different TQL results by setting different relationship directions. For example, in your

business world, as illustrated below, you want to create a compound relationship that connects
between a query node of the CIT a and a query node of the CIT b. Depth is defined at 5 (for details, see

"Depth" on page 91).
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al

D @ &
O © &

In the Add Triplet dialog box, you can create compound definitions to link query nodes a and b using
different relationship directions.

Compound Definition Source Target Relationship  Relationship Direction
#1 query nodea query nodec  <relationship> source --> target
#2 query node ¢  query node b | <relationship> source --> target
#3 query node ¢  query node b | <relationship> = source <--target

o Compound definitions 1 and 2 result in the following query:

Compound definitions 1 and 2
al b1

« Compound definitions 1 and 3 result in the following query:

Compound definitions 1 and 3
al b2

« Compound definitions 1, 2, and 3 result in the following query:
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Cl Instances Dialog Box
This dialog box displays all of the Cl instances found for the selected TQL query node.

To access  To access in Enrichment Manager, Impact Analysis Manager, and the
Modeling Studio:

In the editing pane, right-click the required query node and select Show Element
Instances.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Show Element Instances option.

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |§| button to the right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Show Element’s Instances.

To access in Integration Studio:

Create an integration point based on a Jython integration adapter. On the Trigger Cl
Instance menu, choose Select Existing ClI.

Important = The columns in the table display the attributes of the selected Cl type. The attributes
information = displayed vary according to the Cl type selected.

By default, only columns corresponding to attributes that have been defined with the
Asset Data, Managed, and Comparable attribute qualifiers in the CIT Manager are
displayed as columns in the dialog box. For details, see "Attributes Page" on page
505.

Relevant "How to Define an Impact Rule — Workflow" on page 463
tasks , . .
"How to Define an Enrichment Rule — Scenario" on page 529
"How to Define a TQL Query" on page 24
"How to Create a Pattern View" on page 269

"How to Create a Template" on page 270

"How to Create a Perspective" on page 272
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"Work with Population Jobs" in the HPE Universal CMDB Data Flow Management

Guide

"Work with Data Push Jobs" in the HPE Universal CMDB Data Flow Management

Guide

See also « "Topology Query Language (TQL) Overview" on page 15

« "Topology Query Language User Interface" on page 44

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)
Show Cl instances of. | Metwork =,

P>
S

HPE Universal CMDB (10.31)

Description

Specify the CIT you want displayed in the table. The table also includes
the children of the selected CIT.

Delete from CMDB. Deletes the selected ClI.

Properties. Opens the Configuration Item Properties dialog box for the
selected Cl.

Refresh. Refreshes the list of Cl instances.

Set Filter. Filters the Cl instances you want to display for the selected
query node. Opens the Filter Cl Instances dialog box.

Clear Filter. Clears the filter definitions you created in the Filter Cl
Instances dialog box.

Select Columns. Enables you to select the columns to be displayed.
For details, see "Select Columns Dialog Box" on page 568.

Sort Column Content. Enables you to set the sort order of the Cl
instances. For details, see "Sort Column Content Dialog Box" on page
569.

Find. Displays the Find toolbar.
Send Mail. Enables you to send the table data in an email.

Export Data To File. Enables you to select the format for previewing
and exporting the table data. The available options are:

« Excel. The table datais formatted as an .xIs (Excel) file that can be
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Ul Element (A-2) Description

displayed in a spreadsheet.

o PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

o CSV. The table data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options
from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens the CSV
file.

« XML. The table data is formatted as an XML file that can be opened
in a text or XML editor.
Tip: To extract HTML code from the report:
« Open the file in an HTML editor

« Copy the relevant table into the target file

Rows per page Select the number of rows to be displayed on each page. You can also
manually enter value for the number of rows per page.

K < > 1 Click to navigate through the results page by page or to jump to the first
or last page.

<ClI Instances> The Cl instances found for the selected TQL query node. You can
double-click an instance to open the Configuration Item Properties
dialog box for that CI.

<Cl instances shortcut = Fordetails, see "IT Universe Manager Shortcut Menu" on page 231.
menu>

Display Label The name of the Cl instance as it appears in the topology map.
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Conditions Preview Dialog Box

This dialog box displays the conditions selected when selecting a complex type condition in the
Element Type tab of the Query Node Properties dialog box.

To access Click the Preview [ button from the Element Type tab of the Query Node

Properties dialog box.

See also "Query Node Conditions" on page 19

User interface elements are described below:

Ul Element (A-2) Description

Cl Type Displays the subtypes for which you defined conditions.

Condition Displays the icon of the selected condition, as defined in the Legend.
Filter by Specifies the selected condition (i.e., by Cl type or by qualifier, and for

qualifier, specifies the qualifiers).

Element Layout Preview Dialog Box

This dialog box displays the attributes selected in the Element Layout tab of the Query Node Properties
dialog box to be included in the query results for the selected element.

To access Click the Preview IX] button from the Element Layout tab of the Query Node
Properties dialog box.

See also "Query Node Conditions" on page 19

User interface elements are described below:

Ul Element (A-Z) Description

Attributes Mode Displays the Attributes condition selected in the Element Layout tab of the
Query Node Properties dialog box.

Cl Type Displays the CIT of the selected query node or relationship.

Excluded Attributes Displays the attributes appearing in the Excluded Attributes pane in the
Element Layout tab of the Query Node Properties dialog box.
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Ul Element (A-Z) Description
Qualifier Marked Displays the qualifiers selected in the Element Layout tab of the Query
Attributes Node Properties dialog box.

Specific Attributes Displays the attributes appearing in the Specific Attributes pane in the
Element Layout tab of the Query Node Properties dialog box.

Filter Cl Instances Dialog Box

This dialog box enables you to reduce the number of Cl instances to be displayed in a list by selecting a
condition and a value for a specific CI.

To access  Click the Filter ¥ button in the Cl Instances dialog box.

Important A description of the filter condition you defined appears above the table columns in the
information Cl Instances dialog box. For example, the following illustration shows that a filter
condition was created to display only Cl instances whose Cl type is Windows.

|Fi|ter: Cl Type[Eqgual nt]; I
Display Label | Cl Type
WNKPUKROT Windows

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:

Ul Element (A-

Z) Description
Attribute Displays all the attributes of the CI type to which the CI belongs.
Condition Select the required operator. For details, see "Attribute Operator Definitions" on
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Ul Element (A-
Z) Description
page 38.
NOT Select to filter the results by the negation of a condition and value.
Value Select or enter the required value.

Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query nodes using a join relationship.

To access In Enrichment Manager or Impact Analysis Manager, click the Add [/ button in

the Add Join Relationship dialog box.

Important You cannot select attributes of type list for a join relationship condition.
information

Relevant tasks .« "How to Define an Impact Rule — Workflow" on page 463
« "How to Define an Enrichment Rule — Scenario" on page 529
» "How to Define a TQL Query" on page 24
« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer

Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-2) Description

<Selected A selected query node. The first attribute applies to <end_1>.

query
node1>

<Selected | A selected query node. The second attribute applies to <end_2>.

query
node2>

Operator | Select one of the following operators:

« Equal. The system checks whether two selected attributes are equal.
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Ul
Element
(A-2) Description

« Not equal. The system checks whether two selected attributes are not equal.

« Sub string. The system checks whether the value of the first attribute is a substring
of the value of the second attribute.

« Sub string ignore case. The system checks whether the value of the first attribute
is a substring of the value of the second attribute regardless of the string's case.

Note: When using the operator Not equal, ensure that both sides of the join
relationship have a limited result size. It is recommended to define more specific
conditions so as not to overload the system with large results.

Layout Settings Dialog Box

This dialog box enables you to determine which attributes are used in the calculation of the TQL query
when using the UCMDB API. For details, see HP Universal CMDB Web Service API in the HPE
Universal CMDB Developer Reference Guide.

To access  Click Advanced layout settings in the Query Node/Relationship Properties dialog
box in Enrichment Manager or Impact Analysis Manager.

Important | Since this option is only relevant when querying the CMDB API, the query results in
information the user interface are not impacted by the attributes you select in this dialog box.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:
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Ul Element (A-Z) Description

Attribute name The name of the attribute.

Calculate Select this check box to include the attribute in the query's calculation.

Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the selected TQL query
node/relationship.

To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

access o . . .
In the editing pane, right-click the required query node and select Query

Node/Relationship Properties or double-click the required query node or relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Query Node Properties option.

To access in DFM:

1. Toaccess from the Adapter Definition tab, select an adapter. Click the Edit Input
Query <! putton to the right of the Input Query box to open the Input Query Editor.

2. Right-click the required query node/relationship and select Query Node Properties
or Relationship Properties or double-click the required query node or relationship.

Relevant | . "How to Define an Impact Rule — Workflow" on page 463
tasks o "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer Reference
Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:
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ul
Element
(A-Z) Description

Element (Optional) The Element name box contains the name of the selected query

name node/relationship. By default, the Cl type is assigned as the element's name. You can
rename a TQL query node in the Element name box giving it a unique label. This can be
helpful when there is more than one query node of the same ClI type in the TQL query.

Element Displays the Cl type of the selected query node. If you want to change the query node
type type to a child of the original type, select a subtype from the drop-down list.

Note:

« If you have already defined a complex type condition for the query node, the
condition is lost when you change the query node type.

« This feature is only available in the Modeling Studio.

Include  Select to display both the selected Cl and its children in the topology map.

subtypes
Note: This feature is only available in Enrichment Manager and Impact Analysis

Manager.

Query Click Query Result to display a topology map of the TQL query showing the number of
Result instances of each query node/relationship.

Note: This feature is only available in the Modeling Studio.

Show Select Show element in query results to display the selected TQL query node in the
element  editing pane. When this option is cleared, a Hidden in Query Results indicator =

in query  appears to the right of the selected TQL query node in the editing pane.
results

m

Ipaddres,
ontainment

% tembership @

Windows

ol
Iastnet

Any query results pertaining to that TQL query node are not displayed in the topology
map. This can be useful when certain relationships or TQL query nodes are required to
build the query but are not needed in the results. For example, Windows are connected
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Ul
Element
(A-2) Description

to the IP Subnet by defining specific IP Addresses, but in any query results you may
want to view the IP Address elements only and not the Windows elements.

Attributes Tab

This tab enables you to create an expression defining conditions that restrict the number of query nodes
that appear in the query. You can add an attribute condition to a query node or relationship and filter the
query results.

To access  Click the Attributes tab in the Query Node/Relationship Properties dialog box.

Important Each row represents an attribute condition that you specify. Use the And/Or column
information and the Brackets columns to link multiple conditions. In this way, you can construct a
more precise logical statement to generate the required results.

Note:

« This tabis not available for calculated relationships.

« When you access the Query Node/Relationship Properties dialog box in
Modeling Studio, this tab is read-only for Enrichment and Impact type queries
for which an Enrichment rule or Impact rule is defined.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks o "How to Define an Enrichment Rule — Scenario” on page 529
« "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:
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Ul Element
(A-Z)

ar

&

Advanced
layout
settings

And/Or

Attribute
name

Brackets ¢ )

Criteria

Default Value

NOT

Description

Add. Adds an attribute condition row. Select the attribute name, operator, and
value to define the attribute condition.

Delete. Deletes the selected attribute condition.
Up. Moves the selected row up.
Down. Moves the selected row down.

Show Criteria. Displays the criteria of the selected condition in a pop-up dialog
box.

Opens the Layout Settings dialog box which enables you to determine which
attributes are used in the calculation of the TQL query when querying the CMDB
using third-party or custom tools.

Note: This feature appears only in Enrichment Manager and Impact Analysis
Manager.

Click inside the And/Or field and select either And or Or to link multiple
conditions.

Select an attribute from the drop-down list.

Note: When you select one of the following attribute types: float, double, or
long, the In operator is not available.

Click inside the Brackets box to display a list of brackets you can use to build
more complex, logical statements.

Contains the attribute condition definition as defined in the Cl Instances dialog
box.

For parameterized attributes, enter a default value for the parameter.

Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system contains
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Ul Element

(A-2) Description
three nodes: Node1 is assigned the value A, Node2 is assigned the value B
and Node3 is not assigned a value. You create a query to retrieve all nodes
that are equal to A and select NOT; the results of your query only include
Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on

page 38.

Note: When you select one of the following attribute types: float, double, or
long, the In operator is not available.

Parameterized Select Yes to define a parameterized value for the attribute. Select No to define a
fixed value for the attribute.

Note: This feature is only available in the Modeling Studio.

Value Enter or select the value of the attribute. The Value options vary according to the
attribute type you select.

Note: You can paste a copied value into the window by pressing CTRL+v on
the keyboard.

Cardinality Tab

In this area, you can define a relationship cardinality, which enables you to define how many Cl
instances you expect to have at the end of a relationship in your query result.

To access  Click the Cardinality tab in the Query Node Properties dialog box.

Important Select the required relationship to which the selected query node is attached. Then
information = define the lower and upper limits for including the query node at the other end of the
relationship in the query results.

Each row represents a cardinality condition that you specify. Use the And/Or column
and the Brackets columns to link multiple conditions.

You can define relationship conditions that enable the relationship's connecting query
node to be included in the TQL query results by creating an expression defining that
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condition. For an example, see "Query Node/Relationship Properties Dialog Box" on
page 72.
Note:

« This tab only appears when a query node is selected.

« When you access the Query Node/Relationship Properties dialog box in
Modeling Studio, this tab is read-only for Enrichment and Impact type queries

for which an Enrichment rule or Impact rule is defined.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

o "How to Create a Perspective" on page 272

User interface elements are described below:

Ul Element (A-Z) Description

Add. Adds a cardinality condition row. Select the query node and max and
min values to define the cardinality condition.

@ Delete. Deletes a cardinality condition from the Cardinality area.
|E| Up. Moves a selected row up.

m Down. Moves a selected row down.

(=8 Show Criteria. Displays the criteria in a pop-up dialog box.
[ Inserts 1 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.
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Ul Element (A-2) Description

o Inserts 0 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or to link multiple
conditions.
Brackets ¢ ) Click inside the Brackets box to display a list of brackets you can use to

build more complex, logical statements.

Criteria Contains the cardinality condition definition as defined in the CI Instances
Dialog Box.
Max Enter the value that defines the upper limits for including the query node at

the other end of the relationship in the query results.

Note: You can use an asterisk (*) in the Max box to represent an
infinite value.

Min Enter the value that defines the lower limits for including the query node at
the other end of the relationship in the query results.

For example, if <end_1> is IpAddress and <end_2> is Windows, entering
1 in the Min box and asterisk (*) in the Max box instructs the system to
retrieve only those IP Addresses that are connected to at least one
Windows operating system. (The asterisk indicates an infinite value.)
Entering 3 in the Min box and asterisk (*) in the Max box instructs the
system to retrieve only those Windows operating systems that are
connected to at least three IP Addresses.

Query Node Select the required relationship to which the selected query node is
attached. The list contains all the relationships that are linked to the
selected query node.

Not Select NOT if you want the condition statement to do the opposite of what
is defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system
contains three nodes: Node1 is assigned the value A, Node2 is
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Ul Element (A-2) Description

assigned the value B and Node3 is not assigned a value. You create a
query to retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3 is not
assigned a value.

Example of a Relationship Condition

The example of relationship conditions is based on the following TQL query:

m

InAddres,
antainment

| Membership E
.5

Mode o]
IpSubnet

In the Relationship Cardinality dialog box, the following relationship conditions are defined for the
query:

« Containment —Min: 2, Max: 4

« Membership —Min: 1, Max: *

Using the OR operator, the definitions appear in the Cardinality section, as follows:

nor | ( | Criteria [ 3 | Andor
Cortainment (MNode, [pAddress): 2.4 OR
Membership (lpSubnet, Mode) : 1..*

e [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)] means that the
node must either have between two and four IP Addresses OR be a member of the IP Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as follows:

wor | ( | Criteria | 3 | Andior
Containment (Node, [pAddress): 2.4 AND
Membership (lpSubnet, Mode) : 1.*

e [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)] means that the
node must have between two and four IP Addresses AND also be a member of the IP Subnet.
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Note: A cardinality of (0..0) is only valid when both ends of a relationship are defined with that
cardinality. If one end is defined with cardinality (0..0) and the other end is defined with a different
cardinality, the condition is invalid. However, the TQL query is saved (the cardinality has no effect
on the query results).

Element Type Tab

This area enables you to specify subtype conditions for the selected query node or relationship.

To access Click the Element Type tab in the Query Node/Relationship Properties
dialog box.

Important This tab is only available in the Modeling Studio.

information

This tab is not available for calculated relationships.
Relevant tasks « "How to Define a TQL Query" on page 24
« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270
» "How to Create a Perspective" on page 272

« "How to Define a Complex Type Condition - Scenario" on page 31

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the selected
conditions:

« @ Include the subtype without its descendants.
« @ Include the subtype with its descendants.
« ™ Exclude the subtype without its descendants.

% Exclude the subtype with its descendants.

Cl When Customize subtypes is selected, the Cl Types pane displays a tree

Types/Relationships = with all subtypes of the selected Cl type (for relationships, the

pane Relationships pane displays a tree with all subtypes of the selected
relationship). After selecting conditions in Conditions pane, click the
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Ul Element (A-2) Description

Preview [2] button to open the Conditions Preview dialog box.

Conditions pane For details, see "Query Node/Relationship Properties Dialog Box" on page
72.

Customize subtypes Select Customize subtypes to set a complex type condition. Select the
required subtypes from the tree in the Cl Types/Relationships pane and
select conditions for them in the Conditions pane, as described below.

Element type Select Element type to set a simple type condition. If you want to include
all subtypes of the selected Cl type, select the Include subtypes check
box. If you do not want to include all subtypes, clear the check box.

Conditions Pane

Ul Element (A-2) Description

Apply this condition = Select this check box to apply the specified condition for the selected Cl
recursively on all type to all of that Cl type's descendants, recursively.

subtypes of

<selected Cl type>

By ClI types Select By Cl types to include or exclude all instances of the selected Cl
type in the query results.

By qualifiers Select By qualifiers to include or exclude instances of the selected Cl
type with specific qualifiers in the query results. A pop-up window appears
with alist of qualifiers. Select the required qualifiers for the selected
subtype. For details on the qualifiers, see "Qualifier Tab" on page 84.

Condition Select a condition for the selected Cl type. The following options are
available:

« None. No condition is selected for this Cl type. Instances of this Cl
type and all its descendants are included in the query results, unless a
parent Cl type of this Cl type was selected for exclusion and the Apply
recursively check box was selected.

« Include <selected subtype> in the query. Includes instances of the
selected Cl type in the query results (according to the condition
selected). An example of a situation where this option is relevant is
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Ul Element (A-2) Description

where a parent of the Cl type was selected to be excluded and the
Apply recursively check box was selected. You can select certain
subtypes to be included, so the query results exclude all subtypes of
the parent Cl type except for the specified ones.

« Exclude <selected subtype> from the query. Excludes instances of
the selected Cl type from the query results (according to the condition
selected).

Element Layout Tab

This area enables you to select the attribute values returned in the query results for the selected query
node or relationship.

To access  Click the Element Layout tab in the Query Node/Relationship Properties dialog box.

Important = When you make a selection of the attributes to include in the query results for a
information = particular CIT, the selection also applies to all of its descendant CITs. You can
manually exclude specific attributes for descendant CITs in the Conditions pane.

This option is only relevant when querying the CMDB API. The query results in the
user interface are not impacted by the attributes you select in this dialog box.

This tab is only available in the Modeling Studio.
This tab is not available for calculated relationships.
Relevant « "How to Define a TQL Query" on page 24
tasks « "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

« "How to Define a Complex Type Condition - Scenario" on page 31

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<Legend> Indicates the icons displayed next to the subtypes based on the selected
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Ul Element (A-2)

Cli
Types/Relationships
pane

Conditions pane

No attributes
Select attributes for
layout

Conditions Pane

Ul Element (A-Z)

Attributes condition

Attributes with the
following qualifiers

Available Attributes

HPE Universal CMDB (10.31)

Description
attributes condition:
« @ Include all attributes for this subtype.

« @& Include only the selected attributes for this subtype.

When Select attributes for layout is selected, the Cl Types pane displays
a tree with all subtypes of the selected ClI type (for relationships, the
Relationships pane displays a tree with all subtypes of the selected
relationship). After selecting conditions in Conditions pane, click the
Preview 2. button to open the Element Layout Preview dialog box.

For details, see "Conditions Pane" below.

If you select No attributes, no attribute values are returned in the query
results for the selected query node or relationship.

If you select Select attributes for layout, you can select the attributes to
be included in the query results for the selected query node or relationship.

Description
Select one of the following options:

« None. No attributes are included in the query results for the selected
element.

« All. All attributes defined for the selected element are included in the
query results.

« Specific Attributes. Only the selected attributes are included in the

query results for the selected element.

You can include attributes with specific qualifiers. Click the ellipsis button
to open a dialog box with the available qualifiers and select the required
qualifiers.

Note: This feature only appears when you select Specific Attributes
for the Attributes condition.

Displays all of the available attributes for the selected element.
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Ul Element (A-2) Description

Excluded Attributes = When All is selected as the Attributes condition, you can exclude selected
attributes by moving them into the Excluded Attributes pane.

When Specific Attributes is selected as the Attributes condition fora CIT
that has inherited an attribute selection from its parent CIT, you can
exclude specific attributes from the selection by moving them to the
Excluded Attributes pane.

Alternatively, if you select attributes with selected qualifiers fora CIT, you
can exclude some attributes from that selection by moving then to the
Excluded Attributes pane.

You can move attributes into and out of the pane using the arrow buttons.

Exclude specific Select this check box to enable the Available Attributes and Excluded
attributes Attributes panes and the arrow buttons.

Note: This feature only appears when you select All for the
Attributes condition.

Specific Attributes Displays the attributes to be included in the query results for the selected
element. Move attributes into and out of the pane using the arrow buttons.

Note: This feature only appears when you select Specific Attributes
for the Attributes condition.

Qualifier Tab

This area enables you to define qualifier conditions for the selected query node or relationship. For
example, you can use a qualifier to define a CIT as abstract, meaning you cannot create instances from
it.

To access Click the Qualifier tab in the Query Node/Relationship Properties dialog box.
Important By default, multiple selection links the conditions with the OR operator.
information

Note: This tabis only available in Enrichment Manager, Impact Analysis
Manager, and the Input Query Editorin DFM.

Relevant tasks « "How to Define an Impact Rule — Workflow" on page 463
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o "How to Define an Enrichment Rule — Scenario" on page 529
» "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
» "How to Create a Template" on page 270

» "How to Create a Perspective" on page 272

User interface elements are described below:

Ul Element
(A-Z) Description

<Qualifiers> Forallist of the available qualifier options, see "Qualifiers Page" on page 509.

Negate If this check box is selected, then the element is included in the query results only if it
Qualifiers has no qualifier in the list of selected qualifiers.

Identity Tab
This area enables you to filter the TQL query results according to the element ID of the instances found

for the selected TQL query node.

To access  Click the Identity tab in the Query Node Properties dialog box.

Important Move the required element from the Optional identities pane on the left to the
information Selected identities pane on the right to define what you want included in the TQL
query results using the left and right arrows.

Note: This tab only appears when a query node is selected.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

« Implement a Discovery Adapter in the HPE Universal CMDB Developer
Reference Guide
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"How to Create a Pattern View" on page 269
"How to Create a Template" on page 270

"How to Create a Perspective" on page 272

The following elements are included (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

<Toolbar>

Description

For descriptions of the toolbar buttons, see "Cl Instances Dialog Box" on
page 65.

Optional identities  Displays all the instances found for the selected TQL query node.

pane

Selected identities  Displays the elements that are used to define what should be included in the

pane

TQL query results.

Refine Query Node Type Dialog Box

This dialog box enables you to change the ClI type of a TQL query node after you have created a TQL

query.

To access

Important
information

Relevant
tasks

In Impact Analysis Manager or Enrichment Manager, right-click the required query

node and select Refine Query Node Type.

Note: If you are using Enrichment Manager, select Query mode at the top of the

editing pane to display the Refine Query Node Type option.

You can change the Cl type to a type from one of the ClI type's children, if one exists.

If no such Cl type exists, this option does not appear.

"How to Define an Impact Rule — Workflow" on page 463
"How to Define an Enrichment Rule — Scenario" on page 529
"How to Define a TQL Query" on page 24

"Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

"How to Create a Pattern View" on page 269

"How to Create a Template" on page 270
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« "How to Create a Perspective" on page 272

See also « "Topology Query Language (TQL) Overview" on page 15

o "CIl Type Manager" on page 481

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<List of Cl types from which to choose> Select the required Cl type.

Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be created.

To access | Inthe editing pane of Impact Analysis Manager, Enrichment Manager, and the
Modeling Studio, click the Create Relationship [* button on the toolbar and draw a

line between two query nodes. The Select Relationship Type dialog box opens
automatically.

Important = Select one of the following relationship types:

information . . . . . I
« Regular Relationship. For details, see "Add/Edit Relationship Dialog Box" on
page 53.
« Join Relationship. For details, see "Add/Edit Join Relationship Dialog Box" on
page 50.
« Compound Relationship. For details, see "Add/Edit Compound Relationship
Dialog Box" on page 47.
« Calculated Relationship. For details, see "Add/Edit Calculated Relationship
Dialog Box" on page 45.
Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks

o "How to Define an Enrichment Rule — Scenario” on page 529
« "How to Define a TQL Query" on page 24

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
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See also

"How to Create a Template" on page 270

"How to Create a Perspective" on page 272

"How to Add Query Nodes and Relationships to a TQL Query" on page 25

"Cl Type Relationships" on page 485

Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of query nodes that appear in

the query.

To access

Important
information

Relevant
tasks

In Impact Analysis Manager, Enrichment Manager and the Input Query Editor in DFM,
click Condition €%/ in the Add Triplet dialog box.

In the Modeling Studio, click Condition (#linthe Subgraph Definition dialog box.

Contains the following tabs:

Attribute. Enables you to define attribute conditions for query nodes and
relationships. See a description of the elements in the Attribute tab in the table
below. Each row represents an attribute condition that you specify. Use the
And/Or column and the Brackets columns to link multiple conditions. In this way,
you can construct a more precise logical statement to generate the required
results.

Qualifiers (for Enrichment Manager, Impact Analysis Manager, and the Input
Query Editorin DFM). Enables you to define qualifier conditions for the selected
query node or relationship. For details, see "Qualifier Tab" on page 84.

Element Type (for the Modeling Studio). Enables you to define subtype
conditions for the selected query node or relationship. For details, see "Element
Type Tab" on page 80.

"How to Define an Impact Rule — Workflow" on page 463
"How to Define an Enrichment Rule — Scenario" on page 529
"How to Define a TQL Query" on page 24

"Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

"How to Create a Pattern View" on page 269
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« "How to Create a Template" on page 270

« "Microsoft Internet Information Services (II1S) Discovery" in the HPE Universal
CMDB Discovery and Integrations Content Guide

« "How to Create a Perspective" on page 272

User interface elements are described below:

Ul
Element
(A-Z) Description

i Add. Adds the subgraph condition definition.

g Delete. Deletes the subgraph condition definition.
[ Up. Moves a selected row up.

[ Down. Moves a selected row down.

(=X Show Criteria. Displays the subgraph condition definition in a pop-up dialog box.

And/Or | Click inside the And/Or field and select either And or Or to link multiple conditions.

Attribute Choose an attribute from the list.
name

Brackets Click inside the Brackets box to display a list of brackets you can use to build more
L) complex, logical statements.

CIT Contains the CIT selected from the Source and Target lists.

Note: This option is not relevant when accessing the dialog box from the Modeling
Studio.

Criteria = Contains the attribute condition definition as defined in the CI Instances Dialog Box.

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances
that were not assigned a value. For example, let us assume that your system
contains three nodes. Node1 is assigned the value A, Node2 is assigned the value B
and Node3 is not assigned a value. If you create a query in which you want to
retrieve all nodes that are equal to A and you select NOT, the results of your query
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ul
Element
(A-Z) Description

only include Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page 38.

Value Enter or select the value of the attribute. The Value options vary according to the
attribute type you select.

Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL query data related to a
specific Cl.

To access To access in Enrichment Manager, Impact Analysis Manager, and the Modeling

Studio:

In the editing pane, right-click the required query node and select Subgraph
Definition.

Note: If you are using Enrichment Manager, select Query mode at the top of
the editing pane to display the Subgraph Definition option.

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |E| button to the right
of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Subgraph Definition.

Important The following icon is displayed next to the query node for which you define a
information  subgraph:

m

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529

« "How to Define a TQL Query" on page 24
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See also

« "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide

« "How to Create a Pattern View" on page 269
« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272
« "Subgraph Definition" on page 22

« "How to Create a Subgraph Definition — Scenario" on page 31

User interface elements are described below:

Ul Element
(A-2)

Depth

Element
condition
exists

Relationship

Relationship
Direction

Source

Description

Add. Adds a subgraph definition. In Enrichment Manager, Impact Analysis
Manager, and the Input Query Editorin DFM, click to open the Add Triplet dialog
box. In the Modeling Studio, click to add a row to the table.

Delete. Deletes the selected subgraph definition.

Condition. Enables you to edit a subgraph definition. In Impact Analysis Manager,
Enrichment Manager, and the Input Query Editorin DFM, it opens the Edit Triplet
dialog box. In the Modeling Studio, it opens the Subgraph Condition Definition dialog
box.

A number that represents the longest path (that is, the maximum number of
connecting query nodes) allowed between two Cls in the CMDB that should be
included in the DFM process.

Default: 5

A green asterisk appears next to either the source, relationship, or target in the
subgraph definition if an attribute condition has been defined for one of them in the
Subgraph Condition Definition dialog box. For details, see "Subgraph Condition
Definition Dialog Box" on page 88.

The relationship selected connecting the source to the target query node.

The direction of the relationship selected, indicating which query node is dependent
on the other.

The required source query node selected.
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Ul Element
(A-Z) Description
Target The required target query node selected.

User Preferences Dialog Box

This dialog box enables you to reset system preferences.

To access  Select Tools > User Preferences, or click the Configure User Preferences 5l

button on the Status Bar.

Important | All the preferences you select (such as whether to display certain wizard pages or
information warning message preferences) are stored in the system. This dialog box enables you
to reset those preferences.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description

<Left pane> Select the preferences page to edit. The following options are available:

« Wizard Preferences. Enables you to define whether to hide or display certain
wizard pages.

« Optional Messages Preferences. Enables you to define whether to hide or
display certain messages.

« Discovery Preferences. Enables you to define:
o Whether to hide or display certain Discovery warning messages
o The required default external editor (such as Notepad)
o Whether to use Basic or Advanced Discovery mode

« General. Enables you to define general application preferences.

« Reports. Enables you to set the category of Custom Reports selected by
default.

<Preferences The list of warning messages and their user-selected preferences.
list>

Filter by Enter a search word to filter the list of options.
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Ul Element

(A-Z) Description

Reset All Click toreset all the preferences to their default values.
Reset Page Click toreset the selected preference to its default value.

Troubleshooting and Limitations — Topology Query
Language
This section describes troubleshooting and limitations for Topology Query Language.
« When creating resources, such as TQL queries, views, and Impact rules, make sure that there are
no spaces at the end of the resource name.
« Inamultitenancy environment, TQL query names cannot contain an @ character.

« When importing a resource (for example, TQL query, view) in a multi-tenancy environment in
Modeling Studio, for the import to work, the TQL query used for the creation of the view needs to
have as consumer or owner tenant, the tenant associated with the user that performs the import.
The user who performs the import of a view has to have at lest view permission on the TQL query
used.

The instructions below are an example for your reference:

a. Create atenant.

b. Create a role with the following permissions: All permissions on view and folder, and
permissions to access Modeling Studio.

c. Create a user with the above role in the context of tenant from step a.

d. Goto Modeling Studio > Resources > View, assign the tenant created in step a for the
desired folder as owner tenant. (Meaning that the views are assigned to the tenant associated
with the user who will perform the import.)

e. Loginas the new user.
f. In Modeling Studio, import a new view.

« If an error occurs while working with views in the Modeling managers, when adding Cls to the
CMDB, or when updating existing Cls, and the error log indicates that objects are missing in the
database, do the following:

a. Perform a DB backup.

b. Access the JMX console and run the following methods under service=DAL services:

HPE Universal CMDB (10.31) Page 93 of 572



Modeling Guide
Chapter 1: Topology Query Language

« rebuildModelViews

« rebuildModelDBSchemaAndViews

Caution: Invoking the above JMX method could drop the following: attributes, tables, indexes.
Random usage is prohibited.

« Ifthe login takes along time when navigating to the Modeling modules, go to Infrastructure Settings
Manager and set the value of the mam.gui.automation.flow.mapping.enabled setting to false.
This disables the Automation Flow functionality but improves the login time for the Modeling
modules.

» For TQL queries to be valid, they must comply with certain restrictions.
This section includes the following topics:
o "Understanding Validation Restrictions" below
o "Impact Analysis TQL Query Validation" on the next page

o "Enrichment TQL Query Validation" on page 96

Understanding Validation Restrictions

For Impact Analysis, Discovery, and Enrichment TQL query types to be valid, they must comply
with the following restrictions:

o Unique Names. TQL query elements must have unique names.

o Self Relationships. A TQL query must not contain self relationships, that is, a relationship must
not lead from a query node to itself, as the following example illustrates:

Foute

o Containment ij
éo—r@

IpAddress
Mode

o Cyeclic Graph. The TQL query structure cannot be a closed circle, as shown in the following
example:
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=

ode

Maraged Relationship
Containment

Configurationltem

IpAddress :
tembership

IpAddress_1

o Separate Query Nodes and Groups. All the TQL query nodes must be linked to one another,
that is, the TQL query cannot contain separate query nodes or groups, as the following example

illustrates:
S ‘.Node
Cantainment CDmFJ!JSITmn
i
mi L
4.'7'_]5 .
ATH Port Eridgye

Impact Analysis TQL Query Validation
Impact Analysis TQL queries must also comply with the following restrictions:

o Number of query nodes. An Impact Analysis TQL query must consist of at least two query
nodes.

o Trigger and affected query nodes must be connected. There must be a path of relationships
from the triggered query node to the affected query nodes.

o Selecting query nodes to function as Impact Analysis triggers. When selecting query
nodes to function as Impact Analysis triggers, the query nodes must comply with the following
restrictions:
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« You can select more than one query node as a trigger. However, you cannot define a query
node both as affected and as a trigger.

« If aquery node has a relationship whose minimum limit is O (meaning that one of its ends
does not necessarily have a query node linked to it), the query node that is linked to its other
end cannot be a root cause query node (because it may or may not exist in the TQL query).
For details about minimum limits, see "Cardinality Tab" on page 76. For example,
Configuration Item cannot be either a root cause or affected query node because it is
connected to the query node with a Min limit of o.

Cardinality: Containment (Mode, [pAddress) : 1..* AND
(| Compostion (Mode, Configurationtterm) : 0..*

/«"ﬁNnde
e
J(-‘-'
Lt tainment

e

B Coriposition 1

@ ty
Configurationltem IpAddress

Cardinality: Composition (Mode, Configurationttem) : 1..* Cardinality: Containment (Mode, IpAddress) : 1.*

Note: A query node that is hidden cannot be a root cause or an affected query node.

o The connection between trigger and affected query nodes. The trigger query node and
affected query nodes you define must be connected by a path of relationships from the triggered
query node to the affected query nodes.

Enrichment TQL Query Validation
Enrichment TQL queries must comply with the following restriction:

o Required elements. You cannot perform Enrichment on a non-required query node, that is, a
query node that does not necessarily appear in the TQL query results.

Example 1. In this example, the TQL query results can be either A and B or A and C. Therefore,
you cannot add an Enrichment query node to query nodes B or C because they are not required
elements. You can add an Enrichment query node to query node A because it always appears in
the TQL query results. For details on how to add Enrichment query nodes and relationships, see
"How to Add Enrichment Query Nodes and Relationships to an Enrichment TQL Query" on page
533.
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,-énrichrnent relationship

Example 2. In this example, both A and B are required elements that always appear in the TQL
query results. Only C is not a required element because it has a cardinality of 0. Therefore, you
cannot add an Enrichment query node to it.

s
&
E,nﬁl::hmenl relationship

A\
Ervichmant relationsHip
A
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This chapter includes:

Calculated Relationships Overview ... 98
Calculated Relationships . ... ... e 98
Calculated Relationship Types ...l 99
How to Set Folding Rules for Composite Cls ... .. 99

Calculated Relationships Overview

A calculated relationship represents the connection between two Cls, whose path meets the conditions
defined for the triplets on which it is based in the Cl Type Manager. For details on how to define triplets,
see "Triplets Page" on page 511.

You can use calculated relationships to create TQL queries just like any other relationship in the Cl
Type model. This enables you to base Enrichment rules, Impact rules, and views on calculated
relationships.

The direction of the calculated relationship is not always the same direction as the physical relationship
taken from the Cl Type model. There can be one or more relationships between two Cls, depending on
the way the triplets, on which the calculated relationship is based, are defined.

Calculated Relationships

Calculated relationships are defined by one or more triplets. Each triplet is defined by the following
components:

« One source Cl type
o One target Cl type
« A physical relationship type (for example, Containment) that links the two CI types

« The required direction. The direction can be identical to or opposite from the direction of the physical
relationship between the source and target Cls.
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Since calculated relationships are defined by physical relationships from within the class model, their
lifetime is determined by the lifetime of the physical relationships. When the physical relationship in the
class model is removed, the corresponding calculated relationship is removed from all view results as
well.

Note: If you create a new ClI type or relationship in the Cl Type Manager, you need to define the
required triplets.

Example of a Triplet Definition:

@_J Web Service Link: \_,a Running Software =)

Calculated Relationship Types

There is one out-of-the-box calculated relationship called Impacted By. Impacted By contains two
subtypes, each one representing a different type of dependency relationship (complete dependency vs.
potential dependency.)

« Impacted by (Directly)

« Impacted By (Potentially)

How to Set Folding Rules for Composite Cls

This task describes how to configure the folding rules which define the composite Cls used in
Configuration Manager. Composite Cls form the content of the managed views.

Note: This task is only relevant for users of HPE Universal CMDB Configuration Manager.
This task includes the following steps:

» "Prerequisites" on the next page
« "Define a folding rule with no conditions" on the next page

» "Define afolding rule with conditions" on page 101
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1. Prerequisites

Consider how you want to display the data in composite Cls in Configuration Manager and then
decide on the rules for the scope of the composite Cls.

2. Define a folding rule with no conditions
a. Select Modeling > Cl Type Manager.

b. Select Calculated Relationships from the list box in the CI Types pane. Under Calculated
Links, select Folding Rules (Configuration Manager).

c. Intheright pane, click the Triplets tab.

d. Inthe Triplets tab, click [ to open the Add Triplet dialog box. Define the triplet as follows:

Ul Element Description

Source Select the required source Cl type.

Target Select the required target Cl type.

Relationship Select the required relationship connecting the source and target Cl
types.

Note: The list of available relationships appears only after
defining the source and target Cl types.

Relationship Select the required direction.
Directi .
irection o = Thedirection is from source to target.
o = The direction is from target to source.

The direction of the relationship determines which is the composite
Cl and which is the component CI.

« When the relationship's arrow is pointing to the target, the source
query node is the composite Cl and the target query node is the
component Cl:
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Ul Element Description

Compaosite Cl Component CI

Relatianshio

Source A

« When the relationship's arrow is pointing to the source, the target
query node is the composite Cl and the source query node is the
component Cl:

Component Cl Composite CI

Relationship
Source B Target B

e. Click OK to save your changes.

After saving the changes, Configuration Manager receives notification of the change and
recalculates the relevant views.

3. Define a folding rule with conditions

Select this option if you want to specify attribute conditions for a specific node. Only Cls that
match those conditions will be folded under the rule in Configuration Manager. For example, you
can specify that only installed software with a specific name is a component Cl of the node.

a. Select Modeling > Modeling Studio.

b. Onthe Resources tab, select Queries from the Resource Type list box.

c. Inthe Configuration Manager node of the tree, click £ and add a folder called Filtered

Folding Rules, if one does not already exist.

d. Select New > Query to open the TQL Query Editor. Define a TQL query that has the following
structure:

source > relation > target
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For details about the source and target nodes, see the table in "Define a folding rule with no
conditions" on page 100. For general information about creating TQL queries, see Define a
TQL Query.

e. Click the Edit properties |f§.'i'| button and select Perspective in the Type drop-down list.
f. Click OK.
g. Right-click the source query node icon and select Set As Contact Query Node.

h. Right-click the target query node icon and select Query Node Properties. Click [ to specify

the required conditions for the folding rule.

i. Click OK to save your changes. The following picture shows an example of a TQL query that
was defined for a folding rule. In this example, Node is the source of the TQL query and
InstalledSoftware is the target:

4

LB

Composition ==
= S )

Mode

Installed
Software

j- Execute the following JMX command:

i. Access the JMX console by launching your Web browser and entering the following
address: http://<server_name>:<port_number>/cnc/jmx-console, where <server_
name> is the name of the machine on which Configuration Manager is installed.

ii. Enterthe JMX console authentication credentials.

iii. Click Configuration Manager > View Service. Select updateFoldingRules and click
Invoke.

k. Restart the Configuration Manager server.
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This chapter includes:

Generate aDirect Link —OVerview .. ... ... il 103
How to Generate a Direct Link —Scenario ......... . ... ... .. 104
How to Create a Direct Link to a Template with ParameterValues ... ... ... ...................... 104
How to Encrypt the Password of a Direct Link Usingthe JMX Console ............................ 105
Generate a Direct Link User Interface ... . 106

Generate a Direct Link — Overview

Direct Links enables you to create a URL that guides another user to a specific target view or Cl in
Universal CMDB.

You can create a URL that:

« Opens a specific Universal CMDB view or Cl directly in Universal CMDB. This enables users to
retrieve information from Universal CMDB without being located in the Universal CMDB context.

Note: To open a specific view or Cl directly in Universal CMDB, use the Open in context
links option. For details, see "Select Command Page" on page 107.

« Enables integration with Universal CMDB:

o If you create a URL using the Embedded links option, the URL takes you first to the Universal
CMDB login page. After you enter your login name and password, the target page opens in your
browser.

Note: To open the target page in your browser, use the Embedded links option. For
details, see "Select Command Page" on page 107.

When you create a URL, you can:

« Sendthe URL to an email recipient
« Copy the URL to the clipboard

« Test the URL to ensure that the target application page can be found
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The user to whom you are sending the URL must have an account with sufficient privileges to open the
target page. You must apply the appropriate viewing and editing permissions to the users and user
groups that want to access the target view. You set permissions in Managers > Security > Roles
Manager. For details, see "Roles Manager Page" in the HPE Universal CMDB Administration Guide.

How to Generate a Direct Link — Scenario

This scenario describes how to generate a direct link to email the URL of a specific Cl to another
person.

Jane Harrison is a senior engineer in the ABC Software company. She has encountered a problematic
Clin aview she has created. She wants to inform Henry Jones, who is working with the same view
through HPE ServiceCenter, about the problematic Cl. Since the view Jane has created contains many
hundreds of Cls, she decides to email Henry the URL of the Cl so that he does not have to spend a lot
of time searching for that specific CI.

InIT Universe Manager, Jane selects Generate Direct Link from the Edit menu. On the Select
Command page, she selects Open in context links and then the Show view option, and clicks Next.

On the Direct Link Parameters — Show View page, she selects the view she created, the
problematic Cl, and View topology as the mode in which Henry should open the CI. When the URL is
created, she emails Henry the link to the problematic ClI.

For details, see "Generate Direct Link Wizard" on page 107.

How to Create a Direct Link fo a Template with
Parameter Values

This task describes how to create a direct link to a template by including the parameter values in the
URL.

This task includes the following steps:

« "Create a Direct Link to a Template" on the next page
« "Edit the URL" on the next page

» "Paste the URL into a Browser" on the next page
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1.

Create a Direct Link to a Template

InIT Universe Manager, select Edit > Generate Direct Link to run the Generate Direct Link
wizard. On the Select Command page, select Embedded links. Select Show view topology
from the list of options. On the Direct Link Parameters page, select the required template from the

drop-down list.

Edit the URL

When the wizard finishes, click Copy URL and paste the URL into a text editor such as Notepad.
Append the following text to the end of the URL:
&params=[parameterl=valuel,parameter2=value2]

where parameterl and parameter2 are the parameter names for the selected template and
valuel and value2 are the values you want to enter for the parameters.

Note: Any special characters must be entered using the URL encoding. In the above
example, the URL encoding for the [ character is %5B, the URL encoding for the ] character is
%5D, and the URL encoding for the comma is %2C. Thus, the actual text to enter is:

&params=%5Bparameterl=valuel%2Cparameter2=value2%5D

3. Paste the URL into a Browser

Paste the URL into a browser. Universal CMDB opens to the selected template with the
parameters assigned the specified values.

How to Encrypt the Password of a Direct Link Using
the JMX Console

This task describes how to encrypt the password contained within a direct link using the JMX console.

To encrypt the password of a direct link using the JMX console:

1.

Launch your Web browser and enter the following address: https://<server_name>:<port
number>/jmx-console, where <server_name> is the name of the machine on which Universal
CMDB is installed.

Under UCMDB-UI, locate UCMDB Integration.
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3. Under getEncryptedPasswordForURL, enter your user name and the password to encrypt.

4. Click Invoke to view the encrypted string.

Generate a Direct Link User Interface

This section includes (in alphabetical order):

» "Generate Direct Link Dialog Box" below

o "Generate Direct Link Wizard" on the next page

Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can access Universal
CMDB.

To From the Modeling main menu, select Edit > Generate Direct Link. After you
access configure the Direct Link parameters in the "Generate Direct Link Wizard" on the next
page, click Finish on the Finish page to open the Generate Direct Link dialog box.

In IT Universe Manager, click the Generate Direct Link to View = button on the ClI

Selector toolbar in Browse Views mode.

In the Reports module, click the Generate Direct Link = button on the toolbar or select

Operations > Generate Direct Link > Direct link to application on the Modeling
main menu.

Relevant | "How to Generate a Direct Link — Scenario" on page 104
tasks

See also | "Generate a Direct Link — Overview" on page 103

User interface elements are described below:

Ul Element
(A-2) Description

Copy URL  Copies the URL to the clipboard.

Description = Describes the parameters that are included in the URL. For details on selecting the
parameters, see "Select Command Page" on the next page.
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Ul Element
(A-Z) Description

Link URL The created URL that accesses the specified Universal CMDB function.
Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application page can be found.

Note: This button is not available when using Linux.

Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific target view or Cl in
Universal CMDB.

To access | From the Modeling main menu, select Edit > Generate Direct Link.

Important By default, this wizard is set to display a Welcome page. You can choose not to
information = display the Welcome page by selecting the Do not show this page again check

box.

Relevant "How to Generate a Direct Link — Scenario" on page 104

tasks

Wizard The Generate Direct Link wizard contains:

ma

P "Select Command Page" (<Open in context links options> and <Embedded links

options>) > "Finish Page"

See also "Generate a Direct Link — Overview" on page 103

Select Command Page

This wizard page enables you to select the required parameters that must be added to the URL.

You can create two types of links:

« Open in context links. Creates a URL that opens a specific view or Cl directly in Universal CMDB
without having to be in the Universal CMDB context:

« Embedded links. Creates a URL that enables you to embed an Universal CMDB applet into
external applications.
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Important By default, this wizard is set to display a Welcome page. You can choose not to
information = display the Welcome page by selecting the Do not show this page again check

box.

Wizard The Generate Direct Link wizard contains:

map "Select Command Page™ (<Open in context links options> and <Embedded links
options>) > "Finish Page"

See also "Generate Direct Link Wizard" on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

<Left A graphic illustration of the selected command.
pane>

Cll Grid Creates a URL that displays all the Cl instances found in the CMDB for a selected Cl
type and its children. For details, see "Direct Link Parameters — Cll Grid Page" on
page 112.

| Note: Available when you select the Embedded links option.

Cl Selector Creates a URL that embeds the Cl Selector displaying the Cls of a selected view,
into external applications. For details, see "Direct Link Parameters — C| Selector
Page" on page 110.

| Note: Available when you select the Embedded links option.

Cl Type Creates a URL that embeds the Cl type selector into external applications. For
Selector details, see "Direct Link Parameters — Cl Type Selector Page" on page 111.

| Note: Available when you select the Embedded links option.

Description A description of the selected command.

Impact Map Creates a URL that embeds an impact map into an external application. For details,
see "Direct Link Parameters — Impact Map Page" on page 113.

Note: Available when you select the Embedded links option.

Model Creates a URL that embeds the Model Editor into an external application, highlighting
Editor
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Ul Element
(A-Z)

Query
Editor

Related Cls

Report
Viewer

Report
Viewer -
Saved
Report

Show ClI
properties

Show view

Show view
topology

HPE Universal CMDB (10.31)

Description

the selected Cls in the Cl Selector in the Model Editor. For details, see "Direct Link
Parameters — Model Editor" on page 114.

| Note: Available when you select the Embedded links option.

Creates a URL that embeds the Model Editor into an external application, displaying
the selected TQL query. For details, see "Direct Link Parameters — Query Editor" on
page 115.

| Note: Available when you select the Embedded links option.

Creates a URL that opens a topology map displaying the selected Cl and its
immediate neighbors within the selected view. For details, see "Direct Link
Parameters — Related Cls Page" on page 115.

| Note: Available when you select the Embedded links option.

Creates a URL that opens a specific report. For details, see "Direct Link Parameters
— Report Viewer Page" on page 116.

| Note: Available when you select the Embedded links option.

Creates a URL that opens a saved topology or custom report. For details, see "Direct
Link Parameters — Report Viewer — Saved Report Page" on page 116.

| Note: Available when you select the Embedded links option.

Creates a URL that displays a Cl's properties. For details, see "Direct Link
Parameters — Show CI Properties Page" on page 117.

| Note: Available when you select the Embedded links option.

Creates a URL that displays the selected view and optionally preselects a query node
in it. For details, see "Direct Link Parameters — Show View Page" on page 119.

| Note: Available when you select the Open in context links option.

Creates a URL that displays the topology map of the selected view and embeds it in
an external application. For details, see "Direct Link Parameters — Show View
Topology Page" on page 118.
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Ul Element
(A-Z) Description
| Note: Available when you select the Embedded links option.
Startin Creates a URL that opens Universal CMDB at the selected page. For details, see
mode "Direct Link Parameters — Start in Mode Page" on page 120.
| Note: Available when you select the Open in context links option.
Steps The current step in the procedure.

View Editor Creates a URL that opens a specific view in the Pattern View Editor in Modeling
Studio. For details, see "Direct Link Parameters — View Editor Page" on page 118.

| Note: Available when you select the Embedded links option.

Views Creates a URL that embeds the View Selector in an external application, enabling you
Selector to select and display a view in that application. For details, see "Direct Link
Parameters — Views Selector Page" on page 119.

| Note: Available when you select the Embedded links option.

Direct Link Parameters — Cl Selector Page

This wizard page enables you to create a URL that embeds the Cl Selector displaying the Cls of a
selected view, into external applications.

Wizard map "Select Command Page" (Embedded links > CI Selector) > "Finish Page"
Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

User interface elements are described below:

Ul Element (A-Z) Description

Allow multi selection = Allow single or multiple selection of Cls.

Selected view Select the required view from which you want to select the required Cls.
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Ul Element (A-2) Description
« Click |E| to open the View Selector dialog box. Select the view you
want to appear in the Cl Selector.

« Click #to delete the selected view.

Direct Link Parameters — Cl Type Selector Page

This wizard page enables you to create a URL to a hierarchical tree or list of selected Cl types, which
can be embedded into an external application.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Cl Type selector) > "Finish Page"

User interface elements are described below:

Ul Element (A-Z) Description

Cl type selector View the selected Cl types in either a hierarchical tree or list.
mode

Invisible CITs (tree Select the Cl types you do not want to appear in the tree.

only) —
. Click&/to open the Cl Type Selector dialog box. Select the Cl types you

want to appear in the tree.

. Click ¥/ to delete the selected Cl types.

Root Cl Type (tree = Select the Cl type you want to use as the root Cl type in a hierarchical tree.

onl —
Y) . Clickl/to open the Cl Type Selector dialog box. Select the Cl type you

want to use as the root Cl type in the tree.

. Click #¥ to delete the selected Cl type. The default is Configuration

Item.
Selection mode Allow single or multiple selection of Cl types.

Unselectable CITs = Select the Cl types which cannot be selected in the tree.
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Ul Element (A-Z) Description

(tree only) . Clickl&/to open the Cl Type Selector dialog box. Select the Cl types

which cannot be selected in the tree.
. Click [#¥ to delete the selected Cl types.

Visible CITs (list Select the Cl types which you want to appear in the Cl type list.

only) —
. Click € to open the CI Type Selector dialog box. Select the Cl types

which you want to appear in the Cl type list.

. Click % to delete the selected Cl types.

Note: If you choose to view the CITs in alist, then you are required to
select at least one Cl type.

Direct Link Parameters — Cll Grid Page

This wizard page enables you to display all of the Cl instances found in the CMDB for the selected CI
type and for its children.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Cll Grid) > "Finish Page"

See also "Cl Instances Dialog Box" on page 65

User interface elements are described below:

Ul Element (A-2) Description
Class type Select the required Cl type.

« Click |Z| to select the required Cl type.

P
o

« Click to clear the box.
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Direct Link Parameters - Impact Map Page

This wizard page enables you to run an Impact Analysis rule defined in Impact Analysis Manager. The
URL you create enables you to embed a topology map showing a simulation of all the Cls that are
affected by the selected trigger Cl for the selected severity and state. For details, see "Run Impact
Analysis Dialog Box" on page 244.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Impact map) > "Finish Page"

See also "IT Universe Manager" on page 180
User interface elements are described below:

ul

Element

(A-2) Description

Filter by Select the Cl types you do not want to appear in the impact analysis results.
Cl types —
. Click =l to select the required Cl types.
« Click |E| to delete the selected Cl types.

Rule Enables you to define where you can run Impact Analysis rules.
bundle

Severity = Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the System Type Manager. For
details, see "System Type Manager" on page 486.

For example, you can create an Impact rule in the Impact Analysis Manager (see the
"Impact Rules Definition Dialog Box" on page 475, that defines the severity of the trigger
query node as other than No Change. If you select a severity other than No Change, for
example, Plan, the condition is met and the simulated changes in the system are
triggered.

For details, see "Run Impact Analysis Dialog Box" on page 244.
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ul
Element
(A-Z) Description

Trigger , Click |E| to select the Cls that are used as the triggers in an impact map. These Cls

Cls represent the simulated changes to be made to the system. Opens the CI Selector
dialog box. For details on how to use the Cl Selector pane, see "Cl| Selector" on page
134.

« Click %o delete the selected Cls.

Direct Link Parameters — Model Editor

This wizard page enables you to embed the Model Editor into an external application, highlighting the
selected Cls in the Cl Selector in the Model Editor.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Model Editor) > "Finish Page"

See also "Business Cl Models" on page 259

User interface elements are described below:

Ul Element (A-
Z) Description
Model name Select the model you want to display in the Model Editor.

« Click |Z| to open the Select Model dialog box. Select the model you want to

appear in the Model Editor.

=
A

« Click to delete the selected model.

Selected Cl in Select the Cls you want to appear highlighted in the CI Selector in the Model
search Editor.

« Click IZI to open the Cl Selector.

« Click £ to delete the selected Cls.
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Direct Link Parameters — Query Editor

This wizard page enables you to embed the Model Editor into an external application, displaying the

selected TQL query.
Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Query Editor) > "Finish Page"

See also "Business Cl Models" on page 259

User interface elements are described below:

Ul Element (A-
Z) Description
Query name Select the model you want to display in the Model Editor.

« Click |Z| to open the Select Query dialog box. Select the query you want to
appear in the Model Editor.

3
=

« Click %% to delete the selected query.

Direct Link Parameters — Related Cls Page

This wizard page enables you to embed a topology map into an external application. The map displays
a specific Cl, and all the Cls that are linked to it by a distance of ho more than one relationship.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Related Cls) > "Finish Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description
Cls Select the Cl type you want to appear in the topology map.

« Click |E| to select the required Cl types. Opens the Cl Selector dialog box.

. Click 1% to delete the value in the Cls box.

Filter by Cl types Restrict the results of the topology map to related Cls of one or more Cl types.

« Click |Z| to select the required Cl types.

. Click % to delete the value in the Filter by ClI types box.

Restrict to view Restrict the results of the topology map to related Cls from a specific view.
« Click |E| to select the required view. Opens the View Selector dialog box.

« Click ¥ to delete the selected view in the Restrict results to view box.

Direct Link Parameters — Report Viewer Page

This wizard page enables you to create a URL that opens a specific report.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Report Viewer) > "Finish Page"

User interface elements are described below:

Ul Element
(A-2) Description

Report type | Select the required report type. For information about the different report types, see
"Reports" on page 354.

Direct Link Parameters — Report Viewer — Saved Report Page

This wizard page enables you to create a URL that opens a saved topology or custom report.
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Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Report Viewer - Saved Report) >
"Finish Page"

User interface elements are described below:
Ul Element (A-Z) Description

Report Select the required saved report.

« Click |j to open the Select Report dialog box. Select the required
topology or custom report.

« Click |E| to delete the selected report.

For information about saved reports, see "Reports" on page 354.

Direct Link Parameters — Show Cl Properties Page

This wizard page enables you to view basic information for an existing ClI.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Show CI properties) > "Finish Page"

See also "Configuration Item Properties Dialog Box" on page 217
User interface elements are described below:

Ul Element (A-Z) Description

Source CI object ID Select the required ClI.

« Click |l to select the source Cl and retrieve its object ID. Opens the

Select Source Cl dialog box. For details, see "C| Selector" on page
134.
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Ul Element (A-Z) Description

. Click %% to delete the value in the Source ClI object ID box.

Direct Link Parameters — Show View Topology Page

This wizard page enables you to display the topology map of the selected view and embed it in an
external application.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Show view topology) > "Finish
Page"

User interface elements are described below:

Ul Element (A-Z) Description
Show topology of . Click [ to select the required view to be opened by the URL. Opens
view the View Selector dialog box.

. Click %€ to delete the selected view in the Show topology of view box.

Direct Link Parameters — View Editor Page

This wizard page enables you to create a URL that opens a specific view in the Pattern View Editorin
Modeling Studio.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > View Editor) > "Finish Page"

See also "Building a Business View" on page 253

User interface elements are described below:
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Ul Element (A-Z) Description

View name . Click =/ to select the required view to be opened by the URL. Opens

the View Selector dialog box.

« Click {0 delete the selected view in the View name box.

Direct Link Parameters — Views Selector Page

This wizard page enables you to embed into an external application, the View Selector, that enables
you to select, and display a view in that application.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Embedded links > Views Selector) > "Finish Page"

See also "Building a Business View" on page 253

Direct Link Parameters — Show View Page

This wizard page enables you to create a URL to a specific view and optionally select a specific query
node in that view. When the view opens, the Cl you chose is selected in the view. The view opens in IT
Universe Manager.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.

Wizard map "Select Command Page" (Open in context links > Show view) > "Finish Page"
User interface elements are described below:

Ul Element
(A-2) Description

<Left pane> A graphic illustration of the selected option.
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Ul Element
(A-Z) Description

Advanced Hide or display the Advanced pane in IT Universe Manager.
pane
(visibility)

Select ClI (Optional) Click to select a Cl and retrieve its object ID. When the view opens, the
from view Cl you chose is selected in the view.

result —
. Click €/ to choose the CI you want selected in the target view and retrieve its
object ID. Opens the Select Cl dialog box. For details, see "Cl| Selector" on page
134,
. Click % to delete the object ID for the selected Cl in the Select Cl from view
result box.
Selected The target view to be opened by the URL.
View

« Click IEI to select the target view to be opened by the URL. Opens the Select

View dialog box.

« Click /o delete the selected view in the Selected view box.

View mode  The view options are:
« View Topology. Displays an entire layer within a view.

« Related in View. Displays the selected Cl and its immediate neighbors within
the current view.

« Related in CMDB. Displays the selected Cl and its immediate neighbors in the
CMDB.

Direct Link Parameters - Start in Mode Page

This wizard page enables you to start the UCMDB application at the selected page, for example, in the
Modeling Studio page.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 106.
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Wizard map "Select Command Page" (Open in context links > Start in mode page) > "Finish
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the UCMDB application in the selected mode.
Finish Page

This is the final page of the Generate Direct Link wizard. Click Finish to close the wizard and create a
URL. Opens the Generate Direct Link dialog box.

Important For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 107.
Wizard map "Select Command Page" (<Open in context links options> and <Embedded links

options>) > "Finish Page"
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This chapter includes:

Using the Direct Link Functionality to Embed UCMDB Applets ... ... ... ...... 122
UCMDB Applet Tag Overview .. 123
Direct Link Operation FIoW ... 124

Note: This chapter is relevant to integration developers only.

Using the Direct Link Functionality to Embed
UCMDB Applets

You can directly embed UCMDB applets into external applications using a direct link. A direct link is a
URL that you create using the Direct Links wizard. For details, see "Generate Direct Link Wizard" on

page 107.

You can embed UCMDB applets in the following ways:

» Using the URL itself to display CMDB content in an external application. For example, you can
create a URL in the Direct Links wizard to display the properties of a certain Cl. The login page
opens if you are not already logged into Universal CMDB.

Note: Usingthe URL to enable the integration requires opening the link in an IFrame or a new
window. This does not allow you to manage the resulting UCMDB applet using Javascript due
to cross-site scripting issues. For example, if you use a URL that displays the properties of a
specific Cl using the object ID, you cannot use the same URL to display the properties of

another ClI.

« Using the UCMDB applet tag to embed the UCMDB applet in an extemnal application. This enables
integration developers to display a part of the Universal CMDB user interface as part of their own
application. In addition, this enables interaction with the embedded Universal CMDB user interface

using Javascript.
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UCMDB Applet Tag Overview

The UCMDB Applet tag creates the environment needed for the UCMDB applet to run (HTML,
Javascript, and server session parameters). The code behind the tag can log into the Universal CMDB
server in one of the following cases:

« Thelogin parameters are specified and the user is not already logged in.

« The clear session parameter is true.

Once a user session is established, the tag continues to write the required applet environment (HTML
and Javascript code) to the result of the JSP processor. The resulting HTML page includes the required
Javascript code to load the UCMDB applet from the specified server. On error, the specified error string
is printed to the page. This string can be customized using the userErrorMessage parameter and may
include HTML elements and HTML wrapped Javascript code to initiate error handling scenarios.

Example of the Usage of a UCMDB Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://server_name.server_domain:server_port"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"

userPassword="password"

customerId="1"

encoded="false"

printDebuglogs="true"

userkErrorMessage="This is your general error"
navigation="false"

clearSessionCookies="false"
command="ShowCISelector"/>

Caution: You retrieve the directLinkParameters from the URL created in the Direct Links
wizard. Insert the values for each parameter in the tag as displayed. If the URL contains
values for parameters not displayed above, copy them into the directLinkParameters line of
the tag. For details on how to create a direct link, see "Generate Direct Link Wizard" on page
107.

The UCMDB applet tag is located at <Universal CMDB root folder>\deploy\ucmdb-ui\WEB-
INF\tags\ucmdb_applet.tag.
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You can copy the UCMDB applet tag to an external application server. The UCMDB applet tag
requests the login data from the Universal CMDB server provided that:
« The external application server can communicate with JSP tags.

« The Universal CMDB server is accessible to the external application server and to the browser.

Direct Link Operation Flow

This section describes different scenarios in which direct links are used to embed UCMDB applets into

external machines.

This section includes the flow descriptions:

» "Regular Login" below

« "An Embedded UCMDB Applet Using a Direct Link URL" on the next page

e "An Embedded UCMDB Applet Usinga UCMDB Applet Tag" on page 127

Regular Login

This flow describes a regular login to the Universal CMDB server. It serves as a base reference for the

direct link flows.
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1. The user enters the direct link URL (into the browser) to log into the Universal CMDB server.
2. The browser sends the login request to the Universal CMDB server.

3. The server checks the user credentials and creates a user session if required.

4. The server retumns the requested first page of Universal CMDB.

5. The browser loads the Java virtual machine (JVM) with the code base location parameter (which
instructs the JVM from where to load the UCMDB applet files) as the Universal CMDB server.

6. UCMDB applet files (jars) and data are transferred between the Universal CMDB server and the
JVM loaded in the browser.

At this point, the UCMDB applet is loaded and regards Universal CMDB as the server with which it
should communicate.

An Embedded UCMDB Applet Using a Direct Link URL

This flow shows how to use the direct link to open a UCMDB applet (opened to a specified context) ina
new browser frame.
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1. The external application has a page that needs to show the UCMDB applet.

2. The returned page includes a directive to open the direct link in an IFrame or new browser window.
3. The browser opens a new frame (IFrame or new window) with the direct link as the frame URL.

4. The new frame sends the direct link to the Universal CMDB server.

5. If the useris not already logged into Universal CMDB, Universal CMDB displays the login page
and waits for the user to enter credentials and click the login button.

6. The user session is created, if required.
7. The Universal CMDB server returns a page that includes the directive to load the UCMDB applet.

8. The browser processes the page. When the browser encounters the directive to load the UCMDB
applet, it starts the JVM. The browser then passes the needed parameters to the JVM, including
the Universal CMDB server location as "code base."

9. UCMDB applet files (jars) and data are transferred between the Universal CMDB server and the
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JVM loaded in the browser.

Caution: The Universal CMDB server must be accessible from the browser machine.

An Embedded UCMDB Applet Using a UCMDB Applet Tag

This flow shows how to use the UCMDB applet tag in conjunction with direct links to embed the
UCMDB applet (opened to a specified context) in an external application page.

HP Business
Service
Management/HP
External Universal CMDB
Browser application server
11
2 -
I
3
L
- 5 - 4

JYM - 7

. The UCMDB applet tag is included in the processed JSP in the external application.

The UCMDB applet tag uses the parameters given to it to create an HTTP/HTTPS connection to
the Universal CMDB server and requests the applet HTML snippet code.

If the user is not already logged in, the parameters from the UCMDB applet tag are used (see the

tag itself for reference information regarding this step). If login fails, the UCMDB applet tag returns
an error message, either the preset one or the one specified in the UCMDB applet tag parameters.

. The Universal CMDB server returns the HTML snippet code (with embedded Javascript) that
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loads the UCMDB applet. The external application can now incorporate this snippet code into the
page, and send the page to the browser.

5. The external application sends the complete page that includes the HTML snippet code to the
browser.

6. The browser processes the page. When the browser encounters the HTML snippet code that
loads the UCMDB applet, the JVM is started. The browser then passes the needed parameters to
the JVM, including the Universal CMDB server location as "code base".

7. UCMDB applet files (jars) and data are transferred between the Universal CMDB server and the
JVM loaded in the browser.

Caution: The Universal CMDB server must be accessible from both the browser machine as
well as the external application machine.
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This chapter includes:

Cl Selector OVEIVIEW ... ... . . . 129
How to Display a View in Browse Mode ... . . 129
How to Searchfor ClsinSearchMode ... ... .. . . . 130
How to Modify Cl Selector Display Options ... ... . 131
Cl Selector UserInterface ....... ... ... . L 132
Troubleshooting and Limitations — Cl Selector ... ... .. 145

Cl Selector Overview

Note: The Cl Selector was known as View Explorer in earlier versions of Universal CMDB.

The CI Selector presents the elements of the IT universe model in Universal CMDB through the
medium of views. Universal CMDB displays the C| Selector in the left pane of IT Universe Manager
and the Modeling Studio.

When you select a view in the Cl Selector, the configuration items (Cls) contained in the view are
displayed in a hierarchical tree format according to the relationships defined between the Cls. A view
may be empty if no Cls were found matching the TQL query. For details on views, see "View Formats"
on page 252.

You can use the Cl Selector to select views and to locate Cls. You can select a view and browse
through the list of Cls, or you can search for a specific Cl by name or by CI type. You can also save the
search criteria for future use.

For information on the components of the Cl Selector, see "Cl| Selector User Interface" on page 132.

How to Display a View in Browse Mode

When the CI Selector is set to Browse mode, you can display the contents of a selected view. For
details on the Cl Selector user interface in Browse mode, see "Cl| Selector" on page 134.

This task includes the following steps:
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» "Prerequisites" below

« "Select aView to Display" below

1. Prerequisites

In the CI Selector pane, select Browse Views mode.

2. Select a View to Display

Click the ellipsis |E| button to open the View Selector dialog box and select the view you want to
display. The name of the selected view is shown in the View box. The Cls in the view appear in
the Cl tree in the lower part of the Cl Selector pane. The view remains selected when you move to
other applications in Universal CMDB.

How to Search for Cls in Search Mode

The CI Selector search tool enables you to locate a specific Cl. The search is executed on the entire
CMDB. For details on the Cl Selector search tool user interface, see "C| Selector" on page 134.

This task includes the following steps:

» "Prerequisites" below

« "Search by Cl Name or Global ID" below

» "Search by Configuration Item Type" on the next page

» "Runthe Search and Sort the Results" on the next page

« "Runan Advanced Search" on the next page

Prerequisites

In the CI Selector pane, select Search Cls mode and select the Simple tab.

Search by Cl Name or Global ID

To search for Cls by name, enter a string in the ClI Name box, representing the name of the Cl, or part
of the name. The search returns all Cls that contain the entered string somewhere in their names
(within the boundaries of the other search criteria that you define).
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Alternatively, enter the global ID of a Cl in the CI Name box. You need to enter the full global ID.

Note: The search by Cl name option is not case sensitive.

Search by Configuration ltem Type

You can search for Cls using the Cl Type box. This search returns Cls of the type specified in the CI
Type box.

Click the ellipsis |Z| button and select the required Cl type. You cannot manually enter a CIT in the CI

Type box.

After defining a Cl in the CI Type box, Universal CMDB remembers your selection until you move to a
different application, or until you define a different value.

Run the Search and Sort the Results

Run the search. The results appear in the lower part of the Cl Selector pane, showing the Cl name and
type for each entry. You can sort the search results by clicking the appropriate heading.

When you select a Cl in the search results, the Cl appears in the topology map with its related Cls in
the CMDB.

Optionally, save the search criteria by clicking the Save || button and entering a name for the search.

For details, see "Save Search Criteria Dialog Box" on page 145.

Run an Advanced Search

You can select the Advanced tab for other search options. For details on the Cl Conditional search,
see "Cl Conditional Search Dialog Box" on page 133. For details on the Running Software search, see
"Running Software Search Dialog Box" on page 144.

How to Modify CI Selector Display Options

You can modify the display options for the Cl Selector. These options are configured in the
Infrastructure Settings Manager.

Caution: Modifying certain settings in the Infrastructure Settings Manager can adversely affect
the performance of Universal CMDB. Do not modify settings without first consulting HPE
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Software Support or your HPE Professional Services representative.
This task includes the following steps:

« "Prerequisites" below

« "Modify Selected Settings" below

1. Prerequisites

Access the Infrastructure Settings Manager by selecting Managers > Administration >
Infrastructure Settings Manager.

2. Modify Selected Settings
The following settings can be modified:

o Immediate Children Count. Number of children immediately displayed when expanding their
parent's query node in the Cl Selector.

o Maximal Children Count. Maximum number of children displayed under their parent's query
node in the Cl Selector.

o Maximal search results size. Maximum number of CMDB instances that can be returned in
one search operation.

o Recently Used Views List size. Maximal number of recently used views to store per user.

Cl Selector User Interface

This section includes (in alphabetical order):

Cl Conditional Search Dialog BoX ... .. ... .. 133
Cl S It Or . L 134
Organize Searches Dialog BOX . ... .. 143
Running Software Search Dialog BOX ... ... ..o oo i 144
Save Search Criteria Dialog BOX . ... ... 145
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Cl Conditional Search Dialog Box

This dialog box enables you to search for Cls by attribute conditions, by related Cls, and by attribute
conditions of related Cls.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis button
access next to Cl Conditional Search.

See "Cl Selector Overview" on page 129
also

User interface elements are described below:

Ul Element

(A-2) Description

Attribute Select an attribute from the drop-down list.

name
Note: If you select Display Label from the Attribute name list, the operator
Like ignore case does not appear in the Operator list since a Display Label
Like ignore case condition can be added using the Cl name/Related C| Name.

Cl Name Enter a Cl name for which to search.

Cl Type Click the ellipsis | button to select a CI type from the tree.

Integration If you want to run your search over federated Cls also, click the ellipsis IZI button to

Points select the target integration points for the Cls.
Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local search
results.

Operator Select an operator from the drop-down list.

Related CI Enter the name of a related CI for the search.

Name

Related CI  Click the ellipsis | button to select a CI type from the tree for a search by related

Type Cl.

Relationship Click the ellipsis | button to select a relationship from the tree for a search by
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Ul Element
(A-Z)

Type

Search by
Cl
conditions

Search by
related CI
conditions

Search by
related CI
criteria

Value

Description
related Cl.
Select the check box to run a search for Cls with the specified conditions.

Each row represents an attribute condition that you specify. Use the And/Or column
and the Brackets columns to link multiple conditions. Select NOT if you want the
condition statement to do the opposite of what is defined. In this way, you can
construct a more precise logical statement to generate the required results.

*| Add attribute condition. Adds an attribute condition row. Select the attribute

name, operator, and value to define the attribute condition.

%] Delete selected row. Deletes the selected attribute condition.
% Move selected row up. Moves the selected row up.

| Move selected row down. Moves the selected row down.

. Show Criteria. Displays the criteria of the selected condition in a pop-up dialog

box.

Select to run a search for Cls related to Cls with the specified conditions.

Note: If you select Display Label from the Attribute name list, the operator
Like ignore case does not appear in the Operator list since a Display Label
Like ignore case condition can be added using the Cl name/Related C| Name.

Select to run a search for Cls related to the specified Cls or Cl types.

Enter a value for the attribute condition.

Cl Selector

This feature enables you to select views and to locate Cls.

To access

Important
information

Appears in the left pane of the IT Universe Manager page and the Modeling Studio.

The CI Selector consists of two functional formats: Browse Views mode and Search
Cls mode.
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« InBrowse Views mode, you can search for and display a view, and browse
through the view to locate a particular Cl. You can also perform operations on the
CI from a shortcut menu.

« In Search Cls mode you can search for one or more Cls in the CMDB by name or

by Cl type.
Relevant "How to Display a View in Browse Mode" on page 129
tasks .
"How to Search for Cls in Search Mode" on page 130
See also "Cl Selector Overview" on page 129

Browse Views Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

|§| Refresh Cls Tree. Refreshes the data content of the hierarchical
tree structure that may have been modified by other users.

it Show Template Parameters. Opens the Template Parameter
Values dialog box, which enables you to edit the parameters of the
selected template.

| Note: This button is only active when a template is selected.

> Add selected Cls to model/view. Adds the selected Cls to the
current model or view.

| Note: This button only appears in the Modeling Studio.

1] Add to model as related Cls. Adds the selected Cl to the model as
arelated CI.

Note: This button is only active in the Model Editor of the
Modeling Studio.

&% Open selected model in a new tab. Opens the selected model in
the Model Editor.
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Ul Element (A-2) Description

Note: This button is only active when a model is selected in the
Modeling Studio.

& Show models containing selected CI. Displays a list of models
containing the selected CI.

Note: This button only appears in the Modeling Studio.

| InIT Universe Manager, this represents Show View Definition,
which takes you directly to the view definition in the Modeling Studio
for the current view.

In the Modeling Studio, this represents Open selected view, which
opens the selected view in the Editor pane.

) Show views containing selected Cl/model. Displays a list of
views containing the selected Cl or model.

Note: This button only appears in the Modeling Studio.

La Generate view for selected model. Opens the Creating New View
dialog box which enables you to build a view based on the selected
model.

Note: This button is only active when a model is selected in the
Modeling Studio.

2 Show Discovery and Changes Summary. Enables you to
rediscover all the Cls in a selected view by manually starting the
DFM jobs that originally discovered them. For details, see "Show
Discovery Status and Changes Dialog Box" on page 247.

| Note: This button only appears in IT Universe Manager.

= Generate Direct Link to View. Enables you to create a direct link to
the view using the Direct Links wizard.

| Note: This button only appears in IT Universe Manager.

|§| Export Browse Results to File. Enables you to export the browse
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Ul Element (A-2) Description
results. Choose the export format from the following options:

« Excel. The table data is formatted as an .xIs (Excel) file that can
be displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting Cls to PDF format, the maximum
number of Cls that can be exported is approximately 20,000,
depending on the amount of text associated with the
exported Cls. It is also important to select a reasonable
number of columns to display to ensure that the report is
legible.

« RTF. The table data is exported in Rich Text Format.

« CSV. Thetable data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display correctly,
the comma (,) must be defined as the list separator. In
Windows, to verify or modify the list separator value, open
Regional Options from the Control Panel, and on the
Numbers tab ensure that the comma is defined as the List
Separator value. In Linux, you can specify the list separator
in the application that opens the CSV file.

« XML. The table data is formatted as an XML file which can be
opened in a text or XML editor.
Tip: To extract HTML code from the report:
« Open the file in an HTML editor

« Copy the relevant table into the target file

] Snapshots. Enables you to work with snapshots. The following
options are available:

« Save Snapshot. Select to open the Save Snapshot dialog box,
which enables you to save a snapshot of the view. For details,
see "Save Snapshot Dialog Box" on page 246.
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Ul Element (A-2)

<Cls>

<Tooltip>

Find

View

HPE Universal CMDB (10.31)

Description

« Compare Snapshots. Select to run the Compare Snapshots
Report. For details, see "Compare Snapshots Report" on page
391.

« Schedule Snapshot. Select to open the Schedule Job dialog
box. For details, see "Schedule Report/Snapshot Dialog Box" on
page 440.

« Show Scheduled Snapshot Jobs. Select to open the Job List
dialog box. For details, see "Job List Dialog Box" on page 413.

| Note: This button only appears in IT Universe Manager.

View Based Report. Displays the topology report for the selected
view.

Note: This button only appears in IT Universe Manager.

Asset Report. Opens the Asset report for the selected view. For
details, see "Asset Report" on page 367.

| Note: This button only appears in IT Universe Manager.

Click the ellipsis button to the right of the View box, to open the View
Selector dialog box. You can browse through the folder tree to locate
the view you want to display.

Enables you to move to the next or previous result of the search for
the string entered in the Find box.

The Cls contained in the currently selected view.

Hold the cursor over a Cl to display a tooltip with the relevant Cl
type.

Enter a Cl name or a portion of a Cl name in the Find box to locate a
Clinthe Cl tree.

The View box displays the currently selected view. To select a view
to display, click the down arrow on the right side of the View box; this
displays an abridged list of views, containing the most recently
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Ul Element (A-2) Description

accessed views. Click the arrow at the bottom of the list to scroll
through the entire list. The recently accessed views appear at the top
of the drop-down, above the dividing line. The complete list of views
appears below the line.

Alternatively, place the cursorin the list and begin typing the view
name. If the first few letters that you type match an existing entry,
Universal CMDB completes the view name. If the names of several
views begin with those letters, all matching views are displayed in
the list.

Note: If the selected view in the View box fails to load, the
value in the View box is set to the default (empty) selection.

Search Cls Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
& Show Search Results in Table. Opens a separate pane with a

table of the Cls in the search results.

| Note: This button only appears in IT Universe Manager.

> Add selected Cls to model/view. Adds the selected Cls to the
current model or view.

Note: This button only appears in the Modeling Studio.

i Add to model as related Cls. Adds the selected Cl to the model
as arelated ClI.

Note: This button is only active in the Model Editor of the
Modeling Studio.

&0 Open selected model in a new tab. Opens the selected model in
the Model Editor.
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Ul Element (A-2)

55

L3
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Description

Note: This button is only active when a model is selected in
the Modeling Studio.

Show models containing selected Cl. Displays a list of the
models containing the selected ClI.

| Note: This button only appears in the Modeling Studio.

Show views containing selected Cl/model. Displays a list of the
views containing the selected CI or model.

Note: This button only appears in the Modeling Studio.

Generate view for selected model. Opens the Creating New
View dialog box which enables you to build a view based on the
selected model.

Note: This button is only active when a model is selected in
the Modeling Studio.

Export Search Results to File. Enables you to export the search
results. Choose the export format from the following options:

« Excel. The table data is formatted as an .xls (Excel) file that can
be displayed in a spreadsheet.

o PDF. The table data is exported in PDF format.

Note: When exporting Cls to PDF format, the maximum
number of Cls that can be exported is approximately
20,000, depending on the amount of text associated with
the exported Cls. It is also important to select a reasonable
number of columns to display to ensure that the report is
legible.

« RTF. The table data is exported in Rich Text Format.

o CSV. Thetable data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.
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Ul Element (A-2) Description

Note: Forthe CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list separator
value, open Regional Options from the Control Panel, and
on the Numbers tab ensure that the comma is defined as
the List Separator value. In Linux, you can specify the list
separator in the application that opens the CSV file.

o XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.

Tip: To extract HTML code from the report:
o Open the file in an HTML editor

o Copy the relevant table into the target file

= Manage the list of saved searches. Opens the Organize
Searches dialog box, where you can edit or delete searches from
the list of saved searches.

Collapse/Expand Search Criteria Panel. Collapses or expands

»

the search criteria area.

|E| Start the Search. Runs the search. The search results are
displayed in the lower part of the Cl Selector pane.

[ Save the Last Search Pattern. Saves the current search criteria
for future use.

@ @ Enables you to move to the next or previous result of the search for
the string entered in the Find field.

<Search results> After you run the search, the results are listed in the lower part of
the Cl Selector pane. The results are shown in two columns:

« Name. Contains the name of the CI.

« CI Type. Contains the Cl type of the CI.

If the Cl or view name is abbreviated, hold the pointer over the entry
to see the full name. You can sort the search results by clicking the
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Ul Element (A-2)

Advanced tab

Cl Name

Cl Type

Find

Searches

Search results count

Simple tab

Shortcut Menu Options

Description
appropriate heading.
The following detailed search options are available:

« CI Conditional Search. Enables you to search for Cls by
attribute conditions, by related Cls, and by attribute conditions
of related Cls.

« Running Software Search. Enables you to search for hosts by
the applications running on them and for applications by the host
on which they are running.

For each of the searches, click the ellipsis |£| button to open the

search dialog box. After running a search, click Save |@| to save the

search for future use.

To search for a Cl by name, enter the name or global ID of the CI for
which to search.

To search for Cls by Cl type, click the ellipsis button to select a Cl
from the Select Configuration Item Type dialog box.

Enter a Cl name or a portion of a Cl name in the Find box to locate a
Clinthe search results.

Select a search from the drop-down list of saved searches.

The Search results count below the Find box displays the total
number of Cls found in the search.

The Simple tab includes the standard search functionality. Click the
Advanced tab for more detailed search options.

Menu Item Description

<IT Universe The regular shortcut menu for the topology map in IT Universe Manager is also

Manager shortcut = available from the Cl Selector. For details on the menu options, see "IT

menu options> Universe Manager Page" on page 226.
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Menu Item

Add

Add to model as
related Cls

Generate view for
selected model

Open selected
model in a new
tab

Show containing
models

Show containing
views

Description

Adds the selected Cl to the current model or view.
| Note: This feature only appears in the Modeling Studio.
Adds the selected Cl as arelated Cl to the current model.

Note: This feature only appears in the Modeling Studio.

Select to create a view based on the current model. The Creating New View
dialog box opens which enables you to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Opens the selected model in a new tab in the Model Editor.

| Note: This feature only appears in the Modeling Studio.

Select Show models containing selected Cl to display a list of the models
containing the selected ClI.

| Note: This option only appears in the Modeling Studio.

Select Show views containing selected Cl/model to display alist of the
views containing the selected CI or model.

Note: This option only appears in the Modeling Studio.

Organize Searches Dialog Box

This dialog box enables you to edit or delete searches from the list of saved searches.

To access

See also

Click the Manage the list of saved searches 5 button in the CI Selector.

"Cl Selector Overview" on page 129

User interface elements are described below:
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Ul

Element

(A-Z) Description

|z| Click to edit the selected search. For simple searches, the Cl Simple Search dialog
box opens, which enables you to edit the name and type of the Cl. For Cl Conditional
searches, the Cl Conditional Search dialog box opens.

g Click to delete the selected search.

[z Click to expand the search tree.

=] Click to collapse the search tree.

<Searches Displays all the saved searches in tree format.
tree>

Find Enter a search name or a portion of a search name in the Find box to locate it in the list.
Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous

Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running on them and to search for
applications by the host on which they are running.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis button
access next to Running Software Search.

See "Cl Selector Overview" on page 129
also

User interface elements are described below:

Ul
Element
(A-2) Description

Host Enter the name of the node for which you are searching.
name
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Element
(A-Z) Description

Running Select a running software Cl from the drop-down list.

Software
Note: The drop-down list may not display an accurate list of available running

software Cl types (only the option Any appears). In this event, perform the Host
name search only.

Search Select Running Software or Node.

for
Note: To search for a running software Cl running on a specific node, enter a node

name, select the required running software Cl and click Search to search for it.

Save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

To access Click Save £l from Search mode in the Cl Selector.

See also "Cl Selector Overview" on page 129

User interface elements are described below:

Ul Element (A-

Z) Description

Existing Displays a list of existing searches in tree format.

Queries

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the Find box to locate it in
the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Previous  Click to go to the previous occurrence of the selected search phrase in the list.

Troubleshooting and Limitations — Cl Selector

This section describes troubleshooting and limitations for the Cl Selector.
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Unavailable Views and Cls

The View list in the Cl Selector may not display all views in the CMDB, or it may not display the
contents of a view, for any of the following reasons:

« The View list includes only the views for which you have the necessary permissions. Similarly,
Search mode is only available if you have the Allow Search general action permission. To set
permissions, select Managers > Administration > Roles Manager. For more information, see
Roles Manager in the HPE Universal CMDB Administration Guide.

« Views that are currently inactive appear in red in the View list, but they cannot be selected. In IT
Universe Manager, inactive views appear in faded text.

« Out-of-the-box views for which you do not have a license may appear in the View list, but these
views do not contain Cls. For information on the out-of-the-box views, see "Predefined Folders and
Views" on page 257.

Note: After deleting one or more query nodes from a TQL query, it can take time for changes to
be updated to the view; meanwhile, the removed Cls appear in the view. If you select one of

these Cls before it is updated, an error message is displayed. Click the Refresh button to update
the view.
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This chapter includes:

Topology Map OVEIVIEW . . 147
Handling Large VieWs . . .. 148
Topology Map User Interface . .. ... . 148

Topology Map Overview

The Topology Map provides a graphical display of a view. All the Cls in a given layer of the view are
represented by icons and the connecting lines represent relationships. You can select a Cl in the
Topology Map or in the Cl Selector in the left pane. You can also drill down in the Cl Selector to display
different layers of the view in the Topology Map.

The label of a Cl appears under the icon. You can set the maximum number of characters per line and
the maximum number of lines in a Cl label in the User Preferences dialog box under General. For
details, see "User Preferences Dialog Box" on page 92.

A Cl that has an additional CI layer beneath it, created by the hierarchy set for the view, appears with a
downward arrow icon in the Topology Map, as well as a count indicator displaying the total number of
Cls in all of the sublayers under it. You can click the arrow to display the Cls contained in the sublayer.

g

&)

192.168.214.02

When you hold the pointer over the Cl icon, a tooltip displays the Cl's details. When you hold the
pointer of the count indicator, a tooltip displays a breakdown of the Cls beneath that CI by CI type.

The topology map is automatically updated dynamically with changes in the IT Universe data, such as
new Cls discovered by the Data Flow Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom in, change the layout of the
Topology Map, and print the Topology Map. Additional functionality is available from the shortcut menu
by right-clicking a Cl in the Topology Map or in the C| Selector.
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Handling Large Views

The Topology Map cannot display a view with more than 900 Cls in a single layer. When you select a
view which contains a layer with more than this number of Cls, the Topology Map appears empty. A
layer with more than 900 Cls can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following methods:

« Reduce the TQL query results by redefining the view in the Modeling Studio. For details, see
"Change Query Node/Relationship Type Dialog Box" on page 287.

« Define a different hierarchy for the view to redistribute the Cls among the view's layers. For details
on defining hierarchy, see "Setting the View Hierarchy" on page 254.

o Reset the maximum number of Cls allowed in the configuration parameters. Select the Max Object
Count GUI for TS parameter under Visualization Settings in the Infrastructure Settings Manager.
However, be aware that increasing the maximum number of Cls per layer may significantly slow
down the redrawing of the Topology Map.

For details regarding Infrastructure Settings Manager, see "Infrastructure Settings Manager User
Interface" in the HPE Universal CMDB Administration Guide.

Topology Map User Interface

This section includes (in alphabetical order):

Export Map to Image Dialog BOX .. ... 149
Layout Properties Dialog BoX .. ... 150
Main MenU . 163
Print Dialog BoOX oL 164
Print Preview Dialog BoX ... ... L 165
Print Setup Dialog BoX .. ... il 165
To0lbar OptiONS .. L 167
Topology Map Sidebar . .. ... 176
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Export Map to Image Dialog Box

This dialog box enables you to save a topology map to afile.

To access From a topology map, select Operations > Export Map to Image.
Relevant tasks "How to Print and Save a Topology Map to File" on page 209
See also « "Topology Map Overview" on page 147

» "Topology Map User Interface" on the previous page

User interface elements are described below:

Ul Element (A-Z) Description

Actual Size Save the view so that the graph node sizes are at
maximum.

Current Zoom Level Save the view as you see it on the topology map. For

example, if you have used the Interactive Zoom mode to
decrease the view magnification, the graph nodes also
appear smaller in the saved view. For details, see
"Interactive Zoom" on page 171.

Custom Specify the size of the view you want to save in the Width
and Height boxes.

File Name Specify the required file name and location (or click Browse
to search for the file and location).

Fitin Canvas Expand or shrink the view so that it fits in the pane.

Image Quality The quality of the printed map. Select High, Medium, or
Low.

Selected Objects Only Saves only the graph nodes/Cls and their relationships that

you selected in the map.
Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the pane.
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Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a view, to achieve the clearest
presentation possible and to better understand and monitor the managed data.

To access  Select Layout > Layout Properties.

Important  You define the layout of a view's layers by assigning logical positions for the graph's
information = nodes and relationships that appear in a layer. You customize the layer layouts by
modifying the default values.

You set layout definitions for a specific layer only. The definitions cannot be saved for
a different layer or a different view.

Parameter values are in pixels.

See also « "Topology Map Overview" on page 147

« "Topology Map User Interface" on page 148

Global Tab

This area enables you to define global layout parameters.

To access Click the Global tab in the Layout Properties dialog box.

Important information The Global tab enables you to define global settings for the layout.

User interface elements are described below:

Ul
Element
(A-2) Description

Drawing Select one of the following options for fitting the layout:
Fitting . .
« Fit to Canvas. Fit the layout to the canvas on the screen.
« Fit for Printing. Fit the layout to a page for printing.
« No Fitting. Do not change the layout.

Labeling Select Perform Labeling to ensure that the labels appear when the layout is redrawn. If
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Ul
Element
(A-Z) Description

this field is not selected, labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to all nested layers of the
topology map.

All Styles Tab

To access  Click the All Styles tab in the Layout Properties dialog box.

Important The All Styles tab enables you to define general layout parameters for disconnected
information = graph nodes and connected components.

« A disconnected graph node is a node that is not connected to any other graph
node.

« Adisconnected component is a component that is not connected to any other
component. It contains a set of graph nodes that can be connected to each other.

This illustrates a connected component with five graph nodes:

This illustrates a connected component with two graph nodes:

O—0O

This illustrates four disconnected components, each made up of a single,

disconnected graph node:
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User interface elements are described below:

Ul Element
(A-2) Description

Components The spacing between the components in a disconnected graph consists of both a
constant value and a proportional value based on the sizes of the components.

Select Detect Components to view the disconnected components. You can
specify that all components be laid out together or individually, regardless of the
other components. If the grouping for components is selected, each component is
laid out, and the resulting components are packed together.

When Detect Components is selected, enter values for the following settings:

« Constant Spacing. Set constant spacing (horizontal and vertical) around each
disconnected component.
Default value: 20

« Proportional Spacing. Set spacing (horizontal and vertical) that is proportional
to the size of the component around each disconnected component.
Default value: 0.05

Disconnected The spacing between the graph nodes in a disconnected graph consists of both a
Graph Nodes constant value and a proportional value based on the sizes of the graph nodes.

Select Detect Disconnected Graph Nodes to view the disconnected graph
nodes. You can specify that disconnected graph nodes be grouped into one
component or laid out individually.

When Detect Disconnected Graph Nodes is selected, enter values for the following
settings:

« Constant Spacing. Set constant spacing (horizontal and vertical) around each
disconnected graph node.
Default value: 20

HPE Universal CMDB (10.31) Page 152 of 572



Modeling Guide
Chapter 6: Working with the Topology Map

Ul Element
(A-2) Description
« Proportional Spacing. Set spacing (horizontal and vertical) that is proportional
to the size of the component around each disconnected graph node.
Default value: 0.05
Margin Enter values for the right, left, top, and bottom margin spacing for the layout.
Spacing
Circular Tab

To access | Click the Circular tab in the Layout Properties dialog box.

Important The Circular tab enables you to group a graph's nodes into groups or clusters based
information = on the grouping options you select. It is particularly suited for visualizing ring and star
network topologies, and for link analysis.

User interface elements are described below:

Ul
Element
(A-2) Description

Clustering = Set the values for the following settings:

« Cluster Size Factor. Specifies the ratio between the average cluster size and the
number of clusters. The size of a cluster is defined as the sum of the weights of all
graph nodes in the cluster. You can assign a weight value to each graph node.

« Min Number of Clusters. The minimum number of clusters in a layer.

« Max Number of Clusters. The maximum number of clusters in a layer.

Cluster Displays clusters eitherin a symmetric or circular layout style.
Layout

Select one of the following options:
Style

« Symmetric. Displays clusters in a symmetric layout style.
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Ul
Element
(A-Z) Description

7
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« Circular. Displays clusters in a circular layout style.

[ w
o, o

Layout Adjusts the quality of the layout produced to fit your application's needs. The quality
Quality reflects the number of steps or the method used to produce the layout. For example,
high quality is sharper but takes more time to set the layout.

Select one of the following options:

« Draft. Produces faster results (faster than Medium and Proof).

« Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as Proof.

« Proof. Produces a more refined result but takes more time.
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Ul
Element
(A-Z) Description

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try each
option to determine which works best for you.

Spacing Sets the spacing around each graph node within the same cluster and between
clusters.

Enter values for the following settings:

« Between Graph Nodes. Sets the spacing around each graph node within the same
cluster. The larger the spacing, the more graph nodes there are on the cluster
boundary.

Default value: 50

This illustration shows smaller graph node spacing:

This illustration shows larger graph node spacing:

« Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing:

ity

This illustration shows larger cluster spacing:

o
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Hierarchical Tab

To access | Click the Hierarchical tab in the Layout Properties dialog box.

Important The Hierarchical tab shows the precedence relationships that can represent

information organizational or information management system dependencies, as well as process
models, software call graphs, and work flows. The hierarchical layout emphasizes
dependencies by placing the graph nodes at different levels.

User interface elements are described below:

Ul Element
(A-2) Description
Backward  Specifies how backward relationships are displayed in the hierarchical layout.
Edges
g Select one of the following options:

« Minimize Backward Edges. Sets the number of backward relationships
displayed in a layer to a minimum.

« Optimize for Feedback Flow. Sets the number of backward relationships
displayed in a layer to a maximum. This mode is more appropriate for flow charts.

Horizontal | Enables you to set the minimum horizontal distance between two neighboring graph
Spacing nodes at each level.

Enter values for the following settings:

. Between Graph Nodes. Sets a horizontal space around each graph node in the
layer.
Default value: 28

« Between Edges. This setting is available only when you select Routing >
Orthogonal. It sets a horizontal space between edges in the graph.
Default value: 12

Layout Adjusts the quality of the layout produced to fit your application's needs. The quality
Quality reflects the number of steps or the method used to produce the layout. For example,
high quality is sharper but takes more time to set the layout.

Select one of the following options:

« Draft. Produces faster results (faster than Medium and Proof).
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Ul Element
(A-2) Description

Draft

o Medium. Produces aresult that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as Proof.

o Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality
setting varies depending on the nature of the graph being laid out. You can try
each option to determine which works best for you.

Level Enables you to set the way graph nodes are vertically aligned.
Alignment : .
Select one of the following options:
« Top. This illustration shows that the top of the graph nodes at the same level of the
hierarchy are aligned:

« Center. This illustration shows that the center of the graph nodes at the same level
of the hierarchy are aligned:

« Bottom. This illustration shows that the bottom of the graph nodes at the same
level of the hierarchy are aligned:
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Ul Element
(A-2) Description

Orientation Enables you to set the orientation of the hierarchy.
Select one of the following options:
« Top to Bottom. The children are located above the parent.
« Left to Right. The children are located to the left of the parent.
« Bottom to Top. The children are located below the parent.

« Right to Left. The children are located to the right of the parent.

Orthogonal This setting is available only when you select Routing > Orthogonal. Maintain the

Routing -  size of a graph node. Clear this option if you want the layout to increase the size of a
Fix Node graph node, if it is necessary to maintain the specified relationship spacing, when
Sizes more than one relationship is attached to the same side of the graph node.
Polyline This setting is available only when you select Routing > Polyline. Polyline routing
Routing - routes edges (connecting lines) as one or more straight line segments with arbitrary
Spacing angles. Path nodes are added automatically to prevent the edges (connecting lines)
Between from overlapping.
Bends

Default Value: 12
Routing Select the type of routing for the layout. The available options are:

« Orthogonal
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Ul Element
(A-2) Description

« Polyline

Undirected Edge direction is not used to build the levels of the hierarchical drawing.

Layout
Variable Variable level spacing adjusts the spacing between pairs of neighboring levels
Level according to the density of edges between the levels.
Spacing i . . :
If the drawing's edges are orthogonally routed, this ensures the desired vertical
spacing between horizontal edges (in a top-to-bottom or bottom-to-top layout) routed
between levels.
If the routing is polyline, variable level spacing makes it easier to distinguish among
edges in very dense drawings.
Vertical Enables you to set the minimum vertical distance between two neighboring graph
Spacing nodes on different levels.

Enter values for the following settings:

« Between Graph Nodes. Sets a vertical space around each graph node in the
level.
Default value: 28

. Between Edges. This setting is available only when you select Routing >
Orthogonal. It sets a vertical space between edges in the graph.
Default value: 12

Orthogonal Tab

To access Click the Orthogonal tab in the Layout Properties dialog box.

Important The Orthogonal tab enables you to set orthogonal layout route relationships

information horizontally and vertically. This results in relationships bending at 90-degree
angles only.

User interface elements are described below:
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Ul
Element
(A-Z) Description

Fix Node | Maintain the size of a graph node. Clear this option if you want the layout to increase
Sizes the size of a graph node if it is necessary to maintain the specified relationship spacing
when more than one relationship is attached to the same side of the graph node.

Horizontal = Enables you to set the minimum horizontal distance between graph nodes.
Spacin
P 9 Select one of the following options:

« Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20
« Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Layout Adjusts the quality of the layout produced to fit your application's needs. The quality
Quality reflects the number of steps or the method used to produce the layout. For example,
high quality is sharper but takes more time to set the layout.

Select one of the following options:
« Draft. Set the layout to draft quality.
« Medium. Set the layout to medium quality.

« Proof. Set the layout to proof quality.

Vertical Enables you to set the minimum vertical distance between graph nodes.
Spacing . .
Select one of the following options:
« Between Graph Nodes. Set a vertical space around each graph node in the layer.
Default value: 100

. Between Edges. Set a vertical space between elements in the layer.

Default value: 20
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Symmetric Tab

To access Click the Symmetric tab in the Layout Properties dialog box.

Important The Symmetric tab displays a clear representation of complex networks. The
information symmetric layout emphasizes the symmetries that may occur in a graph.

User interface elements are described below:

Ul
Element
(A-2) Description

Layout Adjusts the quality of the layout produced to fit your application's needs. The quality
Quality | reflects the number of steps or the method used to produce the layout. For example, high
quality is sharper but takes more time to set the layout.

Select one of the following options:

« Draft. Produces faster results (faster than Medium and Proof).

o Medium. Produces a result that is a combination of Draft and Proof, that is, it
produces a more accurate graph layout than Draft, but not as accurate as Proof.

o Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality setting
varies depending on the nature of the graph being laid out. You can try each option to
determine which works best for you.

Spacing = Allows you to set constant horizontal and vertical spacing around each graph node in the
layer. The value you specify is a guideline for the layout, so that it is possible that the
spacing for a particular pair of graph nodes might be different from the one you specified.
The larger the graph node spacing, the farther apart the graph nodes are spaced in the

HPE Universal CMDB (10.31) Page 161 of 572



Modeling Guide
Chapter 6: Working with the Topology Map

Ul
Element
(A-Z) Description

final layout.

Default value: 50

The following figure illustrates smaller and larger spacing:

A

\

PN
~ - ~

- -

[]

,—1
—

—

1

node spacing=75

node spacing=150

Routing Tab

To access

Important

Click the Routing tab in the Layout Properties dialog box.

information | where they are, and reroute the lines orthogonally.

User interface elements are described below:

ul
Element
(A-Z) Description

The Routing tab enables you to produce drawings that leave graph nodes essentially

Fix Node | Maintain the position of all the graph nodes in the display. Clear this option for the
Positions | layout to move the graph nodes if it is necessary to improve the layout. The movement

is minimal, avoids overlaps, and minimizes bend points.

Fix Node Maintain the size of a graph node. Clear this option if you want the layout to increase
Sizes the size of a graph node if it is necessary to maintain the specified relationship spacing
when more than one relationship is attached to the same side of the graph node.

Horizontal =Enables you to set the minimum horizontal distance between graph nodes.
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Ul
Element
(A-Z) Description

Spacing Select one of the following options:

- Between Graph Nodes. Set a horizontal space around each graph node in the
layer.

Default value: 20
- Between Edges. Set a horizontal space between elements in the layer.

Default value: 12

Vertical Enables you to set the minimum vertical distance between graph nodes.
Spacing . .
Select one of the following options:
« Between Graph Nodes. Set a vertical space around each graph node in the layer.
Default value: 20

. Between Edges. Set a vertical space between elements in the layer.

Default value: 12

Main Menu

This feature contains the options for working with the topology map.

To access Located in the upper left portion of the screen.

Important The specific options contained within the Main Menu drop-downs are detailed in
information "Toolbar Options" on page 167.

See also « "Topology Map Overview" on page 147

« "Topology Map User Interface" on page 148

User interface elements are described below:

Ul Element
(A-2) Description
Edit Contains selection options for the topology map.

Editor Item Contains the topology map shortcut menu options for the current manager.
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Ul Element
(A-Z) Description

Note: This drop-down does not appear in Cl Type Manager.
Layout Contains options for changing the layout of the topology map.

Note: This drop-down does not appear in Reports.

Managers  Contains links to the different UCMDB modules.
Operations | Contains options for printing or exporting the topology map.

Resources ' Contains the left pane shortcut menu options for the current manager.

Note: This drop-down does not appear in IT Universe Manager or Reports, and in
Cl Type Manager it is called Cl Types.

Tools Contains the User Preferences, User Profile, Log Configuration, Screen Capture, and
Refresh User Authentication tools.

View Enables you to hide or display the different panes of the module.

Print Dialog Box

This dialog box enables you to print the contents of the topology map.

To access | Select Operations > Print.

Important | The results of printing a topology map is similar to a screen capture. Therefore, before
information | printing, it is recommended to:

« Define your print settings and arrange the contents of the topology map according
to your requirements. For details, see "Print Setup Dialog Box" on the next page.

« Arrange the contents of the topology map for print. You can use the Layout option
and Layout Properties. For details about the layout options, see "Layout
Properties" on page 171. For details about layout properties, see "Layout
Properties Dialog Box" on page 150.

Relevant "How to Print and Save a Topology Map to File" on page 209
tasks

See also « "Topology Map Overview" on page 147
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« "Topology Map User Interface" on page 148

User interface elements are described below:

Ul Element (A-Z) Description
Number of copies Enter the number of copies you want to print.
Properties Define document properties as required.

Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map before printing.

To access Select Operations > Print Preview.
Relevant tasks "How to Print and Save a Topology Map to File" on page 209
See also » "Topology Map Overview" on page 147

« "Topology Map User Interface" on page 148

User interface elements are described below:

Menu Item Description

LELI Print Setup. Opens the Print Setup dialog box where you can define the print settings.
& Print. Prints the map. For details, see "Print Dialog Box" on the previous page.

4 Zoom In. Zooms in to focus on specific details of the map.

4 Zoom Out. Zooms out to view the map.

4 Fit. Fit the complete view in the pane.

Print Setup Dialog Box

This dialog box enables you to define the print settings for a topology map.

To access Select Operations > Print Setup.
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Relevant tasks

See also

"How to Print and Save a Topology Map to File" on page 209

« "Topology Map Overview" on page 147

« "Topology Map User Interface" on page 148

User interface elements are described below:

Ul Element
(A-Z)

Actual Size
Color

Font

Page Setup

Pages

Position

Print
Background

Print
Border

Print
Caption

Print Crop
Marks

Print
Current
Selection

Print
Current
Window

Print Entire
Drawing

HPE Universal CMDB (10.31)

Description

Print the view as it really is.
Set the text color.

Set the required font.

Set the printer settings.

Divide the map into rows and columns and print each section separately. Enter the
number of columns and rows in the Page Columns and Page Rows boxes.

Select the position of the caption from the Position list.

Print the background behind the view.

Print the map with a border. Click Color to select the required border color.

Enter the caption in the text area and click Font to select the required custom font.

Print the crop marks.

Print the selected graph nodes and their relationships.

Print the part of the view that appears in the pane.

Print the complete view.
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Ul Element
(A-Z) Description

Print Page Print the page numbers.
Numbers

Zoom Level  Print the view at the current zoom level.

Toolbar Options

The following table contains a description of each Topology Map toolbar option, organized
alphabetically.

Button Option Name Use This Option to...

dim Additions Count Calculate the number of instances that are
created as a result of an Enrichment Rule. The
number of TQL query node instances and
relationships that are created appear next to the
Enrichment query nodes/relationships, as seen
in the figure below.

)

InSubnet{l)

Membership(s1)

[

Mew Nodeid1)

Note: This option appears on the toolbar in
Enrichment Manager only.

Advanced Pane Toggle between hiding and displaying the
Advanced Pane at the bottom center of the
screen.

To access: Select View > Advanced Pane.

& Calculate Query Calculate the number of instances found for each
Result Count TQL query node/relationship.
Change Label Enter the maximum number of characters that
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Button Option Name
Length/Properties
Cl Types Tree
I8 Create Relationship
g Delete Selected Item
(s)
Drag Map
|£| Drill Down One Layer

HPE Universal CMDB (10.31)

Use This Option to...
the labels should contain.

To access: In IT Universe Manager and the
Modeling Studio, select Layout > Change
Label Properties. In the other managers, select
Layout > Change Label Length.

Toggle between hiding and displaying the ClI
Type Selector at the right of the screen.

To access: Select View > Cl Types Tree.

Note: Inthe Modeling Studio, this option is
called Cl Types.

In most managers, create a relationship between
two existing TQL query nodes. For details, see
"How to Add Query Nodes and Relationships to
a TQL Query" on page 25.

InIT Universe Manager, create a relationship
between existing Cls. For details, see "Attaching
Existing Cls" on page 189.

Delete a Cl from IT Universe Manager or a TQL
query node from Impact Analysis Manager or
Enrichment Manager.

Drag the view.

To access: Open the drop-down menu in the
Mode box or select View > Drag Map. In T
Universe Manager and the Modeling Studio,
select Layout > Dragging Mode.

Move down one level in the topology map. This
option is enabled only if there is an additional Cl
layer below it, created by setting the hierarchy of
the view. For details on setting the hierarchy, see
"Setting the View Hierarchy" on page 254.

Note: This option appears only in IT
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Button Option Name
oy Enable/Disable
Related Cls Retrieval
Entities Tree
Export Map to Image
Fit to Window
Generate Direct Link
(2] Go Up One Layer
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Use This Option to...

Universe Manager.

Toggle between disabling and enabling the
redrawing of the topology map with related Cls
when selecting a new ClI in the Cl Selector.

Note: This option appears only in IT
Universe Manager in the Related Cls tab.

Toggle between hiding and displaying the
manager specific entities tree at the left of the
screen.

To access: Select View > Entities Tree.

Note: Inthe Modeling Studio, each of the
tabs of the Left pane (Resources, Cl Types,
Cl Selector) is listed as a separate option.

Save the topology map to afile. For details, see
"Export Map to Image Dialog Box" on page 149.

To access: Select Operations > Export Map to
Image.

Fit the complete map in the pane.
To access: Select Layout > Fit to Window.
Generate a direct link to a view or ClI.

To access: Select Edit > Generate Direct
Link.

Move up one level in the topology map. This
option is enabled only if there is an additional ClI
layer above it, created by setting the hierarchy of
the view. For details on setting the hierarchy, see
"Setting the View Hierarchy" on page 254.

Note: This option appears only in IT
Universe Manager.
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Button

Option Name

Hide All Inheritance

From Map

Hide All Query Node
Labels

Hide All Relationship
Labels

Hide All
Relationships

Hide/Show Get
Related Cls pane

HPE Universal CMDB (10.31)

Use This Option to...

Toggle between showing and hiding Inheritance_
f relationships and their connecting query nodes.

To access: Select Layout > Hide All
Inheritance From Map.

Note: This optionis only active on the
toolbar in Cl Type Manager.

Toggle between showing or hiding the
CI/CIT/query node/pattern labels.

To access: Select Layout > Hide All Query
Node Labels.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

Toggle between showing or hiding the
relationship labels.

To access: Select Layout > Hide All
Relationship Labels.

Note: This optionis called Hide edges'
labels in IT Universe Manager and the
Modeling Studio.

Toggle between showing and hiding the
relationships in the displayed map.

To access: Select Layout > Hide All
Relationships.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

Toggle between hiding and displaying the Get
Related Cls pane.

Note: This option appears only in IT
Universe Manager in the Related Cls tab.
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Button Option Name

Interactive Zoom

Layout

Layout Properties

HPE Universal CMDB (10.31)

Use This Option to...

« Decrease the view magnification by clicking
and pushing the pointer upwards.

« Magnify the view by clicking and pulling the
pointer downwards.

To access: Open the drop-down menu in the
Mode box or select View > Interactive Zoom.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

Select the layout display from the list. The
options are:

« Hierarchical Layout. Enables you to display
the precedence relations in the topology map.

« Hierarchical Layout with Orthogonal
Routing. Displays a hierarchical layout with
edges composed exclusively of horizontal
and vertical lines, forming right angles where
they intersect.

« Symmetric Layout. Enables you to display
clear representations of complex networks.

« Circular Layout. Groups a graph's nodes
into groups or clusters.

« Orthogonal Layout. Displays a layout with
edges composed exclusively of horizontal
and vertical lines, forming right angles where
they intersect.

For further details about each of the options, see
"Layout Properties Dialog Box" on page 150.

Note: These layout options are only
relevant for Enrichment Manager, CIT
Manager, and Impact Analysis Manager.

Define the view's layer layout, by assigning
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Button Option Name

Log Configuration

Map overview

Maximize
Workspace/Restore

Workspace

Navigation
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Use This Option to...

positions for the query nodes and relationships of
the view. For details, see "Layout Properties
Dialog Box" on page 150.

To access: Select Layout > Layout
Properties.

Open the Log Configuration dialog box.
To access: Select Tools > Log Configuration.

Open a small box with a copy of the topology
map. This is useful in large views when zooming
in.

To access: Select Layout > Map Overview. In

IT Universe Manager and the Modeling Studio,
select Layout > Show Map Overview.

Toggle between the regular display and a full-
screen display of the topology map.

Take the pointer to the next connected
CI/CIT/TQL query node in a clockwise direction.

« Left-click to move in a clockwise direction.

« Right-click to point to the next CI/CIT/query
node/pattern in a clockwise direction.

To access: Open the drop-down menu in the
Mode box or select View > Navigation.

Note:

« You can use this option only on
CI1/CIT/query nodes/patterns that are
connected by relationships.

« This option is not available in IT
Universe Manager and the Modeling
Studio.
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Button Option Name Use This Option to...

@ New ClI Define a new unrelated Cl. For details, see
"Working with Cls" on page 184.

Note: This option appears on the toolbar in
IT Universe Manager only.

@ New Related CI Define a new related Cl. For details, see
"Working with Cls" on page 184.

Note: This option appears on the toolbar in
IT Universe Manager only.

Place in Center Place the selected CI/CIT/query nodes/pattern
in the center of the map.

To access: Select Layout > Place in Center.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

Print Print the contents of the topology map. For
details, see "Print Dialog Box" on page 164.

To access: Select Operations > Print...
Print Preview Preview the contents of the map before printing.
To access: Select Operations > Print Preview.

Print Setup Define print settings for printing the topology
map. For details, see "Print Setup Dialog Box"
on page 165.

To access: Select Operations > Print Setup...

4ifm Remove Enrichment Remove the instances created from an
Results Enrichment rule from the CMDB.

Note: This option appears on the toolbarin
Enrichment Manager only.

Screen Capture Take a snapshot of the screen using the Screen
Capture tool.
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Button Option Name Use This Option to...

To access: Select Tools > Screen Capture.

IE Select Select a CI/CIT/TQL query node or multiple
Cls/CITs/TQL query nodes.

To access: Open the drop-down menu in the
Mode box or select View > Select. InIT
Universe Manager and the Modeling Studio,
select Layout > Selection Mode.

Select All Select all the Cls and relationships in a selected
layer.

To access: Select Edit > Select All.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

Select All Query Select all the query nodes in a selected layer.

Nodes .
To access: Select Edit > Select All Query

Nodes.

Note: This optionis not available in IT
Universe Manager and the Modeling Studio.

™ Select Columns Enables you to select the columns to be
displayed. For details, see "Select Columns
Dialog Box" on page 568.

Note: This option is displayed in Text mode
of IT Universe Manager only.

Set Change Open the Change Timeframe dialog box, which
Timeframe enables you to set the period for the display of
added or changed Cl indicators.

Note: This option appears on the toolbarin
IT Universe Manager only.

&1 Show Candidates for  Identify the Cls in the current view which are
Deletion candidates for deletion.
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Button Option Name

(€] Show Schedule Info

=1 Sort Column Content
Straighten

User Preferences

User Profile

HPE Universal CMDB (10.31)

Use This Option to...

Note: This option appears on the toolbarin
IT Universe Manager only.

Display the scheduling information for the
selected job. For details, see "Discovery
Scheduler Dialog Box" in the HPE Universal
CMDB Data Flow Management Guide.

Note: This option appears on the toolbarin
Data Flow Management > Discovery
Module/Jobs > Dependency Map tab. For

details, see "Dependency Map Tab" in the
HPE Universal CMDB Data Flow
Management Guide.

Enables you to set the order of the visible
columns. For details, see "Sort Column Content
Dialog Box" on page 569.

Note: This option is displayed in Text mode
of IT Universe Manager only.

Straightens any selected relationship between
two query nodes that has angles.

To access: Select Layout > Straighten.

Note: This option is only available in
Enrichment Manager and Impact Analysis
Manager.

Opens the User Preferences dialog box which
enables you to reset warning message
preferences. For details, see "User Preferences
Dialog Box" on page 92.

To access: Select Tools > User Preferences.

Opens the User Profile dialog box which displays
the user details for the user currently logged in.
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Button Option Name Use This Option to...

To access: Select Tools > User Profile

Zoom In Zoom in on a specific section of the topology
map by clicking and drawing a selection
rectangle around the part to magnify. The area
you select is displayed at the highest percentage
that fits in the topology map.

To access: Open the drop-down menu in the
Mode box or select View > Zoom In. InIT
Universe Manager and the Modeling Studio,
select Layout > Zoom in.

Topology Map Sidebar

The following table contains a description of each Topology Map sidebar option. The Topology Map
sidebar appears in IT Universe Manager and the Modeling Studio.

Button Option Name Use This Option to...
[2] Move Layout Move the sidebar to the right or left side of the screen.
Toolbar to
« Right/Left
@, Zoom In/Out Zoom in or out on the topology map.
=
a
Selection Toggle between Selection mode and Dragging mode in
Mode/Dragging the topology map.
3G9 Mode
an Refresh to get an | Refresh the topology map to optimize the layout.

optimal layout

Fit to Window Fit the complete map in the pane.

Change Map Select the map layout. The following options are
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Button Option Name Use This Option to...
Layout available:

. “Hierarchical Layout. Displays the precedence

relations in the topology map.

. “! Hierarchical Layout with Orthogonal

Routing. Displays a hierarchical layout with edges
composed exclusively of horizontal and vertical
lines, forming right angles where they intersect.

. % Circular Layout. Groups a graph's nodes into

groups or clusters.

. B Orthogonal Layout. Displays a layout with
edges composed exclusively of horizontal and
vertical lines, forming right angles where they
intersect.

. ‘i Symmetric Layout. Displays clear

representations of complex networks.

a
3

Map Settings Y ou can modify the following settings:

.i’.l—ﬂ

. < Hide/Show Edges' Labels. Hide or display the

labels of all relationships.

. "')r Hide/Show Count Indicators. Hide or display
the count indicators for the query nodes.
ﬁ?
. Enable/Disable Edges' Highlighting.

Highlight all the relationships to and from the
selected query node.

. Hide/Show Legend. Toggle between hiding and
displaying the topology map legend.

[ Map Tools The following tools are available:

. [ Show Map Overview. Open a small box with a

copy of the topology map. This is useful in large
views when zooming in.
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Button Option Name Use This Option to...

. @ Print. Print the topology map.

. & Export Map to Image. Save the topology map to

afile.
|E| Expand All Expand all the CI groupings in the topology map.
Groups
Note: This option is only available when a grouping
option is selected.
|E| Collapse All Collapse all the CI groupings in the topology map.
Groups
Note: This option is only available when a grouping
option is selected.
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This chapter includes:

IT Universe Manager OVEIVIEW ... 180
Working with Views in IT Universe Manager . . ... ...l 181
View Tree StruCtUre ... . 183
Working With ClS 184
Working with Relationships . ... 187
How to Create Cls and Relationships . ... ... . 192
How toView Related Cls ... ... .. . i 193
How to Check the Status of Application Discovery (RediscoveraView) ......._................... 194
How to Check the Network Availability of an Inventory Cl ... ... ... 196
How to View Discovery Status and Errors foraSelected Cl ... .. . . 199
How to Retrieve Impact Analysis Results —Scenario ... .. 203
How to Take a Snapshot Of a ViewW .., 209
How to Print and Save a Topology Map to File ... . 209
IT Universe Manager User Interface ... . .. 209

IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe model. The following
tasks represent the basic functionality of the application:

« Creating Cls without creating relationships. You can define new Cls that are added to the
CMDB individually, so that no new relationships are created. For details, see "Creating a Non-
Related CI" on page 184.

« Creating Cls with relationships for them. You can define new Cls and attach them to existing
Cls, so defining a new Cl and a new relationship in the CMDB. For details, see "Creating a Related
CI" on page 185.
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« Adding existing Cls and creating relationships for them. You can attach Cls to an existing Cl,
so creating new relationships for existing Cls. For details, see "Attaching Existing Cls" on page
189.

« Deleting Cls. You can delete Cls from the CMDB. For details, see "Deleting Cls" on page 185.

o Getting Impact Analysis results. You can run the Impact rules you defined for a view to simulate
how certain defined changes impact your system, and to discover the root causes of the changes.
For more information about Impact rules, see "Impact Analysis Manager Overview" on page 462.

« Taking a snapshot of a view. Universal CMDB enables you to display the status of a view in one
snapshot by comparison with its status taken at a different time. For details on how to take
snapshots, see "How to Take a Snapshot of a View" on page 209.

Populating the IT Universe Model

The IT Universe model in the CMDB contains the Cls and relationships produced by the Cl-generating
tools that operate within Universal CMDB. Most Cls and relationships originate from one of the
following sources:

. Data Flow Management (DFM). Automatically creates Cls and relationships based on the
discovered IT resources and topology in your company's infrastructure. For details, see Data Flow
Management Overview in the HPE Universal CMDB Data Flow Management Guide.

« IT Universe Manager. Enables you to manually create Cls and relationships that represent logical
and physical elements of the business. For details, see "Working with Cls" on page 184.

« Enrichment Manager. Enables you to add Cls and relationships to the CMDB by receiving data
from the attributes of Enrichment query nodes as defined in the Enrichment TQL query. For details,
see "Enrichment Manager" on page 527.

Working with Views in IT Universe Manager

InIT Universe Manager, you analyze data at the view level. Views are subsets of the IT Universe,
containing only those Cls relating to a specific area of interest. All views are based on a pattern which
determines the content of the view.

« Pattern views and template-based views are built from a TQL (Topology Query Language) query
that defines the structure of the view. The view displays only those Cls and relationships that
satisfy the query definition.

HPE Universal CMDB (10.31) Page 181 of 572



Modeling Guide
Chapter 7: IT Universe Manager

« Perspective-based views are built manually, by selecting a group of Cls and applying perspectives
to them. A perspective is a pattern used to define which related Cls are included in the view.

You build all views in the Modeling Studio, using the appropriate editor for each view type. For
information on the different view types and how they function, see "View Formats" on page 252.

Note: You must have Update permissions for a view to edit the view. If you do not have the
necessary permissions, contact your Universal CMDB Administrator.

Cls created by DFM are automatically added to each view where the Cls (and their relationships) fit the
TQL definition for the view. When you open a view in the CI Selector, the TQL query for the view
queries the CMDB for Cls that match the defined pattern. If there are no matches (for example, in the
case of a view fora DFM process where the process has not yet run) then the view remains empty.

You can also include Cls from external data sources (federated Cls) in your view, by defining the query
to run over integration points for federated data sources. The federated Cls appear in the view with an
arrow icon indicating that they are from a federated source.

¢

For details on federated data sources, see "Integration Studio Overview " in the HPE Universal CMDB
Data Flow Management Guide.

Note: For out-of-the-box queries that have integration points defined, the data source is set as
UCMDB.

When you define a new Cl while working in any view in IT Universe Manager, the Cl (and any
associated relationship) is created in the CMDB. The Cl is added to your current view only if it meets
the view's TQL specifications.

If the created CI and relationship do not meet the TQL requirements, then the Cl and relationship are
created in the CMDB but are not visible in the view. Similarly, if you attach an existing Cl to a Cl in the
view, and the new pattern does not meet the TQL requirements, then the attached Cls do not appear in
the view, but the relationship is still created.

Templates and Template-based Views

If you open a template in IT Universe Manager, it is displayed in the topology map like a pattern view.
Click the Show Template Parameters * button on the Cl Selector toolbar to open the Template

Parameter Values dialog box, where you can change the values of the template parameters and
thereby affect the view results displayed in the topology map. You can try different parameter values
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and see the resulting topology map, but you cannot save changes to the template itself. To save the
view results as a template-based view with the selected parameters, click the Save As View button in
the Template Parameter Values dialog box.

You can also create a direct link to a template in IT Universe Manager and insert the parameter values
directly into the URL. For details, see "How to Create a Direct Link to a Template with Parameter
Values" on page 104.

View Lifecycle

If you do not access a view from the CI Selector for a specified period of time, the view is cleared out,
to save memory in the system. It is not deleted from the CMDB; the view can be retrieved by clicking
on it. The default time period for clearing out unused views is one hour.

Note: Views defined as persistent are not cleared out and always remain in the memory.

Hidden Views

You can designate a view as a hidden view that does not appear in IT Universe Manager by defining a
bundle for hidden views and assigning the view to that bundle.

To designate a view as a hidden view:

1. Inthe Infrastructure Settings Manager, select Hidden Bundles Names in Cl Selector.

2. Enter the name of the new bundle as the default value and save the setting.
3. Inthe Modeling Studio, open the relevant view and click the View Definition Properties |@'|
button on the toolbar.

4. Inthe View Definition Properties dialog box, select the hidden views bundle and assign the view to
it.

View Tree Structure

Views are organized in a hierarchical tree format in the left pane of IT Universe Manager, which is
known as the Cl Selector. The view name appears in the View box above the tree and acts as the
containing folder for the Cls in the view.

The first level of the Cl Selector tree consists of the query nodes for the root Cls. A root Cl is the
starting point for a view subtree. A view may contain any number of subtrees. Under the root Cls come
the branch Cls, expanding down to the leaf Cls as the last query nodes at the ends of each branch.
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The Cls at each level in a subtree are considered to be attached to the Cl on the branch directly above.
This attachment generally depicts a dependent relationship, so that the higher branch (closer to the root
Cl) represents a component of your business that depends on the Cls on the next branch down (closer
to the leaf Cls) in the business process. For example, an application depends on the servers running
the application.

The attachment between a higher and a lower query node is referred to as a parent-child relationship.
The parent Cl may have many attached child Cls, and the child Cls pass operational status to the
parent.

The tree topology is determined by the hierarchy defined for the view. In a pattern view, these are
defined for the specific view. In a template-based or a perspective-based view, the hierarchy is defined
as part of the template or perspective. For details on defining the hierarchy, see "Setting the View
Hierarchy" on page 254.

Working with Cls

InIT Universe Manager, you can create related and non-related Cls, delete Cls, edit the Cl properties,
and remove out-of-date Cls using the aging mechanism.

This section includes the following topics:

« "Creating a Non-Related CI" below

« "Creating a Related CI" on the next page
« "Deleting Cls" on the next page

« "Cl Properties" on page 186

« "Removing Out-of-Date Cls Using the Aging Mechanism" on page 186

Creating a Non-Related Cl

You can define anew Cl in IT Universe Manager by clicking the New Cl '# button on the toolbar. The

New CI dialog box opens, which enables you to define the properties for the new Cl. The Cl is created
in the CMDB. For details, see "New Cl/New Related Cl Dialog Box" on page 238.

Note: The Clis added to the view only if it meets the specifications of the pattern of the view,
template, or perspective.
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A Cl created in this way is added as an independent entity without any relationship to any other existing
Clinthe CMDB.

Creating a Related ClI
You can define a new Cl to be added as a parent, child, or sibling of an existing ClI.

To define a new related Cl:

1. Select the Cl in your view to which you want to attach the new CI.
2. Click the New Related CI @ button on the toolbar.

3. Inthe New Related CI dialog box, define the properties and relationship for the CI. For details, see
"New CI/New Related Cl Dialog Box" on page 238.

The Cl and relationship are created in the CMDB.

Note: The Cl and relationship are added to the view only if they meet the specifications of the
pattern of the view, template, or perspective.

Deleting Cls

You can delete a Cl by selecting Delete from CMDB from the shortcut menu in IT Universe Manager.
The Cl is deleted from the CMDB and from all views. If the CI has children, they are not automatically
deleted when you delete the parent Cl. If you delete a Cl without first deleting the relationship between
the Cl and any child Cls that appear with the parent Cl in a view, the child Cls are removed from the
view.

If the child Cls do not appear in any other view, they remain in the CMDB without appearing in a view.
The child Cls might appear in the future in views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and parent Cl is a Composition
relationship; in that case, when the parent Cl is deleted, the contained Cl is also removed from the
CMDB. For example, if a node Cl is the container for a child CPU CI, then when the node Cl is deleted,
the CPU is also removed from the CMDB.

When you delete a Cl that was created by the DFM process, the Cl is restored the next time that DFM
runs (if the Cl is still valid), and it reappears in all relevant views.

Note: Sometimes, a Cl is deleted from the CMDB but it still appears in a TQL query because the
query was not yet updated due to its priority level. When the query is consumed in IT Universe
Manager, UCMDB cannot find any of the Cl's properties, and it is displayed with a no label name
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in the topology map.

Cl Properties

In IT Universe Manager, you can edit the properties of a Cl. The CI properties are divided into several
categories which appear in the New CI dialog box:

« The general properties of a Cl are common to all Cls. Some general properties are defined
automatically during Cl creation; others can only be defined manually in the New CI dialog box.

« CIT-specific properties are created as part of the CIT definition in the Cl Type Manager. The values
for the CIT-specific properties are taken from the Cls discovered during DFM. The values can also
be entered manually, when you manually create Cls to represent entities in your infrastructure. For
details, see "Cl Type Manager" on page 481.

« Key properties can be general or CIT-specific properties, which must be assigned a value to create
aninstance of the Cl type.

You can access the Configuration Item Properties dialog box to view the CI properties from IT Universe
Manager by right-clicking the Cl and selecting Properties or by clicking the Properties tab in the
Advanced pane. You can also edit the CI properties if you have the necessary permissions for editing
Cls. For details on Cl properties, see "Configuration Item Properties Dialog Box" on page 217.

The CIT-specific properties are displayed in the Specific Properties section of the Configuration Item
Properties dialog box when you sort the properties using the Categorized button. Some properties for
the automatically created Cls can be edited, however, if the Cl is configured to Allow Cl Update (in
the General Properties), then DFM may override your changes when it updates the Cl. A description of
the selected property can be found in the Description area at the bottom of the Configuration Item
Properties dialog box.

Some of the CIT-specific properties for DFM Cls are set by default to be monitored for changes. When
one of these properties has been modified, information on the change can be viewed in a Cl change
report. For more information, see "C| Change Report" on page 377.

Removing Out-of-Date Cls Using the Aging Mechanism

If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is not
rediscovered by DFM and no manual update occurs), an aging mechanism deletes the Cl from the
CMDB. For details, see Cl Lifecycle and the Aging Mechanism in the HPE Universal CMDB
Administration Guide.

Note: The following actions that apply to Cls cannot be performed on federated Cls:

HPE Universal CMDB (10.31) Page 186 of 572



Modeling Guide
Chapter 7: IT Universe Manager

« Editing the CI properties

« Deleting the CI

« Creating arelationship to another CI
« Viewing the Cl History

« Adding the Cl to a Discovery job

« Removing the Cl from a Discovery job

Working with Relationships

Many of the relationships between Cls in the CMDB are created automatically, for example, by DFM.
In addition, you can create relationships manually in IT Universe Manager, Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio.

This section includes the following topics:

« "Creating Relationships" below

« "Creating Hierarchical Relationships" on the next page
» "Attaching Existing Cls" on page 189

« "Setting the View Hierarchy" on page 189

« "Relationship Properties" on page 189

» "Viewing Related Cls" on page 190

» "Deleting Relationships" on page 190

« "Inter-Layer Relationships" on page 190

Creating Relationships

You can create relationships by right-clicking a Cl or multiple Cls in the CI Selector pane or the
Topology Map and selecting Relate to CI from the shortcut menu. In the Topology Map, you can define
a relationship between two Cls in the view by drawing a line between the two, using the Create

Relationship I% button from the toolbar. Either of these actions opens the Insert Relationship dialog

box. For details, see "Insert Relationship Dialog Box" on page 222.
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You can create as many relationships as necessary between a Cl in the CMDB and other Cls. Each
new relationship exists as its own entity in the CMDB, and has its own properties that can be edited in
IT Universe Manager (as described in "Configuration Item Properties Dialog Box" on page 217). You
can also create more than one relationship between the same two Cls, when each relationship is based
on a different relationship type. In the following example, host7 has both a Backbone and a Talk
relationship with switch3.

=

Talk
ackbone

&

switch3

host?

Note: If a Running Software Cl is related to another CI with a Containment relationship, you
cannot create another Containment relationship from the Running Software CI.

Creating Hierarchical Relationships

By attaching one CI to another in IT Universe Manager you create a hierarchical relationship (parent-
child) between them, so that one Cl is influenced by the other.

Certain relationships defined in this way are restricted to the relationship type usage (if the relationship
is between two non-monitoring Cls), or the relationship type Monitored By (if the child Cl in the
relationship is a monitor type Cl); however, other relationship types are used between specific types of
Cls. For example, if a relationship is defined between two node Cls, there are several possible
relationship types.

Select Relatienship
Source CI host08 (Mode)
Target Cl{s). host07?

Relationship: | b

I— Membership
Dependency

3

Direction:

Define Relation

’» Backhone =
=1

4 (1] k
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Note: When you attach a child Cl to a parent Cl, you are creating that relationship in the CMDB.
The child therefore impacts on the parent Cl in every view where the relationship exists, and is
displayed in every view where the child and relationship match the TQL query.

Attaching Existing Cls

You can attach existing Cls using the Insert Relationship dialog box. The dialog box has two modes:

« Selecting the Cls that you want to attach.

« Defining the relationship between the original Cl and the Cls to attach.

When selecting the Cls to attach, you can select multiple Cls from a view to attach to the original Cl.
However, all Cls that you want to attach in one operation must have the same relationship type. For
example, you cannot attach a Cl that uses the relationship usage in the same operation as a Cl that
uses the relationship Monitored By.

Setting the View Hierarchy

After setting the query node and relationship definitions of a view, you can set a hierarchy for the view.
This enables you to define the organizational structure of Cls in the view by displaying selected Cls at
different levels. When no hierarchy is defined, the Topology Map or table displays all Cls included in the
query results on one level by default. For example, if the query results include nodes and IP Subnets,
both Cl types are displayed on the same level in the Topology Map or table.

Note: The maximum number of Cls that can be displayed in a single layer of the Topology Map is
900. If a view contains a layer with more than 900 Cls, the view is not displayed in the Topology
Map until the hierarchy is changed. However, a layer with more than 900 Cls can be displayedina
table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on page 254.

Relationship Properties

Relationships have properties, similar to Cls. You can access the Configuration Item Properties dialog
box to view the relationship properties from IT Universe Manager by right-clicking the relationship and
selecting Properties or by clicking the Properties tab in the Advanced pane. You can also edit the
relationship properties if you have the necessary permissions for editing Cls. For details on relationship
properties, see "Configuration Item Properties Dialog Box" on page 217.
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Note: For relationships of type composition connected to a Cl of type Node Element or its
descendant Cl types, relationship properties are not saved. When a TQL query containing such a
relationship is run, the default values for the relationship properties are used even if you edited the
properties.

Viewing Related Cls

You can view all the Cls related to a selected Cl in the topology map. Select a Cl in a view and then
select the Related Cls tab. The Get Related Cls pane enables you to select the scope of the display. If
you select View, the topology map displays only the selected Cl and its related Cls in the view (no
matter where it is in the view hierarchy). If you select CMDB, it displays the selected Cl and all of its
related Cls in the CMDB. You can also filter the results from the Get Related Cls pane by Cl type and
apply perspectives to a Cl. For details, see "Get Related Cls Pane" on page 236.

You can also display Related Cls using the Get Related Cls from CMDB dialog box. For details, see
"Get Related Cls From CMDB Dialog Box" on page 222.

Deleting Relationships

The Topology Map shows only the relationships for the Cls that are part of the current view; however,
the same relationships may also be part of other views. When you delete a relationship in IT Universe
Manager, it is deleted from the CMDB and from all views.

When a relationship is deleted, the Cl on the other end of the relationship may remain in the view, if it
still matches the pattern of the view. However, if the deleted relationship is a composition link, the
target Cl is deleted with it.

In a perspective-based view, you can remove the Cl completely from the view (without deleting it from
the CMDB), by hiding it from the view in the Perspective-based View Editor in the Modeling Studio.

When you delete a relationship that was created by the DFM process, the relationship is restored the
next time that DFM runs (if the relationship is still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple Cls and relationships, from a view.

Inter-Layer Relationships

In certain circumstances, IT Universe Manager displays a relationship between Cls in a layer of a view
that does not reflect an actual relationship between the Cls in that layer, but rather a relationship
between Cls on deeper layers of the view. Such a relationship is known as an inter-layer relationship.
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For example, in the following view, two node Cls are related to each other with a dependency
relationship. Each is also related to an IP Subnet by a membership relationship and the view hierarchy
is defined such that the nodes are on the layer beneath the IP Subnet.

@

IpSubn

Membership % wompership_1

é‘ Dependency é

Mode_1 Mode

When you consume the view in IT Universe Manager, the relationship between the node Cls (which are
under different IP Subnets) is displayed in the higher layer of the view as a relationship between the
parent IP Subnets, even though the actual relationship only exists between the Cls in the lower layer of
the view. You can double-click the relationship to display the full path between the IP Subnets.

Another form of inter-layer relationship occurs when the same Cl appears under more than one parent
Cl of the same type in the layer above it. In such a case, the child Cl and its relationships are
duplicated in the view display, due to the hierarchy definition. The relationships of such child Cls result
in inter-layer relationships between the parent Cls. This type of inter-layer relationship is known as a
duplication metalink.

For example, in the following view, a single node Cl appears under two IP Subnet Cls in the hierarchy.
The node and its children thus appear twice in the view - once under each IP Subnet. Each node is
effectively related to the child Cls of the node under the other IP Subnet, which generates an inter-layer
relationship between the two IP Subnets.
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Inter-layer relationships and duplication metalinks are displayed in gray in the topology map. The
following options are available for viewing inter-layer relationships (defined in the View Definition
Properties dialog box in Modeling Studio):

« None. Hide all inter-layer relationships.

« Inter-Layer. Display inter-layer relationships of the first type, but not duplication metalinks.

« Full. Display all inter-layer relationships, including duplication metalinks.
A tooltip for the inter-layer relationship displays the inner relationships which it represents. If there is
only one inner relationship, the relationship label displays that relationship type. If there are multiple
inner relationships, the label becomes Inter-layer and the tooltip displays a list of all the inner

relationships. If there are more than ten inner relationships, only the first ten are displayed, and a note
indicates that there are more inner relationships.

How to Create Cls and Relationships

This task describes how to create related and non-related Cls, as well as relationships between Cls, in
the CMDB.

This task includes the following steps:
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o "Define a New Non-related CI" below
o "Define a New Related CI" below

» "Attach Existing Cls" below

Define a New Non-related Cl

Click the New CI @ button on the toolbar. In the New CI dialog box, select a Cl type from the tree and
define the properties for the new ClI. For details, see "New Cl/New Related Cl Dialog Box" on page
238.

Define a New Related Cl

Click the New Related CI @ button on the toolbar. In the New Related Cl dialog box, select a Cl

type from the tree and define the properties for the new Cl. On the Relationship page of the dialog box,
select the type of relationship and define its properties. For details, see "New Cl/New Related CI
Dialog Box" on page 238.

Attach Existing Cls

Select a Cl in aview. Right-click the Cl and select Relate to ClI. In the Insert Relationship dialog box,
select a target Cl. On the Relationship page of the dialog box, select the type of relationship and define
its properties. For details, see "Insert Relationship Dialog Box" on page 222.

How to View Related Cls

The following steps describe the options for viewing related Cls in IT Universe Manager.

» "Display Related Cls" below
« "Select the Scope of the Display" on the next page
« "Filter the Related Cls" on the next page

o "Apply Perspectives to a CI" on the next page

Display Related Cls

InIT Universe Manager, select a Cl in the Topology map or the Cl Selector and select the Related Cls
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tab. Click the Enable Related Cls Retrieval “ button. The selected Cl is displayed with its related

Cls. Select a different Cl or multiple Cls from the CI Selector, and the display changes accordingly.
Note: You can display the Related Cls content in map mode or in text mode.

For details on the Get Related Cls user interface, see "Get Related Cls Pane" on page 236.

Select the Scope of the Display

In the Get Related Cls pane, select the scope of the related Cls display. Click the Show Related Cls
button. The display changes according to your selection.

Filter the Related Cls

In the Filter Related Cls by Cl Type section, select the Cl types to appear in the related Cls display.
Click the Filter Related Cls button. The filtered results appear in the tab. The scope selected above
still applies and the display is reduced according to your filter selection.

Apply Perspectives to a Cl

In the Apply Perspectives to Cl section, select the perspectives to apply to your selected CI. Click the
Apply Perspectives button. The results are displayed in the tab.

| Note: This feature is only relevant when CMDB is selected as the scope.

How to Check the Status of Application Discovery
(Rediscover a View)

As an application owner or administrator, you need to be kept informed of any problems with your
application. So, for example, it is important to know that discovery is working properly and that its
current configuration can connect to the application database. This section explains how to run the
rediscovery procedure that enables you to check the current status of the discovery of an application.

Note:

« Set up and configuration is performed by the UCMDB administrator. For details, see
"Prerequisites" on the next page.

« Rediscovery is performed by the application owner/administrator. For details, see "Access the
View" on the next page.
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« You do not need any knowledge of Data Flow Management (DFM) to run this procedure.
« By default, you can run the rediscovery procedure on views that contain fewer than 10,000 Cls.

For details on changing this number, see "Important information" on page 247.

This task includes the following steps:

« "Prerequisites" below
« "Access the View" below
« "View Results in the View" on the next page

« "Schedule the Rediscovery" on the next page

1. Prerequisites
Note: This step is performed by the UCMDB administrator.

a. InDFM, create a module that contains the jobs that must discover the application. For details,
see How to Run Module/Job-Based Discovery in the HPE Universal CMDB Data Flow
Management Guide.

b. Activate the module and all the jobs. The jobs must remain activated.

c. Verify that the module has run without errors. For details, see Error Messages Overview and
Discovery Module/Jobs - Details Tab in the HPE Universal CMDB Data Flow Management
Guide.

d. Correct any errors in the application and confirm that DFM finds no errors during the next run.

Caution: The application owner cannot rediscover a view if DFM is reporting errors. You
must set an error-free baseline.

e. Inthe Modeling Studio, define a view that includes the application Cl or Cls to be
rediscovered. These are the Cls that are created when you activate the jobs that discover the
application. For details, see "How to Create a Pattern View" on page 269.

f. Notify the application owner of the name of the view.

2. Access the View

Note: This step is performed by the application owner/administrator.
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In IT Universe Manager, access the view that includes the application Cls to be rediscovered. For
details, see "How to Search for Cls in Search Mode" on page 130.

3. View Results in the View

a. Check the complete application. Click the Show Discovery and Changes Summary ®
button on the CI Selector toolbar. The Show Discovery Status and Changes of View dialog
box is displayed. The dialog box displays information about which jobs and trigger CI
discovered the Cls in the view, on the last occasion that DFM ran the discovery for the jobs.
For details, see "Show Discovery Status and Changes Dialog Box" on page 247.

To run the discovery, click the Rerun Discovery button. To view information about the jobs
and trigger Cls, use the links to drill down. For details, see Error Messages Overview in the
HPE Universal CMDB Developer Reference Guide.

b. Check specific components of your application. Select the component's Cl in the
Topology Map pane and display the Discovery tab in the Advanced pane. For details, see
"Show Discovery Status and Changes Dialog Box" on page 247.

Torediscover several Cls, press CTRL, select the Cls and display the Discovery tab.

To run the discovery, click the Rerun Discovery button.

4. Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the Job Definition window,
choose the Rerun Discovery on View action. For details, see Job Definition Dialog Box in the
HPE Universal CMDB Administration Guide.

How to Check the Network Availability of an
Inventory Cl

As a discovery administrator, you might often need to perform troubleshooting of network connection
issues and/or credential related issues. This section explains how to use the network ping options
available in the new Check Network Availability dialog box to troubleshoot network connection
issues and/or credential related issues against an inventory Cl in IT Universe Manager.

Note:
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« This feature is available for the Node type inventory Cls only.

« Touse this feature, you need to have the Run Discovery and Integration and the Check
Network Availability permissions. The out-of-the-box Discovery and Integrations Admin

role has these required permissions by default.

This task includes the following steps:

o Prerequisites

o Check the Network Availability of an Inventory Cl

1.

Prerequisites

To use this feature, you need to have the Run Discovery and Integration and the Check
Network Availability permissions. The out-of-the-box Discovery and Integrations Admin role

has these permissions by default.

If you want to assign these permissions to a custom role (say, IT Administrator), do the following:

Note: This step is performed by the system administrator.

Loginto UCMDB and go to Security > Roles Manager > Roles.
Select a role for which you want to assign the required permissions.

You may need to create one if you do not have such arole. In this case, IT Administrator is
created and selected.

In the Resources tab of the IT Administrator window, select CIT Menu Items in the Resource
Types pane, select Node in the Resources pane, and then select Check Network
Availability in the Available Actions pane and move it the Selected Actions pane.

Go to the General Actions tab of the IT Administrator window, select Run Discovery and
Integration in the Available Actions pane and move it the Selected Actions pane.

Check the Network Availability of an Inventory Cl

To check the network availability of an inventory CI of the Node type,

a.

b.

In UCMDB, go to Modeling > IT Universe Manager.
In IT Universe Manager, search for Node type inventory Cls.

Select a Cl of your interest from the returned result, and then right-click the inventory ClI in the
map and select Actions > Check Network Availability from the shortcut menu.

Click a desired icon and provide necessary values in order to perform a network ping.
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. IP Ping. Displays the IP Ping Settings dialog box, which enables you to specify the
necessary values to perform a network IP ping.
« IP Address. Select the IP address of your target node (in IPv4 or IPv6 format) from the

drop-down list of available IP addresses. You can also manually enter the IP address
(in IPv4 or IPv6 format) of a target node.

« Probe. Select a probe from the drop-down list of connected probes to perform IP ping.

« Ping Times. Number of attempts for the selected probe to perform IP ping. Default
value: 4.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to perform
IP ping. Default value: 60,000 (ms).

. () Ping with UD Agent. Displays the UD Agent Ping Settings dialog box, which enables

you to specify the necessary values to perform a network ping with UD agent.

« IP Address. Select an IP address from the drop-down list of available IP addresses.
You can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click l:==/ to open the Choose Credential dialog box, which enables you to

select an existing credential for the probe to use. By default all credentials available for
the selected protocol type are selected.

If there is no existing credential, click = to create one.

« Probe. Select a probe from the drop-down list of connected probes to ping with UD
agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping with
UD agent. Default value: 60,000 (ms).

. (&) Ping with SNMP. Displays the SNMP Ping Settings dialog box, which enables you to

specify the necessary values to perform a network ping with SNMP.

« IP Address. Select an IP address from the drop-down list of available IP addresses.
You can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click l:==/ to open the Choose Credential dialog box, which enables you to

select an existing credential for the probe to use. By default all credentials available for
the selected protocol type are selected.

If there is no existing credential, click L= to create one.

« Probe. Select a probe from the drop-down list of connected probes.
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« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping.
Default value: 60,000 (ms).

e. Click OK to perform the network ping.

UCMDB server dispatches an ad hoc task to the selected probe, and the probe will ping the
target node.

f. The result pane displays the ping result.
For IP Ping, the result is the output of the ping command.

For Ping with UD Agent or Ping with SNMP, the result is either success or failure. An error
message follows when the network ping fails.

How to View Discovery Status and Errors for a
Selected Cl

As an IT administrator, with the new View Discovery Status and Error permission, you are able to
run the enhanced Show Discovery Progress action in IT Universe Manager. This allows you to,

« Show Errors. You can view all error/warning messages during the discovery progress for a
selected Cl.
« Show All “<Error Message>” Issues. Displays all similar discovery issues related to a specific

job, thus allowing you to view all Cls impacted by this particular discovery issue.

This enables you to focus on troubleshooting the root cause of the errors and warnings for a particular
Cl or Cls impacted by a particular discovery issue, without having to access the Universal Discovery
module which contains too many unnecessary information. Then you can verify if a Cl data error is
caused by any discovery issue.

Note: Running the Show Discovery Progress action in Universal Discovery allows you to view
discovery statuses and error/warning messages for all triggered Cl instances.

This task includes the following steps:

« Prerequisites: Grant the Required Permissions

» View Discovery Status and Errors in IT Universe Manager
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1. Prerequisites: Grant the Required Permissions

Note: This step is performed by the system administrator.

To view discovery status and errors in IT Universe Manager, your administrator need to grant
the following permissions to you:

o View Discovery Status and Error

o

Show Discovery Status

o

Loginto UCMDB and go to Security > Roles Manager > Roles.
b. Select arole for which you want to assign the required permissions.

Create a new role if you do not have such arole. In this case, IT Administrator is created and
selected.

Note: The View Discovery Status and Error permission is not available for all out-of-
the-box roles.

c. Inthe IT Administrator window, go to the General Actions tab, select the View Discovery
Status and Error action in the Available Actions pane and move it the Selected Actions pane.

d. Gotothe Resources tab, select CIT Menu Items in the Resource Types pane, select

Configurationltem CI type in the Resources pane, and then select Show Discovery Status
in the Available Actions pane and move it the Selected Actions pane.

To view all discovery status and errors in Universal Discovery, you also need the access to
the Universal Discovery module.

a. Enable the View Discovery Status and Error and Show Discovery Status permissions by
following the instructions above.

b. Go tothe Resources tab, select Ul Modules in the Resource Types pane, and then select
and move Universal Discovery to the Selected Ul Modules with Permissions pane.

2. View Discovery Status, Errors, and Warnings for a Selected Cl in IT Universe

Manager

a. Loginto UCMDB with the new role IT Administrator, go to Modeling > IT Universe
Manager.

b. Inthe Cl Selector pane, go to the Search Cls tab, click the Start the Search 2 jicon for the
Cl Name field.
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c. From the returned results, select a discovered node to allow the page to load.

d. Right click the discovered node, select Actions > Show Discovery Progress.

The Discovery Progress dialog box pops up and loads discovery statistics.

=

el
| Triggered Cls |

Pogress | oo
Total [¥] FON [ %]

Pending Probe 0

Reached Probe

Completed 3 2 1«

Total 3 2 1w

e. Inthe Cl Instances table,

« Click thelink in the Q column and select Show errors.

« Click thelink in the A column and select Show warnings.

The Discovery Progress dialog loads error or warning messages that are related to the
selected node.
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| £ | Discovery Progress

20 ©

| Trggered Cls > Completed with Errors

Error Message | Job
Imvalid user name or password Hest Connecticn by Shell
Key exchange failed Hest Connecticn by Shell

f. To view details of an error/warning message entry, double-click the error/warning message,
or, select it and click the Show Triggered Cls |=% ! icon.

Detailed error/warning messages occurred during the discovery progress for the particular pair
of error message and job you selected are displayed.

@ Discovery Progress E

L s AT Filter: Status[Errors by message]; Look for:

| Tnggered Cls = Completed with Errors = Hest Connection by Shell

Detailed Mes... | cl | Probe | RelatedHost | RelatedIPs | Reported
NTCMD: Inv... 16.187.189... | DatsFlowPr..  soditvm0351 | 16.187.189.. 0511212015 .

g. Toview all Cls impacted by a particular discovery issue,

i. Go back to the Completed with Errors page by clicking Up One Level .

ii. Right-click the error/warning message of your interest and select Show All <Error
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Message> Issues.

EiR s

| Tnggered Cls » Completed with Errors |

Invalid user name or pasg = Error 1
Remove Cl
Key exchange failed Error 1

Rerun Discovery
Show Al "Imvalid user...” [ssues

iii. All Cls impacted by this particular discovery issue are displayed.
@ Discovery Progress u

i RS AT Filter- Status[Errors by message]; Look for:

| Triggered Cls > Completed with Errors > Host Connection by Shell - All

DetaledMe. | © | Probe | RelatedHost | RelatediPs | Reported |
NTCMD: In... | 16.187.189.... | DataFlowPr.. 16.187.189.... | 0511212015 ...
NTCMD: In... | 16.187.189... DataFlowPr.. sgditvm0380 16.187.189... 0512/2015..
NTCMD: In... | 16.187.189.... | DataFlowPr... sgditvm0349 | 16.187.180... 0512/2015..
NTCMD: In... | 16.187.189.... DataFlowPr.. 16.187.189.... | 0511212015 ...
NTCMD: In... | 16.187.189.... | DataFlowPr.. sgditvm0432 | 16.187.180... 0512/2015..
NTCMD: In... | 16.187.189.... DataFlowPr.. 16.187.189.... | 0511212015 ...
NTCMD: In... | 16.187.189.... | DataFlowPr... sgditvm0327 | 16.187.189... 0512/2015..
NTCMD: In... | 16.187.189.... DataFlowPr.. 16.187.189.... | 0511212015 ...

-
RITRAN- AQ AT ATN Mt e a d e A2 407 400 NEMTINAL :l
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How to Retrieve Impact Analysis Results — Scenario

Impact Analysis Manager enables you to create an Impact rule that allows you to simulate the impact
certain infrastructure changes have on your system. The results of the Impact rule are displayed in IT
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Universe Manager. The Impact Analysis results in this task describe how a change in CPU operation
impacts the node to which it is connected.

This task includes the following steps:

« "Define an Impact Analysis TQL Query " below
« "Define an Impact Rule" below
» "Create a View in the Modeling Studio" on page 206

o "Get Impact Analysis Results" on page 206

1. Define an Impact Analysis TQL Query

To define an Impact Analysis TQL query, you need to create an Impact rule and then add the TQL
query nodes and relationships that define the query.

To create an Impact Analysis TQL query, select Managers > Modeling > Impact Analysis
Manager. For details about how to add query nodes and relationships to a query, see "How to Add
Query Nodes and Relationships to a TQL Query" on page 25.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship.

=

nibe

|
| Compositian
o

Cpu

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the changes
you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger and select Define Impacted to open
the Impacted Query Nodes dialog box. Select the query node that you want the trigger query node
to impact and click Next. Then click the Add button to open the Impact Rules Definition dialog box
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to set conditions for defining impacted query nodes. For details about how to define an Impact rule,

see "Impact Rules Definition Dialog Box" on page 475.

Note: The change state option in the Impact rule definition is no longer relevant for Impact

Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the severity
of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal state,

the node is impacted. Since the severity is set to 100% of the trigger's severity, the severity of
the node is the same as the severity of the CPU, which is determined when Impact Analysis

is run.
B impact Rules Definition l
[ Description: | |
1| Conditions
State: | operation |" |
Operator: | Mot equal |v |

Value comparizon: | Marmal

() Range % = %

() Fixed severity:

® Severity relative to trigger severity (%):

In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the

impacted query node.
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=
Mode

Composition

‘;'+

Cpu

3. Create a View in the Modeling Studio

Go to the Modeling Studio and create a view matching the TQL query of the Impact rule you
defined. For details, see "Pattern View Editor" on page 318.

4. Get Impact Analysis Results

Select Managers > Modeling > IT Universe Manager and select the required view in the Cl
Selector. To get Impact Analysis results, run the Impact rule on a Cl instance in the topology map
that is a trigger. Right-click a trigger Cl and select Run Impact Analysis to open the Run Impact
Analysis dialog box. In the dialog box, select the Impact rules to run. If you want to select Only
Impact rules located in specified bundle, make sure to add your Impact rule to the required bundle
using the Properties option for the selected Impact rule. For details, see "Impact Rule Groups
Page" on page 479.

For details on how to run an Impact rule, see "Run Impact Analysis Dialog Box" on page 244.

Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node connected by a
Composition relationship. The CPU query node is defined as the trigger query node and the
query node of type node is defined as the impacted query node.

The following Impact rule is defined for the query.
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Impact Rules Definition E2

Description: | |

1| rCenditicns

State: | operation |v |

Operatar: | Mot equal |" |

Value comparison: | Marrmal |v |

Scope

® any
O a
) Pange % = %

) Fixed severity:

(®) severtty relative to trigger severity (%):

Right-click a CPU Cl in the view, and select Run Impact Analysis to open the Run Impact
Analysis dialog box. Set the trigger severity to a value other than Normal.

Run Impact Analysis

Run Impact Analysis
I:/\ Select the impact analysis trigger and the set of impact rules that will be executed

Trigger Severity

-8

1 1 1 1 1 1 1 1
Critical

Correlation Rules

® |all Impact Pules
@] Only impact rules located in specified bundle

To see results, click one of the following:

o Show in Views. This assigns a status to all the Cls in the view. Only the node ClI
connected to the CPU CI (whose severity was changed), becomes impacted. The trigger
Cl and the impacted CI turn orange because the trigger severity was set as Major (7) on
the scale in the Run Impact Analysis dialog box, which is assigned an orange color.
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o Show Map. A map appears in a separate window containing only the trigger CPU CI and
the node Cl it impacted. The relationship connecting the two Cls contains the name of the
Impact rule defined in Impact Analysis Manager.

Note: Optionally, you can create a URL that enables you to embed the map. For
details, see "Direct Link Parameters — Impact Map Page" on page 113.

[
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o Generate Report. Generates an Impact Analysis report that displays a list of Cls that are
impacted in the system as a result of the simulated changes. For details, see "Run Impact
Analysis Dialog Box" on page 244.
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How to Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then compare snapshots of the
same view taken at different times using the Compare Snapshots Report. For details on how to take a
snapshot of a view, see "Save Snapshot Dialog Box" on page 246. For details on how to view actual
differences in the compared views, see "Compare Snapshots Report" on page 391.

How to Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. Before printing, it is
recommended to define your print settings and arrange the contents of the topology map according to
your requirements. For details on how to define print settings, see "Print Setup Dialog Box" on page
165. For details on how to preview the content of the topology map before printing, see "Print Preview
Dialog Box" on page 165. For details on how to print the content of a topology map, see "Print Dialog
Box" on page 164. For details on how to save a topology map to file, see "Export Map to Image Dialog
Box" on page 149.

IT Universe Manager User Interface

This section includes (in alphabetical order):

Add Cls to Model Dialog BOX ... 210
Add Cls to View Dialog BOX ... ... 210
Change Timeframe Dialog BOX .. .. ... 211
Check Network Availability Dialog BoX . ... . 212
Cl/Relationship History Dialog BOX ... .. 214
Configuration Item Properties Dialog Box .. ...l 217
Generate Sub Report Dialog BOX . ... ..l 221
Get Related Cls From CMDB Dialog BOX .. ... ... 222
Insert Relationship Dialog BOX .. ... 222
ITUniverse Manager Page .. ... 226
New CI/New Related Cl Dialog BoX ... . . 238
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Recently Discovered By Dialog Box ... il 243
Run Impact Analysis Dialog BoX ... .. 244
Save Snapshot Dialog BoX ... . 246
Show Discovery Status and Changes Dialog BoxX ... . 247
Show IMPact Pane ..o L 248

Add Cls to Model Dialog Box

This dialog box enables you to add selected Cls to a model.

To access Select Managers > Modeling > IT Universe Manager. Right-click a Cl or multiple
Cls inthe Cl Selector and select Add Cls to Model.

Important This feature is only relevant for instance based models. You cannot add selected
information  Cls to a pattern based model.

See also « "IT Universe Manager Overview" on page 180
« "IT Universe Manager User Interface" on the previous page

« "Business Cl Models" on page 259

User interface elements are described below:

Ul Element (A-Z) Description

<Model tree> When Existing Model is selected, select a model from the tree.
Define New CI When New Model is selected, define the name and properties of the
Properties model.

Existing Model Select Existing Model to add the selected Cls to an existing model.
New Model Select New Model to add the selected Cls to a new model.

Select Cl Type When New Model is selected, select a Cl type for the model.

Add Cls to View Dialog Box

This dialog box enables you to add selected Cls to a perspective-based view.
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To Select Managers > Modeling > IT Universe Manager. Right-click a Cl or multiple Cls in
access the Cl Selector and select Add Cls to View.

See « "IT Universe Manager Overview" on page 180
also « "Working with Views in IT Universe Manager" on page 181

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:

Ul Element (A-
Z) Description
<View tree> When Existing View is selected, select a view from the tree.

Existing View Select Existing View to add the selected Cls to an existing perspective-based

view.
New View Select New View to add the selected Cls to a new perspective-based view.
View Name When New View is selected, edit the name of the view.

Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set the time frame for the
changes to display.

To access  Select Managers > Modeling > IT Universe Manager. Click the Set Change

Timeframe button on the main toolbar or the IT Universe status bar.

Important = When the change indicators are displayed in the topology map, a message appears
information = onthe IT Universe status bar Change Timeframe is Active.

To hide the indicators, open the dialog box and select Do not display changes, or

click the Reset Change Timeframe |9| button on the IT Universe status bar.

See also « "IT Universe Manager Overview" on page 180

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:
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Ul Element (A-Z) Description

Display changes Select this option to display an indicator next to each Cl that was added or
according to the = changed within the selected period as follows:

selected . 1 Indicator for an added CI

timeframe
« 2 Indicator for a changed Cl

Select a time period from the drop-down list. If you select Custom, click the
ellipsis L=/ button to select the Date From and Date Until fields. The changes

to the Cls of the view within the selected period are displayed in the map.

When the indicators are displayed, you can click the indicator to open the ClI
History dialog box, which displays the history for the Cl over the selected
period.

Do not display Select this option to hide the change indicators.
changes

Check Network Availability Dialog Box

This dialog box displays the result returned from performing IP ping, UD agent ping, or SNMP ping
against a selected inventory Cl of the Node Cl type.

To access | Use one of the following:

« InIT Universe Manager, go to the Cl Selector pane > Search Cls tab > search for
Node type Cls > right-click an inventory CI from the returned result and select
Actions > Check Network Availability from the shortcut menu.

« Inthe Cl Instances dialog box, right-click an inventory Cl instance, click Actions,
and select Check Network Availability. For information about the CI Instances

dialog box, see Cl Instances Dialog Box.

Important « The Check Network Availability option is only available in the Actions list for a
information selected inventory Cl of the Node Cl type.

« The Check Network Availability option is available with Content Pack 16.00 or
later.

Relevant How to Check the Network Availability of an Inventory Cl
tasks

User interface elements are described below:
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ul
Element
(A-Z) Description

Name Name of the selected Node type inventory CI.
ID ID of the selected Node type inventory ClI.
Cl Type @ Subtype of the selected Node type inventory CI.

() IP Ping. Displays the IP Ping Settings dialog box, which enables you to specify the
following values to perform a network IP ping:

o IP Address. Select the IP address of your target node (in IPv4 or IPv6 format) from
the drop-down list of available IP addresses. You can also manually enter the IP
address (in IPv4 or IPv6 format) of a target node.

« Probe. Select a probe from the drop-down list of connected probes to perform IP ping.

« Ping Times. Number of attempts for the selected probe to perform IP ping. Default
value: 4.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to perform
IP ping. Default value: 60,000 (ms).

() Ping with UD Agent. Displays the UD Agent Ping Settings dialog box, which enables
you to specify the following values to perform a network ping with UD agent:

o IP Address. Select an IP address from the drop-down list of available IP addresses.
You can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click l:==/ to open the Choose Credential dialog box, which enables you to
select an existing credential for the probe to use. By default all credentials available
for the selected protocol type are selected.

If there is no existing credential, click = to create one.

« Probe. Select a probe from the drop-down list of connected probes to ping with UD
agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping
with UD agent. Default value: 60,000 (ms).

ftsh Ping with SNMP. Displays the SNMP Ping Settings dialog box, which enables you to
specify the following values to perform a network ping with SNMP:

o IP Address. Select an IP address from the drop-down list of available IP addresses.
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ul
Element
(A-Z) Description

You can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click ===/ to open the Choose Credential dialog box, which enables you to

select an existing credential for the probe to use. By default all credentials available
for the selected protocol type are selected.

If there is no existing credential, click L to create one.

« Probe. Select a probe from the drop-down list of connected probes to ping with UD
agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping
with UD agent. Default value: 60,000 (ms).

<Result ' Displays the result returned by the selected probe after performing IP ping, UD agent
Pane> ping, or SNMP ping against a selected inventory Cl of the Node ClI type.

For IP Ping, the result is the output of the ping command.

For Ping with UD Agent or Ping with SNMP, the result is either success or failure. An
error message follows when the network ping fails.

Cl/Relationship History Dialog Box

This dialog box displays a list of Cl or relationship attributes in which changes have occurred as well as
the differences between two configuration files.

To access  InIT Universe Manager, right-click the selected CI or relationship in the Cl Selector or
the Topology Map and select Cl History.

Note: Cl and relationship history data is also available in the History tab of the
Advanced pane in IT Universe Manager.

Important All Cl and relationship attributes are included in the History, except for attributes
information marked with the Not Tracked for History qualifier in the Cl Type Manager. For
details, see "Add/Edit Attribute Dialog Box" on page 494.

Note: In a multi-tenancy environment, the Cl History dialog box only displays
history events that are relevant to the tenants associated with your View Cls
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permission. However, Remove Cl/relationship events that occurred before an

upgrade to UCMDB version 10.01 are displayed independent of the tenants
associated with the View Cls permission.

See also « "IT Universe Manager Overview" on page 180

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:

Ul Element (A-Z)
Is]

=Y

HPE Universal CMDB (10.31)

Description

Refresh. Refreshes the data in the table.

Show Difference. Enables you to view the difference between two
history entries for the content of a configuration file. This is relevant
in the following situations:

« Select two history entries for the Document Content attribute
for Cls of the type Configuration Document to compare to
each other.

« Select one history entry for the Document Content attribute
for Cls of the type Configuration Document to compare to
the current content for that CI.

Click the Show difference button to open the Visualdiff report,
which displays a comparison of the two entries. Text added to the
second entry appears highlighted in yellow. Text removed from the
first entry appears highlighted in red. Differences between the
entries appear highlighted in green.

Export Data To File. Enables you to export the history data.
Choose the export format from the following options:

« XLS. The table data is formatted as an .xIs (Excel) file that can
be displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable
number of columns to display to ensure that the report is
legible.
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Ul Element (A-2) Description
« RTF. The table datais exported in Rich Text Format.

« CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the Control
Panel, and on the Numbers tab ensure that the comma is
defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens
the CSV file.

« XML. The table data is formatted as an XML file that can be
opened in a text or XML editor.
Tip: To extract HTML code from the report:
« Open the file in an HTML editor

« Copy the relevant table into the target file

Attribute The name of the attribute.
Change Date The date when the last change occurred.
Filter by Filter the data in the table by one or more of the following filters:

« Time Range. Select the time period for which the CI history is
displayed.

« Change Type. Select the type of changes displayed in the
table.

« Attribute. Select the attribute types displayed in the table.

Modified By Indicates the cause of the change. For example, the field can
contain the name of a user or a DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.
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Configuration Item Properties Dialog Box

This dialog box enables you to view and edit basic information for an existing CI or relationship.

To access  Select Managers > Modeling > IT Universe Manager and use one of the following:

« Select a Cl or relationship in the topology map or a Cl in the Cl Selector. In the
Advanced Pane, select the Properties tab and click Edit.

« Select a Cl or relationship in the topology map or a Cl the Cl Selector and click the
Show CI Properties () button.

« Right-click a CI or relationship in the Topology map or a Cl in the Cl Selector and
select Properties.

Important = The Configuration Item Properties dialog box contains two types of properties:

information . Lo . . . .
« General properties, which include general information about the Cl or relationship.

These properties are common to all CITs and are documented below.
« ClIT-specific properties, which include properties specific to that Cl. These

properties vary according to the type of Cl or relationship and are not documented.

When you sort the properties by category, the CIT-specific properties appear at the
top of the list and the general properties appear at the bottom.

You can view a description of the selected property in the Description Area at the
bottom of the dialog box. Click the Show/Hide Description Area button to display
the Description Area.

Mandatory fields are marked with an asterisk (*).

Note: Universal CMDB does not fully support surrogate pairs and combining
characters.

See also « ClI Lifecycle and the Aging Mechanism in the HPE Universal CMDB
Administration Guide

« "Working with Cls" on page 184

« "IT Universe Manager User Interface" on page 209

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-Z) Description
= Categorized. Displays the properties by category.
= Alphabetic. Displays the properties alphabetically.
i Show/Hide Description Area. Toggles between showing and hiding the description
area at the bottom of the CI Properties dialog box.
& Expand. Expands the properties tree when the properties are displayed by category.
& Collapse. Collapses the properties tree when the properties are displayed by
category.
HExport - Export Data To File. Enables you to export the table data. Choose the export format

from the following options:

« Excel. The table data is formatted as an .xls (Excel) file that can be displayed in a
spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of columns to
display to ensure that the report is legible.

« RTF. The table data is exported in Rich Text Format.

« CS8V. The table data is formatted as a comma-separated values (CSV) text file
that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display correctly, the comma (,)
must be defined as the list separator. In Windows, to verify or modify the list
separator value, open Regional Options from the Control Panel, and on the
Numbers tab ensure that the comma is defined as the List Separator value. In

Linux, you can specify the list separator in the application that opens the CSV
file.

« XML. The table data is formatted as an XML file that can be opened in a text or
XML editor.

Tip: To extract HTML code from the report:
o Open the file in an HTML editor

o Copy the relevant table into the target file
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Ul Element
(A-Z)

<Quick
filter>

Actual
Deletion
Period

Allow CI
Update

Apply

Cl Type

Created By

Create
Time

Deletion
Candidate
Period

HPE Universal CMDB (10.31)

Description

Enter a string in the Quick filter box to filter the property names and values. Click the
left end of the box to open the drop-down menu of filter options:

« Select All to search for the filter string in both property names and property
values. Select Name to search for the filter string in property names only. Select
Value to search for the filter string in property values only.

« Select Case sensitive to search for the filter string exactly as entered. Select
Case insensitive to ignore the case of the filter string.

« Select Use wild cards to use the wildcard symbol * in the filter string.

« Select Match from start to search for the filter string at the beginning of a property
name or value. Select Match exactly to search for the exact filter string. Select
Match anywhere to search for the filter string anywhere in the properties.

The number of days after which the Cl or relationship is deleted.

When selected, this option allows the DFM process to automatically update the Cl or
relationship properties with information that it discovers. If you change the value of a
property supplied by the DFM process, the value is overridden by the discovered
value.

When this option is cleared, the CI or relationship properties are not overridden by the
DFM process.

Click Apply to save the changes made to the Cl or relationship properties.

The type of the Cl or relationship (read-only value). For information about CITs in
Universal CMDB, see "CI Type Manager" on page 481.

The user name of the administrator who manually created the CI or relationship,
where applicable (read-only value).

The date and time when the ClI or relationship was created.

The period after which the Cl becomes a candidate for deletion when the aging
mechanism is enabled.
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Ul Element
(A-Z) Description

Description A brief description of the Cl or relationship.

Display The name of the ClI or relationship as it appears in the CI Selector.
Label
Edit In the Properties tab of the Advanced pane, you can view a Cl's properties but you

cannot edit them. Click Edit to open the Configuration Iltem Properties dialog box
where you can edit the properties.

Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a

Aging Clis not rediscovered by DFM and no manual update occurs), an aging mechanism
deletes the CI from the CMDB. For details, see The Aging Mechanism Overview in
the HPE Universal CMDB Administration Guide.

True: the aging mechanism is enabled for this CI or relationship.

False: the aging mechanism is disabled for this CI or relationship.

Note:
« If the aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain Cls only.

« The default value is determined by the default value of the Enable Aging
attribute for the ClI type of the selected ClI.

Global Id The internal ID of the CI or relationship in the CMDB (read-only value).

Last The time that the CI or relationship was last accessed, whether when being updated
Access or being discovered by DFM. This field is only displayed for certain Cls or
Time relationships.

This parameter is used by the aging mechanism. For details, see Cl Lifecycle and the
Aging Mechanism in the HPE Universal CMDB Administration Guide.

Note: By default, this property is updated every time the Cl is touched by a
running discovery job or integration. To prevent this property from being updated
by a discovery job or integration, go to the Data Flow Management module, and
in the Adapter Management > Adapter Configuration tab, clear the Update
last access time option. For more details, see Adapter Configuration Tab in the
HPE Universal CMDB Data Flow Management Guide.
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Ul Element

(A-Z) Description

Last The date and time when the ClI or relationship properties were last updated.

Modified

Time

Name The name of the ClI or relationship.

Note Enables you to enter other information about the CI or relationship.

Origin An ID for the source that automatically created the CI or relationship, or the
application where the ClI or relationship was created (read-only value).

Reset Click the Reset button to restore the original property settings of the Cl or

relationship.
Updated by = The user name of the administrator who updated the CI or relationship properties.

User Label Enables you to define a display label for the Cl or relationship. If no value is entered,
the Cl name appears as the default label.

Shortcut Menu

Menu Item Description

Copy Property Name = Copies the name and value of the selected property to the memory.
and Value

Generate Sub Report Dialog Box

This dialog box enables you to generate a Sub Report for the selected Cl.

To access  InIT Universe Manager, right-click a Cl in the topology map or the Cl Selector and
select Generate Sub Report.

Important A Sub Report enables you to apply a perspective to a selected Cl and view the results
information  in report format. Select a perspective from the list and click OK. The Sub Report
opens in a separate window.

See also o "IT Universe Manager Overview" on page 180

« "IT Universe Manager User Interface" on page 209
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<List of available perspectives> The list includes only perspectives that are designated as a Sub
Report perspective in its Report Properties. Only perspectives
matching the selected Cl type are displayed.

Description A description of the selected perspective.

Get Related Cls From CMDB Dialog Box

This dialog box enables you to view the Cls related to a specified Cl in the CMDB in map or table
format.

To access | InIT Universe Manager, right-click the required Cl and select Get Related Cls.

Important = The Get Related Cls From CMDB dialog box is a standalone version of the Related

information Cls tabin IT Universe Manager. You can control the content of the display using the
features in the Get Related Cls pane. For details, see "Get Related Cls Pane" on
page 236.

You cannot select the scope of the related Cls displayed in the Get Related Cls From
CMDB dialog box. The scope is the entire CMDB.

Note: The text mode format includes the icons found in the CI Instances dialog
box. For details, see "Cl Instances Dialog Box" on page 65.

Relevant "How to View Related Cls" on page 193
tasks
See also « "IT Universe Manager Overview" on page 180

« "IT Universe Manager User Interface" on page 209

Insert Relationship Dialog Box

This dialog box enables you to attach Cls to the Cl you selected in the Cl Selector.

To access In IT Universe Manager, right-click a Cl in the Topology Map or the CI Selector, and
select Relate to CI.

Important To create a relationship between two Cls, select the source Cl in the Cl Selector or
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information  the Topology Map and then select Relate to Cl from the shortcut menu. On the first
page of the dialog box (the Cl Selection page), you select the target Cl(s). Then
click Relationship, to select the relationship type on the second page of the dialog

box.

You can also create a relationship between two Cls graphically by clicking the
Create Relationship [* button on the toolbar and drawing a line between the two

Cls. Inthis case, a smaller version of the Insert Relationship dialog box opens,
which contains the following tabs:

« Select Relationship. Displays a tree with the available relationship types.
Select the required relationship.

Note: You can double-click the relationship you select to save using the

default properties.

« Relationship Properties. Displays the properties of the selected relationship.
You can edit the properties as described in "Define Relationship Properties
Pane" on the next page.

Relevant "How to Create Cls and Relationships" on page 192
tasks
See also « "Cl Selector" on page 134

« "Relationship Page" on the next page

User interface elements are described below:

Ul Element
(A-Z) Description
> Adds the selected Cls in the left pane to the Target Cls pane.
< Removes the selected Cls from the Target Cls pane (this does not delete the Cls

from the CMDB).

Select target = Select a view to display in the view tree and select Cls to move to the Target Cls

Cls pane.

For details on the Select target Cls pane, see "C| Selector" on page 134.
Source CI The Cl you selected as the source ClI.

Target Cls Displays the Cls you have selected as target Cls for the relationship.
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Relationship Page

This page enables you to define the relationship to be created between the original Cl and the Cls
selected on the Cl Selection page of the dialog box.

To access  Click the Relationship button from the Insert Relationship dialog box.

Important = When defining multiple relationships, you can define different descriptions and
information = property values for each relationship. Skip the property definitions here and edit each
relationship individually after it is created.

User interface elements are described below:

Select Relationship Pane

Ul Element
(A-2) Description
Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or between a group Cl and
a monitor Cl), only one direction is valid.

Relationship Define the type of relationship created between the original Cl and the Cls being
attached. Select an option from the list.

Source CI Displays the name of the Cl on the first end of the relationship. This is the CI that
you selected in the view.

Target CI Displays the name of the Cl on the second end of the relationship, that is attached to
the original ClI.

Define Relationship Properties Pane

Ul Element

(A-2) Description

Actual The period after which the relationship is deleted when the aging mechanism is
Deletion enabled.

Period
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Ul Element
(A-Z)

Allow CI
Update

Created By

Create
Time

Deletion
Candidate
Period

Description

Destination
Network
Address

Enable
Aging

Last
Access
Time

Last
Modified

HPE Universal CMDB (10.31)

Description

When the value is set to true, the DFM process automatically updates the
relationship.

The user name of the administrator who manually created the relationship, where
applicable.

The date and time when the relationship was created.

The number of days after which the relationship becomes a candidate for deletion.

A detailed description of the relationship.

Defined only for route links. Indicates the destination network address to which this
route is configured.

If a Cl or relationship is not updated or refreshed over a period of time (for example, a
Clis not rediscovered by DFM and no manual update occurs), an aging mechanism
deletes the CI from the CMDB. For details, see "Cl Lifecycle and the Aging
Mechanism" in the HPE Universal CMDB Administration Guide.

True: the aging mechanism is enabled for this CI or relationship.

Default value: false. The default value for DFM Cls is true.

Note:

« Ifthe aging mechanism is disabled, this field is ignored.

« This field is only displayed for certain Cls.

The time that the relationship was last accessed, whether when being updated or
being discovered by DFM. This field is only displayed for certain Cls.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle and
the Aging Mechanism" in the HPE Universal CMDB Administration Guide.

The date and time when the relationship properties were last updated.
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Ul Element

(A-Z)
Time

Must

Name

Note
Origin
Updated
By

User Label

Weight

Description

When the value is set to true, the child Cl is dominant when the percentage rule is
used to calculate status for the parent CI. If the Cl has low status, the parent must
take the child Cl status, if necessary overriding the percentage rule calculation. This
is useful to give emphasis to an important Cl. For example, you might want to define
Must for a database Cl, so that status is critical all the way up the subtree if the
database falls, regardless of the status of the other Cls in the subtree.

The must status defined for a relationship applies for that relationship only —it is not
used in any other relationships of the child Cl. This field is only relevant when working
with HPE Business Service Management.

A brief description of the relationship. If no value is entered, the relationship type is
used in place of the name.

Enables you to enter other information about the relationship.

An ID for the source that automatically created the relationship, or the application
where the relationship was created.

The user name of the administrator who updated the CI properties.

Enables you to define a display label for the relationship. If no value is entered, the
relationship name appears as the default label.

When a weight value is entered, the child Cl is given more weight in percentage
calculations, when percentage rule is used to calculate status for the parent Cl. For
example, if a child Cl is given a weight of 3, then it has three times more impact on the
parent status calculation than its unweighted siblings.

The weight defined for a relationship applies for that relationship only — it is not used in
any other relationships the child Cl may have. This field is only relevant when working
with HPE Business Service Management.

IT Universe Manager Page

This page enables you to define and manage the Cls and relationships in your views.
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To access | Select IT Universe Manager from the Navigation Menu or select Managers >
Modeling > IT Universe Manager.

Important = The IT Universe Manager page contains the following panes:

information . . .
« CI Selector. Displays the Cls of a selected view. You can select the view from a

drop—down list or search for a specific Cl. For details, see "C| Selector" on page
134.

« Topology Map. Displays the Cls of a selected view in Map mode or Text mode.

« Advanced Pane. Displays properties, history, and discovery for the selected CI
orview.

« Get Related Cls. This pane can be accessed from the Related Cls tab of the
Topology Map. It controls the content of the display in the tab.

InIT Universe Manager, you can create new Cls, modify existing Cls, or delete Cls.
All of these actions have a direct effect on the entire IT Universe model. For example,
if you delete a Cl in your view, that Cl is deleted from the IT Universe model and no
longer appears in any view.

Relevant « "How to Create Cls and Relationships" on page 192
tasks « "How to Print and Save a Topology Map to File" on page 209

« "How to Check the Status of Application Discovery (Rediscover a View)" on page
194

o "How to Retrieve Impact Analysis Results — Scenario" on page 203
« "How to Take a Snapshot of a View" on page 209

o "How to View Related Cls" on page 193

See also « "IT Universe Manager Overview" on page 180
o "Working with Views in IT Universe Manager" on page 181
« "Cl Selector" on page 134
« "Topology Map Overview" on page 147

« "IT Universe Manager User Interface" on page 209

Topology Map

This area displays the Cls of the currently selected view in graphical or table format. By default, the Cls
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are displayed in graphical format.

To access | Select Managers > Modeling > IT Universe Manager.

Important You can customize the Topology Map shortcut menu to include other commands (for

information = example, ping, run a program, open a URL) from within Cl Type Manager. For details,

see "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"

on page 503.

Note: For grouped Cls and the relationships between them, not all of the
shortcut menu options are active. Grouped Cls appear in parentheses in the Cl
Selector and in the Topology Map. You can double-click a link to a grouped Cl to
open the Link Map, which displays the individual Cls and relationships. Right-
click a Cl or relationship in the Link Map to display the regular shortcut menu. For
details about grouping Cls, see "Query Node Grouping Dialog Box" on page 331.

See also "Working with the Topology Map" on page 147

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

12t Mp Map mode

B Tet Text mode

Show Clinstances of: | Metwork =

<Breadcrumbs>

HPE Universal CMDB (10.31)

Description

Map. Displays the selected layer of Cls in topology map format.

Note: If the selected layer of the view is too large to display in
topology map format, a message appears with a link to display
the layer in text format.

Text. Displays the attribute properties of the Cls in the selected layer
in table format.

For details on some of the toolbar icons in Text Mode, see "Cl
Instances Dialog Box" on page 65.

Specify the CIT you want displayed in the table. The table also
includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

At the top of the topology map, the breadcrumbs indicate the relevant
query nodes in each layer of the view for the path to the selected
layer. The first item in the path is the Top Layer. When you select a
CI from the layer below, the parent Cl forms the next item in the
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Ul Element (A-2) Description

breadcrumb path. You can click on any item in the path to display that
layer in the topology map.

<ClI type attributes> The columns appearing in Text mode represent the CIT attributes of
the selected Cls.

<Group by> The Cls in the topology map are displayed according to the default
grouping selected in the view definition. When consuming the view in
IT Universe Manager, you can manually select a different grouping
method. The available options are:

« Group by Layer. Group the Cls according to the value of the
layer attribute of their Cl type.

« Group by CI Type. Group the Cls according to their Cl type.

« Group by Classification. Group the Cls according to the value of
the classification attribute of their Cl type.

« No Grouping. Do not group Cls.

Note:
« This option is available in Map mode only.

« When a grouping option is selected, each group contains an
indicator displaying the number of Cls in the group. If a group
contains alarge number of Cls, it opens in collapsed format,
displaying only the name and count indicator. Click the + sign
button to expand the group and display all the Cls. You can
set the threshold of Cls for automatically collapsing the group
by modifying the Initially expand group max Cls threshold
setting in the Infrastructure Settings Manager.

<IT Universe Status Bar> The status bar below the topology map indicates the status of the
following processes:

« if Impact Analysis is active or not
« if Change Timeframe is active or not
« if Candidates for Deletion are shown or not

« the time of the last update of the data
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Ul Element (A-2)

<Legend>

<Main Menu>

<Query Node>

<Relationship>

<Toolbar>

HPE Universal CMDB (10.31)

Description

Indicates the icons displayed next to Cls with any of the following
special statuses:

« Added. When Change Timeframe is active, indicates that the CI
was added.

« Candidate for Deletion. Indicates that the Cl is a candidate for
deletion.

« Changed. When Change Timeframe is active, indicates that the
Cl was changed.

« Drill Down One Layer. Indicates that there are Cls under the Cl
on a lower layer.

« External. Indicates that the Cl is a federated CI.

« Impacted. When Impact Analysis is active, indicates an impacted
Cl.

« Impacted and Trigger. When Impact Analysis is active,
indicates a trigger Cl that is impacted.

« Note. Indicates that a note was added for the CI.

« Trigger. When Impact Analysis is active, indicates a trigger Cl.
For details, see "Main Menu" on page 163.
The query nodes in the topology map represent Cls.

Hold the pointer over a query node to display its tooltip which
describes the type of the Cl.

The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, which
describes the type of the relationship.

#
S

Note: When you select a calculated relationship, the Delete

button on the toolbar is disabled.

For details, see "Toolbar Options" on page 167.
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Ul Element (A-2) Description

Note: When accessing the Topology map via direct links, the
toolbar includes options from the Related Cls Map. For details,
see "Get Related Cls From CMDB Dialog Box" on page 222.

<Tooltip> Hold the pointer over a Cl to display a tooltip which shows Cl data.
The tooltip displays all attributes for the Cl which are marked with one
of the following qualifiers:

« Comparable

« Asset Data

« Managed
When you hold the pointer over a count indicator, the tooltip displays
the breakdown of the Cls under it by Cl type. When a grouping option

is selected, hold the pointer over the group to display a tooltip showing
the breakdown of Cls in the group by ClI type.

<Topology Map Sidebar> For details, see "Topology Map Sidebar" on page 176.

Related Cls Click the Related Cls tab to display the interdependencies of the
selected Cl within the view or the entire CMDB. You can control the
scope of the display from the Get Related Cls pane.

View Results Click the View Results tab to display an entire layer within a view.

IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed alphabetically) available by right-
clicking a Cl or relationship in the C| Selector pane or the Topology Map:

Menu Item Description
Actions Select one of the following options:

o Add ClI to Discovery Job. Displays the Add Cl to Discovery Job dialog
box, which enables you to manually invoke a DFM job for the selected ClI.
You can use this option to discover additional information about the Cl
through one of the available DFM jobs.
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Menu Item

Add Clis to
Model

Description

« Remove CI from Discovery Job. Displays the Remove CI from

Discovery Job dialog box, which enables you to manually remove a Cl from
the DFM job.

Show Discovery Progress. Opens the Discovery Progress dialog box for
the selected ClI.

Recently Discovered By. Opens the Recently Discovered By dialog box
for the selected ClI.

Open CI Credentials. Displays the Protocol Parameter dialog box, which
enables you to view the details of a previously-defined credential for that ClI.
You cannot make any changes.

Note: This option is only relevant for Cls that include a credentials
property.

For details, see Protocol Parameter Dialog Box in the HPE Universal
CMDB Data Flow Management Guide.

Edit Cl Credentials. Displays the Choose Credentials dialog box, which
enables you to choose another credentials set or edit the existing
credentials.

Note: This option is only relevant for Cls that include a credentials
property.

For details, see the supported protocols in the HPE Universal CMDB
Discovery and Integrations Content Guide.

Reprocess Scan File. Reprocesses the scan files for the selected node.
Note: This option is only available for Cls of type node or its subtypes.

Check Network Availability. Opens the Check Network Availability dialog
box for the selected Cl.

Adds selected Cls to a new or existing model.

Add Cls to View Adds selected Cls to a new or existing perspective-based view.

Assign Tenants

Open the Assign Tenants dialog box which enables you to assign tenants to the
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Menu Item

Cl/Relationship
History

Compare Cls
Report

Delete from
CMDB

Generate Sub
Report

Get Related Cls

Label

Merge Cls

HPE Universal CMDB (10.31)

Description

Cl.
Note: This option is only available when multi-tenancy is enabled.

Displays the Cl History dialog box. For details, see "Cl/Relationship History
Dialog Box" on page 214.

Run a Compare Cls Report for the selected Cl. For details, see "Compare Cls
Report" on page 387.

Note: This option is only active when one or two Cls are selected.

Enables you to delete the selected Cl or relationship from the view and from the
CMDB.

Note: When you delete a parent Cl, the selected Cl and its children are
removed from the view, but only the selected Cl is removed from the
database.

Opens the Generate Sub Report dialog box, which enables you to select
perspectives for the Cl to create a Sub Report. For details, see "Generate Sub
Report Dialog Box" on page 221.

Opens the Get Related Cls from CMDB dialog box. For details, see "Get
Related Cls From CMDB Dialog Box" on page 222.

Select one of the following options:

- Edit Label. Opens the Edit Label dialog box which enables you to edit the
name of the Cl.

o Restore Default Label. Resets the Cl name to its default value from the
CMDB.

Opens the Merge Cls dialog box enabling you to manually merge Running
Software, Node, and Business Element Cls.

In the Merge Cls dialog box, select one of the Cls to be the main CI. The other
Cls, the merging Cls, are merged into the main Cl. Cls are merged as follows:

« Properties from the merging Cls that do not exist in the main Cl are copied
to the main CI.
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Menu Item Description

« Properties that exist in both the main and merging Cls are merged according
to the defined reconciliation priority:

o If all the Cls have the same priority, then the main Cl's property is
retained.

o If the Cls have different priorities, the property of the Cl with the higher

priority is used.

After the merge, the Global ID of the main Cl remains, and the merging Cls are
deleted.

Note:

« This option is only relevant when at least two Cls of type Running
Software, Node, or Business Element are selected. Cls can only be
merged if their Cl types are on the same branch in the Class Model.

« When you merge Cls, the topologies of the views that contain those
Cls are updated.

Example:

Merge Cls

Note Select one of the following options:
« Add Note. Opens an editing box where you can add a note to the CI.

« Delete Note. Deletes all text saved in a note for the selected ClI.

Open Opens the UCMDB Browser.

UCMDB Browser
Note: This option is only available when a single Cl is selected. It is not

relevant for relationships.
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Menu Item Description

Properties Displays the Properties page for the selected Cl or relationship. For details, see
"Configuration Item Properties Dialog Box" on page 217.

Relate to CI Opens the Insert Relationship dialog box. For details, see "Insert Relationship
Dialog Box" on page 222.

Run Impact Enables you to run the Impact rule you defined in the Impact Analysis Manager.
Analysis Displays the Run Impact Analysis dialog box. For details, see "Impact Analysis
Manager" on page 462.

Note: You can only see Impact Analysis results if you defined an Impact
rule for that view in Impact Analysis Manager.

Show Appears only for compound relationships. Displays the Link Map for the

Compound Path = selected relationship, which shows the Cls involved in the compound
relationship.

Show Impact Enables you to select a Cl that is defined by an Impact rule as a root cause ClI,

and to display all the Cls that are impacted by it, and their statuses, in a
separate window.

This option appears only after the following has occurred:

« You defined an Impact rule for the selected view in Impact Analysis
Manager (for details, see "Impact Analysis Manager" on page 462).

« Youclicked Show in Views in the Run Impact Analysis dialog box.

« Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP Address ClI) that
specifies that the rule impacts nodes, ports, and client-servers linked to the IP
Address.

By using the Show Impact option, you can display all Cls that are impacted by
the IP Address ClI.

Show Root This option enables you to retrieve root cause information for Cls that are

Cause impacted by a chain of Impact rules. The output of Show Root Cause displays
a logical map that describes a chain of trigger/impacted CITs that impact the
Cl.

The root cause Cl is displayed in a separate window. If only one Impact rule is
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Menu Item

Advanced Pane

Description
defined for this Cl, the Impact Analysis window is directly displayed.
This option appears only after the following has occurred:

« You defined an Impact rule for the selected view in the Impact Analysis
Manager (for details, see "Impact Analysis Manager" on page 462).

« You clicked Show in Views in the Run Impact Analysis dialog box.

« Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause Cl and all the other CITs in the
Impact rule chain.

To view the information about specific Cls that are triggered orimpacted by the
Impact rule, double-click the relationship connecting the Cls. A map is
displayed.

User interface elements are described below:

Ul
Element

(A-2) Description

Discovery Displays the discovery progress for the selected Cls. For details, see Discovery
tab Progress Dialog Box in the HPE Universal CMDB Data Flow Management Guide.

History Displays the history for the selected Cl. For details, see "Cl/Relationship History

tab Dialog Box" on page 214.

Properties ' Displays the selected Cl's properties (the same properties that appear in the

tab Configuration Item Properties dialog box). You can view the properties in the properties

tab, but you must open the dialog box to edit the properties. For details, see

"Configuration Item Properties Dialog Box" on page 217.

Get Related Cls Pane

This pane enables you to control the different options for viewing related Cls for a selected ClI.
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To access

Important
information

Relevant
tasks

Appears in the Related Cls tab of IT Universe Manager. If it is hidden, click the Show
Get Related Cls pane ‘& putton on the toolbar to display it.
You can control the display in the Related Cls tab with the following controls:

« Set the scope of the display

« Filterthe related Cls by Cl type

« Apply perspectives to the selected Cl

It is possible to display related Cls for several Cls at the same time. Hold down the
CTRL key to select multiple Cls at the same time in the CI Selector or the topology
map.

Note: You can select to run the Get Related Cls search over integrated Cls also.
If the search results include Cls from a federated data source, they appear in the
topology map with an arrow icon, indicating that they are federated Cls.
However, you cannot display related Cls of a federated ClI.

"How to View Related Cls" on page 193

User interface elements are described below:

Ul Element
(A-Z)

!

S

Description

Back. Displays the previous search results.
Forward. Display the next search results.

Clear Current Display. When the button is selected, the related Cls are added to
the current results. When it is not selected, the current display content is cleared and
only the new related Cls are displayed.

Display search results with/without grouping. When the button is selected, the
related Cls are displayed with the hierarchical grouping of the applied perspective.
When it is not selected, the related Cls are displayed without any grouping.

Select Target Integration Points. Enables you to include integrated Cls in your
search results. Select the required integration points from the pop-up dialog box.
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Ul Element

(A-2) Description
Note: If you select a disconnected integration point for your search, an error
message appears when the search is run, asking if you want to see local search
results.

Apply Select perspectives from the list to apply to the selected Cl. Only perspectives

perspectives relevant to the selected Cl appear in the list. The selected Cl is used as content for
to CI the selected perspectives and the view results are displayed.

Note: Application of perspectives is only relevant when CMDB is selected as
the scope. The feature is inactive when View is selected as the scope.

Filter Select the Cl types from the list to display in the related Cl results. Only the selected
Related Cls Cl types appear in the displayed results.
by CI Type
Select Select the scope of the related Cls displayed:
scope . . .
« View. All related Cls in the selected view.
« CMDB. All related Cls in the CMDB.
Note: This feature is not available in the Get Related Cls from CMDB dialog
box opened from the shortcut menu.
Show Click to display the related Cls according to your selection.
Related Cls

New Cl/New Related ClI Dialog Box

This dialog box enables you to define a new CI or a new related Cl.

To access  |n|T Universe Manager, click the New CI @ button on the toolbar to create a non-

related Cl. Select a Cl in the topology map and click the New Related CI @l button

to create a related CI.

Important = To define a new Cl, select the Cl type from the tree at the top of the dialog box. The
information Cl types in the tree that are available to be instantiated appear in black. The Cl types
in faded text cannot be instantiated.
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Edit the properties in the Define new CI properties area. The table below includes the
properties which are common to all Cls. In addition, there are other properties specific
toeach ClI.

If you are creating a related Cl, click Relationship to go to the relationship mode of
the dialog box. Select a relationship and edit its properties.

Relevant "How to Create Cls and Relationships" on page 192
tasks
See also « "Cl Selector" on page 134

« "Relationship Dialog Box" on page 241

« "ClI Lifecycle and the Aging Mechanism" in the HPE Universal CMDB
Administration Guide

User interface elements are described below:

Ul Element

(A-2) Description

Actual The period after which the Cl is deleted when the aging mechanism is enabled.
Deletion

Period

Allow CI When the value is set to true, this option enables the DFM process to automatically
Update update the CI properties with information that it discovers. If you change the value of

a property supplied by the DFM process, the value is overridden by the discovered
value.

When the value is set to false, the CI properties are not overridden by the DFM
process.

Created By | The user name of the administrator who manually created the Cl, where applicable.
Create Time @ The date and time when the Cl was created.

Deletion The period after which the Cl becomes a candidate for deletion when the aging
Candidate mechanism is enabled.
Period

Description A description of the CI.

Display The label that appears for the Cl in the topology map.
Label
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Ul Element

(A-Z) Description

Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a
Aging Clis not rediscovered by DFM and no manual update occurs), an aging mechanism

deletes the CI from the CMDB. For details, see "The Aging Mechanism Overview" in
the HPE Universal CMDB Administration Guide.

True: the aging mechanism is enabled for this CI.
False: the aging mechanism is disabled for this ClI.
The default value is determined by the default value of the Enable Aging attribute of
the Cl type.
Note:
« If the aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain Cls only.

« You can change the default value for all new Cls of this type by editing the
default value of the Enable Aging attribute for this Cl type. For details, see
"How to Enable and Run the Aging Mechanism" in the HPE Universal
CMDB Administration Guide.

Is Candidate Indicates if the Cl is a candidate for deletion.
For Deletion

Last Access The time that the Cl was last accessed, whether when being updated or being
Time discovered by DFM. This field is displayed only for certain Cls.

This parameter is used by the aging mechanism. For details, see "CI Lifecycle and
the Aging Mechanism" in the HPE Universal CMDB Administration Guide.

Last The date and time when the CI properties were last updated.

Modified

Time

Name The name of the CI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the ClI, or the application where the

Cl was created.

Relationship For arelated Cl, click Relationship to go to the relationship mode of the dialog box.
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Ul Element

(A-Z) Description

Select Cl Enables you to select the Cl type from the tree for the new CI. The Cl types that are
Type available for the selected Cl or view appear active in the Cl type tree. The other CI

types appear in faded text and cannot be selected.

To limit the Cl type tree to Cl types from the current view, select Cl Types from the
current view on the right. To display all Cl types in the tree, select All Cl Types.

Updated By = The user name of the administrator who updated the Cl properties.

User Label Enables you to define a display label for the CI. If no value is entered, the Cl name
appears as the default label.

Relationship Dialog Box

This page enables you to define the relationship between the new Cl and the Cl selected in the view, as
well as the properties of the relationship.

To access Click Relationship from the New Related CI dialog box.
Important This page only appears for new related Cls.
information

User interface elements are described below:

Ul Element

(A-2) Description

Allow CI When the value is set to true, the DFM process automatically updates the
Update relationship.

CI Definition CI Definition. Returns to the Cl properties mode of the dialog box.

Created By | The user name of the administrator who manually created the relationship, where
applicable.

Create Time The date and time when the relationship was created.
Description A description of the relationship.
Direction Select the relationship direction from the drop-down box.

Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a
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Ul Element
(A-Z)

Aging

Last Access
Time

Must

Name

Network
Address

Description

Clis not rediscovered by DFM and no manual update occurs), an aging mechanism
deletes the CI from the CMDB. For details, see The Aging Mechanism Overview in
the HPE Universal CMDB Administration Guide.

True: the aging mechanism is enabled for this relationship.
False: the aging mechanism is disabled for this relationship.

The default value is determined by the default value of the Enable Aging attribute of
the Cl type.

Note:
« Ifthe aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain relationships only.

« You can change the default value for all new relationships of this type by
editing the default value of the Enable Aging attribute for this relationship
type. For details, see How to Enable and Run the Aging Mechanism in the
HPE Universal CMDB Administration Guide.

The time that the relationship was last accessed, whether when being updated or
being discovered by DFM. This field is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details, see CI Lifecycle and
the Aging Mechanism in the HPE Universal CMDB Administration Guide.

When the value is set to true, the child Cl is dominant when the percentage rule is
used to calculate status for the parent CI. If the Cl has low status, the parent must
take the child Cl status, overriding the percentage rule calculation if necessary. This
is useful to give emphasis to an important Cl. For example, you might want to define
Must for a database Cl, so that status is critical all the way up the subtree if the
database falls, regardless of the status of the other Cls in the subtree.

The Must status defined for a relationship applies to that relationship only —it is not
used in any other relationships of the child Cl. This field is only relevant when
working with HPE Business Service Management.

The name of the Cl.

Defined only for route links. Indicates the destination network address to which this
route is configured.
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Ul Element

(A-Z) Description

Note Enables you to enter other information about the ClI.

Origin An ID for the source that automatically created the relationship, or the application

where the relationship was created.

Relationship Enables you to define the type of relationship that is created between the two Cls.

Note: If you receive an error message about a lack of reconciliation data when
you create a Cl, use either a Composition or Containment relationship. You can
change the relationship to a different type after you create the Cl.

Source CI The name of the CI on the first side of the relationship. This is the CI that you
selected in the view.

Target CI The name of the CI on the second side of the relationship. This is the new CI that
you are creating.

Updated By = The user name of the administrator who updated the relationship properties.
Update Time The date and time when the CI properties were last updated.
User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child Cl is given more weight in percentage
calculations, when the percentage rule is used to calculate status for the parent ClI.
For example, if a child Cl is given a weight of 3, then it has three times more impact
on the parent status calculation than its unweighted siblings.

The weight defined for a relationship applies to that relationship only — it is not used
in any other relationships of the child Cl. This field is only relevant when working
with HPE Business Service Management.

Recently Discovered By Dialog Box

This dialog box displays the discovery jobs that discovered the selected Cl within the specified time
period.

To In IT Universe Manager, right-click a Cl and select Actions > Recently Discovered By
access from the shortcut menu.

User interface elements are described below:
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Ul Element
(A-Z)

r

Discovered
On

From Date

Job Name
Probe

Trigger CI

Description

Refresh. Refreshes the data.

The date the Cl was discovered by the discovery job.

Select the time period to check for jobs that discovered the selected CI. You can
select Custom and a specific date to search all discovery jobs from that date until

now.
The name of the job that discovered the selected Cl.
The probe on which the Cl was discovered.

The trigger ClI for the discovery job.

Run Impact Analysis Dialog Box

This dialog box
view.

To access

Important
information

enables you to run the Impact rule you defined in Impact Analysis Manager for that

Select Managers > Modeling > IT Universe Manager. Right-click a trigger query
node in the Topology Map and select Run Impact Analysis or click the Run Impact

Analysis Now |£| button on the IT Universe status bar.

You can:

« Display in a new window all the Cls that are impacted by the trigger Cl. The
relationships in the map represent the Impact rules. The name of the relationship
is the name of the Impact rule you defined in the Impact Analysis Manager. For
details, see "Show Map" on page 246.

« Simulate how the statuses of the impacted Cls are impacted. For details, see
"Show in Views" on the next page.

« Generate a report that displays a list of Cls that are impacted in the system as a
result of the simulated changes. For details, see "Generate Report" on the next

page.

Note: This dialog only appears if an Impact rule is defined for that view. For
details, see "Impact Analysis Manager" on page 462.
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Relevant "How to Retrieve Impact Analysis Results — Scenario" on page 203
tasks
See also o "IT Universe Manager Overview" on page 180

« "Impact Analysis Manager Overview" on page 462

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:

Ul Element (A-Z) Description
All Impact rules Select to execute all impact rules in the system in the impact analysis.
Generate Report Generates an Impact Analysis report, which displays information that is

divided as follows:

« Grouping by CIT. All the impacted Cls (the Cls that are impacted in
the system as a result of the simulated changes), sorted by CIT.

. Affected Application. All the impacted Cls that belong to a specific
business service.

« Triggered Cls. The Cls that represent the changes you want to make
to the system.

For details on the Impact Analysis report, see "Impact Analysis Report" on
page 411.

Impact rules bundle = Select the bundle containing the required impact rules for the impact

analysis.
Only Impact rules Select to execute the impact rules from the specified bundle in the impact
located in specified analysis.
bundle
Show in Views Simulates how the statuses of the impacted Cls are impacted for the

selected state. The Topology Map displays the statuses of the trigger Cls
as well as all statuses of the Cls that are impacted by it.

The Topology Map also displays the Impact Analysis indicators:
« Atrigger Cl is marked by this indicator: [-].

« A Clthatis both animpacted and a trigger Cl is marked by this
indicator: [2].
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Ul Element (A-2)

Show Map

Trigger Severity

Description

« Animpacted Cl is marked by this indicator: [+].

Note: The statuses that appear here and the colors that represent
each status are defined in the severity list for that state in the System
Type Manager. For details, see "Create/Update List/Enumeration
Definition Dialog Box" on page 519.

Enables you to select an Impact rule, and then display in a new window, a
simulation of all the Cls that are impacted by the trigger CI for the selected
state. If only one Impact rule is defined for this Cl, the Impact Rules
window is displayed directly. For more details, see "Show Impact Pane" on
page 248.

The relationships in the map represent the Impact rules and the name of
the relationship is the name of the Impact rule you defined in the Impact
Analysis Manager.

Note: Show Map enables you to view the results of multiple triggers.
Select the required severity on the scale.

Note: The severity scale was defined for the state in the System
Type Manager. For details, see "System Type Manager" on page 486.

For example, you can create an Impact rule in the Impact Analysis
Manager that defines the severity of the trigger query node as other than
Warning (1). If you select a severity other than Warning (1), for example,
Minor (3), the condition is met and the simulated changes in the system
are triggered.

For details, see the "Impact Rules Definition Dialog Box" on page 475.

Save Snapshot Dialog Box

This dialog box enables you to take a snapshot of a view and save it.

To access  |n|T Universe Manager, click the Snapshot [& button in the CI Selector and select

Save Snapshot.

Important You can compare snapshots of the same view taken at different times using the
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information Compare Snapshots Report. For details, see "Compare Snapshots Report" on page

391.
Relevant « "How to Take a Snapshot of a View" on page 209
tasks « "How to Compare Snapshots" on page 358
See also « "IT Universe Manager Overview" on page 180

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:

Ul Element (A-

Z) Description

Description A description of the snapshot (optional).

Note A note about the snapshot (optional).

View Name The name of the view as it appears in the Cl Selector. This field cannot be

edited.

Show Discovery Status and Changes Dialog Box

This dialog box enables you to find recent changes, for example, to an application, by rediscovering the
Cls and jobs in a view.

To access  InIT Universe Manager:

« Torediscoverall Cls of a view, click the Show Discovery and Changes

Summary ‘2 putton on the toolbar of the Browse Views tab in the CI Selector.

The Show Discovery Status and Changes dialog box is displayed.

« Torediscoverone Cl or several Cls in a view, select the Cl and display the
Discovery tab in the Advanced pane.

Important | By default, you can run the rediscovery procedure on views that include less than
information 10,000 Cls.

To increase the number of Cls that you can rediscover in a view:

1. Access the Infrastructure Settings Manager (Administration > Infrastructure
Settings Manager).
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2. Select the Max Cls in view supported to rediscover setting in the
infrastructure settings table.

3. Click the Value column and change the number.

4. Restart the server for the change to take effect.

For details on working with the Infrastructure Settings Manager, see "Infrastructure
Settings Manager" in the HPE Universal CMDB Administration Guide.

Relevant "How to Check the Status of Application Discovery (Rediscover a View)" on page
tasks 194

See also « "Discovery Control Panel - Details Tab" in the HPE Universal CMDB Data Flow
Management Guide

« "IT Universe Manager User Interface" on page 209

User interface elements are described below:

Ul Element (A-2) Description
= Refresh. Refreshes the status of the selected Cls.

This button is disabled when there is no data to be reloaded.

Rerun Discovery. Reruns the discovery.

E
Discovery Progress For details, see "Discovery Control Panel - Details Tab" in the HPE

Status on View Universal CMDB Data Flow Management Guide.

History Changes on For details, see "Cl/Relationship History Dialog Box" on page 214.
View

Show Impact Pane

This page opens a window that displays the statuses of the trigger Cl as well as all statuses of the Cls
that are impacted by it.

To access In the Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click the Impact Analysis Is Active link on the
IT Universe status bar.

Important = The following tabs are available:
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information .« Impact Results. Displays a map of all Cls impacted by the selected ClI.

« Trigger Cls. Displays a table of information on the selected trigger Cls.

You can only see Impact Analysis results if you defined an Impact rule for that view in
Impact Analysis Manager. For details, see "Impact Analysis Manager" on page 462.

To view information about specific Cls that are triggered or impacted by the Impact
rule, double-click the relationship connecting the Cls. A map is displayed.

The relationships in the map represent the Impact rules. The name of the relationship
is the name of the Impact rule you defined in the Impact Analysis Manager.

Relevant "How to Retrieve Impact Analysis Results — Scenario" on page 203
tasks
See also o "IT Universe Manager Overview" on page 180

« "Impact Analysis Manager Overview" on page 462

« "IT Universe Manager User Interface" on page 209

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to Cls with any of the following special
statuses:

« Added. When Change Timeframe is active, indicates that the Cl was
added.

« Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

« Changed. When Change Timeframe is active, indicates that the Cl was
changed.

« Drill Down One Layer. Indicates that there are Cls under the Cl on alower
layer.

« External. Indicates that the Cl is a federated CI.
« Impacted. When Impact Analysis is active, indicates an impacted CI.

« Impacted and Trigger. When Impact Analysis is active, indicates a trigger
Cl that is impacted.

« Note. Indicates that a note was added for the CI.
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Ul Element (A-Z) Description

« Trigger. When Impact Analysis is active, indicates a trigger Cl.

<Relationship>  The relationships represent the Impact rule you defined in the Impact Analysis
Manager. For details, see "Impact Rules Definition Dialog Box" on page 475.

<The statuses The statuses that appear and the colors that represent each status are the ones
and the colors that are defined in the severity list for that state in the System Type Manager.
that represent For details, see "Create/Update List/Enumeration Definition Dialog Box" on
each one> page 519.

<Toolbar> The Show Impact pane toolbar contains most of the buttons on the IT Universe

Manager toolbar.

<Topology Map  Fordetails, see "Topology Map Sidebar" on page 176.
Sidebar>
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Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create your own views, or work
with the out-of-the-box (factory) views provided with your Universal CMDB installation.

The IT Universe model in the configuration management database can be very large, holding thousands
of configuration items (Cls). A view enables you to build a subset of the overall IT universe model,
containing only those Cls relating to a specific area of interest. You can define your own views to
display only the information that is relevant to your organization's business needs.

Universal CMDB supports three view formats: pattern views, template based views, and perspective-
based views, which are populated through different processes. For details, see "View Formats" below.

View Formats

Universal CMDB supports three view formats that can be used to populate your view:

» Pattern views are built from a Topology Query Language (TQL) query that defines the structure of
the view. You can create a new TQL query as you build the view or base the view on an existing
query. The view displays only those Cls and relationships that satisfy the query definition. When
the view is displayed or refreshed, the Modeling Studio queries the CMDB for all elements that fit
the query, and automatically updates the view with those elements.

« Template based views are based on a TQL query, to which a template is then applied. The
template is a reusable view that includes parameters, which are saved as part of the template. This
enables you to build multiple views with the same settings without having to re-enter the parameter
information. The view displays only those Cls and relationships that satisfy the query definition and
the conditions of the template. For details on templates, see "Templates and Perspectives" on page
256.

« Perspective-based views are built by selecting a collection of individual Cls and applying a special
type of template, known as a perspective, to it. Instance views, which no longer exist, are replaced
by perspective-based views. For details on perspectives, see "Templates and Perspectives" on
page 256.

When you select a view for editing from the view tree in the left pane, it opens on the editing pane in the
appropriate editor.
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Building a Business View
In the Modeling Studio, you can define your own views to model your business environment.

This section includes the following topics:

« "The Structure of a View" below
« "Setting the View Hierarchy" on the next page

« "Topology Reports" on page 255

The Structure of a View

The views you create should provide the business users with logical representations of your company's
structure, processes, and goals. To meet these requirements, you generally build multiple views
representing different aspects of your business; for example, you could build business views that
revolve around any of the following:

« Company structure, so that data is organized by the geographical location of branches, or by data
centers.

« Business processes, so that data is organized by line of business, or by applications.

« Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the actual hierarchical structure
of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

« Top level. The highest levels of the view, consisting of the root Cl and the branches below it, are
normally built from logical Business Cl types such as Location, Line of Business, Customer,
Application, and so on.

« Intermediate level. The intermediate branches of the view normally consist of System CI types,
representing actual hardware and software and/or monitoring group ClI types, representing groups
containing monitors.

« Bottom level. The lowest level of the view, consisting of leaf Cls at the ends of the subtrees, is
built from the Monitor Cl types.
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Note: The bottom level is only relevant when a monitoring solution such as HPE Business
Service Management is connected and modeled in the CMDB.

Setting the View Hierarchy

The Pattern View Editor enables you to set the view hierarchy using the Hierarchy pane on the right
side of the screen. There are two methods available for setting the hierarchy: Manual and Rule-based.
The manual method is selected by default.

« Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed in a tree format. You can
create the hierarchy by manually dragging a selected query node under another query node or by
using the toolbar buttons. The system only allows you to move a query node under another query
node when the resulting hierarchy is valid. For details, see "Hierarchy Pane" on page 319.

It is possible to place a single query node from the view into the hierarchy multiple times. You can
then adjust the hierarchy so that the query node appears in different layers, according to the required
layout. The view results in such an instance would be the same as if you added another query node
to the TQL query. Using the same query node twice in the hierarchy enables you to achieve the
desired view results using a simpler TQL query.

Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to group Cls by different
criteria for the convenience of viewing the display. Click the Add Group By 'S putton and select
one of the options. You can create a subgroup for Cls of the same type in the Topology Map using
the Add Group by CI Type option. You can create a subgroup for a specific query node by
selecting the Add Group by View Node option. You can group Cls by a common attribute using
the Add Group by Attribute button and entering a regular expression as described in "Query Node
Grouping Dialog Box" on page 331. For details about regular expressions, see "Regular Expression
Examples" on page 571.

You can also create nested groups (a query node group inside another query node group) to help
fine-tune the TQL query results that are displayed in the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can use their operation
state attribute to create more focused groups.

« Rule-Based Hierarchy Method

HPE Universal CMDB (10.31) Page 254 of 572



Modeling Guide
Chapter 8: Modeling Studio

In the rule-based hierarchy method, you define hierarchy rules, using the Hierarchy Rules dialog
box. You select a source CIT, target CIT, relationship type, and relationship direction, which define
the conditions for a hierarchy rule. Any Cls in the view which satisfy the defined conditions are
subject to the rule, that is, the target Cl is placed on the layer below the source CI. For details on
defining hierarchy rules, see "Hierarchy Rules Dialog Box" on page 293.

Hiding and Displaying Query Nodes in the View Results

You can select to hide certain query nodes so they do not appear in the view results. The following
options are available:

» Hide/Show Element in Query Results. These options are available by right-clicking a query node
in the Query Definition pane. Cls matching a query node that is set as hidden are excluded from the
query results. You cannot set all of the query nodes as hidden; at least one query node must be
shown for the query definition to be valid.

« Set View Node Invisible/Visible. These options are available by right-clicking a query node in the
Hierarchy pane. Cls matching a query node that is set as invisible are excluded from the view
results. However, if a function is defined in the Report Layout pane, it takes invisible query nodes
into account. For example, a Count function will include Cls corresponding to invisible query nodes
in the total count.

When a query node is set as invisible in the hierarchy, all of its descendants are automatically set
as invisible. This enables you to hide an entire branch of the view results. The query definition
cannot have visible query nodes under an invisible query node. When an invisible query node is set
as visible, its descendants are not changed automatically.

A valid hierarchy definition must have at least one visible query node, other than the root query
node. The root query node can never be set as invisible.

When the TQL query is calculated, UCMDB first filters the query results by the Hide/Show Element
in Query Results settings. The query results are then filtered again by the Set Query Node
Invisible/Visible settings. The final view results reflect the combination of both filters and are
displayed in IT Universe Manager, the Result Preview in Modeling Studio, and the topology report for
the view in Reports.

Topology Reports

You can view the data of any view in report format in the Reports module. Such a report is called the
topology report of the view. You define the topology report settings in the Report tab of the Pattern
View Editor in the Modeling Studio. For details on Topology Reports, see "Topology Reports Overview"
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on page 354.

Templates and Perspectives

A template is a reusable pattern view with defined parameters. You use templates to build template-
based views, setting the values of the parameters for each specific view. Any changes made to a
template affect all existing views based on that template.

Template-based views can be opened in IT Universe Manager, like pattern views. You can also open
the template itself in IT Universe Manager to view the results for various parameter values. If you want
to save the results, you must save it as a template-based view. You define templates, template-based
views, and pattern views in the Pattern View Editor.

Perspectives are a type of template designed to be applied to a specific collection of Cls, similar to the
pattern in a pattern view. For example, a perspective could comprise a node containing an IP Address.
In that case, the resulting perspective-based view would include all the Cls from among the Cls in the

Cl selection, along with the IP Addresses contained in the node Cls.

The most basic perspective is known as the Content Only perspective and consists of only the query
node itself. If you apply the Content Only perspective to a Cl collection, the resulting view contains
only the selected Cls themselves.

Perspectives are also created and edited in the Pattern View Editor. You can have multiple views,
templates, and perspectives open in the Pattern View Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in the IT Universe Manager; however, perspective-
based views can be opened in the IT Universe Manager, like all other views. For details, see "Building a
Perspective-based View" on page 261.

In summary, the Views tree in the Resources tab of the Cl Selector in the Modeling Studio can include
the following distinct entities:

o patternviews

« templates

« template based views
« perspectives

« perspective-based views

You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are created and viewed:
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Can be opened in IT Universe

Type of View Created in: Manager

Pattern View Pattern View Editor Yes

Template Pattern View Editor Yes, for the current session only
Template-based View  Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based Perspective-based View Yes

View Editor

Predefined Folders and Views

The Views tree in the Resources tab of the Cl Selector in the Modeling Studio includes predefined
folders and views, as described in the following sections:

o "Predefined Folders" below
» "Factory Views" below

« "Predefined Perspectives" on the next page

Predefined Folders

The hierarchical file folder system in the Cl Selector can help you organize your views. Predefined
folders are provided for the out-of-the-box views; you can modify these folders, or add additional folders
according to your organization's requirements.

Factory Views

Your Universal CMDB installation includes out-of-the-box pattern views, templates, and perspectives.
These views provide a quick start for working with the CMDB.

The out-of-the-box views are initially empty. As soon as Cls are added to the CMDB by one of the CI
generators, the TQL query built into each pattern view is able to identify the Cls that meet the pattern
requirements, and add them to the view.

Views for Cls are created when a discovery process is run; the out-of-the-box views that are provided
correspond to the relevant Universal Discovery packages. For example, the Oracle view (Root >
Database > Oracle > Oracle) is populated with Cls that are created when Data Flow Management
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activates the Database - Oracle module. For details on running DFM, see "Module/Job-Based
Discovery Workflow" in the HPE Universal CMDB Data Flow Management Guide.

Some of the out-of-the-box views are considered basic to the system and cannot be deleted from the
folders.

Note: Out-of-the-box database views can be used for reporting as long as you perform read-only
operation. For more details, see "Use OOTB Database Views for Reporting" on page 268.

Predefined Perspectives

Universal CMDB also provides out-of-the-box perspectives. One example is the Content Only
perspective, which includes only the elements of the view content itself, without any additional Cls.

Creating Template Based Views

Template-based views based on the same template contain the same query nodes and relationships.
They differ only in their parameter values. You create template-based views using the Template-based
View wizard. The wizard enables you to create multiple views at one time based on the same template.
When creating multiple views, you have the option of entering parameter values manually or importing
them from a CSV file. The CSV file must be formatted correctly for the wizard to import the values. It
must contain the name of at least one of the template parameters in the first row and it must contain at
least one record. The records should be in separate rows and the parameter values for each record
should be in the same row, separated by commas.

The wizard also provides an Advanced Naming feature, which enables you to define an expression for
the view names based on parameter values. For example, if your base template is called Server_
Template, and one of the template parameters is Serial Number, you could define the view names to
be Server <Serial Number>. In this way, the wizard automatically inserts the respective value of the
parameter Serial Number into the name of each view.

An alternate way to assign names to the views when importing values from a CSV file is toinclude a
column in the file called template_based_view_name. The file entries corresponding to this column
are automatically entered by the wizard as the view names. Note that this naming method overrides the
Advanced Naming feature; that is, view names are assigned the entries in the template_based view
name column of the file, even when the Advanced Naming feature is selected.

For details on creating template-based views, see "Template-based View Wizard" on page 340.
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You can also edit the parameters of a template-based view when the view is open in the Editor, from
the Template Parameter Values dialog box. For details, see "Template Parameter Values Dialog Box"
on page 345.

You cannot edit the report layout for a template-based view. To change the report layout, you need to
make changes in the base template of the view.

Business Cl Models

This section includes the following topics:

« "Instance-based Models" below
« "Pattern-based Models" on the next page

» "Defining a Pattern-based Model over an Instance-based Model" on page 261

The collection of Cls which compose the view content of perspective-based views can be selected in
two ways. You can select Cls from the Cl Selector and drag them onto the editing pane. In this case,

you can build a view by applying a perspective to the collection and the collection cannot be reused in
another view without repeating the selection process. The other way to select the Cls to appear in the
view is by creating a model.

A model is a reusable collection of Cl instances that define a business entity, such as a business
service or line of business. By creating a model, you are building a Cl collection that can be reused with
other perspectives to create different views. Any changes you subsequently make to the model are
reflected in all the views based on that model. There are two types of models: instance-based models
and pattern-based models.

Instance-based Models

You build an instance-based model by first selecting a business Cl to serve as its basis. The available
business Cls include group, application, business service, business unit, and line of business. Then,
you can add Cls to your model in the following ways:

« Manually, by dragging Cls from the Cl Selector into the Model Editor
« Revealingrelated Cls using a reveal path and selecting the ones to add to the model

« Defining a watchpoint for a selected Cl and automatically adding Cls to the model

You can also begin building a model by dragging Cls onto the empty canvas and selecting Create a
new model.
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The model you create is a Cl itself and the Cls in your model are related to the model by Contains
relationships. You must save your model before applying a perspective to it to build a view.

Caution: The changes you make in a model affect the entire universe, not just the views based on
that model. Thus, if you delete a Cl from a model, you are deleting the relationship that existed
between the Cls from the CMDB.

When working in IT Universe Manager, you can add selected Cls directly to a new model or an existing
model. For details, see "Add Cls to Model Dialog Box" on page 210.

Pattern-based Models

Another type of model you can build is a pattern-based model. In a pattern-based model, you define a
TQL query to determine the Cls included, rather than selecting them manually. You can base your
pattern-based model on an existing TQL query or create a new TQL query.

You must designate at least one query node in the model's TQL query as output for the model. The Cls
of that type which match the pattern of the TQL query are the ones included in the model output.

The pattern-based model created is saved as a Cl like an ordinary model, and can be used to form the
content of a perspective-based view. The new TQL query created is saved as an ordinary query and
can be used as the basis for a pattern view.

Pattern-based models are not updated continuously. Each model is calculated at the time it is saved
and the TQL query runs at specific intervals to update the model. All existing pattern-based models are
updated at the same time. To set the frequency of the pattern-based model updates, click the © button
in the Resources tab of the left pane to open the Pattern Based Model Scheduler dialog box. The
settings you select also apply to all pattern-based models created subsequently. For details, see
"Pattern Based Model Scheduler Dialog Box" on page 315.

Note:

« When you export a pattern-based model in Package Manager, the underlying TQL query of the
model, as well as an enrichment used to update the model content, are added to the
package. When you view the package resource, or deploy or undeploy the package, only those
resources are displayed. The model name does not appear. A pattern-based model exported
from UCMDB 10.x cannot be imported into a UCMDB version earlier than 10.00.

« When you delete a pattern-based model (either from the Modeling Studio or from the IT
Universe), the Business Enrichment, Job Scheduler, and pattermn-based model Cl are also
deleted.
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Defining a Pattern-based Model over an Instance-based Model

When defining a pattern-based model, it is possible build it on top of an existing instance-based model.
In this case, only the pattern of the model that you build is visible on the canvas, as in a new pattern-
based model. However, the Cls in the instance-based model also remain in the new model and appear
in the view results when the model is used to build a perspective-based view. Similarly, when you
access the model in IT Universe Manager, both the Cls in the instance-based model and those
retrieved by the pattern-based model are visible. The model is saved with the name of the original
instance-based model, in effect creating a hybrid model with both instance-based and pattern-based
components.

If you delete the model, only the additional pattern-based part of the model is deleted. The model
reverts to an instance-based model and the Cls included in it become visible in the Model Editor.

Building a Perspective-based View

A perspective-based view is composed of perspectives applied to a model or a collection of Cls. The
perspective is a special type of template which is designed to be applied to a subset of the IT Universe
model.

The Content pane of the Perspective-based View Editor displays the models or Cls you have selected
to serve as the basis of your view. The Perspective pane displays the selected perspectives. The
Preview pane displays the resulting view based upon your content and perspective selections. When
you make a change in the content or perspective selections, the view is updated accordingly in the
Preview pane. For details, see "Perspective-based View Editor" on page 325.

This section includes the following topics:

« "Content" below
» "Perspectives" on the next page
« "Views Based on Multiple Perspectives" on page 263

« "Including and Excluding Child Cls" on page 264

Content

The content in a perspective-based view can be selected in two ways:
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« You can add individual Cls to the view manually, using the CI Selector. The Cls in the collection are
independent of each other. In this case, the collection of Cls is not defined as a model and cannot
be reused in another view.

« You can add one or more models to the view, using the Cl Selector. Alternatively, you can start by
working with a model in the Model Editor and select Generate View for Selected Model to build a
view based on that model. In this case, the identical content can be used to build another view by
selecting the same models.

You can select both individual Cls and models to form the content of a perspective-based view;
however in that case, the models are treated as ordinary Cls. The models themselves are included in
the view without their hierarchy of child Cls.

When working in IT Universe Manager, you can add selected Cls directly to the content of a new or an
existing perspective-based view. For details, see "Add Cls to View Dialog Box" on page 210.

Perspectives

The perspectives you select for your view determine which Cls are included in the view. A perspective
is a reusable pattern, similar to a template. The difference between a perspective and a regular
template is that the perspective includes one or more query nodes designated as contact query
nodes. A contact query node is a query node in the pattern which is used to apply the pattern to
specific content and it is indicated by a small icon that appears next to the query node=. .

For example, in the following perspective, a query node of type Windows is designated as the contact
query node and it has an IP Address related to it by a containment relationship.

=

L2

indows

Zontalnment

@.r

InAddress

When this perspective is applied to a Cl collection, the resulting view contains all the Cls in the original
collection as well as the IP Addresses connected to the Windows Cls in the collection (the Cls that
were added by applying the perspective).
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A perspective can have several contact query nodes, but every disconnected graph within a
perspective must have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are affected.

Views Based on Multiple Perspectives

You can select multiple perspectives to apply to the content of your view. There are two ways to select
multiple perspectives:

« Perspective groups

« Perspective chains

In a perspective group, you select two or more perspectives to apply simultaneously to the same
input content.

In a perspective chain, you select two or more perspectives at different levels of the view creation.
The perspective in the first level is applied to the original view content to generate results in the form of
a Cl collection that serves as input content for the next level. The perspective in the second level is
then applied to this content to generate the view results. You can build views based on multiple levels
of perspectives, each one generating input content for the following level.

It is possible to apply both of the above methods at the same time, that is, by selecting multiple
perspectives in each of the levels of a perspective selection.

For example, select a collection of IP Subnet Cls as your input content and select a perspective that
adds the node Cls related to the IP Subnets as the first level perspective. The results of this stage
consist of the original IP Subnets and their related nodes. Then add a second perspective level and
select two perspectives for it: one that adds CPU Cls related to nodes and one that adds File System
Cls related to nodes. The final results include the original IP Subnets, their related nodes, and the
CPUs and File Systems related to those nodes.

These options help to simplify the process of creating a perspective-based view, by breaking down the
functionality of a perspective into its component parts. Instead of building a separate large and complex
perspective for each required view, you can construct a custom perspective combination to match the
requirements of your specific case from smaller and more basic perspectives.

Caution: Saving or updating a perspective based view with several perspectives (for example,
seven perspectives), may cause performance issues and it also may get the UCMDB server
stuck.

In case you experience the above behavior and there is no other solution that can be used:
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1. Gotothe UCMDB JMX Console, locate the setGlobalSettingValue JMX method in the
UCMDB:service=Settings Services category.

2. Provide the following parameter values:
name: pbv.max.perspectives.to.start.use.remove.on.update

value: Specify the number of perspectives used in the perspective based view which crashed
the system.

3. Click Invoke.

4. Restartthe UCMDB Sever.

Including and Excluding Child Cls

When adding Cls that have children to a view, the Cl and its children are only included in the view if the
pattern of the perspective includes children for the selected Cl type. In that case, children are included
for all Cls of that type. After creating a view, you can hide specific Cls from the view by selecting the
Clinthe View Results pane and selecting Hide Cl from View from the shortcut menu or clicking the
Hide CI from View button on the toolbar. This option is only available for Cls that were added to the
view via the perspective and were not part of the original content on which the view was based. Thus, if
the view was based on a collection of Cls, the Cls in that collection cannot be hidden from the view. If
the view was based on a model, the model itself cannot be hidden from the view, but the Cls contained
in the model can be hidden.

Revealed Cls and Watchpoints

The Modeling Studio provides two advanced methods of adding Cls to an existing model: revealing
related Cls and defining watchpoints.

This section includes the following topics:

« "Revealing Cls" below

« "Watchpoints" on page 267
Revealing Cls

One approach to building a model is to add Cls related to the Cls in the model. The Modeling Studio
provides a tool to help you reveal those Cls. The process of revealing related Cls involves constructing
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areveal path, which is a chain of Cl types that are related to each other. The first item in your reveal
path is the Cl type of the Cl from which you started to reveal Cls. The Modeling Studio locates all of its
related Cls and lists their Cl types. By selecting one of those types, you build the next step of your
path. All the related Cls of that type appear in the lower pane of the dialog box. You can select the ones
you want to include in your model. The process is repeated to build the following step of the path.

For example, if you begin to reveal Cls from a Cl of type Windows, the Modeling Studio may reveal
related Cls of types Interface, Network, and IP. If you select Network, the related Cls of type Network
appear in the lower pane and can be added to the model by dragging them into the Cls Basket or

clicking the Cls Basket icon:

X
é} Revealing Related Cls... (2)
i Ateach step ofthe reveal path, select revealed Cls to add to your model.
Feveal Path: i Windows =» FuE Et
Cl Type Conditions Cl count
-“|- Interface 3|
=% Network 1
e 1
Finct I P - © E
-
'fi:' Drop Clz in order to add them to model... _“8
| MName | Cl Type
=% 16.59.60.0 Metwork
Find: I P - g E
Clz Basket

Click Next to build the next step of the path using Network as your selection. The Modeling Studio
reveals related Cls of type Windows, Unix, and IP. Unix is selected and the Unix Cls appear in the
lower pane and can be added to the model by dragging the selected ones into the Cls Basket pane:
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Reveal (Is

Revealing Related Cls... (3)

Ateach step ofthe reveal path, selectrevealed Cls to add to your model.

Reveal Path: [ Windows = 5% Network 3 ., Suamn
b4 =
Cl Type | Conditions | Cl count
ﬁ Windows 35
e 43
Finet | @ G) |
-
@ Drop Cls in order to add them to model... &
Mame Cl Type
' labm1ss04 Unix
ﬁ notredame Unix
ﬁ labm1sun0s Unix
& tabm1 itgo7 Unix
 labmiitg10 Unix
& tgbm1hp7 Unix
5 labm1itgn2 Unix
Einct | | @ @) |
Cls Basket
Einish Relp
———e

Click Next to build the next step of the path using Unix as your selection:
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x|
Revealing Related Cis... (4)
At each step of the reveal path, select revealed Cls to add to your model.
Reveal Path: [ Windows = 5% Network 2> 5 Unix = Saue path
Cl Type Conditions Cl count
L8 SNMP 12 | =
|4 05 User 122
=# Disk 12 |3
. ECPU Gl I
543} nterface 23
=% Network 2
L 55H 13 v]
Find: L l® @ =
-
@ Crop Cls in order to add them to model...
MName | Cl Type
Clz Basket
=3 = 2 S

In this case, a reveal path of Windows > Network > Unix was constructed. At each step, you have
the option of adding any of the revealed related Cls to your model. For details on revealing Cls, see
"Reveal Cls Dialog Box" on page 335.

Itis also possible to construct a reveal path without revealing Cls. For details, see "Create/Edit/Save
Reveal Path Dialog Box" on page 290.

Watchpoints

Another method of locating related Cls to add to the model is by defining a watchpoint for a selected ClI
in the model. A watchpoint is a mechanism which is triggered when a new related CI of a specified type
is created. Every watchpoint is defined in connection with a reveal path. If a new related Cl of any ClI
type included in the path is created, the watchpoint is triggered and an indicator appears next to the
model. For details on defining a watchpoint, see "New Watchpoint Dialog Box" on page 313.

Note: You must save a new model before defining watchpoints for its Cls.
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All the related Cls detected by the watchpoint are displayed in the Watchpoints Updates dialog box.
The dialog box enables you to select the ones to add to your model and the ones to suppress, or
exclude from your model. For details, see "Watchpoints Updates Dialog Box" on page 351.

You also have the option to include the detected Cls in your model automatically by selecting the check
box in the New Watchpoint dialog box. In this case, all Cls detected by the watchpoint are added to the
model.

A watchpoint can also be used to detect Cls included in the model which are no longer related to the
model. If such Cls are found along the reveal path connected to the watchpoint, they also appear in the
Watchpoints Updates dialog box. You can accept the suggestion to remove the Cls from your model,
or you can suppress the suggestion, thereby keeping the Cls in your model.

Note:

« Although a watchpoint is defined for an individual Cl, the watchpoint results display related Cls
of the Cl types included in the reveal path for all Cls in the model.

« When adding Cls to a model using watchpoints or revealed Cls in a multi-tenancy environment,
only Cls with a consumer tenant matching the owner tenant or consumer tenants of the model
are added.

Use OOTB Database Views for Reporting

The out-of-the-box (OOTB) or factory database views can be used for reporting as long as you perform
read-only operation.

The views names are stored in the CLASS_MODEL_ENCODING table. You can find names of
database views for each CIT by executing the following select statement:

select CLASS_NAME, VIEW_BY_CLASS from CLASS_MODEL_ENCODING

There is no clear rule for determining the view name based on the class name. Usually if the table name
is CDM_<CLASS_NAME>_<CUSTOMER_ID>, the view name is something similar to <CLASS _
NAME> <CUSTOMER_ID>. But for some classes where the name length is greater than 32
characters (Oracle limitation), the table name and view name might contain number sequences.
Therefore the best solution to find a view name is to run the above select statement.

Note:
« Database views will change when the Data Models are updated.

« Running more than 10 reports with large amount of data may lower the UCMDB performance.
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« Runthe DB views reports only when no discovery, enrichments, integration, aging, or purging
runs.

« Only database views should be used for reporting, not tables.

For details about how to define report setting, see "How to Define Report Settings" on page 279.

How to Create a Pattern View
This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

o "OpenaNew View in the Pattern View Editor" below

« "Add Query Nodes and Relationships to a TQL Query" below
« "Set the View Hierarchy" below

« "Set the View Properties" on the next page

« "Define the Report Settings - Optional" on the next page

« "Set Permissions" on the next page

1. Open a New View in the Pattern View Editor

Click New |2 and select Pattern View. In the New Pattern View dialog box, select the base TQL

query on which your new view is based, or select Create new query to build a new TQL query.
The Pattern View Editor opens. For details, see "New Pattern View/Template/Perspective Dialog
Box" on page 312.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes
and relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL
Query" on page 25.

Note: If you are starting with a blank view, you must add at least one query node in order to

save your view.

3. Set the View Hierarchy
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Set the hierarchy for the view by moving the required query nodes in the Hierarchy pane. For
details, see "Setting the View Hierarchy" on page 254.

When you are finished, click Save || to save the view.

4. Set the View Properties

Set the view properties, such as the priority and the default layout for the view in the View
Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog Box" on
page 332.

5. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 279.

6. Set Permissions

Apply viewing and editing permissions to users and user groups for the new view. You set
permissions in Managers > Security > Roles Manager. For details, see "Roles Manager Page"
in the HPE Universal CMDB Administration Guide.

How to Create a Template

This task describes how to define a new template.

This task includes the following steps:

o "Open aNew Template in the Pattern View Editor" on the next page

« "Add Query Nodes and Relationships to a TQL Query" on the next page
« "Set Parameter Values" on the next page

« "Set the Template Hierarchy" on the next page

« "Set the Template Properties" on the next page
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« "Define the Report Settings - Optional" on the next page

« "Set Permissions" on the next page

1. Open a New Template in the Pattern View Editor

Click New i and select Template. In the New Template dialog box, select the base TQL query
on which your new template is based, or select Create new query to build a new TQL query. For
details, see "New Pattern View/Template/Perspective Dialog Box" on page 312.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes
and relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL
Query" on page 25.

Note: If you are starting with a blank template, you must add at least one query node in order
to save your template.

3. Set Parameter Values

Right-click a query node or relationship in the TQL query and select Query Node Properties. In the
Attributes tab, add an attribute with a parameterized value. For details, see "Query
Node/Relationship Properties Dialog Box" on page 72.

Note: If you do not set any parameters, when you try to save your template, you must save it
as a pattern view.

4. Set the Template Hierarchy

Set the hierarchy for the template by moving the required query nodes in the Hierarchy pane. For
details, see "Setting the View Hierarchy" on page 254.

When you are finished, click Save || to save the template.

5. Set the Template Properties

Set the template properties, such as the priority and the default layout for the template in the View
Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog Box" on
page 332.
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6. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 279.

7. Set Permissions

Apply viewing and editing permissions to users and user groups for the new template. You set
permissions in Managers > Security > Roles Manager. For details, see "Roles Manager Page"
in the HPE Universal CMDB Administration Guide.

How to Create a Perspective

This task describes how to define a new perspective.

This task includes the following steps:

« "Open a New Perspective in the Pattern View Editor" below
« "Add Query Nodes and Relationships to a TQL Query" below
» "Select a Contact Query Node" on the next page

« "Set the Perspective Hierarchy" on the next page

« "Set the Perspective Properties" on the next page

« "Define the Report Settings - Optional" on the next page

« "Set Permissions" on the next page

1. Open a New Perspective in the Pattern View Editor

Click New |'-_-'-| and select Perspective. In the New Perspective dialog box, select the base TQL

query on which your new Perspective is based, or select Create new query to build a new TQL
query. For details, see "New Pattern View/Template/Perspective Dialog Box" on page 312.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes
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and relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL
Query" on page 25.

3. Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query node. Right-click the query
node and select Use As Contact Query Node.

Note: If you do not select a contact query node, when you try to save your perspective, you
must save it as a pattern view.

4. Set the Perspective Hierarchy

Set the hierarchy for the perspective by moving the required query nodes in the Hierarchy pane.
For details, see "Setting the View Hierarchy" on page 254.

When you are finished, click Save || to save the perspective.

9. Set the Perspective Properties

Set the perspective properties, such as the priority and the default layout for the perspective in the
View Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog
Box" on page 332.

6. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the
report for each query node of the view. You can also set the order of the report columns, set the
sort order of each column, and add a chart. For details, see "How to Define Report Settings" on
page 279.

7. Set Permissions

Apply viewing and editing permissions to users and user groups for the new perspective. You set
permissions in Managers > Security > Roles Manager. For details, see "Roles Manager Page"
in the HPE Universal CMDB Administration Guide.
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How to Create a Dynamic Widget
This task describes how to define a new dynamic widget for the UCMDB Browser.

This task includes the following steps:

« "Create a New Dynamic Widget in the Pattern View Editor" below
« "Add Query Nodes and Relationships to a TQL Query" below
« "Select Attributes for the Widget" on the next page

» "Set Values for the Widget's Attributes" on the next page

—_

- Create a New Dynamic Widget in the Pattern View Editor

Click New |;| and select Dynamic Widget. In the New Dynamic Widget dialog box, select the

base TQL query on which your new dynamic widget is based, or select Create new query to build
anew TQL query.

2. Add Query Nodes and Relationships to a TQL Query

In the View tab, add the query nodes and relationships that define the query. For details, see "How
to Add Query Nodes and Relationships to a TQL Query" on page 25.

Note: The root (and only the root) of the folding definition in the TQL query must be
designated as a contact query node for the dynamic widget to display data about that node in
the UCMDB Browser. If no contact query node is specified, the TQL query is saved as a
pattern view and not as a dynamic widget.

a. Specify whether to use a manual (default) or rule-based hierarchy when defining the TQL
query. For details, see "Setting the View Hierarchy" on page 254.

Note: If you are starting with a blank widget, you must add at least one query node in
order to save your widget.

b. Foreach property for which you want data to be displayed in notifications in the dynamic
widget, do the following:

i. Right-click a node in the topology map and select Query Node Properties.
ii. Click the Element Layout tab.

iii. Select the Select attributes for layout radio button.
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iv. Inthe Conditions pane, select either All (to display all attributes of the selected node) or
Specific Attributes (to display only the attributes you select).

v. Select attributes in the Available Attributes pane and click 2 to add them to the Specific

Attributes pane.

vi. Click OK when you are finished.

3. Select Attributes for the Widget

In the Report tab, select a node in the Hierarchy pane, and choose the attributes for that node for
which you want data to be displayed in the widget.

Note: Inthe Hierarchy pane in either the Report tab or the View tab, you can specify a
grouping option on any node. Although you can choose between different grouping options,
the Cl's attributes are always displayed in groups by Cl type when you view the dynamic
widget in the UCMDB Browser in Widget Details mode. To set a grouping option, right-click a
node in the hierarchy tree and select one of the grouping options (attribute, Cl type, or view

node).

4. Set Values for the Widget's Attributes

In the Widget tab, select a node and specify how and where you want the selected attributes to be
visible in the widget. For details, see "Pattern View Editor" on page 318.

o Select the Show path check box to cause the UCMDB Browser to display the route in the
dynamic widget from a specific node in the view definition to all the node's children.

o Select the Browser Cl access control check box to ensure that the dynamic widget displays
data only according to the permissions that were specified on the Browser Cl Access Control
tab in the Roles manager. If the check box is not selected, the dynamic widget will display all
data, without permission enforcement.

o Select an initial display mode for the dynamic widget.

« Properties Mode. Displays individual properties for Cls.

Note: If you do not select a Widget Type value, Properties Mode is enabled by default.

« Topology Map Mode. Displays Cls according to your current topology.

« Topology CIT Group Mode. Displays Cls grouped by CI type according to your current
model.

« Topology Textual Mode. Displays a list of Cls broken down by ClI type.
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The topology mode that you select is the initial view selection until you change to another one
in the UCMDB Browser.

When you are finished, click Save ||.

How to Create a Template Based View

This task describes how to define a single template based view.

This task includes the following steps:

o "Prerequisites" below

« "Define a New Template Based View" below

« "Select a Template" below

« "Select the Method for Adding Parameter Values" below
» "Set Parameters" on the next page

« "Set Permissions" on the next page

1. Prerequisites

If you want to base your view on a new template, create the template first. For details, see "How
to Create a Template" on page 270.

2. Define a New Template Based View

You define a new template based view using the Template-based View wizard. Click New |"_-'-| and
select Template Based View.

3. Select a Template

On the Select Template page of the wizard, select a template on which to base your view. For
details, see "Select Template Page" on page 341.

4. Select the Method for Adding Parameter Values

On the Import Parameter Values page of the wizard, select the method for adding the parameter
values. For details, see "Import Parameter Values Page" on page 342.
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Set Parameters

On the Enter Parameters page, enter the parameter values for the view. For details, see "Enter
Parameters Page" on page 343.

Note: You can also edit the parameters from within the Editor after creating the view, by
selecting Show Parameters * from the toolbar or the shortcut menu.

When you are finished, click Finish to open the view in the Editor. Click Save || to save the

view.

Set Permissions

Apply viewing and editing permissions to users and user groups for that view. You set permissions
in Managers > Security > Roles Manager. For details, see "Roles Manager Page" in the HPE
Universal CMDB Administration Guide.

How to Create Multiple Template Based Views

This task describes how to define multiple template-based views.

This task includes the following steps:

1.

"Prerequisites" below

"Define New Template Based Views" on the next page

"Select a Template" on the next page

"Select the Methods for Adding Parameter Values and Naming Views" on the next page
"Set Parameters" on the next page

"Select the Location for Saving the Views" on the next page

"Save the Views" on the next page

"Set Permissions" on the next page

Prerequisites

If you want to base your views on a new template, create the template first. For details, see "How
to Create a Template" on page 270.
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2. Define New Template Based Views

You define new template based views using the Template-based View wizard. Click New |;| and

select Template Based View.

3. Select a Template

On the Select Template page of the wizard, select a template on which to base your views. For
details, see "Select Template Page" on page 341.

4. Select the Methods for Adding Parameter Values and Naming Views

On the Import Parameter Values page of the wizard, select the method for adding the parameter
values. Also, if you want to use the Advanced Naming feature, select the check box on this page.
For details, see "Import Parameter Values Page" on page 342.

5. Set Parameters

On the Enter Parameters page, enter the parameter values for the view. If you selected to import
the parameter values from a CSYV file, they are automatically entered in the table. You can edit the
view names and parameter values manually on this page. You can also add new views to the table
or delete views from the table. For details, see "Enter Parameters Page" on page 343.

6. Select the Location for Saving the Views

On the Select Location page, select the location in the view tree in which to save the new views.
For details, see "Select Location for Views Page" on page 343.

7. Save the Views

On the Summary page, review the details of the views you created. If there are no further changes,
click Save to save the views in the selected location.

8. Set Permissions

Apply viewing and editing permissions to users and user groups for each view created. You set
permissions in Managers > Security > Roles Manager. For details, see "Roles Manager Page"
in the HPE Universal CMDB Administration Guide.
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How to Define Report Settings

This task describes how to define report settings for a view, template, or perspective.

This task includes the following steps:

—_

"Prerequisites" below

"Select Attributes to Appear as Report Columns" below
"Add Function Columns to the Report - Optional" below
"Set the Sort Order of the Column Content" below

"Add a Chart to the Report - Optional" on the next page

"Set the Report Properties" on the next page

Prerequisites

After defining the content and hierarchy of a view, template, or perspective, you can define the
report settings. Select the Report tab in the Pattern View Editor.

Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy pane and select the
attributes to appear as columns in the report for that query node. You select attributes in the Query
Node Definition pane by moving them from the Attributes list to the Report Layout list. Set the
order of the columns using the arrow buttons in the Report Layout list. For details, see "Pattern
View Editor" on page 318.

Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node consisting of data derived from a
function performed on one of its child query nodes. Click the Add Function “ button to open the

Add Function dialog box where you can select the relevant settings. For details, see "Add/Edit
Function Dialog Box" on page 285.

Set the Sort Order of the Column Content

Click the Set Sort Order =" button to open the Sort Column Content dialog box. Determine the

columns by which to sort the report by moving columns from the Available Columns list to the
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Sorted Columns list. Use the arrow buttons to set the sort order of the columns. Use the Sort
Ascending/Sort Descending buttons to set the sort direction for each column. For details, see
"Sort Column Content Dialog Box" on page 339.

. Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table, for a selected layer of the
view. When the necessary conditions for adding a chart are satisfied, the Define Chart link in the
Chart Properties section of the Query Node Definition pane is active. Click the link and enter the
chart settings. For details, see "Chart Properties" on page 324.

6. Set the Report Properties

Select the View tab in the Pattern View Editor. Select the Report Properties W) putton to assign

a title and subtitle to the report and to select the report format. For details, see "Report Properties
Dialog Box" on page 430.

How to Build an Instance-based Model

This task describes how to build an instance-based business Cl model which can serve as the basis
foraview.

This task includes the following steps:
« "Create the New Model" below
« "Add Cls to the Model Manually" on the next page
» "Reveal Cls" on the next page

» "Define Watchpoints for Cls in the Model" on the next page

1. Create the New Model

In the Modeling Studio, click New || and select Instance Based Model to open the New Model

dialog box. Select a Cl type and enter the values for its properties. For details, see "New Model
Dialog Box" on page 311.

Note: You cannot create an instance-based model with an already existing name.
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2. Add Cls to the Model Manually

In the CI Selector, search for the Cls you want to include in your model. Select them and drag
them into the model.

Tip: You can select more than one ClI by holding the CTRL key while selecting Cls.

Reveal Cls

Select a Cl in the model and reveal its related Cls along a reveal path. Add selected Cls from
among the revealed Cls to your model. When you are done, save the model. For details, see
"Reveal Cls Dialog Box" on page 335.

Define Watchpoints for Cls in the Model

Right-click a Cl in the model and select Watchpoint > New Watchpoint. The New Watchpoint
dialog box opens. Select a reveal path and click OK. A small icon appears next to the Cl indicating
that a watchpoint is defined for it. For details, see "New Watchpoint Dialog Box" on page 313.

How to Build a New Pattern-based Model

This task includes the following steps:

1.

"Define the New Model" below

"Enter the Model Details" on the next page

"Select a TQL Query" on the next page

"Add Query Nodes and Relationships to a TQL Query" on the next page
"Set Output Query Nodes" on the next page

"Save the Model" on the next page

Define the New Model

You define a new pattern-based model using the Pattern-based Model wizard. Click New B and
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select Pattern Based Model.

Note: You cannot create a pattern-based model with an already existing name.

2. Enter the Model Details

On the first wizard page, select New Model. Then select a Cl type for the model and enter the
properties. For details, see "Select Cl Type Page" on page 317.

3. Select a TQL Query

On the next wizard page, select a TQL query for the model. You can create a new TQL query or
select an existing query from the tree. The TQL Query Editor opens with the selected query. For
details, see "Query Selection Page" on page 317.

4. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes
and relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL
Query" on page 25.

5. Set Output Query Nodes

Select one or more query nodes in the TQL query to serve as output for the model by right-clicking
them and selecting Add to Model Output. The query node is indicated by a small icon next to it.

6. Save the Model

When you are finished, save the model with a unique name. If you created a new TQL query, the
query is also saved independently of the model and can be re-used as a regular TQL query.

How to Build a Perspective-based View Based on a
Model

This task describes how to build a view in the Modeling Studio based on a model and a perspective.

This task includes the following steps:
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"Open the Model" below

"Select a Perspective" below

"Save the View" below

1. Open the Model

In the Modeling Studio, select Models as the Resource type in the left pane, select the relevant
model, and click Open Model & on the left pane toolbar.

2. Select a Perspective

In the Model Editor, right-click the model and select Generate View for selected model. The
Creating New View dialog box opens. Select perspectives to apply to the model. For details, see
"Creating New View Dialog Box" on page 291.

3. Save the View

The Perspective-based View Editor opens with your new view. Optionally, build a perspective
chain by selecting perspectives for additional levels of the view creation. Rename the view and
save it in the correct folder. For details, see "Perspective-based View Editor" on page 325.

How to Build a Perspective-based View Based on a
Collection of Cls

This task describes how to build a view in the Modeling Studio based on a collection of Cls and a
perspective.

This task includes the following steps:

"Create the New View" below

» "Add Cls to the View" on the next page

« "Select a Perspective and Save the View" on the next page

1. Create the New View

In the Modeling Studio, click New |;| and select Perspective Based View to open the
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Perspective-based View Editor. For details, see "Perspective-based View Editor" on page 325.

2. Add Cls to the View

In the CI Selector, search for the Cls you want to include in your view. Select them and drag them
into the view. For details on the CI Selector, see "Cl Selector" on page 134.

Tip: You can select more than one ClI by holding the CTRL key while selecting Cls.

3. Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your Cl collection. Optionally, you can
build a perspective chain by selecting perspectives for additional levels of the view creation.
Rename the view and save it in the correct folder. For details, see "Perspective-based View
Editor" on page 325.

Modeling Studio User Interface

This section includes (in alphabetical order):

Add/Edit Function Dialog BOX .. ... 285
Change Query Node/Relationship Type Dialog Box ... . 287
Choose Operation for Selected Items Dialog BoxX ... ... . . 288
Conditions of Related Cls Dialog BoX . ... ... L 289
Create/Edit/Save Reveal Path Dialog Box ... . .. 290
Creating New View Dialog BOX ... ...l 291
Cycle Definition Dialog BoX . ... o 292
Hidden Cls Dialog BOX . ... ..o 293
Hierarchy Rules Dialog BOX ... ... ... 293
Left Pane il 294
Manage Cl Watchpoints Dialog BOX . ... e 300
Model EditOr ... .. 301
Modeling Studio Page ... ... . 308
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Models Containing Selected Cl Dialog BOX ... .. o.ooii i 310
New Model Dialog BOX . ... ... . 311
New Pattern View/Template/Perspective Dialog Box ... .. . ... .. ... ... 312
New Watchpoint Dialog BoX ... 313
Open Reveal Path Dialog BOX . ...... ..o 314
Pattern Based Model Scheduler Dialog BoxX .. ... . o e 315
Pattern Based Model Wizard ... ... . il 316
Pattern View Editor . 318
Perspective-based View Editor .. el 325
Query Node Grouping Dialog BoX _ ... ... .. 331
Query/View Definition Properties Dialog Box ... ... .. .. 332
Reveal Cls Dialog BOX . ... ... 335
Save Query Dialog BoX ... oL 336
Save View/Template/Perspective Dialog BOX .. ... . . 337
Select Integration Points Dialog BoX ... 338
Sort Column Content Dialog BoX ... 339
Template-based View Wizard .. . 340
Template Parameter Values Dialog BOX . ... .. .. 345
TQL Query EAOr . 346
Views Containing Selected Cl Dialog BOX ... 350
Watchpoints Updates Dialog BOX ... ... ... 351
<Query/Template/Perspective Name> Dependencies Dialog Box .................................. 352

Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node's functions and parameters you want to
include in the report.

To access  Click the Add Function ‘= button under the Report Layout box in the Query Node
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Definition pane of the Pattern View Editor.

Important When defining the report columns for a selected query node in a view, template, or

information = perspective, you can define a column consisting of data deriving from a function

defined for one of its child query nodes. Select the relevant child query node, attribute,
and function that you want to define.

First, select the required query node and function. The attribute list adjusts to display

the relevant attribute for the selected combination. Select the required attribute.

Relevant "How to Define Report Settings" on page 279
tasks
See also « "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element

(A-Z) Description

Attribute Select an attribute from the list.

Function From the Function list, select the function you want to use to calculate the results

on these columns.

The following are the available options:

Average. The average value of the selected attribute for all the Cl instances of
the selected query node.

Concatenated List. Lists the values of the selected attribute for all the Cl
instances of the selected query node.

Count. Calculates the number of Cl instances of the selected query node.

Distinct List. Lists the unique values of the selected attribute for all the Cl
instances of the selected query node.

Max. The maximum value of the selected attribute for all the Cl instances of
the selected query node.

Min. The minimum value of the selected attribute for all the Cl instances of the
selected query node.

Sum. The sum of the selected attribute values for all the Cl instances of the
selected query node.
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Ul Element
(A-Z) Description

Related Query The child query node on which you want to perform the function.
Node

Title The name of the function attribute displayed in the report.

Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node or relationship after you have
created a TQL query.

To access  Inthe TQL Query Editor or Pattern View Editor, right-click the required query node and
select Change Query Node Type. For relationships, right-click the required
relationship and select Change Relationship Type.

Important = You can change the Cl type of the selected query node to any other valid type based
information = on the existing relationships and conditions of the selected query node.

Relevant « "How to Define a TQL Query" on page 24

tasks « "Implement a Discovery Adapter" in the HPE Universal CMDB Developer
Reference Guide
« "How to Create a Pattern View" on page 269
See also « "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

=) Expand All. Expands all the folders in the tree.
e Collapse All. Collapses all the folders in the tree.
Tree View 2 Click Tree View to select the display format of the Cl type/Relationship tree.

The following options are available:
« by Display label

« by Class name
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Ul Element (A-Z) Description

« by Legacy class name

<ClI Select the required CI type or relationship.
type/Relationship
tree>
Relationship Select the direction of the relationship.
Direction
| Note: Only relevant for relationships.
Relationship The name of the relationship.
Name
| Note: Only relevant for relationships.
Relationship Select an option to define how to handle relationships between identical query
Restrictions nodes or self relationships in the query results. A self relationship is a

relationship that leads from a query node to itself.
« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that
leads to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appearin
the query results.

| Note: Only relevant for relationships.

Choose Operation for Selected Items Dialog Box
This dialog box enables you to create models and views from selected Cls.
To access  Inthe Modeling Studio, drag Cls from the Cl Selector onto the empty canvas.

Important = You can drag individual or multiple Cls onto the canvas. You can select ordinary Cls
information = and/or models to drag onto the canvas. To select multiple Cls, hold the CTRL key
while selecting Cls.

See also » "Building a Business View" on page 253
« "Business Cl Models" on page 259

« "Modeling Studio User Interface" on page 284
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User interface elements are described below:

Ul Element
(A-2) Description

Create a new | Select to build a model comprising the Cls in your selection. If the Cls you dragged
model onto the canvas include at least one Cl that has no valid links to any of the model ClI
types, this option is disabled.

Create a new = Select to build a view based on the CI collection formed by your selection.

view

Edit the Select to edit the selected model in the Model Editor.

model of the

selected CI Note: This option only appears when a single model is dragged onto the

canvas.

Conditions of Related Cls Dialog Box

This dialog box enables you to define conditions for the Cl types in a reveal path.

To Click the Add Condition or Edit Condition button from the Conditions column of the
access Reveal Cls dialog box.

See « "Revealed Cls and Watchpoints" on page 264

also « "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element (A-

Z) Description

i Add the attribute condition you have defined.

g Delete an attribute condition.

i Move a selected row up.

|£| Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or to link multiple
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Ul Element (A-
Z) Description

conditions.
Attribute name  Select an attribute from the list.

L ) Brackets Click inside the Brackets box to display a list of brackets you can use to build
more complex, logical statements.

Criteria Contains the attribute condition definition as defined in the Cl Instances dialog
box.

Not Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the Cl
instances that were not assigned a value. For example, your system
contains three node Cls: Node1 is assigned the value A, Node2 is assigned
the value B and Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the results of your
query only include Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on
page 38.
Value Enter or select the value of the attribute. The Value options vary according to the

attribute type you select.

Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing path.

To To define a new reveal path, click the Reveal foy button from the Model Editor, and select

access  create Reveal Path.

To edit an existing reveal path, select a path from the Open Reveal Path dialog box and
click Edit.

To save areveal path, click Save Path from the Reveal Cls dialog box.

See « "Revealed Cls and Watchpoints" on page 264

also o "Modeling Studio User Interface" on page 284
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User interface elements are described below:

Ul Element
(A-Z)

Description
Name

Preview

Reveal
Path

Creating

Description

Enter a description of the path.
Enter the name of the path.

Opens the Reveal Cls dialog box displaying the related Cls in the path.

Note: This button does not appear in the Save Reveal Path dialog box.
Build the path by clicking the || button to open a dialog box with a Cl type tree. Select
the CI type for the next item in the path.
When you hold the pointer over a reveal path item, the following options are available:
« Delete Selected Item(s). Deletes the selected item from the reveal path.

« Add condition. Opens the Conditions of Related Cls dialog box, which enables
you to set conditions for the reveal path item.

« Refine Query Node Type. Opens a Cl type tree, which enables you to change
the CI type of the reveal path item.

New View Dialog Box

This dialog box enables you to select a perspective to create a view from a model.

To access

Important
information

Relevant
tasks

See also

In the Modeling Studio, right-click a model in the Model Editor, Perspective-based
View Editor, or Cl Selector and select Generate view for selected Model or click the

Generate view for selected model hd button from the Model Editor.

You select perspectives in the left pane and move them to the right pane using the
arrow buttons.

"How to Build a Perspective-based View Based on a Model " on page 282

« "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-2) Description
Available Perspectives A list of the available perspectives to apply to your model.
Selected Perspectives The perspectives you selected to apply to your model.

Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.

To access | Inthe Modeling Studio, right-click a query node in the Hierarchy pane of the Pattern
View Editor and select Define Cycles.

Important | You can extend the TQL query definition of a view by defining a cycle in the view

information = hierarchy. Select a query node in the Hierarchy pane to be the source query node. The
Cycle Definition dialog box displays the valid target query nodes for that source. The
target query node in the cycle, along with its hierarchy, is treated as a child or sibling
of the source query node (depending on your folding rule selection).

Relevant "How to Create a Pattern View" on page 269, "How to Create a Template" on page
tasks 270, "How to Create a Perspective" on page 272
See also « "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul

Element

(A-2) Description

Folding Select one of the following options:

Rule
« Folded cycle under source. The target query node becomes a child of the source
query node.

. Flattened cycle under parent. The target query node becomes a sibling of the
source query node.

Target Displays the valid target query nodes for the selected source query node. A query node is
defined as a valid target query node if all of the following conditions are true:

« itis related to the source query node

HPE Universal CMDB (10.31) Page 292 of 572



Modeling Guide
Chapter 8: Modeling Studio

ul
Element
(A-Z) Description

« itis an ancestor of the source query node (or the source query node itself)

« itis aquery based node (not a grouping node)

Hidden Cls Dialog Box

This dialog box enables you to restore hidden Cls to a view.

To From the Perspective-based View Editor, click the Show Hidden Cls button from the
access toolbar of the View Results pane.

See » "Building a Perspective-based View" on page 261

also « "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<check box> Select the check boxes for the Cls you want to restore.

Cl Type The ClI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected Cls in the view.

Select All Click Select All to select all the Cls in the list for inclusion in the view.
Unselect All Click Unselect All to clear the check boxes of all the Cls in the list.

Hierarchy Rules Dialog Box

This dialog box enables you to set the hierarchy of a view by defining hierarchy rules.

To access From the Hierarchy pane of the Pattern View Editor, when Rule Based is selected as
the hierarchy method, click the Add Hierarchy Rule [ button from the toolbar.

Important For each hierarchy rule you define, select a source Cl type, target Cl type,
information  relationship, and direction.
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Relevant "How to Create a Pattern View" on page 269, "How to Create a Template" on page
tasks 270, "How to Create a Perspective" on page 272
See also » "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

& Add. Adds a hierarchy rule.

g Delete. Deletes the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the selected hierarchy rule.
Relationship Select a direction from the drop-down list to edit the selected hierarchy rule.
Direction

Source Select a Cl type for the source Cl type from the drop-down tree to edit the

selected hierarchy rule.

Target Select a Cl type for the target Cl type from the drop-down tree to edit the
selected hierarchy rule.

Left Pane

This area enables you to browse views (including dynamic widgets) and TQL queries, search for Cls or
models to open in the Editor pane, and select Cl types to use in the TQL Query Editor or Pattern View
Editor.

To access Located to the left of the Editor pane in Modeling Studio.
Important The following tabs are available:
information

« Resources. Enables you to select a model, view, or TQL query to openin
the Editor pane.

« CI Selector. See "Cl Selector" on page 134.

o CI Types. Enables you to select Cl types from the tree to add as a query
node to your TQL query.

See also « "Templates and Perspectives" on page 256
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« "Modeling Studio User Interface" on page 284

Resources Tab

Important When Views or Queries is selected as the resource type, you can drag and drop
information views, queries, or folders to move them from one folder to another.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

gl New Folder. Creates a new folder in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

g Delete. Deletes the selected resource from the CMDB.
Note: When you delete a resource with dependent resources, the dependent
resources are also deleted. Dependent resources can include queries, views,
or custom reports.

= Refresh. Refreshes the resource tree.

|E| Expand All. Expands all the folders in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

|E| Collapse All. Collapses all the folders in the resource tree.
Note: This button only appears when Queries or Views are selected as the
resource type.

B When Queries or Views are selected as the resource type, click Hide Empty

Folders to display only folders containing views or TQL queries.

When Models is selected as the resource type, click Show only models with
content to display only models containing Cls.
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Ul Element
(A-Z)

W

o

@

&

Description
Filter Tree/Table.

When Views is selected as the resource type, click Filter Tree to filter the types of
views, templates, and dynamic widgets that appear in the tree.

When Queries is selected as the resource type, click Filter Tree to filter the TQL
queries that appear in the tree by query type.

When Models is selected as the resource type, click Filter Table to filter the
models in the table by Cl type.

Filter Tree by Bundle. Allows you to filter queries or views by predefined bundle.

If you select more than one bundle from the available list, each resource that
belongs to at least one of the bundles is displayed.

Note: This button is active only when the Filterable Bundles List setting is
configured in the Infrastructure Settings Manager. For details, see
"Infrastructure Settings Manager Page" in the HPE Universal CMDB
Administration Guide.

Open Query. Opens the selected TQL query in a new tab.

Note: This button only appears when Queries is selected as the resource
type.

Open View. Opens the selected view in a new tab.

Note: This button only appears when Views is selected as the resource type.

CI Properties. Enables you to view the properties of the selected model.
| Note: This button only appears when Models is selected as the resource type.

Show views containing selected Cl/model. Displays a list of views including the
selected Cl or model.

| Note: This button only appears when Models is selected as the resource type.

Open Model. Opens the selected model in the Model Editor.
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Ul Element
(A-Z)

2N

<Resources>

Description

Note: This button only appears when Models is selected as the resource type.

Pattern Based Model Scheduler. Enables you to modify the starting time and
repeat interval for all pattern-based models.

Note: This button only appears when Models is selected as the resource type.

Assign Tenants. Opens the Assign Tenants dialog box which enables you to
assign tenants to a model.

Note:
« This button only appears when Models is selected as the resource type.

« This button is only available when multi-tenancy is enabled.

Import From XML. Enables you to import XML files that contain saved views or
queries to the Modeling Studio.

Note: This button only appears when Queries or Views are selected as the
resource type.

Export To XML. Enables you to export the view or query as an XML script. This
option can be used to move a view or query from one workstation to another.

Note: This button only appears when Queries or Views are selected as the
resource type.

When Views or Queries is selected as the resource type, the available views or
TQL queries are displayed under their respective folders in tree format. When
Models is selected as the resource type, the available models are displayed in a
table.

For views, the following view types are included:
. % Denotes a pattern view.
. [ Denotes atemplate.

. i Denotes a template-based view.
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Ul Element

(A-2) Description

El Denotes a perspective.
L& Denotes a perspective-based view.

U Denotes an automation flow mapping. Only relevant when the Automation

Flow Adapter has been deployed. For details, see the UCMDB Browser
documentation.

¥ Denotes a dynamic widget.

Resource Select the resource type to display in the pane. The available options are Models,

Type Views, and Queries.

Note: The maximum number of models to be loaded into the Modeling Studio is
set to 400,000 by default. To change this setting, change the Maximum
number of models in view result setting in the Infrastructure Settings
Manager. For details, see "Infrastructure Settings Manager Page" in the HPE
Universal CMDB Administration Guide.

Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) available by right-clicking a

resource:

Menu Item

Assign Tenants

Create a new

Description

Open the Assign Tenants dialog box which enables you to assign
tenants to the resource.

Create a new view, template, or perspective.

View/Template/Perspective

Delete

Export To XML

Delete the selected resource from the CMDB.

Note: When you delete a resource with dependent resources,
the dependent resources are also deleted. Dependent resources
can include queries, views, or custom reports.

Export the view or query as an XML script. This option can be used
to move a view or query from one workstation to another.
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Menu Item Description

Manage Security Assign the selected resource to specific roles or resource groups.
Note: This option is not relevant for models.

New Folder Create a new folder in the resource tree.

New Template Based View Edit the parameters of the selected template to define a new
template-based view.

Note: This optionis only active when a template is selected in
the view tree.

Open Query/View/Model Open the selected view, TQL query, or model in a new tab.

Properties Opens the CI Properties dialog box for the selected model.

| Note: This optionis only relevant for models.

Refresh Refresh the resource tree.

Remove Remove the selected model.

| Note: This option is only relevant for models.

Rename Folder Rename the selected folder.

Save As Save the selected TQL query with a new name.

Show containing views Opens the Views containing selected Cl dialog box for the selected
model.

Note: This option is only relevant for models.

Cl Types Tab

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
B3 Expand All. Expands all the folders in the CI Type tree.
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Ul Element
(A-Z)

e

Tree View

(4]

<CI Type
tree>

ing Studio

Description

Collapse All. Collapses all the folders in the CI Type tree.

Displays the format of the Cl type tree. The following options are available:
« by Display label
« by Class name

« by Legacy class name

Add Selected CITs to Query. Adds the selected Cl type to the TQL query which is
open in the Editor pane.

Note: This button is only active when a view or TQL query is open in the Editor
pane.

Refresh. Refreshes the ClI Type tree.

The available Cl types are displayed in tree format.

Cl Types Tab Shortcut Menu

The Cl Types tab includes the following elements (listed alphabetically) available by right-clicking a Cl

type:
Menu ltem

Add Selected
CITs to Query

Go to Cl Type
Definition

Show Element
Instances

Description

Select to add the selected Cl type to the TQL query open in the Editor pane.

Takes you directly to the selected Cl type in CIT Manager.

Opens the Cl Instances window, which displays all instances of the selected
CIT. For details, see "Cl Instances Dialog Box" on page 65.

Manage Cl Watchpoints Dialog Box

This dialog box enables you to add or remove watchpoints for a Cl in a model.
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To From within a model in the Model Editor, click the Watchpoint ‘® button and select

access Manage Cl Watchpoints or right-click a Cl in the model and select Watchpoint >
Manage Cl Watchpoints.

See « "Revealed Cls and Watchpoints" on page 264

also

« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element

(A-Z) Description

Add Opens the New Watchpoint dialog box which enables you to add a new watchpoint.

g Remove Deletes the selected watchpoint.

Automated A check mark indicates that the new Cls found by the watchpoint are to be added to
the view automatically.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint The name of the reveal path associated with the watchpoint.

Name

Watchpoint Displays the reveal path for the watchpoint.

Path

Model Editor

This feature enables you to create and edit models.

To access  |nthe Modeling Studio, click the New ki button and select Instance Based Model
to create a new model or select Models as the Resource type and open an existing
model.

Important The Model Editor contains the following panes:

information

« Content pane. Lists the Cls and models contained in the model.

« Information pane. Displays the properties, related Cls and watchpoints for the
selected Cl or model.

You can drag Cls from the Cl Selector into the Content pane of an existing model to
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add them to the model. However, you cannot drag in a Cl that is already included in
the model.

You can drag Cls from the CI Selector into the Related Cls tab of the Information
pane provided that the selected source and target Cl can be related by a usage

relationship.
Relevant "How to Build an Instance-based Model " on page 280
tasks
See also « "Business Cl Models" on page 259

« "Modeling Studio User Interface" on page 284

Content Pane

User interface elements are described below:

Ul Element (A-Z) Description
122 Map Map. Displays the Cls as icons in a diagram.
E Text Text. Displays the Cls in alist.
|; CI Properties. Opens the Configuration Item Properties dialog box for the
selected Cl.
53] Show models containing selected CIl. Displays a list of the models

containing the selected ClI.

LE Show views containing selected Cl/model. Displays a list of the views
containing the selected Cl or model.

éo Open selected model in a new tab. Opens the selected model ina
separate Model Editor tab.

Ld Generate view for selected model. Enables you to create a view based
on the current model. The Creating New View dialog box opens, which
enables you to select a perspective to apply.

x® Remove Selected Cl(s) from the Model. Removes a selected Cl from
the model (it remains in the CMDB).
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Ul Element (A-2) Description

& Insert new model Opens the New Model dialog box which enables you to
define a new model within the existing model.

BE Expand All. Expands the model hierarchy.
Bl Collapse All. Collapses the model hierarchy.
i Reveal. Includes the following options:

« Start Revealing. Opens the Reveal Cls dialog box. For details, see
Reveal Cls dialog box.

« Create Reveal Path. Opens the Create Reveal Path dialog box. For
details, see Create Reveal Path dialog box.

« Open Reveal Path. Opens the Open Reveal Path dialog box. For
details, see Open Reveal Path dialog box.

ey Watchpoint. Includes the following options:

« Watchpoints Updates. Enables you to display the watchpoint results
and select Cls to add to the model. For details, see Watchpoints
Updates dialog box.

« New Watchpoint. Enables you to define a new watchpoint for the
selected Cl. For details, see New Watchpoint dialog box.

« Manage Cl Watchpoints. Enables you to add new watchpoints to the
Cl or remove existing ones. For details, see Manage Cl Watchpoints
dialog box.

=] CI Collection. Enables you to group Cls in a collection under a model.
Select one of the following options:

« Insert New CI Collection. Create a new empty CI Collection. After
creating the collection, you can drag Cls into it from the Cl Selector, the
related Cls tab, or from the model itself.

« Join to CI Collection. Select a Cl or several Cls in the model and join
them to an existing CI collection or form a new collection.

« Decompose Cl Collection. Select a Cl collection and decompose it.
Its Cls remain directly under the main model.

HPE Universal CMDB (10.31) Page 303 of 572



Modeling Guide

Chapter 8: Modeling Studio

Ul Element (A-2)

k Select -

= Prit...

0

Cl Type column

Find

Description

Find. Toggles between displaying and hiding the Find box and arrow
controls.

Note: This button only appears in Text mode.

Refresh. Refreshes the map to optimize the layout.
| Note: This button only appears in Map mode.
Fit to Window. Resizes the map to fit the size of the pane.

Note: This button only appears in Map mode.

Select the functionality of the cursor from the Mode drop-down. The
following options are available:

« Select
« Drag Map

e ZoomIn

Note: This feature only appears in Map mode.
Print. Enables you to select Print, Print Preview or Print Setup.

Show External Relationships. Displays the related Cls for the selected
Cl.

Note: This button only appears in Map mode.

Hide External Relationships. Hides the related Cls of the selected CI.

Note: This button only appears in Map mode.

Indicates that watchpoints are defined for the current CI.

Indicates that the watchpoints have detected new Cls related to the
current model. Click it to open the Watchpoints Updates dialog box.

Displays the type of each Cl in the model.

Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in
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Ul Element (A-2)

Find Next

Find Previous

Highlight

Name column

Description
the model.

Click to go to the next occurrence of the selected search phrase in the
model.

Click to go to the previous occurrence of the selected search phrase in the
model.

Click to highlight all occurrences of the search phrase in the model.

Displays the name of each ClI in the model.

Shortcut Menu Options

Menu Item

Cl Collection

Fit to Window

Generate view
for selected
model

Hide External
Relationships

Insert New
Model

Description

Click CI Collection to group Cls in a collection under a model. Select one of the
following options:

« Insert New CI Collection. Create a new empty collection. After creating
the collection, you can drag Cls into it from the Cl Selector, the related Cls
tab, or from the model itself.

« Join to CI Collection. Select a Cl or several Cls in the model and join them
to an existing CI collection or form a new group.

« Decompose Cl Collection. Select a Cl collection and decompose it. Its
Cls remain directly under the main model.

Resizes the map to fit the size of the pane.
Note: This option only appears in Map mode.
Creates a view based on the current model. The Creating New View dialog box
opens which enables you to select a perspective to apply.
Hides the related Cls from the map.

Note: This option only appears in Map mode.

Opens the New Model dialog box which enables you to create a new model
within the existing model.
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Menu Item

Open selected
model in a new
tab

Print

Properties

Refresh Layout

Remove
Selected Cl(s)
from the Model

Reveal

Select

Show
Containing
Models

Show

HPE Universal CMDB (10.31)

Description

Opens the selected model in a separate Model Editor tab.

Select one of the following options:
o Print
o Print Preview

o Print Setup
Opens the Configuration Item Properties dialog box for the selected Cl.

Refreshes the map and optimizes the map layout.
Note: This option only appears in Map mode.

Deletes the selected Cls from the model (it remains in the CMDB).

The following options are available:

« Start Revealing. Opens the Reveal Cls dialog box. For details, see Reveal
Cls dialog box.

« Open Reveal Path. Opens the Open Reveal Path dialog box. For details,
see Open Reveal Path dialog box.

Select the functionality of the cursor. The following options are available:
o Select
o Drap Map

e Zoom In

Note: This option only appears in Map mode.

Displays a list of the models containing the selected CI.

Displays a list of the views containing the selected Cl or model.
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Menu Item

Containing
Views

Show External

Relationships

Watchpoint

Zoom

Description

Displays the related Cls for the selected ClI.

Note: This option only appears in Map mode.

The following options are available:

« Watchpoints Updates. Display the watchpoint results and select Cls to
add to the model. For details, see Watchpoints Updates dialog box.

« New Watchpoint. Define a new watchpoint for the selected Cl. For details,
see New Watchpoint dialog box.

« Manage Cl Watchpoints. Add new watchpoints to the Cl or remove
existing ones. For details, see Manage C| Watchpoints dialog box.

Select the size of the map from the list of percents.

Note: This option only appears in Map mode.

Information Pane - Properties Tab

This area displays the properties of the selected ClI.

Important This pane is identical to the Properties tab of the Information pane in IT Universe

information Manager. For details, see "Configuration Item Properties Dialog Box" on page 217.

Information Pane - Related Cls Tab

This area displays the Cls related to the model by one of the triplets that includes an Impacted By
(Potentially) relationship.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
g Click to delete the relationship to the selected CI.
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Ul Element
(A-2) Description
& Click Invert Direction to switch the direction of the relationship for the selected ClI.
Note: This option is only active for Cls related by a usage relationship.
<ClI list> Lists the name and ClI type of the Cls related to the model by usage relationships, as
well as the direction of the relationship.
Filter by Select a field by which to filter the results and enter the value in the by box.

Information Pane - Watchpoints Tab
This area displays the watchpoints defined for the selected ClI.

User interface elements are described below:

Ul Element (A-

Z) Description

& Click to open the Manage Cl Watchpoints dialog box, which enables you to edit
the watchpoint.

Automated Indicates whether the new Cls found by the watchpoint are automatically added
tothe view.

Source CI Displays the CI forming the beginning of the reveal path.

Watchpoint The name of the reveal path associated with the watchpoint.

Name

Watchpoint Displays the reveal path of the watchpoint.
Path

Modeling Studio Page

This page enables you to create and edit models and views.

To access = Select Modeling Studio from the Navigation Menu or select Managers > Modeling
> Modeling Studio.

Important = The Modeling Studio page contains the following panes:

HPE Universal CMDB (10.31) Page 308 of 572



Modeling Guide
Chapter 8: Modeling Studio

information . Left pane. Enables you to search for Cls or select a view, model, or TQL query to
open. For details, see "Left Pane" on page 294.

« Editor pane. Displays the topology map of a selected view, model, or TQL query.
The Editor pane is a blank canvas before any views or models are opened. When you

open a view, model, or TQL query, the relevant editor appears there. Multiple views,
models, and queries can be open at the same time in the Editor pane, each within a

separate tab.

Relevant « "How to Create a Pattern View" on page 269
tasks « "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

« "How to Create a Dynamic Widget" on page 274

« "How to Create a Template Based View" on page 276

« "How to Create Multiple Template Based Views" on page 277

« "How to Build an Instance-based Model " on page 280

« "How to Build a New Pattern-based Model " on page 281

« "How to Define Report Settings" on page 279

« "How to Build a Perspective-based View Based on a Collection of Cls" on page

283

« "How to Build a Perspective-based View Based on a Model " on page 282

See also « "Building a Perspective-based View" on page 261

« "Business Cl Models" on page 259

« "Creating Template Based Views" on page 258
« "Templates and Perspectives" on page 256

« "View Formats" on page 252

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-Z) Description

D New New. Select one of the following options:
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ul
Element
(A-Z) Description

« Instance Based Model. To create a new instance based model.

« Pattern Based Model. To create a new pattern based model.

« Pattern View. To create a new pattern view.

. Template Based View. To create a new template-based view.

« Perspective Based View. To create a new perspective-based view.
o Template. To create a new template.

« Perspective. To create a new perspective.

« Dynamic Widget. To create a new dynamic widget for the UCMDB Browser.

o Query. To create anew TQL query.

« Automation Flow Mapping. To create an automation flow mapping. Only relevant

when the Automation Flow Adapter has been deployed. For details, see the

UCMDB Browser documentation.

Ei Save. Saves the changes to your view, model, or query.

For views, a dialog box opens which enables you to rename your view and save it in the

appropriate folder.

|FZ: Save As. Enables you to save your view, model, or TQL query under a new name.

Undo. Reverses the last change you made.

3]

Redo. Repeats the last action you took.

0

the editor.

<Menu> | For details, see "Main Menu" on page 163.

Models Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the models containing the selected ClI.

Maximize Workspace. Toggles between the regular display and a full-screen display of

To Click the Show models containing selected CI & putton in the Model Editor or select
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access Show containing models from the shortcut menu.

See « "Business Cl Models" on page 259

also « "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element

(A-2) Description

|; CI Properties. Opens the Configuration Item Properties dialog box for the selected
model.

) Show views containing selected Cl/model. Displays a list of views containing
the selected model.

g Remove model. Deletes the selected model.

Cl Type Displays the ClI types of the models containing the selected CI.

Find Enter a model name or a portion of a model name in the Find box to locate it in the
list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.

Previous

Name Displays the names of the models containing the selected ClI.

Note: The name of the current model appears in faded text.

New Model Dialog Box

This dialog box enables you to define a reusable model containing a collection of Cls.

To access Click the New |21/ button and select Instance Based Model or dragaCl

from the tree in the CI Selector onto the editing pane and select Create a

new model.
Relevant tasks "How to Build an Instance-based Model " on page 280
See also « "Business Cl Models" on page 259
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« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element
(A-2) Description

Define new Cl = Enter the values for the CI properties. You must enter values for required
Properties properties. The required properties are marked with an asterisk.

Select Cl Type Select a Cl type from the list to serve as the basis for your model.

New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or perspective using the Pattern
View Editor.

To access  |nthe Modeling Studio, click the New | button and select Pattern View, Template,
or Perspective from the drop-down menu.

Important = After making your selection and clicking OK, you go directly to the Pattern View
information Editor to begin building your view. For details, see "Pattern View Editor" on page 318.

Relevant "How to Create a Pattern View" on page 269, "How to Create a Template" on page
tasks 270, "How to Create a Perspective" on page 272
See also » "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-Z) Description

@ Find Next. Goes to the next occurrence of the selected search phrase in the list of TQL
queries.

&) Find Previous. Goes to the previous occurrence of the selected search phrase in the list
of TQL queries.

E Highlight All. Highlights all occurrences of the search phrase in the list of TQL queries.
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ul
Element
(A-Z) Description

<TQL Displays the existing TQL queries in tree format.

query
tree>

Choose | If you want to base your new view on an existing TQL query, select this option and select
base a TQL query from the tree. The Pattern View Editor opens with the selected TQL query on
query the canvas.

Create If you want to base your new view on a new TQL query, select this option. The Pattern

new View Editor opens with a blank canvas.
query
Find Enter a TQL query name or a portion of a query name in the Find box to locate a TQL

query in the list.

New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a Cl in a model.

To access From within a model in the Model Editor, click the Watchpoint ) button and select

New Watchpoint or right-click a Cl in the model and select Watchpoint > New
Watchpoint.

Important If no reveal paths are found for the selected Cl, no watchpoints can be defined.

information , . . .
You cannot define watchpoints for Cls in a new model until you save the model.
Relevant "How to Build an Instance-based Model " on page 280
tasks
See also « "Revealed Cls and Watchpoints" on page 264

« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element (A-Z) Description

Automatically Select to automatically add all revealed Cls from the selected path to the
update model model.
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Ul Element (A-Z) Description

Note: In a multi-tenancy environment, this action requires Data Update
permission in connection with all tenants of the model.

Control updates = Select to manually add revealed Cls from the selected path to the model.

manually

Select Select a reveal path from the drop-down list.

Watchpoint

reveal path

Show reveal Select a Cl type from the drop-down list. All reveal paths beginning with that Cl

paths for Cl type | type appear in the list in the lower drop-down box.

Open Reveal Path Dialog Box

This dialog box enables you to open an existing path.
Toaccess  From within a model in the Model Editor, click the Reveal ‘& putton and select Open
Reveal Path orright-click a Cl in the model and select Reveal > Open Reveal Path.

Important = After selecting the reveal path you want to use, click Execute. If Cls are found on the
information = selected path, the Reveal Cls dialog box opens for that path. If no Cls are found, a
message appears stating that no Cls were found on the path.

See also « "Revealed Cls and Watchpoints" on page 264

« "Modeling Studio User Interface" on page 284

User interface elements are described below:
Ul Element (A-2) Description
Description column  Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you to edit the
selected path.

Execute Opens the Reveal Cls dialog box for the selected reveal path.

Find Enter a path name or a portion of a path name in the Find box to locate a
pathin the list.
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Ul Element (A-2) Description

Find Next Click to go to the next occurrence of the selected search phrase in the list of
paths.

Find Previous Click to go to the previous occurrence of the selected search phrase in the
list of paths.

Highlight Click to highlight all occurrences of the search phrase in the list of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths Select a Cl type from the drop-down list. All paths beginning with the
for ClI type selected Cl appear in the table below.

Pattern Based Model Scheduler Dialog Box

This dialog box enables you to set the starting date and time and the repeat interval for Pattern-based
models.

To access |, the Modeling Studio, click the Pattern Based Model Scheduler © putton in the

Resources tab of the left pane.

Important  All the pattern-based models are updated at the same time. The settings you select

information = apply to all existing pattern-based models as well as those created subsequently. The
default starting time for model updates is the server time at the time the first model is
created. When you open the dialog box, the default starting time is the current server
time at that moment. The default repeat interval is 12-hours.

Relevant "How to Build a New Pattern-based Model " on page 281
tasks
See also « "Business Cl Models" on page 259

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Advanced Pattern Based Model = Select this option to schedule the pattern-based model
Scheduler Updates updates using a Cron expression.
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Ul Element (A-2)

Cron Expression

Daily Pattern Based Model
Scheduler Updates

Repeat interval

Server time

Start at

Validate Expression

Description

When Advanced Pattern Based Model Scheduler Updates
is selected, enter a Cron expression.

For a description of the fields used in Cron expressions and
examples of how to use them, see "Cron Expressions"” on
page 359.

Select this option to schedule the pattern-based model
updates using a starting date and time and a repeat interval.

When Daily Pattern Based Model Scheduler Updates is
selected, select an option for the repeat interval (in hours).
This determines the frequency of the pattem-based model
updates.

Note: The repeat interval must be evenly divisible in a 24-
hour period to ensure that the updates are performed at
the same hours each day.

Displays the time on the server.

Select a starting date and time for the pattern-based model
updates.

After entering a Cron expression, click the Validate
Expression button to confirm that the expression is valid.

Pattern Based Model Wizard

This wizard enables you to build a pattern-based model.

To access |, the Modeling Studio, click the New |4l button and select Pattern Based Model

from the drop-down menu.

Important When you create a pattern-based model, the model is saved as a Cl, as with an

information instance-based model. If you based your model on a new TQL query, the query is also

saved and appears in the TQL query tree.

When you build a pattern-based model over an existing instance-based model, the

model is saved with the name of the instance-based model.
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If you create a new pattern-based model with the same name as a previously deleted
pattern-based model, you can select an old query on which to base the new pattern-
based model or you can create a new query.

Relevant "How to Build a New Pattern-based Model " on page 281
tasks

Wizard The Pattern Based Model Wizard contains:

map

"Select Cl Type Page" > "Query Selection Page"

See also « "Pattern-based Models" on page 260

o "Modeling Studio User Interface" on page 284

Select Cl Type Page
This wizard page enables you to select a Cl type for the model and define its details.
Wizard map The Pattern Based Model Wizard contains:

"Select Cl Type Page" > "Query Selection Page"

User interface elements are described below:

ul
Element
(A-2) Description

Existing Select Existing Model to build a pattern-based model over an existing instance-based

Model model. Select an existing model from the tree.
New Select New Model to create a new pattern-based model (unrelated to any other model).
Model In the Select Cl Type section, select a Cl type from the list to serve as the basis for your

model. Then enter the values for the Cl properties in the Define New Cl Properties
section.

Query Selection Page

This wizard page enables you to select a TQL query upon which the model is based.

Wizard map The Pattern Based Model Wizard contains:

"Select Cl Type Page" > "Query Selection Page"
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z)

=

<TQL
Query
tree>

Choose
base

query

Create

new
query

Find

Description

Find Next. Goes to the next occurrence of the selected search phrase in the list of TQL
queries.

Find Previous. Goes to the previous occurrence of the selected search phrase in the list
of TQL queries.

Highlight All. Highlights all occurrences of the search phrase in the list of TQL queries.

Displays the existing TQL queries in tree format.

If you want to base your model on an existing TQL query, select this option and select a
query from the tree. The TQL Query Editor opens with the selected query on the canvas.

If you want to base your model on a new TQL query, select this option. The TQL Query
Editor opens with a blank canvas.

Note: When you create a pattern-based model based on a new query, the query's
priority is automatically set to Not Active.

Enter a TQL query name or a portion of a query name in the Find box to locate a query in
the list.

Pattern View Editor

This feature enables you to build and edit pattern views, templates, and perspectives.

To access

Important

To open a new view in the Pattern View Editor, go to the Modeling Studio, click the

New L& button and select the required type of view.

To open an existing view in the Pattern View Editor, go to the Resources tab of the
left pane in the Modeling Studio and select Views as the Resource type. Right-click a
view in the tree and select Open View or double click a view or drag a view onto the
Editor pane. The topology map of the view opens in the Editor pane.

You can access the Editor in one of the following modes:

HPE Universal CMDB (10.31) Page 318 of 572



Modeling Guide
Chapter 8: Modeling Studio

information .« InView mode, the following panes are included:
o Query Definition pane. For details, see "TQL Query Editor" on page 346.
o Advanced pane. For details, see "Advanced Pane" on page 1.

o Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the
right portion of the Editor page.)

« InReport mode, the following panes are included:

o Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the
left portion of the Editor page.)

o Query Node Definition. Enables you to select the attributes to be included in
the report and to set their order.

« In Widget mode, the following panes are included:

o Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the
left portion of the Editor page.)

o Widget Node Definition. Enables you to specify options for the Cl's
attributes to be included in the dynamic widget.

Note: Widget mode is available only when creating or editing a dynamic
widget.

Note: To save your view, template, perspective, or dynamic widget, use the
Save button on the Modeling Studio main toolbar.

Relevant o "How to Create a Pattern View" on page 269
tasks « "How to Create a Template" on page 270
o "How to Create a Perspective" on page 272

« "How to Create a Dynamic Widget" on page 274

See also « "Building a Perspective-based View" on page 261
« "Templates and Perspectives" on page 256

« "Modeling Studio User Interface" on page 284

Hierarchy Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element
(A-Z)

=]

Description

Add Group By. Enables you to create a subgroup in the hierarchy. The following
options are available:

« Add Group By Attribute. Opens the Query Node Grouping dialog box, which
enables you to select an attribute for a subgroup in the hierarchy.

« Add Group By CI Type. Create a subgroup in the hierarchy for the Cl type of the
selected query node.

o Add Group by View Node. Create a subgroup in the hierarchy for the selected

query node only.

Note: You cannot define subgroups on a contact query node of a perspective.

Edit Group By Attribute. Opens the Query Node Grouping dialog box, which enables
you to edit the attribute for a subgroup in the hierarchy.

Rename. Enables you to rename the selected query node.

Delete View Node Deletes the selected query node from the hierarchy tree.

Move View Node Layer Up. Moves the selected query node one layer higher in the
hierarchy.

Move View Node Layer Down. Moves the selected query node under the query node
above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree,
clicking Move View Node Layer Down places it under the query node beneath it
in the hierarchy.

Move View Node Up. Moves the selected query node up in the hierarchy tree. The
query node order in the hierarchy determines the query node order in the report
generated for the view in Reports.

Move View Node Down. Moves the selected query node down in the hierarchy tree.
The query node order in the hierarchy determines the query node order in the report
generated for the view in Reports.

Preview. Displays a preview of the topology report.
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Ul
Element
(A-Z)

<Hierarchy
tree>

Hierarchy
Method

Description

Note: This option only appears in the Hierarchy pane when Report mode is
selected.

Report Properties. Opens the Report Properties dialog box, which enables you to set
the title, subtitle, and format for the view's topology report. For details, see "Report
Properties Dialog Box" on page 430.

The query nodes of the TQL query are arranged in a hierarchical tree reflecting the
hierarchy defined for the view.

You can click and drag query nodes to change the hierarchy. When you click a query
node and begin to drag it, the query nodes under which it is possible to place your
query node are highlighted in green.

Select the method of setting the hierarchy:

o Manual. Set the hierarchy manually, by dragging query nodes and using the toolbar
buttons.

« Rule Based. Open the Hierarchy Rules dialog box which enables you to set rules
for the hierarchy.

Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically) available by right-clicking a

query node in the hierarchy tree:

Menu Item

Add Group
By Attribute

Add Group
By CI Type

Add Group
By View
Node

Define

Description

Select Add Group By Attribute to open the Query Node Grouping dialog box,
which enables you to select an attribute for a subgroup in the hierarchy.

Select Add Group By CI Type to create a subgroup in the hierarchy for the Cl type
of the selected query node.

Select Add Group By View Node to create a subgroup in the hierarchy for the
selected query node only.

Select Define Cycles to define a cyclical hierarchy. For details, see "Cycle
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Menu Item
Cycles

Delete View
Node

Move View
Node Down

Move View
Node Layer
Down

Move View
Node Layer
Up

Move View
Node Up

Rename

Set View
Node
Invisible

Set View
Node Visible

Subgraph
Hierarchy

HPE Universal CMDB (10.31)

Description

Definition Dialog Box" on page 292.

Select to delete the selected query node from the hierarchy tree.

Select to move the selected query node down in the hierarchy tree.

Select Move View Node Layer Down to place the selected query node under the
query node above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree,
selecting Move View Node Layer Down places it under the query node
beneath it in the hierarchy

Select Move View Node Layer Up to place the selected query node one layer
higher in the hierarchy.

Select to move the selected query node up in the hierarchy tree.

Select to rename the selected query node.

Select to set the selected query node invisible. Cls of this type do not appear in the
view results.

When this option is selected, a Hidden in Query Results indicator & appears in
the corner of the selected query node in the hierarchy tree.

Select to set the selected query node visible. Cls of this type appear in the view
results.

Enables you to define whether the subgraph defined for the selected query node is
displayed as flat or as folded under the query node.

Note: This option is only relevant for query nodes that have a defined
subgraph.
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Query Node Definition Pane

Important The Query Node Definition pane is disabled for template based views. To make

information = changes to the report layout, edit the based template of the view. When you open a
template based view in the Editor and select the Report tab, a warning message
appears containing a link to the base template of the view.

User interface elements are described below:

ul
Element
(A-Z) Description
M Up. Moves a selected attribute up in the report layout order.
b Down. Moves a selected attribute down in the report layout order.
1% Edit. Enables you to edit the function for the selected attribute.
P Delete. Deletes the selected attribute from the report layout.
> Moves the selected attributes to the Report Layout list.
Add Click Add Function to open the Add Function dialog box, which enables you to define

Function  the functions to include in the report for the selected query node. Each function that you
add is treated as an attribute and becomes a column in the report.

Note: This button is only active if there is a query node below the selected query
node in the view hierarchy.

Attributes The list of available attributes for the selected query node.

Define Click Define Chart to display the data for the current layer of the view in a graphical
Chart chart format. The Chart Properties fields are displayed.

The Define Chart option is only active for a query node or a grouping node that:
« is the top layer of the view and has a layer below it in the view hierarchy
« is the only query node on its layer of the view

« has at least one numeric attribute selected for the report layout

Report Displays the list of attributes selected to appear in the report. Use the toolbar buttons to
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Ul

Element

(A-Z) Description

Layout change the order of the attributes in the report and to add functions.

Set Sort | Click to open the Set Column Sort Order dialog box which enables you to set the order

Order of t

he report columns.

Chart Properties

The Chart Properties portion of the pane includes the following elements (listed alphabetically):

Ul Element (A-
Z)

=
o

Breakdown by

Chart Type

Value

Description

Remove Chart. Removes the chart from the report. The report is generated in
table format.

The chart is broken down by the CI or grouping node display label. This is fixed for
all reports.

Select Pie to create a pie chart or Bar to create a bar chart.

Select a value from the drop-down list.

Widget Definition Pane

User interface elements are described below:

Ul Element
(A-2)

<Enforce
Browser CI

access
control>

<Show
path>

Attribute
name

HPE Universal CMDB (10.31)

Description

Select this check box to ensure that the dynamic widget displays data only
according to the permissions that were specified on the Browser Cl Access Control
tab in the Roles manager. If the check box is not selected, the dynamic widget
displays all data, without permission enforcement.

Select this check box to cause the UCMDB Browser to display the route in the
dynamic widget from a specific node in the view definition to all the node's children.

The attributes for the selected node that are displayed in the dynamic widget.
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Ul Element

(A-2) Description

Details Specifies whether this attribute appears in the Widget Details mode.

Group Specifies the name under which the attribute is grouped in the Widget Details mode.
Name

Overview Specifies whether this attribute appears in the Cl Overview mode.

Refocusable Specifies whether this attribute is displayed as a hyperlink, able to refocus on the Cl
on which the attribute is defined.

Widget Enables you to select an initial display mode. The available types are:

Type
yp « Properties Mode. Displays individual properties for Cls.

Note: If you do not select a Widget Type value, Properties Mode is enabled
by default.
« Topology Map Mode. Displays Cls according to your current topology.

« Topology CIT Group Mode. Displays Cls grouped by Cl type according to your
current model.

« Topology Textual Mode. Displays a list of Cls broken down by ClI type.

The topology mode that you select is the initial view selection until you change to
another one in the UCMDB Browser.

Perspective-based View Editor

This feature enables you to create and edit perspective-based views.

To access | |n the Modeling Studio, click the New |/ button and select Perspective Based View
to create a new view or drag Cls from the CI Selector onto the blank canvas and
select Create a new view.

To open an existing view in the Editor, select Views as the resource type in the
Resources pane, select the required perspective-based view from the tree, and click

Open View I or double-click the view.

Important The Perspective-based View Editor contains the following panes:

information , , ,
« Content pane. Drag Cls and/or models onto this pane to include them in your
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view.
« Perspective pane. Select perspectives to apply to the content to build a view.

« View Results pane. Displays a topology map with a preview of the current view.
This pane includes most of the IT Universe Manager functionality.

Relevant « "How to Build a Perspective-based View Based on a Model " on page 282

tasks « "How to Build a Perspective-based View Based on a Collection of Cls" on page
283

See also « "Building a Perspective-based View" on page 261

« "Modeling Studio User Interface" on page 284

Content Pane

User interface elements are described below:

ul

Element

(A-Z) Description

@ Show View Results in IT Universe. Goes directly to the current view in IT Universe
Manager.

|§i Properties. Opens the Configuration Item Properties dialog box for the selected Cl.

& Show models containing selected Cl. Displays alist of the models containing the
selected Cl.

L Show views containing selected Cl/model. Displays a list of the views containing
the selected Cl or model.

&% Open selected model in a new tab. Opens the selected model in a separate Model
Editor tab.

La Generate view for selected model. Enables you to create a view based on the

selected model. Opens the Creating New View dialog box where you can select a
perspective to apply.

Remove Base Cls. Removes the selected Cl from the view content.
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ul

Element

(A-Z) Description

= View Definition Properties. Opens the View Definition Properties dialog box which
enables you to set properties for the view.

Find. Toggles between displaying and hiding the Find box and arrow controls.

Cl Type  Displays the type of each Cl in the view.

column

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the view.
Find Click to go to the next occurrence of the selected search phrase in the view.

Next

Find Click to go to the previous occurrence of the selected search phrase in the view.
Previous

Highlight Click to highlight all occurrences of the search phrase in the view.

Name Displays the name of each Cl in the view.
column

Shortcut Menu Options

Menu Item Description

Generate view for = Select to create a view based on the selected model. The Creating New View

selected model dialog box opens which enables you to select a perspective to apply.
Open selected Opens the selected model in a separate Model Editor tab.

model in a new

tab

Properties Opens the Configuration Item Properties dialog box for the selected Cl.
Remove Base Deletes the selected Cl or model from the view content.

Cls

Show Containing = Click to display a list of the models containing the selected CI.
Models

Show Containing Click to display a list of the views containing the selected Cl or model.
Views
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Perspective Pane

User interface elements are described below:

Ul Element
(A-Z)

#H
i

1t

Apply Over
Model
Hierarchy

Perspectives

Description

Remove perspective step. Deletes the selected level of the perspective selection.

Move step up. Shifts the perspective selection from the current level to the previous
one.

Move step down. Shifts the perspective selection from the current level to the
following one.

Add perspective step. Adds a new level to the perspective selection. The results of
the previous perspective level serve as the input content for the new level.

Select perspectives. Opens a dialog box with the available perspectives. Move the
required perspectives from the available column to the selected column using the
arrow buttons.

To view a perspective definition, select a perspective in either column and click the
Open Definition link. The perspective definition opens in a separate tab.

For views based on models, select the Apply Over Model Hierarchy check box to
include the model hierarchy in the view and apply the perspectives to the Cls
included in the model as well as to the model itself. Clear the check box to exclude
the model hierarchy from the view and apply the perspectives to the model itself
only. In this case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a collection of Cls oron a
model and a collection of Cls.

Lists the selected perspectives.

A default perspective appears in the window before any selection is made. You can
set the value of the default perspective using the Selected perspectives for new
perspective based views infrastructure setting.

HPE Universal CMDB (10.31) Page 328 of 572



Modeling Guide
Chapter 8: Modeling Studio

View Results Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

Map Displays the view results in Map mode.
Text Displays the view results in Text mode.

Group by Select a grouping method for the Cls in the topology map. The available options
are:

« Group by Layer. Group the Cls according to the value of the layer attribute
of their Cl type.

« Group by CI Type. Group the Cls according to their Cl type.

« Group by Classification. Group the Cls according to the value of the
classification attribute of their Cl type.

« No Grouping. Do not group Cls.

Note:

« This option is available in Map mode only.

« When a grouping option is selected, each group contains an indicator
displaying the number of Cls in the group. If a group contains a large
number of Cls, it opens in collapsed format, displaying only the name
and count indicator. Click the + sign button to expand the group and
display all the Cls. You can set the threshold of Cls for automatically
collapsing the group by modifying the Initially expand group max Cls

threshold setting in the Infrastructure Settings Manager.

{in Create Relationship. Creates a relationship between two Cls in the view.
B} Go Up One Layer. Moves up one level in the topology map.

¥ Drill Down One Layer. Moves down one level in the topology map.

= Delete from CMDB. Deletes the selected Cl from the CMDB.
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Ul Element (A-
Z)

=

0

hé

|

<Breadcrumbs>

<Legend>

Description

Show CI Properties. Opens the Configuration Iltem Properties dialog box for the
selected Cl.

Refresh. Refreshes the view results.

Hide CI from View. Hides the selected CI from the view. This option is only
relevant for Cls that were added to the view via the perspective. You cannot hide
Cls from the original view content from the view.

Note: Hidden Cls can be restored from the Hidden Cls dialog box.

Show Hidden Cls. Opens the Hidden Cls dialog box which enables you to
restore Cls that were hidden from the view manually.

Create view based on selected Cl/s. Enables you to create a new view based
on the Cls selected from the View Results pane.

Expand preview display. Displays the preview in a separate pane.

At the top of the topology map, the breadcrumbs indicate the relevant query
nodes in each layer of the view for the path to the selected layer. The first item in
the path is the Top Layer. When you select a Cl from the layer below, the parent
Cl forms the next item in the breadcrumb path. You can click on any item in the
path to display that layer in the topology map.

Indicates the icons displayed next to Cls with any of the following special
statuses:

o Added. When Change Timeframe is active, indicates that the Cl was added.
« Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

« Changed. When Change Timeframe is active, indicates that the Cl was
changed.

« Drill Down One Layer. Indicates that there are Cls under the Cl on alower
layer.

« External. Indicates that the Cl is a federated ClI.
« Impacted. When Impact Analysis is active, indicates an impacted ClI.

« Impacted and Trigger. When Impact Analysis is active, indicates a trigger
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Ul Element (A-
Z) Description
Cl that is impacted.
« Note. Indicates that a note was added for the CI.
« Trigger. When Impact Analysis is active, indicates a trigger CI.
<Topology The topology map in the View Results pane follows the layout of the topology
Map> map in IT Universe Manager. For details, see "Topology Map" on page 227.

<Topology Map For details, see "Topology Map Sidebar" on page 176.
Sidebar>

Shortcut Menu Options

Menu Item Description

<IT The IT Universe Manager shortcut menu options are available. For details, see "IT
Universe Universe Manager Page" on page 226.

Shortcut

Menu

options>

Create Select Create view based on selected Cl/s to create a new view based on the Cls
view selected from the View Results pane.

based on

selected

Clis

Hide CI Click to hide the selected CI from the view. This option is only relevant for Cls that

from View were added to the view via the perspective. You cannot hide Cls from the original view
content from the view. In the case of a view based on a model, the model cannot be
hidden but its Cls can.

Show Restore hidden Cls to the view.
Hidden
Cls

Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of Cls or to edit an existing grouping.
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To Click the Add Group by B button in the Hierarchy pane of the Pattern View Editor and

access  gelect Add Group by Attribute or right-click the required query node and select Add
Group by Attribute from the shortcut menu.

Relevant | "How to Create a Pattern View" on page 269, "How to Create a Template" on page 270,
tasks "How to Create a Perspective" on page 272

See also | « "Building a Business View" on page 253
« "Modeling Studio User Interface" on page 284
User interface elements are described below:

Ul Element (A-Z) Description

Expression capture Enter the number of the relevant portion of the regular expression. Enter 0

group index if the entire expression is relevant.
Group by Select an attribute from the drop-down list.
Mask to group by Enter a regular expression pattern representing the structure of the

selected attribute.

For details, see "Query Node Grouping" on page 254.

Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or view.

To access | |n the Modeling Studio, click the Query/View Definition Properties " putton in the
TQL Query Editor or Pattern View Editor.

Important In the View Definition Properties dialog box, you can select a default layout for the
information = view. Select an option under Map Layout or under Group by (only one option can be

selected).
Relevant o "How to Create a Pattern View" on page 269
tasks « "How to Create a Template" on page 270
o "How to Create a Perspective" on page 272
« "How to Define a TQL Query" on page 24
See also « "Building a Business View" on page 253
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« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element (A-Z)

Base Query

Bundles

Description

Group by

Inter-Layer Links

Managed by
Configuration Manager

HPE Universal CMDB (10.31)

Description
Select an existing TQL query on which to base your new query. Click
Clear Base Query |9| to remove the selected base query.
Note:
« This field is only relevant for TQL queries.
« This field is optional.
A method of grouping TQL queries or views by category. Select the

bundles associated with the current query or view or create a new bundle
forit.

Note: This field is optional.

A description of the TQL query or view.

Select a default layout for the view, when consuming it in IT Universe
Manager or the view preview. The available options are the ones
described under Group by in "Topology Map" on page 227.

Note:

« This field is only relevant for views.

« If you select a default layout (other than No Grouping) from this
drop-down, the Map Layout field is disabled.

Set the scope of inter-layer relationships displayed in the topology
results. For details, see "Inter-Layer Relationships" on page 190.

Note: This field is only relevant for views.

Select the check box to denote the view as managed in HPE Universal
CMDB Configuration Manager.

Note: This field is only relevant for views and only when HPE
Universal CMDB Configuration Manager is configured and running.
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Ul Element (A-2)

Map Layout

Persistent

Priority

Scope

Type

View refresh rate in
Configuration Manager

View type in
Configuration Manager

HPE Universal CMDB (10.31)

Description

Select a default layout for the view, when consuming it in IT Universe
Manager or the view preview. The available options are the ones
appearing under Layout in the Main Menu.

Note:

« This field is only relevant for views.

« This field is only active when No Grouping is selected under
Group by.

Select to define the TQL query as persistent. A persistent query remains
in the memory permanently.

Select a priority level for the TQL query or view from the drop-down list
(Low, Medium, High, Express, Not Active). This setting determines how
often the query should be rerun automatically by the system to include
updated information from the CMDB.

Note: When you change the priority of a view, the priority of the TQL
query on which the view is based is also changed.

Select the scope of the TQL query from the drop-down list.

Note: This field is only relevant for Integration TQL queries.

Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

If the view is set as Managed by Configuration Manager, select the
view refresh rate from the drop-down list.

Note: This field is only relevant for views and only when HPE
Universal CMDB Configuration Manager is configured and running.

If the view is set as Managed by Configuration Manager, select the
view type from the drop-down list.

Note: This field is only relevant for views and only when HPE
Universal CMDB Configuration Manager is configured and running.
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Reveal Cls Dialog Box

This dialog box enables you to search for Cls related to the Cls in a model and add them to the model.

To access | the Model Editor of the Modeling Studio, select a Cl, click the Reveal foy button,
and select Start Revealing or right-click a Cl in the model and select Reveal > Start

Revealing.

Important = The upper pane displays the Cl types of the Cls related to the selected Cl. The lower
information pane displays the Cls of the type selected in the upper pane.

The first step in the reveal path is the Cl type of the Cl you began with. When you
select a Cl type from the list in the upper pane, that Cl type becomes the second step
in the path. Click Next to display the Cl types available for the next step of the path.

The number at the top of the box in parentheses indicates the length of the
constructed path thus far.

Relevant "How to Build an Instance-based Model " on page 280
tasks
See also + "Revealed Cls and Watchpoints" on page 264

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
3% Delete Selected Item(s). Deletes a selected item from the Cls basket.
|; Cl Properties. Opens the Cl Properties dialog box for the selected CI.
Add Cls to basket. Adds a selected Cl from the lower pane to the Cls basket.
z Find Next. Goes to the next occurrence of the selected search phrase in the list of
Cls.
E Find Previous. Goes to the previous occurrence of the selected search phrase in the
list of Cls.
<Lower Displays alist of related Cls of the type selected in the upper pane.
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Ul Element
(A-Z)

pane>

Cl count
Cls Basket
Cl Type

Conditions

Find

Finish
Next

Reveal
path

Save Path

Description

Indicates how many related Cls of each type were found.
Displays the related Cls you selected to include in the model.
Displays alist of Cl types of the Cls related to the selected CI.

A check mark indicates that conditions were defined for the selected Cl type. Click
the Conditions column for the CI type you want to select and click the Add Condition
or Edit Condition button to open the Conditions of Related Cls dialog box. This
enables you to define and edit conditions for the Cl type.

Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the list of
Cls.

Click Finish when you have finished adding Cls to the Cl basket.
Click Next to display the Cl types available for the next step of the path.
Displays the reveal path being constructed.

Clicking the blue arrows in the path = displays a drop-down list of the Cl types

available for the next step of the path.
Clicking the Cl types in the path displays the following options:

« Jump to page. Refreshes the table with the available Cl types for the selected
step of the path.

« Edit Condition. Opens the Conditions of Related Cls dialog box.

« Delete Selected Item(s). Deletes the selected Cl type from the reveal path (the
path ends at the previous Cl type).

Opens the Save Reveal Path dialog box which enables you to save the path. This
option is only active when a unique reveal path has been constructed.

Save Query Dialog Box

This dialog box

To access

enables you to save a new TQL query.

In the Modeling Studio, click Save Bl when defining a new TQL query.
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Relevant tasks "How to Define a TQL Query" on page 24

See also « "Viewing TQL Query Results" on page 16

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

£ New Folder. Creates a new folder in the resource tree.

g Delete. Deletes the selected resource from the CMDB.

=l Refresh. Refreshes the resource tree.

B Expand All. Expands all the folders in the resource tree.

|E| Collapse All. Collapses all the folders in the resource tree.

> Find Next. Goes to the next occurrence of the selected search phrase in the tree.

@ Find Previous. Goes to the previous occurrence of the selected search phrase in
the tree.

E Highlight All. Highlights all occurrences of the search phrase in the tree.

<Resource Select a folder in the tree in which to save the query.

tree>

Find Enter a folder name or a portion of a name in the Find box to locate a folder in the
list.

Query Name Enter the name of the new TQL query.

Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based view, perspective-based view,
template, or perspective.

To In the Modeling Studio, click the Save || button when defining a new pattern view,

access  template-based view, perspective-based view, template, or perspective.
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See « "Building a Business View" on page 253

also « "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
& New Folder. Creates a new folder in the resource tree.
g Delete. Deletes the selected resource from the CMDB.
= Refresh. Refreshes the resource tree.
=) Expand All. Expands all the folders in the resource tree.
|E| Collapse All. Collapses all the folders in the resource tree.
z Find Next. Goes to the next occurrence of the selected search phrase in the tree.
@) Find Previous. Goes to the previous occurrence of the selected search phrase in
the tree.
E Highlight All. Highlights all occurrences of the search phrase in the tree.
<Resource Select afolderin the tree in which to save the view, template, or perspective.
tree>
Find Enter a folder name or a portion of a name in the Find box to locate a folder in the
list.
New query Select New query if the view is based on a new TQL query.
Note: This field is not relevant for template-based views and perspective-
based views.
View Name Enter the name of the new view, template, or perspective.

Select Integration Points Dialog Box

This dialog box enables you to select integration points to access the required data sources fora TQL
query node.
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To access

Important
information

In the Modeling Studio, right-click a TQL query node and select Select Integration
Points.

You can select the data sources from which the TQL query generates the results for
each query node. For details on data sources, see "Integration Studio Overview " in
the HPE Universal CMDB Data Flow Management Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z)

<Integration
Point list>

All
Integration
Points

Local Data
Source

Select
Integration
Points

Description

A list of integration points for available data sources.

Enables you to include Cls from all UCMDB and external data sources for the
selected query node in the TQL query results.

Note: Only includes integration points where the Cl type of the selected query
node is marked as federated.

Enables you to include Cls from the UCMDB only for the selected query node in the
TQL query results.

Enables you to select integration points to include Cls from the required data
sources only for the selected query node in the TQL query results.

Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a report.

To access

Important
information

Relevant
tasks

See also

In the Modeling Studio, click Set Sort Order in the Query Node Definition pane of the
Pattern View Editor (in Report mode).

The report is sorted by columns following the order of the attributes in the Sorted
Columns pane. Each selected column is sorted in ascending or descending order
according to your selection.

"How to Define Report Settings" on page 279

« "Building a Business View" on page 253
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« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element (A-Z) Description

> Move to Sorted Columns. Moves the selected attribute to the Sorted Columns
pane.
< Move to Available Columns. Moves the selected attribute to the Available

Columns pane.

Ui

Moves all the attributes to the Sorted Columns pane.

£ Moves all the attributes to the Available Columns pane.
[ Moves the selected attribute down in the Sorted Columns list.
[ Moves the selected attribute up in the Sorted Columns list.

=1 Sort Ascending. Sorts the selected column in ascending order.
7 Sort Descending. Sorts the selected column in descending order.
Available The attributes selected to appear as columns in the report.
Columns

Sorted Columns The columns selected to be sorted.

Template-based View Wizard

This wizard enables you to define template-based views manually or by importing parameter data from
aCSVfile.

To access  Click the New 2 button and select Template Based View.

Important = The wizard enables you to create multiple template-based views based on the same

information template. When creating multiple views, the wizard includes the Save Views page as
the final page. When creating a single template-based view, the wizard finishes with
the Parameters page and opens the new view in the Editor. You can save the new
view from within the Editor.

Relevant « "How to Create a Template Based View" on page 276
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tasks « "How to Create Multiple Template Based Views" on page 277
Wizard The Template-based View Wizard contains:
map

"Select Template Page" > "Import Parameter Values Page" > "Enter Parameters
Page" > "Select Location for Views Page" > "Summary Page" > "Save Views Page"
See also » "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

Select Template Page

This wizard page enables you to select a template on which to base your view.

Important If you don't want to use any of the templates in the tree, you can create a new
information template first and then build a view based on it. For details on creating a template, see
"How to Create a Template" on page 270.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" >"Select Location for Views Page" > "Summary Page" > "Save Views Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
= Refresh. Refreshes the template tree.
=) Expand All. Expands all the folders in the template tree.
|E| Collapse All. Collapses all the folders in the template tree.
@ Find Next. Goes to the next occurrence of the selected search phrase in the tree.
@ Find Previous. Goes to the previous occurrence of the selected search phrase in
the tree.
Highlight All. Highlights all occurrences of the search phrase in the tree.
<Template Displays the existing templates in tree format.
tree>
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Ul Element (A-
Z) Description
Find Enter a template name or a portion of a name in the Find box to locate a template

in the list.

Import Parameter Values Page

This wizard page enables you to import parameter values from a CSV file.

Important If you are creating a large number of views based on the same template, you can save
information the parameter values in a CSV file and import them directly into the wizard.

Note: If the CSV file contains any non-English characters, you must use UTF-8
encoding to ensure that the characters are displayed properly.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" >"Select Location for Views Page" > "Summary Page" > "Save Views Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
Add Select this option to enter the parameter values manually, whether for a single view or

parameter | for multiple views.
values
manually

Import Select this option to import the parameter values from a CSV file. Click the ellipsis |Z|

parameter  pytion to browse your files for the required file.
values

from a CSV
file

Use Select the Use Advanced Naming option to automatically name the created views

Advanced based on parameter values. In the box, enter an expression containing at least one

Naming parameter name in angle brackets. The views are named based on the values of the
selected parameter.
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Enter Parameters Page

This wizard page enables you to set the values of the template's parameters for each new view
created.

Important If you are creating multiple views, click Next after you set the parameter values to
information = proceed to the Save Views page. If you are creating a single view, click Finish after
you set the parameter values to open the new view in the Editor.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page"> "Save Views Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

&+ Add view instance. Adds a new view instance.

g Remove view instance. Deletes the selected view instance.

<Parameter In each parameter column, enter or select the required parameter value for each view.

columns>

Reset Click to reset the selected parameter to its original value.

Use Select the Use Advanced Naming option to automatically name the created views
Advanced  based on parameter values. In the box, enter an expression containing at least one
Naming parameter name in angle brackets. The views are named based on the values of the

selected parameter.

Note: All view names must be unique.

View Name Enter names for each of the new views, or use the default names assigned.

Select Location for Views Page

This wizard page enables you to select the location in which to save the created views.

Important All created views must be saved in the same location.
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information

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page"> "Save Views
Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

Col New Folder. Creates a new folder in the view tree.

=l Refresh. Refreshes the view tree.

B Expand All. Expands all the folders in the view tree.

|E| Collapse All. Collapses all the folders in the view tree.

& Find Next. Goes to the next occurrence of the selected search phrase in the tree.

@ Find Previous. Goes to the previous occurrence of the selected search phrase in
the tree.

Highlight All. Highlights all occurrences of the search phrase in the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find box to locate a template
in the tree.

Summary Page

This wizard page displays the details of the created views before saving.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters Page" >

"Select Location for Views Page" > "Summary Page" > "Save Views Page"

User interface elements are described below:
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ul
Element
(A-Z) Description

Save view A summary of the views created including the name of the base template, the number
summary  of views created, and the location selected for saving the views.

Save Views Page

This wizard page enables you to save the new views you created.

Important  This wizard page is only relevant when you are creating multiple template-based
Information = views.

Wizard The Template-based View Wizard contains:

ma
P "Select Template Page" > "Import Parameter Values Page" > "Enter Parameters

Page" > "Select Location for Views Page" > "Summary Page"> "Save Views Page"

User interface elements are described below:

Ul Element

(A-2) Description

Save A table displays the names of the new views and a message indicating whether each
Results view was saved successfully or not.

Template Parameter Values Dialog Box

This dialog box enables you to edit the parameters of a template-based view.

To access | From within a template-based view in the Modeling Studio, right-click a query node
with parameters defined and select Show Node Parameters, or click the Show
Parameters <* button on the toolbar.

Important | When you open the dialog box from the shortcut menu by right-clicking a query node

information with parameters defined, the dialog box only displays the parameters for the selected
query node. When you open the dialog box from the toolbar, it displays all the
parameters defined for any of the query nodes in the view.

Relevant "How to Create a Template Based View" on page 276
tasks
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See also « "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Parameters> Edit the values of the parameters.

TQL Query Editor

This feature enables you to build and edit TQL queries.

To access  Toopenanew TQL query in the TQL Query Editor, go to the Modeling Studio, click

the New L button and select Query.

To open an existing TQL query in the TQL Query Editor, go to the Resources tab of
the left pane in the Modeling Studio and select Queries as the Resource type. Right-
click a TQL query in the tree and select Open Query or double click a TQL query or
drag a TQL query onto the empty canvas. The TQL query opens in a new tab.

Important = To save your TQL query, use the Save button on the Modeling Studio main toolbar.
information

Relevant "How to Define a TQL Query" on page 24
tasks

See also « "Viewing TQL Query Results" on page 16

« "Modeling Studio User Interface" on page 284

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-2) Description
@ Show View Results in IT Universe. Goes directly to the selected view in IT
Universe Manager.
Note: This button only appears for views, templates, or perspectives.
1w Create Relationship. Enables you to draw a relationship from one query node to
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Ul
Element
(A-Z)

<Py

<Legend>

Description

another.

Calculate Query Result Count. Calculates the number of instances found for each
TQL query node or relationship.

Preview. Displays a preview of the TQL query results as they would appearin IT
Universe Manager.

Delete. Deletes the selected query node or relationship from the query.

Query/View Definition Properties.

For queries, opens the Query Definition Properties dialog box which enables you to
edit the type, scope, and priority of the TQL query.

For views, opens the View Definition Properties dialog box.

Report Properties. Opens the Report Properties dialog box, which enables you to set
the title, subtitle, and format for the view's topology report. For details, see "Report
Properties Dialog Box" on page 430.

| Note: This button only appears for views, templates, or perspectives.

Assign Tenants. Opens the Assign Tenants dialog box which enables you to assign
tenants to the resource.

| Note: This button is only available when multi-tenancy is enabled.

Manage Security. Enables you to assign the selected resource to specific roles or
resource groups.

Show Parameters. Opens the Template Parameter Values dialog box which enables
you to edit the parameters of a query node in a template-based view.

Note: This button only appears for template-based views.

Indicates the icons displayed next to Cls with any of the following special
designations:

« ltis defined as a contact query node in a perspective

o ltis afederated Cl
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ul
Element
(A-2) Description
« It has attributes defined
« It has selected identities defined
« lItis hidden in the query results
« lItis defined as the output query node of a pattern-based model
« It has a subgraph defined
<Main For details, see "Main Menu" on page 163.
menu>

<Shortcut = For details, see "Shortcut Menu Options" on page 33.

menu
options>

<Topology For details, see "Topology Map Sidebar" on page 176.

Map
Sidebar>

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and

relationship.

Important The Advanced pane appears in the lower part of the window in the following managers

information and user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query Editorin DFM.

A small green indicator * appears next to the tabs that contain data.

Relevant o
tasks

"How to Define an Impact Rule — Workflow" on page 463
"How to Define an Enrichment Rule — Scenario" on page 529
"How to Define a TQL Query" on page 24

"How to Create a Pattern View" on page 269

"How to Create a Template" on page 270

"How to Create a Perspective" on page 272
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User interface elements are described below:

Ul Description
Elements
(A-Z)

i If the window is not wide enough to display all the tabs, use the left and right arrows to

move to the required tab.

Click Show List to display a list of the available tabs for the current module. You can
select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attributes Tab" on page 74.

Cardinality = Cardinality defines how many query nodes you expect to have at the other end of a
relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see "Cardinality Tab" on page 76.

Data Displays the data sources set for the selected query node.

Sources
Note: This tab appears only in the Modeling Studio.

Details Displays the following information:
« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in
the Modeling Studio.

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not
visible. In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its
children are displayed in the topology map. A red mark indicates that only the
selected Cl appears. This item does not appear in the Modeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.
Element Displays the attributes selection for the selected query node or relationship. It lists the
Layout attributes selected to be included in the query results (when Specific Attributes is

selected as the attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element Layout Tab" on page 82.
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Ul Description
Elements
(A-Z)

| Note: This tab appears only in the Modeling Studio.

Element Displays the subtype conditions defined for the query node or relationship. For details,
Type see "Element Type Tab" on page 80.

| Note: This tab appears only in the Modeling Studio.

Enrichment Displays the Enrichment rule defined for the selected query node or relationship. If the

Rules Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see
"Query Node/Relationship Definition Dialog Box" on page 551.

Note: This tab appears only in Enrichment Manager.

Impacted Indicates which query node is impacted by the changes that occur in the selected

Query trigger query node. If required, you can click Edit to open and modify the Impacted

Nodes Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on
page 474.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Selected Displays the element instances that are used to define what should be included in the
Identities TQL query results. For details, see "Identity Tab" on page 85.

Views Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the views containing the selected ClI.

To Click the Show views containing selected Cl/model 58 putton in the Model Editor or

access  gelect Show containing views from the shortcut menu.
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See
also

» "Building a Business View" on page 253

« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul
Element
(A-Z)

@

Find
Find Next

Find
Previous

Highlight

View
Name

Description

Show View Results in IT Universe. Goes directly to the selected view in IT
Universe Manager.

Delete Selected Item(s). Deletes the selected view.

Disconnect view from perspective. Disconnects the selected view from its
perspective. The view becomes a pattern view.

Enter a view name or a portion of a view name in the Find box to locate it in the list.
Click to go to the next occurrence of the selected search phrase in the list.

Click to go to the previous occurrence of the selected search phrase in the list.

Click to highlight all occurrences of the search phrase in the list.

Displays the list of views dependent on the selected template or perspective.

| Note: The name of the current view appears in faded text.

Watchpoints Updates Dialog Box

This dialog box displays the changes found in related Cls by a watchpoint defined for a model.

To access

Important
information

From within a model in the Model Editor, click the Watchpoint @ button and select

Watchpoints Updates or right-click a Cl in the model and select Watchpoint >
Watchpoints Updates.

The Watchpoints Updates dialog box indicates any changes found involving the Cls
related to the model via the associated reveal path. If a new related Cl is found which
is not included in the model, the suggested update is an added CI. If a Cl in the model
is found to no longer be related via the path, the suggested update is a removed CI.
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This option is only enabled when watchpoints are defined for the model and Cls have

been found.

See also

« "Revealed Cls and Watchpoints" on page 264

« "Modeling Studio User Interface" on page 284

User interface elements are described below:

Ul Element (A-Z)

Accept

Accept All
Cl

Cl Type
Clear All

Restore

Show/Hide
Suppressions

Suggested
Update

Suppress

Suppress All

Description

Select the check boxes for the Cls you want to add to your model or remove
from your model.

Click Accept All to apply all the suggested changes to your model.
The names of the Cls found by the watchpoint.

The types of the Cls found by the watchpoint.

Click Clear All to clear the check boxes for all the found Cls.

Select the check boxes for the Cls in the Suppressed Cls pane that you want to
consider for inclusion in your model.

Toggle between hiding and displaying the Suppressed Cls pane of the dialog
box.

Indicates whether the suggested change is an added Cl or a removed ClI.

Select the check boxes for the Cls you want to exclude from your model or
leave in your model.

Click Suppress All to decline all the suggested changes to your model.

<Query/Template/Perspective Name> Dependencies

Dialog Box

This dialog box enables you to clarify the status of dependent resources when saving changes to a

query, template, or perspective.

To access

In the Modeling Studio, make a change to a query, template, or perspective with

dependent resources. When you click Save, the dialog box opens.
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Important Any change made to a resource affects the views or custom reports based on that

information resource. Before the changes are saved, you need to specify the desired result on the
dependent resources. For each dependent resource, select one of the available
options: Delete or Re-Apply.

Dependent resources include views based on a query, template, or perspective, and
custom reports based on a view, for example, a View Change report.

User interface elements are described below:

ul Description

Element

(A-Z)

Delete Select this option to delete the selected dependent resource.

Re-Apply Select this option to apply the revised query, template, or perspective to the selected
dependent view. The view type remains the same as it was previously (pattern view,
template-based view, or perspective-based view). In the case of custom reports, the
report is updated according to the revised view.

Resource The dependent resources are displayed in a tree format.
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Topology Reports Overview

Topology reports provide a method of displaying the data from views in a report format. Every view
defined in the Modeling Studio has a corresponding topology report in the Reports module. The report
settings are defined in the view definition in Report mode in the Pattern View Editor. For details, see
"Pattern View Editor" on page 318.

For details on selecting the Cls to be displayed in a view, see "Working with the C| Selector" on page
129.

Perspectives, perspective-based views and template-based views also have topology reports. The
reports settings for such views are based on the settings defined in the base template or perspective.

You can open a template in the Reports module and edit the template parameters. You can then save
the template instance as a template-based view by clicking Save As View.

Report Properties

There are two formats for the topology report tables:
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« Flat. In aflat report, the top layer of the report is displayed with the Cls with children appearing as
links. You can click a Cl to drill down to see its children. You can navigate back to higher layers of
the report using the breadcrumbs appearing at the top of the report.

« Hierarchical. In a hierarchical report, all the Cls of the report are displayed in the same table, in tree

format. Cls with children are expandable to display the child Cls beneath them.

Another important difference between flat and hierarchical reports relates to the definition of charts for
the report. In aflat report, you can define a chart for any layer of the report, even if a higher layer is in
table format. In hierarchical reports, you cannot define a chart for a layer if the layer above it is in table
format.

The report format can be set in the Report Properties dialog box, available in both Modeling Studio and
the Reports module. For details, see "Report Properties Dialog Box" on page 430.

Custom Reports Overview

Custom reports consist of charts and tables that help you track and analyze the health of your
monitored environment. They enable you to view and assess performance data collected by Universal
CMDB and stored in the CMDB. When generating reports, you can specify various report settings,
such as time range or location, as well as drill down to see further information.

How to View a Topology Report

This task describes how to create a report based on a previously saved view or pattern.

This task includes the following steps:

« "Prerequisite" below

"Select a Report" below

"Edit Template Parameters" on the next page

1. Prerequisite
(Optional) Use the Modeling Studio to define a new view. For details, see "Modeling Studio" on

page 251.

2. Select a Report
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In the Reports module, select an existing Topology report which corresponds to a view of the
same name. Double-click it or right-click it and select Open Report. The report opens in the right
pane. For details, see "Topology Report" on page 449.

3. Edit Template Parameters

If you selected a report corresponding to a template, edit the template parameters and generate
the report. Click Save As View to save it as a template-based view.

How to Generate a Custom Report

This task describes how to define and generate a report based on a custom layout.
This task includes the following steps:
« "Select the Report Type" below

» "Specify the Required Parameters" below

» "Generate the Report" below

1. Select the Report Type
In the Custom Reports pane, do one of the following:
o Right-click a report name and select Create New Report.
o Click the Create New Report |Z| button and select the required report.

o Double-click a report name.

2. Specify the Required Parameters

Specify the parameters required by the report type that you selected. For details about the
parameters required by each report type, see the relevant report listed in "Reports User Interface”
on page 360.

3. Generate the Report

Click Generate to build the report. If desired, you can refine the parameters and click Generate
again to view an updated report.
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How to Compare Cls

This task explains how to compare the hierarchies of two compound Cls, view a Cl's configuration
document, and show the difference between two configuration documents.

This task includes the following steps:

« "Select the Required Cls" below
« "View a Cl's Configuration Document" below

« "Show the Difference Between Two Configuration Documents" on the next page

1. Select the Required Cls

InIT Universe Manager, select the two Cls you want to compare. The hierarchies of the two
compound Cls are compared in the Compare Cls report (for details, see "Compare Cls Report" on
page 387). You can choose to compare two Cls that appear in a selected view, or in the CMDB.
For details, see "Cl Selector" on page 134.

Example of Nonmatching Cls:

In this example, the No Matching Cl icon is displayed next to the C| LABM3QCRNDDBO03
because it has no corresponding Cl on the other side.

The Show Different Attribute Values icon is displayed next to the MemorySize properties
for the Cls LABM3QCRNDDBO02 and LABM3ASTDBO01 since they have different
MemorySize values.

@ (& 10.000 @ (&) 192.168.226.0
i Ip&ddress Ip&ddress
=@ (2] Windows q L[] 192.168 226 1

< [Z] LABM3QCRNDDEOZ |V Windows

=[E] | ABM3QCRNDDEOS L. [E] LABM3ASTDED1
4 I} 3
Bl 202020 @@ | |lge[ 000 180

P
Mame | Value Mame | Value

Dizcoveredien... DiscoveredWen...
DizcoveredOsN...  Windows 2003 DizcoveredOs...  Windows 2003
DizcoveredOsV... | Microsoft DizcoveredOs...  Microsoft
Host Operating ... 3790 Host Operating ... 3790
! MemorySize [m ﬁ ! MemorySize |4,093

2. View a Cl's Configuration Document
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Select a Cl of the CIT Configuration Document and view the configuration document. For
details, see "Compare Cls Report" on page 387.

3. Show the Difference Between Two Configuration Documents

Select two Cls of the CIT Configuration Document and view the difference between the two
configuration documents. For details, see "Compare Cls Report" on page 387.

How to Compare Snapshots

This task describes how to take a snapshot of a view, and to compare two snapshots of a specific view
taken at different times.

This task includes the following steps:
« "Take a Snapshot of a View " below

« "Save Snapshots on a Periodic Basis" below

« "Compare Snapshots" below

1. Take a Snapshot of a View
a. Selectaview inIT Universe Manager or a Topology report in the Reports module.

b. Click the Snapshot [ button and select Save Snapshot to take a snapshot of the view and

save it. For details, see the "Save Snapshot Dialog Box" on page 246.

2. Save Snapshots on a Periodic Basis

Optionally, you can schedule snapshots to be taken of a certain view at specific times by defining
atask. For details, see "Schedule Report/Snapshot Dialog Box" on page 440.

3. Compare Snapshots

Compare the snapshots of a view taken at different times. Select Modeling > Reports and create
a Compare Snapshots Report. For details, see "Compare Snapshots Report" on page 391.

Example of Snapshots of a View Taken at Different Times:
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In the following example, the Deleted Item icon next to the vmamqa278 Cl in the left pane,

indicates that the Cl has been deleted in the newer view.

| Legend: @ Contains An Updated tem # Deleted ttem -~ Mew tem ¢ Updated kem

Current

Before deleting

E-® &) 1655244 0122

[E] |abm3am2a4
[E] |abm3am288
[E] \abmardeio
[E] mydvmon1
[ ymamaszsa
H @ vmamda27s
2 ymamaszra
@ vmamga309
2 ymamasszso
@ wmamrnd219
@ wmemdbg

[E] ymddm2s

@ wmpcoed?
@ vmpcoe21
@ wmrtsmgwi2
@ wrtsmpcs02

s

B9 &) 16.55.244 0122

[E] |abm3amz284
[E] |abm3am288
[E] \abmardeio
[E] mydvmoo11
[ ymamaazes
@ wmamga27s
2 ymamaszra
@ wmamga309
2 ymamaasso
@ wmamrnd219
@ wmemdbd

] ymddm2s

@ wmpcoed?
@ wmpcoe2l
@ wmrtsmgwi2
@ vrrtsmpes02

How to Enable Hyperlinks and Display Icons

To enable hyperlinks in reports, set the infrastructure setting Enable links in exported reports to

TRUE.

To display icons in exported reports, set the infrastructure setting Display icons in exported reports

to TRUE.

Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by white space. Six of the

fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression:

Field Name

Seconds

Minutes

0-59

0-59

HPE Universal CMDB (10.31)

Allowed Values

Allowed Special Characters
Y

a_*/
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Field Name Allowed Values Allowed Special Characters
Hours 0-23 -

Day of month 1-31 ,-*?2/LWC

Month 1-12 or JAN-DEC ="

Day of week 1-7 or SUN-SAT ,-*?/LC#

Year (optional) empty, 1970-2099 =0

Note: You cannot specify both Day of Month and Day of Week; you must use the ? characterin
one or both of these fields.

The following table contains examples of how to use Cron expressions.

Cron

Expression Meaning

0012**? The task runs every day at 12:00 PM.

0151072 ** The task runs at 10:15 AM every day.

01510**? The task runs at 10:15 AM every day during the year 2011.

2011

00/514**7? The task runs every 5 minutes starting at 2 PM and ending at 2:55 PM, every

day.
0151015*? The task runs at 10:15 AM on the 15th day of every month.
01510 ? * 6L The task runs at 10:15 AM on the last Friday of every month.

01510 ? * 6#3 The task run at 10:15 AM on the third Friday of every month.

Reports User Interface

This section includes (in alphabetical order):

Agent Status RePOr ... 362
Application Breakdown Report . . ... 364

Application License Report
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ASSEt REPOM . 367
Auditing Report . . 369
Changed Application Report . il 373
Changed Views RepOrt ... 375
Gl Change RePOM . L 377
CMDB Utilization RepOrt ... 381
Compare Archives RepOrt .. o L 383
Compare Cls RePOM . L 387
Compare Snapshots Report .. ... 391
Configuration Manager Policy Report ... ... 395
Database Breakdown Report .. 397
Delete Candidates Report . . . ... 400
Dependency RePOrt . . . ... 401
Discovery Ermors Report ... L 403
Generic Breakdown Report .. L 405
Gold Master RepOrt . . .. 407
Hardware Component Summary Report ... il 410
Impact Analysis RepOrt . il 411
Job List Dialog BOX .. ... 413
Licensed OSIs RePOr ... o 415
Migration Progress RepOrt . . . . ... 418
Network Device Breakdown Report . ... oo L 418
Node OS Breakdown Report ... oL 421
Node SuMMaAry RePOrt 423
Node Summary by VLAN Report ... il 425
Number of Changes Report . .. 426
Recognized Applications Report . .. 428
Report Properties Dialog BoOX ... o 430
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Reports Page ... oo 431
Rulebase Support RePOrt ... ... 435
Scan File Status RePOrm ... 436
Scanner Execution Details Report . . ... L 438
Schedule Report/Snapshot Dialog BOX .. ... 440
Service Discovery Errors Report ... 444
Software Utilization Report ... L 446
Solaris Zone RePOIt ... L 448
Topology RepOrt ... 449
View Change Report .. 450
VMware HOst RepOrt 452
VMware Virtual Center Report ... o e 453
Zone-Based Discovery Ermors Report ... .. 454
Report Toolbar OptioNs ... . o L 456

Agent Status Report

This report displays the status of all installed discovery agents that have been updated by the Upgrade
UD Agent discovery job.

[5 Agent Status Report1* x|

F5! Report Parameters || 2] [ @ - & - | |showClinstancesof | Node(1) ¥ It Q
Job Status: (o [¥]
Group By:
|, Generate |
Display Label Agent Version Port Platform | Agent Upgrade Date | Agent Upgrade State
ddmivm32 w10.00.000 build: 427 2,738 Windows 2008 R2 Success
To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report Lkl button and select Agent Status Report.

« Under Discovery Status:
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o Double-click Agent Status Report.
o Right-click Agent Status Report and select Create New Report.

o Select Agent Status Report, and drag it onto the right pane.

Important The report displays detailed information on each discovery agent including the
information  display label, agent version, port, platform, and probe name.

Use the Select Columns [ button to select the attributes to display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-2) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Group By  Select a grouping method for displaying the data. The available options are:

« None
« Job Status

« Agent Version

Job Select an option from the drop-down list to filter the results by the job status of the
Status agent's discovery jobs.
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Application Breakdown Report

This report displays a breakdown of major applications and their versions. Major applications are
Running Software CITs that have been assigned the MAJOR_APP class qualifier. For details, see

"Qualifiers Page" on page 509.

[] Include A1 Integration Points

Courtry or Province: | |

State: [
City: [ an
Applications Breakdown
Applications Breakdown
Break down by Count Click on the chart sections to drill down
Weblogic AS IBM HTTP Server
Amount: 4 Amount: 2

Percentage: 0%

Siebel Gateway
Amount: 1
Percentage: 0%

SAP ITS AGate
Amount: 1

Percentage: 0%

IEMWebSphereMQ
Amount: 16

Percentage: 2%

Percentage: 0%

SAP ABAP
Application Server
Amount: 9
Percentage: 1%

JBoss AS
Amount: 284

JZEE SAF
Central Services
Amount: &
Percentage: 1%

Percentage: 31% /

To access

11S Web Server
Amount: 603
Percentage: 63%

Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

the following:

« Click the Create New Report | button and select Application Breakdown

Report.

« Under Breakdown:
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Relevant
tasks

o Double-click Application Breakdown Report.
o Right-click Application Breakdown Report and select Create New Report.

o Select Application Breakdown Report, and drag it onto the right pane.

"How to Generate a Custom Report" on page 356

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Bar graph/
Pie chart>

<Breadcrumbs>

<Shortcut
Menu>

<Toolbar>

City

Country or
Province

HPE Universal CMDB (10.31)

Description

Each segment of the pie chart/column in a bar graph represents a different
application.

Click aslice/bar to view the application sorted by version, and then drill down to
see the application instances and their attributes.

When you hold the mouse over each segment/bar, a tooltip indicates the name of
the application, the number of Cl instances found for each application, the
percentage of the pie it represents (when viewing the information in pie chart
format), and the CI type the slice/bar represents.

The legend below the pie chart provides the name of each CI, and on the lower
level, their versions.

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Drill down to the level of individual Cls and right-click a Cl in the report to access
the IT Universe Manager shortcut menu. For details, see "IT Universe Manager
Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.

Select the city for which you want to view application breakdown data, or select
All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in the City attribute.

Select the country or province for which you want to view application breakdown
data, or select All to show the breakdown for all countries or provinces.
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Ul Element (A-

Z) Description
Note: This is only relevant for CITs that contain data in the Country or
Province attribute.

Include All Select the check box to include federated Cls in the report. When the check box

Integration is cleared, only local Cls are included in the report.

Points

State Select the state for which you want to view application breakdown data, or select

All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in the State attribute.

Application License Report

This report displays all the application instances detected in the system that require a license.

Group By: | Application Mame [+

e - SR

Application Name Total Installed License Reguired
FZip
Active Perl

ation Assistant for

Chrome Frame

CommTax Communcations Tax L

FileZilla Client

FineReader Engine

Firefox

Google Chrome Browser

HP ication Lil Client
HP Application Lifecycle W t Platform
HP Asset Manager

HP Asset Manager APl

[l L bl el el L el L el e L LN
I T T T T}

To access  Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report ! button and select Application License
Report.

« Under Inventory:
o Double-click Application License Report.
o Right-click Application License Report and select Create New Report.

o Select Application License Report, and drag it onto the right pane.

HPE Universal CMDB (10.31) Page 366 of 572



Modeling Guide
Chapter 9: Reports

Important The top level of the report displays the number of application instances for each

information = application, vendor, or related node, depending on the grouping option selected. This

is based on the license type for each application as defined in the SAl files.

In any layer, you can use the Select Columns ¥ button to select the attributes to

display in the report.

Relevant "How to Generate a Custom Report" on page 356

tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Breadcrumbs>

<Shortcut
Menu>

<Toolbar>

Group By

License
Required

Description

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
For details, see "IT Universe Manager Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.
Select the method for displaying the data. The available options are:

« Application Name

» Vendor Name

« Related Node

For each application, vendor, or related node, displays the number of

applications that require a license. Click the number to drill down and view the
application instances.

On the drill down screen, if the number in the Components column is greater than
0, then the selected application has licensing components.

Asset Report

This report displays a list of all the Cls in a specified view, their attribute values, as well as their child

Cls inthe CMDB. You use Asset reports to view and analyze the contents of the view and focus on the

HPE Universal CMDB (10.31)
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data that is of interest to you. For example, an Asset report can display a list of all the servers that are
part of a specific application contained in the view.

View: | SAM Topology ¥ | | .. Include information based on (®) CMDB ) View

-tm
Display Label |||||| PrimaryDnsName |||||
= @ O00ETFFOO3F1 LABM3IMAMI 1 deviab.ad

L [m] 165956 213

To access  Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report |:| button and select Asset Report.
« Under General:

o Double-click Asset Report.

o Right-click Asset Report and select Create New Report.

o Select Asset Report, and drag it onto the right pane.

Important The report only includes attributes that are marked with the Asset Data qualifier in the
information Attributes tab in the Cl Type Manager. For more details, see "Add/Edit Attribute
Dialog Box" on page 494.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description

<Shortcut  Fordetails, see "IT Universe Manager Shortcut Menu" on page 231.
menu>

<Toolbar>  For details, see "Report Toolbar Options" on page 456.

Include Select one of the following:

information i . . . .
« CMDB. Includes information from the selected view as well as information about

the child Cls and their attribute values in the CMDB.

based on

In this option, the report includes Cls that are connected to the Cls in selected
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Ul Element
(A-Z) Description
view by relationships with the Container qualifier. For example, the report
includes the CPU and memory of a server that is contained in the view.
« View. Includes only information about the Cls and their attributes that are
contained in the selected view.
View Enables you to select a view by opening the View Selector. For details, see "Cl

Selector" on page 134.

Note: When you generate an Asset report from a specific view, the report retains
the same hierarchical structure as the relevant view in the Topology Map.

Auditing Report
This report displays auditing information about Cls, Relationships and many Unified Resource

Manager (URM) resources.

[i5 Auditing Report1* X
[} Report Parameters [ £ -

Time range: | Last week | ¥ | Date from: [ 12/16/14 1.05 PM_ ¥| Date unti: [ 12123114 1.05PM_ ¥

UsersiGroups | admin
Resource types | Cls,Class, Query,Relationships, Role

Change Type Create,Delete, Update

==
Show Cl instances of | Obiect (0) - oMt a
Updated By | Resource T... | Resource Name | cnangetype | Change Date D Revision
admin TaL G5 node_with_udagent Resource modifisd Fri Dec 19 2014 09:27 AM GMT+08:00 node_with_udagent 6548
admin TaL [ node_with_udagent Resource modified Fri Dec 19 2014 09:26 AM GMT=08:00 node_with_udagent 6546
admin TQL @j ip_with_snmp_or_without_host Resource modified Mon Dec 22 2014 02:056 PM GMT+08:00 ip_with_snmp_or_without_host 6606
To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

the following:

« Click Create New Report|'-_-'-| and select Auditing Report.

« Under Administration:

o Double-click Auditing Report.
o Right-click Auditing Report and select Create New Report.

o Select Auditing Report and drag it onto the right pane.
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Important « Thereport is visible only for users with Auditing permission.
information

« The out-of-the-box TenantAdmin role does not have Auditing permission and
cannot create Auditing reports.
« The report supports all standard features of any custom report such as:
o Email
o Scheduling
o Export (only CSV, Excel, and XML)
o Saving the input parameters

« Exploring changes is enabled by right-clicking a row:
o For Cls and Relationships:
A shortcut menu appears, including options related to Cls, such as Cl History.
Exploring shows the history within the selected time frame.
o For URM resources:

Exploring is used for comparing a base revision with any other changes made
on the URM resources.

Note:

« Results cannot be retrieved after purging the history from the JMX.

« Changes that are made by the probe through the discovery process or
made through the integration points do not appear in the report output.

Click Explore Resource. The Compare Revisions dialog opens, displaying a
text area with the same Diff code as in the JMX. The XML of the current
selected revision is displayed in the left panel, and users can select any other
revision of the same resource to display in the right panel.

Different colors indicate different changes as follows:

« Green color for modified lines.
o Red color for removed lines.

« Yellow color for added lines.

Relevant "Generate a Custom Report" in the HP Universal CMDB Modeling Guide.
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element

(A-Z) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Date from Configure a start date and time for the report.

Date until Configure an end date and time for the report.

Time range Select a time frame for the changes that you want to display. The system
automatically provides the starting and ending dates in the Date from and Date
until boxes.

Note: If you select Custom, you can manually configure a start and end date
in the Date from and Date until boxes.

Users/Groups  Click l:=/ and select users and/or groups for the report.

Resource Click ==/ and select resource types toinclude in the auditing report. The available
types resource types are as follows:

« Cls

« Class

« Customer Setting
« Deployed Package
« Discovery Script
« Enrichment Rule
« Global Setting

« ldentification Rule
« Impact Rule

« Integration Point
« Query

« Relationships

« Resource Group

« Resource Tenants Association
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Ul Element

(A-Z) Description

Role

Role Assignment
Scheduled Report
System Type
User

Users Group

View

Change Type Click |E| and select the change type for the report. The available types are as

follows:

« Create

o Delete

« Update
@ Cenerate | Generate Report. Enables you to generate the selected report.
o Note: This button appears disabled prior to defining the report parameters.
<Generated Displays the generated report.
report>

The generated report contains the following columns:

Updated By: The user name of the administrator who updated the item.
Resource Type: Resource type for the item.

Resource Name: Resource name for the item.

Change Type: Change type for the item.

Change Date: Date and time when the item was changed.

ID: Identifier for the item.

Revision: Revision number for the item.
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Changed Application Report

This report displays a bar graph showing the number of detected changes in applications within a
defined period.

Time range: | Last week || Date from: | Mon Feb 152010 09:04 &M IST ¥ | Date until: | Mon Feb 22 2010 09:04 AM IST ¥

Number of Changes Grouped by CI Type

Break down by Added & Removed & Updated Click on the chart sections to drill down

1,500 | e e e e e e e e e e e e e e T e T e e T e
1,400 | || I
L300l
1,200 | [ R e
1,100 { [ R T e e .
1,000 {f-| e R |
oo ] e R
g | [l R s ) I kR e R S Rt
700 - [ 1 T
500
500
400
300
200

° - ﬂ

Value

CI Type

|E| Added ERemoved EUpdated |

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report || button and select Changed Application
Report.
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« Under Change:

o Double-click Changed Application Report.
o Right-click Changed Application Report and select Create New Report.

o Select Changed Application Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356

tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Bar graph>

<Breadcrumbs>

<Toolbar>
Date from
Date until

Time range

Description

Each bar represents a different application type. The colors in each bar represent
the different types of changes that occurred in the application.

Each color in the legend represents a different type of change. The Cl type of
each application is displayed under the relevant bar.

When you hold the mouse over each bar, a tooltip indicates the number of
changes that have occurred (such as the adding, removing, or updating of Cls,
depending on the color), as well as the Cl type the bar represents.

Click the required color in the bar to drill down to see a list of the Cls that have
changed.

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

For details, see "Report Toolbar Options" on page 456.
Configure a start date and time for the report.
Configure an end date and time for the report.

Select a time frame over which to display the detected changes. The system
automatically provides the starting and ending dates in the Date from and Date
until boxes.

Note: If you select Custom, you can manually configure a start and end
date in the Date from and Date until boxes.
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Changed Views Report

This report displays the number of changes that occurred in a specific view within a defined period.

Grouping by View

Break down by Added & Removed & Updated Click on the chart sections to drill down
1,600
1,500
1,400
1,300
1,200
1,100
1,000
200
300
F00
G600
500
400
300
200
100

0

Value

View Name

| O Added ERemaoved EUpdated |

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report || button and select Changed Views Report.
« Under Change:

o Double-click Changed Views Report.

o Right-click Changed Views Report and select Create New Report.

o Select Changed Views Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul

Element

(A-Z) Description

<Bar Each bar represents a different view. The name of each view is displayed under the
graph> relevant bar. The colors in each bar represent the different types of changes that

occurred in the view (added, removed, or updated).

When you hold the mouse over the relevant color in each bar, a tooltip indicates the
name of the view, the change type, and the number of Cl instances that changed in the
view.

See the legend to verify the change type each color represents.

If snapshots were taken of a view at different times, you can click a bar to open the
Compare Views by Snapshots dialog box and display the differences between the
views. For details, see "Compare Snapshots Report" on page 391.

Note: Only views with changes that reflect the differences between two
shapshots, one taken before the Date from date (or, if not available, then after the
Date from date) and another snapshot taken before the Date until date in the
Changed Views report appear in the report.

<Toolbar> For details, see "Report Toolbar Options" on page 456.
Date from Configure a start date and time for the report.
Date until = Configure an end date and time for the report.

Time Select a time frame over which to display the changes. The system automatically
range provides the starting and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a starting and ending
date in the Date from and Date until boxes.
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Cl Change Report

The CI Change report enables you to view and analyze the actual changes made to a specific Cl and
its children. This can help with possible troubleshooting issues related to this Cl. For example, you may
be able to trace the cause of the problem to changes in the CI. Alternatively, the source of the
troubleshooting issue could be related to expected changes which failed to occur. This report enables
you to view Cl attribute changes, as well as Cls that were added to or removed from a Cl and its
children.

Time range: | Last month Date from: | /26/14 445 PM | Date unfil: | 10/26/14 3:45PM =

Selected Cls: | labm3H58 ...| Include information based on: ) CMDB  (®) View

Cl changes Relationship changes

l Cl Changes] Relaticnship Change.s_

Show Cl instances of: | Windows (3) -| =Rt Q
Display Label | Class Name | Attribute Name | | | Change Date | Changer
@ labm3it55 Windows root_iconproperties Tue Oct 21 2014 04:05 PM IDT | Recalculate attribute
@ labm3it58 Windows root_iconproperies Tue Oct 21 2014 04:09 PM IDT = Recalculate attribute
@ labm3it53 ‘Windows root_iconproperties Tue Oct 21 2014 04:05 PM IDT | Recalculate attribute

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report |Z| button and select Cl Change Report.
« Under Change:

o Double-click Cl Change Report.

o Right-click CI Change Report and select Create New Report.

o Select Cl Change Report, and drag it onto the right pane.

Important Only those Cls whose Cls whose properties are marked as either Managed or
information Comparable appear in the report. For details, see "Add/Edit Attribute Dialog Box" on
page 494.

Cl Change reports display:

« Changes that occurred in a selected Cl and all children of the Cl that are related by
the relationship specified in the Change Report link name infrastructure setting.
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The default value of this setting is an empty value, (managed_relationship), that
enables you to track changes of all relationship attributes that are not marked as
Not Tracked in History.

To change the Cls displayed in the generated report, go to Managers >
Administration > Infrastructure Settings Manager and edit the following
settings:

o Select Change Report link name to retrieve Cls that are linked by the selected
calculated relationship. Change the value of the setting to the name of the
relationship as it appears in the Name box (not the Display Name box) in the
Details page of the selected relationship in the Cl Type Manager. For details, see
"Details Page" on page 504. If empty the class name is considered to be
managed_relationship.

o Select Change Report link qualifier to retrieve Cls that are defined with a
qualifier. Change the value of the setting to the name of the required qualifier. For
information about qualifiers, see "Qualifiers Page" on page 509. If empty the
qualifier is considered to be Container.

« Cls with a Composition relationship that were added to, or removed from, a Cl.

Note: In a multi-tenancy environment, the Cl Change report only displays
changes that are relevant to the tenants associated with your View Cls
permission. However, Remove Cl/relationship events that occurred before an
upgrade to UCMDB version 10.01 are displayed independent of the tenants

associated with the View Cls permission.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below:

Ul Element
(A-Z) Description
Date from Configure a start date and time for the report.
Date until Configure an end date and time for the report.
Include Select one of the following:
information ) . . .
« CMDB. Display the changes that occurred to the Cl and its children in the
based on

entire CMDB.
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Ul Element
(A-Z)

Selected Cls

Time range

Description

« View. Display the changes that occurred to the Cl and its children in the
selected view.

Select the required Cls. Opens the Select Cl/View dialog box. For details, see
"Working with the CI Selector" on page 129.

You can choose to display only Cl changes, only Relationship changes, or both in
the results.

Select a time frame over which to display the changes. The system automatically
provides the starting and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a starting and
ending date in the Date from and Date until boxes.

Cl Changes Tab

Important
Information

User interface

Ul
Element
(A-Z)

<Toolbar>

<Shortcut
menu>

Attribute
Name

Change
Date

Changer

HPE Universal

To view the change history of a Cl, right-click anywhere in the row of the required
Cl and select CI History.

elements are described below (unlabeled elements are shown in angle brackets):

Description

For details, see "Report Toolbar Options" on page 456.

For details, see "IT Universe Manager Shortcut Menu" on page 231.

The name of the ClI attribute that was changed.

The date at which the change occurred.

The name of the user that manually modified the Cl's property, or the name of the Data
Flow Probe that automatically discovered a change made to the Cl's property.
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Ul

Element

(A-Z) Description

Class The CI type of the changed CI.
Name

Display The label of the path from the root to the CI.

Label
A backslash (\) in a Cl name indicates a parent-child relationship with the format:
<parent_Cl>\<child_CI>. For example, the entry 16.59.63.0\Windows provides
change information for the Windows CI that is the child of the 16.59.63.0 CI.

New The new value of the Cl attribute.

Value

Old Value The previous value of the CI attribute (before the change).

Relationship Changes Tab

Important To view the change history of a Cl, right-click anywhere in the row of the required
Information Cl and select Cl History.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description

<Shortcut For details, "IT Universe Manager Shortcut Menu" on page 231.
menu>

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Change The date at which the update was performed.
Date
Changer The name of the user that manually modified the Cl's property, or the name of the

Data Flow Probe that automatically discovered a change made to the Cl's property.

Container The label of the path from the root to the container ClI.

Label
A backslash (\) in a Cl name indicates a parent-child relationship with the format:

<parent_CI>\<child_CI>. For example, the entry 16.59.63.0\Windows provides
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Ul Element
(A-2) Description

change information for the Windows CI that is the child of the dancer.hp.com CI.
Event Type  You can have one of the following values:

« Add Related ClI. A contained Cl was added to the container Cl using a
Composition relationship.

« Remove Related Cl. A contained CI that was linked to a container Cl using a
Composition was removed.

Link Type The type of the relationship.

New Value The new value of the relationship attribute.

Old Value The previous value of the relationship attribute (before the change).
Related The label of the path from the root to the contained CI.
Label

Relationship The name of the relationship attribute that was changed.
Attribute

CMDB Utilization Report

This report displays general CMDB statistics. For example, the statistics can include the number of
Impact rules created, how many Cls are contained in the CMDB, or how many snapshots have been

taken.
Hame | Value
Cls and Relationships 11
Views and Reports 0
Enrichment Rules 26
Correlation Rules 13
Snapshots 0
Connected users 4
Running Discovery Jobhs 0

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report i button and select CMDB Utilization Report.

« Under General:
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o Double-click CMDB Utilization Report.
o Right-click CMDB Utilization Report and select Create New Report.

o Select CMDB Utilization Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Toolbar> For details, see "Report Toolbar Options" on page 456.
Name The name of the CMDB statistic.
Value The number of instances for the CMDB statistic found in the system.
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Compare Archives Report

This report enables you to compare two archived reports or an archived report to the current version of
the report.

ﬁP.' Server Metwaork = WD‘ Weekly Status = [ Compare Archives Reporti* X]

5l Repart Parameters [ B - & - B BE A 4 4, &

Feport with archi'u'es| Server Metwark |v|
Auzilable Archives | Name e

Current Current

weekly Status wed Dec 7 2011 01:57 PM IST

[]  200PMDec? Wed Dec 7 2011 0163 PM IST

| Legend: @ Containz An Updated ter ® Deleted tem = New tem © Updated tem

Weekly Status (Wed Dec 7 2011 01 peport with archives Server Network
FES [@RSEmc.a ..] ] labm3amdh3s
—[E LaBmzAMDE4D —[24 | aEMIAMDELD
—[E] LaEmzaMDES —4 | aBMIAMDES
—[E LABMIFTRMD 7 € L ABMIFTRMD7
—[ LagmsLTED B LaBmMaLTED

—[EE LaBMIMAMDEDS € | sBMIMEMDEDS
—[L] LaEMzPCOEDEDS € | aBM3PCOEDEOG
3t 2] | 4EMIPCOEDE 7 € | sBMIPCOEDETE
—[L] LaEMIPCOEDETS B | sBMIPCOEDETD
—[2] LaEMIPCOEDETS —B Lapmancss
—R4 Lagmzgcss —{¢] mi3-cni-i1

—[2] miz-cmb1 ] mydvmi07

—E myeumon ] mydvm073

—E mydumonT3 14— mydvmin74

] myavmoo7a P B myctemoo7?

— & myaumon? —E mydvmi07E

— =] mydvmi07s —EE] siz11r320

— ] sis11ra20 —E] uemdkanaraz0T
[ uemdkanzrazo = A& vmamoaen
—X@ wnaEmcgE 35 —@ wmamya3el

—@ vmEmcE 360 L] wrnammains

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Reportlﬂ button and select Compare Archives Report.

« Under Compliance:
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Important
information

Relevant
tasks

o Double-click Compare Archives Report.
o Right-click Compare Archives Report and select Create New Report.

o Select Compare Archives Report, and drag it onto the right pane.
Alternatively, in the Topology Reports pane, select two archives of the same report
and click the Compare Report Archives I:LT button.

« The Compare Archives report is only available for topology reports.

« You can compare the current version of a report to an archive of that report or two
archives of the same report, but you cannot compare archives of different reports.

« The only format available for previewing and exporting the Compare Archives
report is the Excel format.

"How to Generate a Custom Report" on page 356

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z)

fe

Ee

i

Description

Expand All. Expands the entire hierarchical tree structure of the Cls you selected.
Collapse All. Collapses the hierarchical tree structure of the Cls you selected.
Previous Difference. Finds the previous occurrence of an item marked as changed.
Next Difference. Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the difference between the content
of the two configuration files. Configuration files use the .xml, .txt or .ini extensions.

Select a Cl of the CIT Configuration File in both panes and click the Show
Differences button. A window opens displaying the differences (marked in blue) in the
configuration files.

Show Only Different Cls in Tree. In the <Properties panes>, displays only the part
of the tree structure containing Cls that do not match.

Show Only Different Attribute Values. In the <Properties panes>, toggles between
displaying all the attribute values of the selected Cl or only the attribute values that
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Ul Element
(A-Z)

Fofa

]

HPE Universal CMDB (10.31)

Description

have changed.

Synchronize Selection. Enables you to select a Cl on one side and have its
corresponding Cl automatically selected on the other side.

The default state for the Synchronize Selection button is selected. Deselecting this
button allows you to select different Cls from each of the two trees. This enables you
to compare two different Cls and see their different properties.

Contains An Updated Item. Indicates that a Cl's attribute value has changed. For
example, a Contains an Updated Item icon is displayed next to the 10.0.0.0 Cl in
the figure below since the attribute of its child C1 10.168.100.3 icon has changed.

10.0.0.0

= 10.0.0.0

B4 Ipaddress

] 10.168.100.2
(1] 10.168.100.3
= @[ Windows

g P
me[  ]@0O

Value
Routing Domain Default Dom...
|2 )P Network Mask | 255.0.0.0

Mame |

Deleted Item. Indicates that a Cl has been deleted from the view.

New Item. Indicates that a new Cl has been added to the view.

B4 & 10000
4 Iptddress
[ 10168 100.2
4 [ 10.168.100.3
i+ Windows

Updated Item. Indicates that the attribute value of a Cl has changed.

For example, the figure below shows that the Cls LABM3MAM16 displays the
Updated Item icon because it was updated with a new Version value, as indicated

by the Show Only Different Attribute Values @ icons (see the Name and Value

columns in the bottom panes underneath the tree structure).
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Ul Element
(A-Z)

<Left and
right
panes>

<Properties
pane>

<Shortcut
Menu>

<Toolbar>

Available
Archives

Report with
archives

Description

sanity rep

Sun Apr 11 10:55:08 IDT ...

j LIV L 2
4 | ABM3LTDEO
| | ABM3LTDBEOZ

3

W LTI L T LT L Ty

| | ABM3LTOBO1 (LABM3LTDBO1)
4 | ABM3LTOEO2 (LABM3LTDEOZ)

Application Category | Databaze
Application Versio. .
Product Mame

! Version

sgl_server_dstab. ..

@ (4 LABM3LTDDBO g @ 4 | ABM3LTDDEO (LABM3LTDDEO
@ Y LABM3ZLTDDEOZ @ 4 | ABM3LTDDBOZ2 (LABM3LTDDEO
4 LABM3MAM1 6 hd o 1 LABM3MAMIE (LABM3MANITE)
4 11T k 4 {1 k
Bd. [ 1@ © d. [ 1@ ©
F-a

MName | Value Mame | Value

DiscoveredProduc... M3SGL DB DizcoveredProduc...  MSSGL DB

Application Category  Database
Application Versio...
ProductMame

! Version

sql_server_databa...
2005

Displays a hierarchical tree structure of all the Cls in the view for each archive. The

left side always represents the older of the two archives.

Displays the attributes of the selected CI.

The Properties pane contains the following fields:

« Name. Displays the name of the selected Cl as defined in the Cl's label.

« Value. Displays the attribute value for the currently selected CI.

Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For

details, see "IT Universe Manager Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.

Displays the available archives of the report selected in the Report with archives

field. Select the two archives you want to compare.

| Note: Visible when the Show Report Parameters button is pressed.

Displays the name of the report whose archives you want to compare. Only reports

with archives are displayed.

| Note: Visible when the Show Report Parameters button is pressed.
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Compare Cls Report

This report enables you to compare the hierarchies of two compound Cls. A compound Cl is a Cl that is
linked to another Cl by a relationship with the CONTAINER qualifier. You can display the compared
Cls and their child Cls that appear in a selected view, orin the CMDB.

Compared C1 0001 29F42268

Compared Cl 16595088 Default Domain ke

Mutual View:  unix_View_1

Compare on: O view ® cMDB

| Legend: @ Contains An Updated tem 5= No Matching C1 ¢ Updated tem |

000129F42269 16.59.50.88 DefaultDomain
B+ 2 noo128F42269 B+ [E] 165950 88 Defaut:Domain
-' Interface IpAddress
D (@] Ipaddress L ) 16 59 50.88
L[] 16.44.49.38 SNMP
D (@] SHMP L« "% SNMP (15585088 Defautt
Lo {:} SMNMP (D00129F42269)
4
P
4 ] [k
G 1O . 8. mml  18. .90
o
Mame | Value Mame | Value
DiscoveredProdu... | snmp k- DiscoveredProdu... | snmp =
Application Categ... Application Categ...
Application Versio... 3 <[1 Application Versio... 3
Producthame 1 Producthame 1
! Candidate For ... | Sat May 1 20100... ! Candidate For ... Sun May 2 20100...

To access = Select Managers > Modeling > IT Universe Manager. Right-click a Cl in the
Topology Map and select Compare Cls Report

or

Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Reportlﬂ button and select Compare Cls Report.
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Important
information

Relevant
tasks

« Under Compliance:
o Double-click Compare Cls Report.
o Right-click Compare Cls Report and select Create New Report.

o Select Compare Cls Report, and drag it onto the right pane.

« The Compare Cls page is divided into two panes. Each side displays a
hierarchical tree structure of the Cls you selected. When you select a Cl on one
side, the corresponding CI on the other side is automatically selected, provided
Synchronize Selection is pressed.

« You can compare only two Cls of the same CI type or one of the Cl type's children
in the hierarchy.

« The only format available for previewing and exporting the Compare Cls report is
the Excel format.

« "How to Compare Cls" on page 357

o "How to Generate a Custom Report" on page 356

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z)

M
‘e

@

Description

Previous Difference. Finds the previous occurrence of an item marked as changed.
Next Difference. Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the difference between the content
of the two configuration files. Configuration files use the .xml, .txt or .ini extensions.

Select a Cl of the CIT Configuration File in both panes and click the Show
Differences button. A window opens displaying the differences (marked in blue) in the
configuration files.

Show Only Different Cls in Tree. In the <Properties panes>, displays only the part
of the tree structure containing Cls that do not match.

Show Only Different Attribute Values. In the <Properties panes>, toggles between
displaying all the comparable attribute values of the selected CI or only the attribute
values that are different.

HPE Universal CMDB (10.31) Page 388 of 572



Modeling Guide

Chapter 9: Reports

Ul Element
(A-Z)

Fofa
ala

—_

L

Description

Synchronize Selection. Enables you to select a Cl on one side and have its

corresponding Cl automatically selected on the other side.

The default state for the Synchronize Selection button is selected. Deselecting this
button allows you to select different Cls from each of the two trees. This enables you

to compare two different Cls and see their different properties.

Contains An Updated Item. Indicates that a Cl's attribute value has changed. For
example, a Contains an Updated Item icon is displayed next to the IpAddress Cl in
the figure below since the attribute of its child Cl 10.168.100.2 icon has changed.

=2 (& 10000

=H@l®] paddress

o [l 10,002

o [Il] 10.168.100.2
< [llk] 10.168.100.3
s (@] Met Device

No Matching CI. Indicates that a Cl in one pane does not match any corresponding

Clinthe other pane.

The following example displays the No Matching Cl icon next to the Windows icon

because it does not have a corresponding Cl in the other pane.

=@ (& 10000

@ Ip&ddress

[ 10002

e [ 10168 100 2
=[] 10168100 3
+ (@] Net Device

-

@ [&] 16.59.124.0

o [l 1658124 1
o[l 1658124 2

L 165081240

Updated Item. Indicates that the attribute value of a Cl has changed.

For example, the figure below shows that the Cls 10.0.0.2 and 16.59.124.1 display
the Updated Item icon because they was updated with a new IP Network Mask

value, as indicated by the Show Only Different Attribute Values

@ icons (see

the Name and Value columns in the bottom panes underneath the tree structure).
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Ul Element
(A-Z)

<Toolbar>

<Shortcut
menu>

<Properties
pane>

<Left and
right
panes>

Compare
in

Description
10.0.0.0 16.59.124.0
-9 10000 B9 [&E 16591240
@ Ipdddress Ipliddress
10002 ':: 16.59.124.1
10.168.100.2 16591242
<[] 10.188.100.3 Hew Mode
+ (@] Net Devics L El1g591240
. Mew Mode q —' Switch
= Windows k

':j—' m3-cnk-01
= m3-cnk-02

e [ ]© ©

e [ ]© ©

Faa

MName | Value Name | Value
Routing Domain Default Domain Routing Domain Default Domain
|_!|IP Metwork Mask | 255.255.255.0 |!_|P Metwork Mask | 256.255.252.0

Enables you to move to the next or previous result of the search for the string entered

in the Find field.

For details, see "Report Toolbar Options" on page 456.

For details, see "IT Universe Manager Shortcut Menu" on page 231.

Displays the attributes of the selected Cl.

The Properties pane contains the following fields:

« Name. Displays the attribute name for the selected Cl, which was marked as
Comparable in the Cl Type Manager.

« Value. Displays the attribute value for the currently selected CI.

Displays a tree of the compared Cls and their child Cls that appear in the selected
view orin the CMDB, depending on whether you selected the View or the CMDB

options.

Select one of the following:

o CMDB. Includes the selected Cls and their child Cls that appear in the entire

CMDB.

« View. Includes the selected Cls and their child Cls that appear only in a specific

view.
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Ul Element
(A-Z) Description

Compared Enables you to select the two Cls you want to compare. Click ~|to open the Cls

Cl Selector dialog box. For details, see "C| Selector" on page 134. The Cl you select in
the top box is displayed in the left pane and the Cl you select in the bottom box is
displayed in the right pane.

Find Find. Enter a search name or a portion of a search name in the Find field to locate it in
the list.

Mutual If both of the Cls you are comparing exist within the same view, the name of the view

View is displayed in this field. Otherwise, the field displays the words No mutual view.

Compare Snapshots Report

This report enables you to compare two snapshots of a specific view taken at different times. It enables
you to visualize the differences between the views by comparing the statuses of the view at the times
the snapshots were taken.

Compare Snapshots Report1* |

5! Report Parameters B (== T o O - LS 4,7

iew with snapshots | Metworl Topology |v|
Awailable Snapshots | Time | Descrip... | Owner | Size | Mote |
Current Current 3,861
Mon Apr...  snapshot? 3,861
[] | Mon &pr... | snapshet! 3,861

=

| Legend: @ Contains An Updated kem ¥ Deleted kem = New kem ¢ Updsted tkem |

NetworkT opology Mon Apr 12 14:34:56 IDT ...

3
3

To access  Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report E1 button and select Compare Snapshots
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Report.
« Under Compliance:
o Double-click Compare Snapshots Report.
o Right-click Compare Snapshots Report and select Create New Report.
o Select Compare Snapshots Report, and drag it onto the right pane.

Note: You can also take and compare snapshots in IT Universe Manager (for
details, see "Save Snapshot Dialog Box" on page 246).

Important « You can compare a current snapshot to a previous snapshot or two snapshots
information taken in the past.

« You can define a schedule that takes snapshots of a specific view on a periodic
basis and saves them. For details, see "Schedule Report/Snapshot Dialog Box"
on page 440.

« The only format available for previewing and exporting the Compare Snapshots

report is the Excel format.

Note: Snapshots taken in a version prior to UCMDB 10.00 cannot be compared
with snapshots taken in UCMDB 10.00 or higher.

Relevant « "How to Compare Snapshots" on page 358
k
tasks « "How to Generate a Custom Report" on page 356

See also « "Save Snapshot Dialog Box" on page 246

« "Schedule Report/Snapshot Dialog Box" on page 440

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

=) Expand All. Expands the entire hierarchical tree structure of the Cls you selected.
|E| Collapse All. Collapses the hierarchical tree structure of the Cls you selected.

£ Previous Difference. Finds the previous occurrence of an item marked as changed.
3 Next Difference. Finds the next occurrence of an item marked as changed.
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Ul Element
(A-Z)

B

"
fea

]

L

HPE Universal C

Description

Show Configuration Files Differences. Shows the difference between the content
of the two configuration files. Configuration files use the .xml, .txt or .ini extensions.

Select a Cl of the CIT Configuration File in both panes and click the Show
Differences button. A window opens displaying the differences (marked in blue) in the
configuration files.

Show Only Different Cls in Tree. In the <Properties panes>, displays only the part
of the tree structure containing Cls that do not match.

Show Only Different Attribute Values. In the <Properties panes>, toggles between
displaying all the attribute values of the selected Cl or only the attribute values that
have changed.

Synchronize Selection. Enables you to select a Cl on one side and have its
corresponding Cl automatically selected on the other side.

The default state for the Synchronize Selection button is selected. Deselecting this
button allows you to select different Cls from each of the two trees. This enables you
to compare two different Cls and see their different properties.

Contains An Updated Item. Indicates that a Cl's attribute value has changed. For
example, a Contains an Updated Item icon is displayed next to the 10.0.0.0 Cl in
the figure below since the attribute of its child C1 10.168.100.3 icon has changed.

10.0.0.0

= 10.0.0.0
B4 Ipaddress
] 10.168.100.2

(] 10168.100.3

=1 (2] Windows

g P
me[  ]@0O

Value
Routing Domain Default Dom...
|2 )P Network Mask | 255.0.0.0

Mame |

Deleted Item. Indicates that a Cl has been deleted from the view.

New Item. Indicates that a new CI| has been added to the view.
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Ul Element
(A-Z)

<Left and
right
panes>

<Properties
pane>

<Shortcut
Menu>

Description

B4 [# 10000

B4 IpAddress
t@ 10.168.100.2
s [ 10.188.100.3

=+ |2 Windows

Updated Item. Indicates that the attribute value of a Cl has changed.

For example, the figure below shows that the Cls LABM3MAM16 displays the
Updated Item icon because it was updated with a new Version value, as indicated

by the Show Only Different Attribute Values @I icons (see the Name and Value

columns in the bottom panes underneath the tree structure).

sanity rep Sun Apr 11 10:55:08 IDT ...
f o LAELIVIIL 1 - A LTI L T L LTI e T
4 LABM3LTDBO 4 LABM3LTDEO (LABM3LTDEN)
4 LABM3LTDBOZ2 E 4 LABM3LTDEOZ (LABM3LTDEOZ) =
@ (4 LABM3LTDDBO g @ 4 | ABM3LTDDEO (LABM3LTDDEO
@ 4 | ABM3LTDDBEOZ @ 4 | ABM3ILTDDEOZ (LABM3LTDDED
4 LABM3IMAN16E - G 4 L ABM3MAMIE (LABM3MAMIE)
4 il 3 4 1[I 3
e [ | ® © . [ 0 | ©® @
FS
Mame | Value MName | Value
DigcoveredProduc...  MSSGL DB DigcoveredProduc...  MSSGL DB
Application Category | Database Application Category  Database
Application Versio... Application Versio...
Product Mame sql_server_dstab... ProducthName =ql_server_databa...
! Version ! Version 2005

Displays a hierarchical tree structure of all the Cls in the view for that snapshot
version. The left side always represents the older of the two versions.

Displays the attributes of the selected Cl.
The Properties pane contains the following fields:
« Name. Displays the name of the selected Cl as defined in the Cl's label.

« Value. Displays the attribute value for the currently selected ClI.

Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
details, see "IT Universe Manager Shortcut Menu" on page 231.
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Ul Element
(A-2) Description

<Toolbar>  For details, see "Report Toolbar Options" on page 456.

Available Displays the current status and previously saved snapshots of the view selected in
Snapshots  the View with Snapshots field. Select the two snapshots you want to compare.

By default, snapshots that have been empty for 3 months are hidden.
| Note: Visible when the Show Report Parameters button is pressed.

View with Displays the name of the view whose snapshots you want to compare. Only views for
snapshots | which snapshots have been taken are displayed.

| Note: Visible when the Show Report Parameters button is pressed.

Configuration Manager Policy Report

This report displays Configuration Manager policy compliance level data.

E ion...olicy Report1* |

2B B | =8 vees (]

Views  [test_no_space] leed

Group by | CI Type ﬂ

Configuration Manager Policy Report1
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Display Label

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

HPE Universal CMDB (10.31) Page 395 of 572



Modeling Guide
Chapter 9: Reports

the following:

Right-click Configuration Manager Policy Report and select Create New
Report.

Double-click Configuration Manager Policy Report.

Select Configuration Manager Policy Report in the Custom Reports pane and
drag it onto the right pane.

Important | This report only appears in the Custom Reports menu if Configuration Manager is

Information = running and is configured to work with UCMDB. The Configuration Manager URL
setting in Infrastructure Settings Manager must contain the URL of the Configuration

Manager application.

To view the report, you must configure the CMPolicyAdapter in UCMDB. For details,
see "Federation Workflow with UCMDB" in the HPE Universal CMDB Configuration
Manager User Guide.

Relevant "How to Generate a Custom Report" on page 356

tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Bar graph/
Pie chart>

<Breadcrumbs>

<Toolbar>

Group by

Description

The report shows the average compliance level of the members of each group
(according to the grouping selected under Group by) with their respective
policies.

You can click a group to drill down to the next level, which shows detailed
information for the Cls in the group.

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

For details, see "Report Toolbar Options" on page 456.

Select an attribute from the drop-down list The selected attribute determines how
the output is grouped along the x-axis of the report. It also determines which
columns appear in the second layer of the report.

The available options are:
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Ul Element (A-
Z) Description

o Cltype

« Classification
o Layer

« Policy name

« Policy compliance status

Views Click the ellipsis button to open a view selector dialog box. Select the required
views and click OK. You must select at least one view and no more than five.

Database Breakdown Report

This report displays the breakdown of database types and versions. You can view all databases
deployed in the system or the databases deployed at a specific location.

] Include A1l Integration Poirts

Country or Province: | Al

=]
State: [ 2 =]
City: [ 2 =]

Databazes Breakdown

Databases Breakdown
Break down by Count Click on the chart sections to drill down

MySQL
Amount: 100
Percentage: 25%

SQL Server
Amount: 228
Percentage: 56%
Oracle
Amount: 76

Percentage: 19%
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To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report|;| button and select Database Breakdown

Report.

« Under Breakdown:

o Double-click Database Breakdown Report.
o Right-click Database Breakdown Report and select Create New Report.

o Select Database Breakdown Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356

tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Bar graph/Pie
chart>

<Breadcrumbs>

<Shortcut
Menu>

<Toolbar>

Description

Each segment of the pie chart/column in a bar graph represents a different
database.

Click a slice/bar to view the database sorted by version, and then click again to
drill down to see the version information in table format.

When you hold the mouse over each segment/bar, a tooltip indicates the name of
the database, the number of Cl instances found for each database, the
percentage of the pie it represents (when viewing the information in pie chart
format), and the CI type the slice/bar represents.

The legend below the pie chart provides the name of each CI, and on the lower
level, their versions.

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Drill down to the level of individual Cls and right-click a Cl in the report to access
the IT Universe Manager shortcut menu. For details, see "IT Universe Manager
Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.
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Ul Element (A-
Z) Description
City Select the city for which you want to view database breakdown data, or select
All to show the breakdown for all cities.
Note: This is only relevant for CITs that contain data in the City attribute.
Country or Select the country or province for which you want to view database breakdown
Province data, or select All to show the breakdown for all countries or provinces.
Note: This is only relevant for CITs that contain data in the Country or
Province attribute.
Include All Select the check box to include federated Cls in the report. When the check box
Integration is cleared, only local Cls are included in the report.
Points
State Select the state for which you want to view database breakdown data, or select

All to show the breakdown for all states.

Note: This is only relevant for CITs that contain data in the State attribute.
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Delete Candidates Report

This report displays the CITs and relationships that were deleted within a defined period, and the ones
that are about to be deleted.

Time range: | Last day : Diate from: | Wed Feb 24 2010 05:31 PM IST | Date until: | Thu Feb 25 2010 05:31 PM IST

Deleted CIs and Candidates for Deletion (by CIT)

Break down by Deleted & Expecting deletion Click on the chart sections to drill down
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To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report ki button and select Delete Candidates Report.

« Under General:
o Double-click Delete Candidates Report.
o Right-click Delete Candidates Report and select Create New Report.

o Select Delete Candidates Report, and drag it onto the right pane.
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Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul

Element

(A-2) Description

<Bar Each segment of the column in a bar graph represents a CIT of a Cl or a relationship.
graph>

Click a bar to drill down to display the CITs and relationships that were deleted/are
about to be deleted in table format.

When you hold the mouse over the relevant color of each bar, a tooltip indicates the
number of Cls and relationships that were deleted or the ones that are about to be
deleted and the ClI type the bar represents.

The legend shows which color represents the Cls and relationships that were deleted,
and which color represents those that are about to be deleted. The CIT of each Cl or
relationship is displayed underneath.

<Toolbar> Fordetails, see "Report Toolbar Options" on page 456.
Date from = Configure a start date and time for the report.

Date until = Configure an end date and time for the report.

Time Select a time frame over which to display the detected changes. The system
range automatically provides the starting and ending dates in the Date from and Date until
boxes.

Note: If you select Custom, you can manually configure a starting and ending
date in the Date from and Date until boxes.

Dependency Report

This report enables you to generate a list of all the relationships of the type Dependency that connect
between servers in the selected view, or between the servers in the CMDB and the servers within the
selected view.

The report includes relationships that:
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o Exist between databases and clients
« Exist between clients and servers

« Are created as a result of an MQ connection

View: | Weblogic_To... | |...| Include information based on () CMDE (®) view

Node Relationship Counter | Clients
E or3 Talk 2 [DR3, DR3]
% ilodabm3amrnddb6 deviab ad Talk 2 [iledabm3amrnddb06 devlab ad, lodabm3amrnddb0s devl:
% WMAMRNDS1 Talk 2 [VMAMRND®1, WVMAMRNDS1]
% LABM3AMZ02 Talk 2 [LABM3AM202, LABM3IAM202]
% LABMZAM31 Talk 2 [LABM2AM31, LABM2AM31]
% ilo-llabezx23 devlab ad Talk 2 [lo-illabesx23 devlab ad, lo-llabesx23 deviab ad]
% ilodabm3erp0 deviab ad Tallk 2 [lodabm3erpd deviab ad, lodabm3erp0l devlab ad)
% WMFTRMND27 Talk 2 [VMFTRND27, VMFTRMND27]
% ilodabm3ccem29 devlab ad Tallk 2 [lodabm3cem29 devlab ad, lodabm3cem29 devlab ad]
% ilogh8920rfcE devlab ad Talk 2 [logh8920rfct deviab ad, ilogh8920rfcE devlab ad)
% ilo-llabbac011 deviab ad Tallk 2 [lo-illabbac011 deviab ad, lodlabbac011 deviab ad]
% ilodabm3amrnds? devlab ad Talk 2 [ledabm3amrnds? devlab ad, lodabm3amrmds? deviab ad
Q ilodabm3am235 deviab ad Talk 2 [ilodabm3am235 deviab.ad, lodabm3am235 deviak ad]

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report El button and select Dependency Report.
» Under General:

o Double-click Dependency Report.

o Right-click Dependency Report and select Create New Report.

o Select Dependency Report, and drag it onto the right pane.

Important You can create new TQL queries in Enrichment Manager using the Dependency
information relationship to describe the connection between nodes. Every new Dependency
relationship that is used appears in the Dependency report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
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Ul Element (A-2) Description
<Toolbar> For details, see "Report Toolbar Options" on page 456.

Include information Select one of the following:

based on . .
« CMDB. Display all the servers in the CMDB that are dependent on the
servers in the selected view.
« View. Display all the dependencies between the servers in the
selected view.
View Select the required view.

The generated report includes the following elements (listed alphabetically):

Ul Element (A-Z) Description

Clients The list of clients that are linked to the servers.

Counter The number of clients to which the server is connected.
Node The servers in the selected view.

Relationship The display label of the relationship in the Topology Map.

Discovery Errors Report

This report enables you to uncover specific problems that Data Flow Management encounters during a
run, for example, incorrect credentials.

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do
one of the following:

« Click the Create New Report || button and select Discovery Errors
Report.

« Under Discovery Status:
o Double-click Discovery Errors Report.
o Right-click Discovery Errors Report and select Create New Report.

o Select Discovery Errors Report, and drag it onto the right pane.

Important « Choose which columns to display by clicking the Select Columns button.
information
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« Hide a column by right-clicking its header and selecting Remove Column.

« Hide empty columns by right-clicking a header and selecting Remove
Empty Columns.

« Change the order of columns by dragging and dropping a column header.

Note: The Discovery Errors report is only relevant for errors in jobs that
are currently active.

See also « "Discovery Progress Dialog Box" in the HPE Universal CMDB Data Flow
Management Guide

« "Error Messages Overview" in the HPE Universal CMDB Developer
Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Discovery Select the module for which to display errors. You can select all modules or specific
Module modules.

Discovery Select a Data Flow Probe.
Probe

Generate  Click to generate a list of errors.

Severity Select the types of error to display. For error definitions, see "Error Severity Levels" in
the HPE Universal CMDB Developer Reference Guide.

Note: You can select multiple error types.

Time Select a time frame over which to display the errors. The system automatically
range provides the start and end dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a start and end date in
the Date from and Date until boxes.
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The generated report includes the following elements (listed alphabetically):

Ul Element (A-Z) Description

Cl Type The CIT of the trigger CI.
Count The number of errors contained in the Error Summary group.
Error Message The detailed error message.

Error Summary A brief summary of the error.

Note: Similar errors are grouped together. The count column shows the

number of errors.
Job The job for which the error was reported.
Probe The Data Flow Probe that reported the error.
Related IPs IPs known to be related to the trigger ClI.
Related Node The node that is related to the trigger ClI.
Severity The error severity level (Waming, Error, Fatal Error).
Time Error The time the error was reported.
Reported
Trigger CI The trigger Cl on which the error was reported.

Generic Breakdown Report
This report displays the breakdown of Cl types by the following:

o The CITs grouped under the selected CIT in the CIT tree

o A CIT attribute
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For more details about Cl types, see "Cl Type Manager" on page 481.

[7] Include A1 Integration Paints

CIT to break down: | Corfigurationtern |‘_

Break down By: | Cl Type
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Display Label

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report . button and select Generic Breakdown
Report.

« Under Breakdown:
o Double-click Generic Breakdown Report.
o Right-click Generic Breakdown Report and select Create New Report.

o Select Generic Breakdown Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Bar graph/Pie | Each segment of the pie chart/column in a bar graph represents a CIT ora CIT
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Ul Element (A-
Z) Description
chart> attribute, depending on how that level has been broken down.

Click a slice/bar to drill down to the next level, if one has been defined. You can
generate a report that has up to three different levels. You can also display the
information in table format.

When you hold the mouse over the relevant segment/bar, a tooltip indicates the
number of Cl instances found for that CIT or CIT attribute, the percentage of the
pie it represents (when viewing the information in pie chart format), and the CIT

or CIT attribute the slice/bar represents.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Drill down to the level of individual Cls and right-click a Cl in the report to access
Menu> the IT Universe Manager shortcut menu. For details, see "IT Universe Manager
Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Breakdown by | Select the required breakdown for the first level.

CIT to break The CIT whose instances are broken down by the selected attributes.

down

Include All Select the check box to include federated Cls in the report. When the check box
Integration is cleared, only local Cls are included in the report.

Points

Then by (Optional) Select the required breakdown for the second and third levels.

Gold Master Report

This report compares one or more Cls to another Cl that has been designated as a Gold Master, and
specifies which of the compared Cls are configured differently from the Gold Master ClI.

The report compares the attribute values of the Gold Master Cls to the attribute values of the Compared
Cl of the same CIT.
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Note:

« The Gold Master report only displays a Cl attribute comparison if the values are different.

« Gold Master reports are not available for federated Cls.

If a section is empty, it means that all attribute values of the Gold Master Cls and the Compared Cls for
that CIT are identical. In such a case, the attributes in the next layer in the subgraph are compared, and
the next one, and so on.

Once the compared Cls in a layer are found to have different attributes, the Gold Master report does not
continue the comparison of other layers in the subgraph for differences.

Master CI: labrm3gcrnddb02 ass

Compared Cls:  outdoor,zcdam036, otubman2-l,shvartsgl | s

Dizplay Identical Atribute Values

Exclude Cltypes: ass

To access

the following:

::I =TS I.-
Cisplay Label Attribute Name Value in Goldmaster CI Value in Compare:
El- [E] scdam03s =
EI— @ Windows Cl Instances Count 1
@ labm3gernddb ... Discoverediodel ProLiant BL460c G1 none
@ labm3gernddb .. Windows Physical Memory Size 2084960 none
@ labm3gernddb ... SwapMemory Size 4085 none
@ labm3gernddb...  DomainMName devlab _ad none
@ labm3gernddb..  MemorySize 2048 none
@ labm3gernddb ... DiscoveredVendor HP none
=+ (2] scdam07s
EI— @ Windows Cl Instances Count 2
@ labm3gernddb ... Discoverediodel ProLiant BL460c G1 none
@ labm3gernddie... Windows Physical Memory Size 2094960 none
@ labm3gernddi...  SwapMemory Size 4095 4092
@ labm3gernddi... DomainMame devlab . ad none =
@ labm3gernddi...  MemorySize 2048 4097
@ labm3qgernddi... DiscoveredVendor HP none

Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

Click the Create New Report|;| button and select Gold Master Report.

Under Compliance:

« Double-click Gold Master Report.

« Right-click Gold Master Report and select Create New Report.

« Select Gold Master Report, and drag it onto the right pane.
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Important Only attributes that have been assigned the Comparable qualifier in the CIT Manager

information = can be compared. For details, see "C| Type Manager" on page 481.

Relevant
tasks

"How to Compare Snapshots" on page 358

User interface elements are described below:

Ul Element (A-

Z) Description

<Shortcut For details, see "IT Universe Manager Shortcut Menu" on page 231.
menu>

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Attribute Name

Compared Cls

The name of the ClI attribute.

Enables you to select the Cls whose attribute values you want to compare to the
Gold Master Cl. Opens the Cl Selector. For details, see "CI| Selector" on page
134.

Display Select this check box if you want to include the compared Cls whose

Identical configuration is identical to that of the Gold Master ClI.

Attribute

Values Note: If you do not select this check box, the Value in Gold Master Cl and
Value in Compared CI columns of Cls with identical attribute values are
empty.

Display Label The display name of the Compared CI.

Exclude CI Select the Cl types to exclude from the report.

types

Master ClI Enables you to select the Cl you want to use as a Gold Master CI. Opens the Cl

Selector. For details, see "C| Selector" on page 134.

Value in The value of the attribute in the Compared CI.

Compared CI

Value in Gold The value of the attribute in the Gold Master ClI.

Master ClI
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Hardware Component Summary Report

This report displays data for all the node elements of hardware types detected in the system.

[ Hardware Comp...mmary Report1* x|
| &= - & - Show Clinstances of: | Interface (12) > S| 7wt
Hardware Compenent Summary Report 2 Interface

Display Label | InterfaceDescription | MacAddress

(] e100000 0050569B66C9
(] e100090:1
[ et Agdvanced Micro Devices [AMD] 79c870 [PCnet32 LANCE] D05056AAD067
=
9 100
m Local Area Connection 2 Intel(R) PRO/1000 MT Network Connection #2 005056 AAD00A
m Local Area Connection® 11 Teredo Tunnefing Pseudo-Interface 020054554E01
(] Local Area Connection* 8 isatap.asiapacific. hpacorp.net
[ﬁ Local Area Connection™ 8 6704 Adapter
() Loopback Pseudo-Interface 1 Software Loopback Interface 1
() Microsoft Tun Miniport Adapter Microsoft Tun Miniport Adapter 020054564E01
() virbro DEESBAPACTIE

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report |;| button and select Hardware Component

Summary Report.
« Under Inventory:
o Double-click Hardware Component Summary Report.

o Right-click Hardware Component Summary Report and select Create New
Report.

o Select Hardware Component Summary Report, and drag it onto the right
pane.

Important | The top level of the report displays the number of elements for each device type. Click
information = on a number to drill down to the next layer and view a list of the individual hardware
components with detailed data.

The hardware components displayed in the report include CPUs, disk devices, fans,
hardware boards, 1/0 slots, interfaces, memory units, physical ports, power supplies,
printers and SCSI adapters.

Use the Select Columns [! button to select the attributes to display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.

Impact Analysis Report

This report displays a list of Cls that are impacted in the system as a result of simulated changes. For
details, see "Run Impact Analysis Dialog Box" on page 244.

I 5! Report Parameters | = & - E‘ a

Triggered Cls:  C2 s | Severity:| Major(7) Rule Bundle:; I_ICMDB
Trigaered Cls || Grouping by CIT || Affected Application
Show Cl instances of: | sructureElement (3) T| ﬁ [m =t Q
Display Label
] 1abm2am11
Lh 1112222
] 1abm2am04

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report|£| button and select Impact Analysis Report.
» Under General:

o Double-click Impact Analysis Report.

o Right-click Impact Analysis Report and select Create New Report.

o Select Impact Analysis Report, and drag it onto the right pane.

Relevant "How to Generate a Custom Report" on page 356
tasks
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See also « "Impact Analysis Manager" on page 462

« "RunImpact Analysis Dialog Box" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<Shortcut Menu> Right-click a Cl in the report to access the IT Universe
Manager shortcut menu. For details, see "IT Universe
Manager Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Rule Bundle Enables you to select the rule group with which the Impact
Analysis rule works.

Severity Sets the severity level that we want to simulate for the
triggered Cls.

Triggered Cls Select the Cls that represent the changes you want to
make to the system. Opens the CI Selector.

Affected Application Tab

This tab displays all the Cls that belong to a specific business application, which were affected by the
triggered Cl severity change.

User interface elements are described below:
Ul Element (A-Z) Description
Display Label The name of the ClI or relationship as it appears in the topology map.

Trigger Severity The severity selected in the Severity box.

Grouping by CIT Tab

This tab displays all the Cls related to the triggered Cls that are impacted in the system as a result of
the simulated changes, sorted by Cl type.

User interface elements are described below:
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Ul Element (A-2)

Display Label

Trigger Severity

Description

The name of the ClI or relationship as it appears in the topology map.

The severity selected in the Severity box.

Triggered Cls Tab

This tab displays all the Cls that represent the changes you want to make to the system. The Cls in
this tab are the Cls selected in the Triggered Cls box.

User interface elements are described below:

Ul Element (A-Z)

Display Label

Job List Dialog Box

Description

The name of the Cl or relationship as it appears in the topology map.

This dialog box displays a list of the reports/snapshots that were scheduled to run in the "Schedule
Report/Snapshot Dialog Box" on page 440.

Job List
Job List
o %
Name Description Current._.. | Execution... |Last Exec... | Next Exe... | Time Zone
Il =I5 2 2
oK [ Help |

To
access

HPE Universal CMDB (10.31)

« Todisplay a list of reports scheduled to run, select Managers > Modeling >

Reports. On the Reports page, click the Show Scheduled Report Jobs © button.

« Todefine a schedule for taking snapshots, select Managers > Modeling > Reports.

In the Topology Reports pane, select the required view, click the Snapshots [

button, and then select Show Scheduled Snapshot Jobs.
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Relevant
tasks

« "How to View a Topology Report" on page 355

« "How to Generate a Custom Report" on page 356

User interface elements are described below:

Ul Element
(A-Z)

Q)

%

m

Current
Status

Description

Insert New Scheduled Report. Enables you to define a new job using the Schedule
Report dialog box.

Edit Job. Enables you to edit the selected job using the Schedule Report dialog box.

Create Copy. Enables you to create a copy of the selected job. Opens a new job in
the Schedule Report dialog box that uses the details of the selected job.

Remove Job. Deletes the selected job from the list of scheduled jobs.
Run Job Immediate. Runs the selected job.
Pause Job. Pauses the selected job. Enabled only if the job has a Pending status.
Resume Job. Resumes the selected job.

Note: The Resume button is enabled only for jobs that have a Paused status.
Refresh. Refreshes the list of scheduled jobs.
Clear filter. Clears the current filter.

Change visible columns. Enables you to select the columns to be displayed.

The current status of each scheduled job:
« Running. The job is currently executing.
« Pending. The job is waiting for the scheduling requirements to be fulfilled.
« Completed. The job has finished executing.
« Paused. The job has been paused.
Note: If ajob has a Completed status, and you want to resume running the job,

you can either click Run Job Immediate or change the Next Execution Time to
the current time. If you change it to a future time, the status changes to Pending.
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Ul Element
(A-Z) Description

Description = A description of the scheduled job as defined in the Schedule Report dialog box.

Execution | Thejob's current execution status:

Status « Success. The job completed successfully (denoted by the @ icon).
. Failure. The job failed to execute (denoted by the € icon). Hold the pointer over
the @ icon to display:
o A description of the error
o The related Universal CMDB internal exception
« None. Thejob has not yet been executed.
Last The last time the report ran.
Execution
Time
Name The name of the scheduled job as defined in the Schedule Report dialog box.
Next The next time the report is scheduled to run.
Execution
Time

Time Zone | The time zone in which the job is scheduled to run.

Licensed OSlIs Report

This report shows all the licensed OSlIs (UDi and Full) and all third-party licenses that are counted.

@ Licensed OsIs1= x| 4rBE

B & =ae -8 -

Licensed Cls|| Third party icense|| ASM License] |
Show Clinstances of: [ Windows 28) v % | & | [} =t | @
Cl Identification | Cl Type UD Full | CM Managed

@ achmal Windows true A
5 amcbtest11 Windows true =
5 amdborat02 Windows true

@ amgaautols Windows true

@ amgaautols Windows true

@ appsvmeT Windows true

E5 ddmivm15 Windows true - 3
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To access Select Modeling > Reports. In the Custom Reports pane, do one of the
following:

« Click the Create New Report ekl button and select Licensed OSls Report.

« Click Administration and do one of the following:

o Right-click Licensed OSls Report and select Create New Report.

o Double-click Licensed OSls Report.

o Select Licensed OSls Report and drag it onto the right pane.

Relevant "Generate a Custom Report" in the HP Universal CMDB Modeling Guide
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-2) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> Fordetails, see "Report Toolbar Options" on page 456.

Licensed Cls Tab

Important To view the change history of a Cl, right-click anywhere in the row of the required
Information Cl and select Cl History.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<Toolbar> For details, see "Report Toolbar Options" on page 456.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on page
231.

Cl Identification The name and icon of the CI.

Cl Type The type of the CI.
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Ul Element (A-2) Description
CM Managed Indicates whether a CM license is available or not.
UD Full/UD SAW The Ul element displayed for this column depends on the type of

the existing license and whether the license is available or not.

UD Inventory Indicates whether a UD Inventory license is available or not.

Note: The CM Managed, UD Full/UD SAW, and UD Inventory columns are visible in the user
interface if a relevant license of that sort is applied.

Values for these three columns include:

« "true" if the Cl instance is counted in the relevant context of the similar license

« "false" if the Cl instance is counted in the relevant context of the similar license, but exceeds
capacity limit.

« "-"if the Cl instance is not applicable within the license type mentioned above.

Third party licenses Tab

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

<Toolbar> For details, see "Report Toolbar Options" on page 456.
Adapter The name of the adapter.

Name

Integration The name of the integration that is taken into consideration for a Managed Data

Name Repository (MDR) license.

ASM License Tab

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<Toolbar> For details, see "Report Toolbar Options" on page 456.
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Ul Element (A-2) Description
Display Label Name for a Discovery Service Activity.
ASM License Indicates status of ASM license:

« True-A valid ASM license is available.

« False - ASM license is not available.

Migration Progress Report

This report displays information about nodes and agents that may be useful after a DDMI to Universal

Discovery migration.

To Select Modeling > Reports. In the Custom Reports pane, click Administration, then
access select Migration Progress Report. Click Generate to create a report.

User interface elements are described below:

Ul
Element
(A-Z) Description

<Toolbar> For details, see "Report Toolbar Options" on page 456.

Group by  Select the grouping you want. For example, to see the nodes that have agents
installed, select Nodes with agents. Moreover, to see an overview of all parameters
with count information, select Overview.

Network Device Breakdown Report

This report displays a breakdown of network devices. Only the network devices that meet the following
conditions appear in the report:

« The CIT of the network device has been assigned the qualifier NETWORK_DEVICES. For details,
see "Qualifier Tab" on page 84.
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[T Inchude Al Integration Points

Country ar Province: | A |v|
State: [ (=]
City: | Al |v|

Network Devices Breakdown

Break down by Cl Instances Count Click on the chart sections to drill down

Load Balancer
Amount: 1
Percentage: 3%

Switch
Amount: 16
Percentage: 43%

Met Device
Amount: 20
Percentage: 54%

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report || button and select Network Device
Breakdown Report.

« Under Breakdown:
o Double-click Network Device Breakdown Report.

o Right-click Network Device Breakdown Report and select Create New
Report.

o Select Network Device Breakdown Report, and drag it onto the right pane.
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Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Bar graph/Pie = Each segment of the pie chart/column in a bar graph represents a different
chart> network device.

Click a slice/bar to drill down to see the number of Cl instances per network
device.

When you hold the mouse over each segment/bar, a tooltip indicates the name of
the network device, the number of Cl instances found for each network device,
the percentage of the pie it represents (when viewing the information in pie chart
format), and the CI type the slice/bar represents.

Click a segment/bar to view a specific network device sorted by manufacturer.
Click a segment/bar again to view the details of the Cl instances found for that
network device for that manufacturer in table format.

Each color in the legend represents a different network device.

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Toolbar> For details, see "Report Toolbar Options" on page 456.

City Select the city for which you want to view operating system breakdown data, or
select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in the City attribute.

Country or Select the country or province for which you want to view operating system
Province breakdown data, or select All to show the breakdown for all countries or
provinces.

Note: This is only relevant for CITs that contain data in the Country or
Province attribute.

Include All Select the check box to include federated Cls in the report. When the check box
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Ul Element (A-

Z) Description

Integration is cleared, only local Cls are included in the report.

Points

State Select the state for which you want to view operating system breakdown data, or

select All to show the breakdown for all states.

| Note: This is only relevant for CITs that contain data in the State attribute.

Node OS Breakdown Report

This report displays a breakdown of operating systems. You can view all deployed operating systems
or you can view data for operating systems at a certain location or running on a certain subnet.

] nciude 21 ntegration Poirts

Fiter: (®) By Location () By Subnet

Courtry or Province:

ERRERREN

State
ity
—

Nodes Breakdown

Break down hy: Cl Instances Count Click on the chart sections to drill down

40

Cl Instances Count
S o ow oW
mn S & e o

o

o

o

5\')
G

Display Label

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

the following:

« Click the Create New Report|;| button and select Node OS Breakdown
Report.
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« Under Breakdown:

Relevant
tasks

o Double-click Node OS Breakdown Report.
o Right-click Node OS Breakdown Report and select Create New Report.

o Select Node OS Breakdown Report, and drag it onto the right pane.

"How to Generate a Custom Report" on page 356

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Bar graph/Pie
chart>

<Breadcrumbs>

<Shortcut
Menu>

<Toolbar>

City

Country or
Province

HPE Universal CMDB (10.31)

Description

Each segment of the pie chart/column in a bar graph represents a different
operating system.

Click a slice/bar to drill down to see the number of Cl instances per operating
system in table format.

When you hold the mouse over each segment/bar, a tooltip indicates the name of
the operating system, the number of Cl instances found for each operating
system, the percentage of the pie it represents (when viewing the information in
pie chart format), and the CI type the slice/bar represents.

Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Drill down to the level of individual Cls and right-click a Cl in the report to access
the IT Universe Manager shortcut menu. For details, see "IT Universe Manager
Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.

Select the city for which you want to view operating system breakdown data, or
select All to show the breakdown for all cities.

Note: This is only relevant for CITs that contain data in the City attribute.

Select the country or province for which you want to view operating system
breakdown data, or select All to show the breakdown for all countries or
provinces.
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Ul Element (A-
Z) Description
Note: This is only relevant for CITs that contain data in the Country or
Province attribute.
Filter Select one of the following:
« By Location. Select the required location.
« By Subnet. Enter the required subnet. You can use the wildcard character
asterisk (*) to include several subnets. For example, 1 1 *.
Include All Select the check box to include federated Cls in the report. When the check box
Integration is cleared, only local Cls are included in the report.
Points
State Select the state for which you want to view operating system breakdown data, or

select All to show the breakdown for all states.

| Note: This is only relevant for CITs that contain data in the State attribute.

Node Summary Report

This report displays all the nodes detected in the system and the hardware installed on them.

Group By: Mone bt
B s
Display Label Memory Units Create Time Cl Type
LABM3UCMDEBOB devlab ac [0 | Monapri62m20428 AMIDT  nt
% MTest 1] Mon Apr 16 2012 08:58 AM IDT hode
% e Mode: a Tue Apr A7 2012 09:55 AW DT node
% node 0] Wlon Apr 16 2012 0505 &AM DT node

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report i button and select Node Summary Report.

« UnderInventory:
o Double-click Node Summary Report.

o Right-click Node Summary Report and select Create New Report.
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o Select Node Summary Report, and drag it onto the right pane.

Important If you select one of the grouping options, the top level of the report displays the

information number of nodes for each group. Click on the number of nodes to drill down to the next
layer and view data for those nodes. If you selected None as the grouping option, all
the nodes appear in the top layer.

The second layer also contains some summary columns with numbers that are
clickable links (for example, Disk Devices displays the number of disk devices for
each node). Click the number to drill down to the next layer and view detailed data.

In any layer, you can use the Select Columns ¥ putton to select the attributes to

display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.
Group By Select the method for displaying the data. The available options are:

« None

» Location

o OS Family
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Node Summary by VLAN Report

This report displays all the nodes detected in the system grouped by VLAN.

[ Node Summary by VLAN Reporti* = |

| = - & - Show Gl instances of: s SN 11NN e

VLAN | Device Count

trnet-default
feldlinet-clefaut
VLAND 76
VLA 77
defautt
feldi-clefautt
token—ring-defautt
VLARND 78

==

=

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report L& putton and select Node Summary by VLAN
Report.

« UnderInventory:
o Double-click Node Summary by VLAN Report.

o Right-click Node Summary by VLAN Report and select Create New
Report.

o Select Node Summary by VLAN Report, and drag it onto the right pane.

Important The top level of the report displays the number of devices for each VLAN. You can
information = click the number to drill down to view detailed data on each VLAN. Use the Select

Columns I button to select the attributes to display in the report.
Note: Nodes not connected to a VLAN are not displayed in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.
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Ul Element (A-
Z) Description

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.

Number of Changes Report

This report displays the number of detected changes in a CIT (additions, deletions, or updates) within a
defined time period.

Time range: | Last day Date from: | Mon Mar 1 2010 0319 PM IST * | Date until: | Tus Mar 2 20100319 PM IST +*

Number of Changes Grouped by CI Type

Break down by Number of Changes Click on the chart sections to drill down

150

150
140

130
120
110
100
90
B0
70
&0

Number of Changes

50
40
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To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report | button and select Number of Changes

Report.
« Under Change:
o Double-click Number of Changes Report.
o Right-click Number of Changes Report and select Create New Report.

o Select Number of Changes Report, and drag it onto the right pane.

Important Note: In a multi-tenancy environment, the Number of Changes report only
information | isplays changes that are relevant to the tenants associated with your View Cls
permission. However, Remove Cl/relationship events that occurred before an
upgrade to UCMDB version 10.01 are displayed independent of the tenants

associated with the View Cls permission.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul

Element

(A-Z) Description

<Bar On the first level, each segment of the pie chart/column in a bar graph represents a CIT

graph/Pie of a Cl or a relationship in which there was a detected change. The legend displays the
chart> colors that represent each CIT.

When you hold the mouse over the relevant color of each segment/bar, a tooltip
indicates the number of changes that occurred for that CIT the percentage of the pie it
represents (when viewing the information in pie chart format), and the Cl type the
slice/bar represents

Click a slice/bar to drill down to the second level. to view the types of changes that
occurred for each CIT and the CIT's children. The colors in each segment/bar represent
the different types of changes that occurred in the application. See the legend to verify
the change type each color represents.

Click the required color to drill down to see the number of Cls or relationships for that
type of change in table format. Once you do the second drill down, you get the
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Ul
Element
(A-Z)

<Shortcut
Menu>

<Toolbar>
Date from
Date until

Time
range

Description
instances that represent the changes described.

Changes of type added or updated are taken from the CMDB. Changes of type
deleted are taken from the CI or relationship history.

Drill down to the level of individual Cls and right-click a Cl in the report to access the IT
Universe Manager shortcut menu. For details, see "I'T Universe Manager Shortcut
Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.
Configure a start date and time for the report.
Configure an end date and time for the report.

Select a time frame over which to display the detected changes. The system
automatically provides the starting and ending dates in the Date from and Date until

boxes.

Note: If you select Custom, you can manually configure a starting and ending

date in the Date from and Date until boxes.

Recognized Applications Report

This report displays all the installed applications on the node where you are running the discovery

probe.

Group By: | Felated Mode :

| i

o

Recognized Applications Report 5 Installed Softwares Oh amdewv02

& 7zip

@ Adobe Reader

@ AszetCenter

@ Business Chjects Enterprize Client Tools
@ CollabMet Subversion Command-Line Client
(@) crystal Report Furtime

(2] DE2 Data Server Clisnt

@ Firefox

@ HF fAzset Manager

(@] HP Asset Manager AP

@ HF &zset Manager Inport Tool

@ HP Performance Mahager
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Display Label DiscoveredyWendor Version
Igor Pawvlow 442
Adobe 708
Hewlett-Packard (Peregring Systems) 4.00
SAP (Business Ohjects) EARCH |
CollahMet 1612
SAP (Business Objects) 2005 sp3
1BM 9.7.300.291
Mozilla 3617
Hewlett-Packard 812
Hewlett-Packard 9.30
Hewlett-Packard .11
Hewlett-Packard .00
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To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report B button and select Recognized Applications
Report.

« Under Inventory:
o Double-click Recognized Applications Report.

o Right-click Recognized Applications Report and select Create New
Report.

o Select Recognized Applications Report, and drag it onto the right pane.

Important The top level of the report displays the number of installed applications for each
information application. You can drill down to view detailed data on specific installed applications.

Use the Select Columns ¥ button to select the attributes to display in the report.
When the report is grouped by Application Name or Vendor Name, a column called
Installed On is available at the level of installed applications (after drilling down). The
column displays the location where the application is installed and provides a
clickable link to the node.

When the report is grouped by Related Node, a column called Installed Software is
available, which displays the number of installed applications on that node. It also
provides a clickable link to drill down and display the applications' details.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.
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Ul Element (A-
Z) Description
Group By Select the method for displaying the data. The available options are:

« Application Name
o Vendor Name

o Related Node

Report Properties Dialog Box

This dialog box enables you to set the report title and subtitle.

To Click the Report Properties bl button on the report toolbar in the Reports module or on
access | the TQL Query Editor toolbar in Modeling Studio.

See "Topology Reports Overview" on page 354
also

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
Format Select the report format. The following options are available:

« Flat. The Cls in the top layer are displayed as links. You can click a Cl to drill
down to display its children.

« Hierarchical. All Cls of the report are displayed in one table in tree format.

Sub Report  Select the Sub Report Perspective check box to make this perspective available
Perspective | for building a Sub Report in the Generate Sub Report dialog box.

Note: This check box is only available in the Report Properties dialog box for
perspectives.

Subtitle Enter the report subtitle.

Title Enter the report title.
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Reports Page

This page enables you to create Topology reports based on the data in views, as well as a number of
predefined Custom report types.

To access Managers > Modeling > Reports

Relevant tasks « "How to View a Topology Report" on page 355
« "How to Generate a Custom Report" on page 356
« "How to Compare Cls" on page 357

« "How to Compare Snapshots" on page 358

See also « "Report Toolbar Options" on page 456
« "Custom Reports Overview " on page 355

« "Topology Reports Overview" on page 354

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-2) Description
<Left The following panes are included:
pane> . .
« Topology Reports. Displays reports of the views and templates that were created
using the Modeling Studio. For details, see "Topology Report" on page 449.

« Custom Reports. Displays various preset types of reports in chart or table format.
For details, see "Reports User Interface" on page 360.

<Right Displays the selected report.
pane>

Left Pane

User interface elements are described below:
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Ul

Element
(A-Z)

Description
Create New Report. Enables you to select the type of report that you want to create.

In the Topology Reports pane, select Pattern View, Perspective, or Template, and
you go directly to the Modeling Studio to create the selected type of resource.

In the Custom Reports pane, select a report from the list of Custom reports.
Open Report. Generates an existing report in the Report pane.

Show View Definition. Displays the selected view's definition in the Modeling
Studio. For details, see "Modeling Studio" on page 251.

Note: This option is available only for Topology Reports.

Delete Report.
« Inthe Custom Reports pane, deletes the selected report.

« Inthe Topology Reports pane, deletes the archived report.

Compare Report Archives. Opens the Compare Archives report when two archives
of the same report are selected.

Note: This option is available only for Topology Reports.

Schedule Report. Opens the Schedule Report dialog box, which enables you to
define a job that:

« Schedules the generation of a report

« Specifies one or more formats in which to send the report, and the report's
recipients

« Specifies the recurrence of the job

For more information on the Schedule Report dialog box, see "Schedule
Report/Snapshot Dialog Box" on page 440.

Note: This option is available only before you generate a report or when you open
a saved report.

Show Scheduled Reports Jobs. Opens the Job List dialog box, which displays the
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ul
Element
(A-Z) Description

reports that have been scheduled to run. For details, see "Job List Dialog Box" on page
413.

[= Snapshots. Enables you to do the following:

« Save asnapshot of the active report. For details, see "Save Snapshot Dialog Box"
on page 246.

« Compare a previously saved snapshot to the active report or to another snapshot.
For details, see "Compare Snapshots Report" on page 391.

« Schedule snapshots to be saved. For details, see "Schedule Report/Snapshot
Dialog Box" on page 440.

« Display the currently scheduled snapshot jobs. or details, see "Job List Dialog
Box" on page 413.

Note: This option is available only for Topology Reports.

B4 Send Mail. Opens the Send Mail dialog box. You can send an email containing the
generated report in various formats, or as a direct link. For details on the various
formats, see "Report Toolbar Options" on page 456.

Select one or more of the available formats for the generated report to be sent as
attachments to an email recipient.

Note:

« Required fields are marked with an asterisk.
« When entering an email address, ensure that the email's domain is a valid one.

« Inthe Send Mail dialog box, the From field is populated with the email address
defined in the user details for the current user. If no email is defined for the
current user, the default email address of the customer is used.

= Generate Direct Link. Creates a direct link to the specific location on the server of the
selected report, or to the data that you have exported as a specific format.

|E| Export Report. Enables you to select the format for previewing and exporting the
report. The available options are:
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ul
Element
(A-Z) Description
o CSV. The report data is formatted as a comma-separated values (CSV) text file
that can be displayed in a spreadsheet.
Note: Forthe CSV formatted table data to display correctly, the comma (,)
must be defined as the list separator. In Windows, to verify or modify the list
separator value, open Regional Options from the Control Panel, and on the
Numbers tab ensure that the comma is defined as the List Separator value. In
Linux, you can specify the list separator in the application that opens the
CSVfile.
« PDF. The report data is exported in PDF format.
Note: When exporting to PDF, select a reasonable number of columns to
display to ensure that the report is legible.
o XLS. The report data is formatted as an .xlIs (Excel) file that can be displayed in a
spreadsheet.
Note: Forlarge reports, you can reduce the time required for exporting the
report by setting a fixed column size using the Column Size For XLS Export
setting in the Infrastructure Settings Manager.
« XML. The report data is formatted as an XML file that can be opened in a text or
XML editor.
Tip: To extract HTML code from the report:
o Open the file in an HTML editor
« Copy the relevant table into the target file
Note: When you export a generated report, a dialog box opens asking whether
you want to open the exported file. You can define whether to hide or display this
message using the "User Preferences Dialog Box" on page 92.
= Refresh. Refreshes the report tree.
=) Expand All. Expands the tree structure.
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ul

Element

(A-Z) Description

B Collapse All. Collapses the tree structure.

& Assign Tenants. Opens the Assign Tenants dialog box which enables you to assign
tenants to the selected custom report.

Note:
« This option is only relevant when a saved Custom Report is selected.
« This option is only available when multi-tenancy is enabled.
Manage Security. Enables you to assign permission for the selected custom report to
specific roles or to add the report to selected resource groups.
| Note: This option is only available for Custom Reports.

&= Hide Empty Folders. Toggles between displaying all folders and only folders that
contain reports.

@ ©  Find the next occurrence of the phrase/Find the previous occurrence of the
phrase. Enables you to move to the next or previous result of the search for the string
entered in the Find field.

= Highlights all occurrences of the phrase. Highlights all occurrences in the Cl tree
of the string entered in the Find field.

Find Enter a search name or a portion of a search name in the Find field to locate it in the

list.

Rulebase Support Report

This report displays information about device nodes and their attributes. This report may be useful for
troubleshooting issues with the rulebase.

| Note: Export this report in .csv format when sending to HP Support.

To Select Modeling > Reports. In the Topology Reports pane, click Network, then double
access click Rulebase Support Report.

User interface elements are described below:
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Ul Element (A-2)

<Toolbar>

Description

For details, see "Report Toolbar Options" on page 456.

Scan File Status Report

This report displays the scan files generated by the Inventory Discovery by Scanner discovery job.

[ Report Parameters i & - # - Show Clinstances of: | Node (56) > Mt Q
Time range: | Lastday | v | Date from: [ 424112 4:22PM_ | Date unti [ 4/25/124:22PM ¥
L-‘. e ‘

Hast | Run Date Scanner Ci | Upgrade Date Probe Name
itsamgavm02 ‘Wed Apr 25 2012 12:12 PM CST _default.oxz. Wed Apr 25 2012 11:38 AM CST DataFlowProbe
PCOESHV22 ‘Wed Apr 25 2012 11:53 AM CST _default oxz. Wed Apr 25 2012 11:26 AM CST DataFlowProbe
BBPFSMM2 ‘Wed Apr 25 2012 11:53 AM CST _default oz Wed Apr 25 2012 11:28 AM CST DataFlowProbe
itsamgavm59 ‘Wed Apr 25 2012 11:55 AM CST _default oz Wed Apr 25 2012 11:27 AM CST DataFlowProbe
WIN-B2FVLLC2080 ‘Wed Apr 25 2012 11:54 AM CST _default oz Wed Apr 25 2012 11:26 AM CST DataFlowProbe
ddmivm23 Tue Apr 24 2012 08:39 PM CST _default oz Tue Apr 24 2012 08:04 PM CST DataFlowProbe
BBPFSMMS5 ‘Wed Apr 25 2012 11:57 AM CST _default oz Wed Apr 25 2012 11:32 AM CST DataFlowProbe
‘amdevjp ‘Wed Apr 25 2012 11:40 AM CST _default oz Wed Apr 25 2012 11:26 AM CST DataFlowProbe
ucmdb0101 ‘Wed Apr 25 2012 12:01 PM CST _default oz Wed Apr 25 2012 11:38 AM CST DataFlowProbe
itsamgavmb4 ‘Wed Apr 25 2012 12:08 PM CST _default oz Wed Apr 25 2012 11:33 AM CST DataFlowProbe
SAQAXSS30VMP1Z ‘Wed Apr 25 2012 12:03 PM CST _default oz Wed Apr 25 2012 11:39 AM CST DataFlowProbe
QASERVERZ ‘Wed Apr 25 2012 12:15 PM CST _default oz Wed Apr 25 2012 11:39 AM CST DataFlowProbe
g1invm145 ‘Wed Apr 25 2012 11:56 AM CST _default oz Wed Apr 25 2012 11:26 AM CST DataFlowProbe
itsamgavm145 ‘Wed Apr 25 2012 11:51 AM CST _default oz Wed Apr 25 2012 11:26 AM CST DataFlowProbe
SMCIo31 ‘Wed Apr 25 2012 11:54 AM CST _default.oz Wed Apr 25 2012 11:27 AM CST DataFlowProbe

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:
« Click the Create New Report 21| button and select Scan File Status Report.
« Under Discovery Status:
o Double-click Scan File Status Report.
o Right-click Scan File Status Report and select Create New Report.
o Select Scan File Status Report, and drag it onto the right pane.
Important The Host column indicates the node on which the scan file is generated. The Run
information Date and Upgrade Date columns display the latest run and upgrade times for the
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scanner . The Scanner Configuration and Probe Name columns display the
configuration file and data flow probe gateway last used by the scanner. There is a
hidden column called Scan File Path, which displays the full path of the scan file
stored on the Data Flow Probe. To display this column, add it to the visible columns

manually using the Select Columns ™ putton every time a new report is generated.

You can download the selected scan file to the local machine by right-clicking a scan
file and selecting Download Scan File from the context menu. If the Inventory Tools
are installed on the computer, when you open the downloaded scan file, the Viewer
application is launched to display the contents of the scan file. For more information,
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see Inventory Tools in the HPE Universal CMDB Data Flow Management Guide.

Right-click a scan and select View Communication Log to display the scanner log
for debug information. This option is only available when the scan did not finish
successfully.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-2) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> Fordetails, see "Report Toolbar Options" on page 456.
Date from = Configure a start date and time for the report.
Date until = Configure an end date and time for the report.

Time Select a time frame over which to display the scan files. The system automatically
range provides the starting and ending dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a starting and ending
date in the Date from and Date until boxes.
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Scanner Execution Details Report

This report displays runtime data from all Inventory Discovery jobs.

Job Status:

Group By:

oo ETElE

Display Label
deimivmO3
autozerver]
amclew2003
appsvn7d
btoaZkir2en20
arndey02
tEarmgavmGd
*=930vwmdew10

To access

Mone bl

Scanner Wersion

100.00.000 build 400
10,000,000 build 400
10,000,000 build 400
10000000 build 400
10.00.000 build 400
10.00.000 build 400
100.00.000 build 400
10,000,000 build 400

the following:

« Click the Create New Report|:
Report.

« Under Discovery Status:

Important

Report.

Start Tim
fed Mar 21 2012 01:
red Mar 21 2012 01:
red Mar 21 2012 01:
fed Mar 21 2012 01:
red Mar 21 2012 01:
red Mar 21 2012 01:
fed Mar 21 2012 01:
red Mar 21 2012 01:

e

00 Pa ST
0o P IST
o1 Ph ST
01 PMIST
01 PMIST
01 PhIST
03 PMIST
10 PM ST

o Double-click Scanner Execution Details Report.

Duration

10 minute(s) 58 second(s)
22 minute(s) 32 second(s)
32 minuters) 51 secondis)
33 minute(s) 22 seconds)
22 minute(s) 31 second(s)
32 minuters) 51 secondis)
33 minutes) 12 second(z)
33 minute(s) 54 secand(s)

Select Managers > Modeling > Reports. In the Custom Reports pane, do one of

button and select Scanner Execution Details

o Right-click Scanner Execution Details Report and select Create New

o Select Scanner Execution Details Report, and drag it onto the right pane.

The report displays the following data for each Inventory Discovery job: the display

information l|abel of the host being scanned, the scanner version, the start time, duration,

schedule and status of the job, the probe name, any error messages and the last

successful execution time for the job.

Use the Select Columns [! button to select the attributes to display in the report.

Relevant
tasks
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"How to Generate a Custom Report" on page 356
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> For details, see "Report Toolbar Options" on page 456.
Group By Select a grouping option for the displayed data.

Job Status = Select an option from the drop-down list to filter the results by the job status of the
discovery job.
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Schedule Report/Snapshot Dialog Box

This dialog box enables you to define a schedule for running reports, and then send them by email to
specified recipients. You can also define a schedule for taking snapshots of a specific view. You can
see the list of reports/snapshots that have been scheduled to runin the "Job List Dialog Box" on page
413.

Schedule Job

C Schedule Job

Here you can define the scheduled job..

Schedule Job

Mame: 'Send report =Microzoft Cluster Servers

Description; This job sends report =Microsoft Cluster Servers

Action Definition

Report: Microzoft Cluster Server

Formats:
Acabe Document (* pdf)

Microsoft Office Excel Workbook (* x1g)

Comma Separated Values (*.cav)
$ML Diatai® xml)
Cirect Link (LURLY
Sendto
Time Policy
Repeat: s Starts: Ends:
Draily 16M209 * | | 1403 * & Mever Liritil
Wieekly
hanthly
Yearly
Time Zone: Aziallerusalem i n;;‘f Server Time:
To « Toschedule reports to run, select Managers > Modeling > Reports. In the
access Topology Reports or Custom Reports pane, select a report and click the Schedule

Report © putton.

« Todefine a schedule for taking snapshots, select Managers > Modeling > Reports.
In the Topology Reports pane, select the required view, click the Snapshots [

button, and then select Schedule Snapshot. Alternatively, in IT Universe Manager,
click the Snapshots button in the Cl Selector, and then select Schedule Snapshot.
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Relevant « "How to Compare Cls" on page 357

task
asks « "How to Compare Snapshots" on page 358

The following elements are included:

Ul Element (A-2) Description
Click to validate the Cron expression you entered in the Cron Expression
box.
== (Appears only when you select Day of Month.) Clears the selected dates

in the calendar.

Actions The available options are:
« Mail. Sends the report to the mail recipient in the Send box.
« Archive. Archives the report result in the database.

« Save to File System. Saves the report to the UCMDB Server file
system (in the UCMDBServer/Runtime folder). This option is only
available when the path is configured, using the Report root folder
setting in Infrastructure Settings Manager.

Note:

« This feature is only available when defining a schedule for running
reports.

« You can select multiple options (for example, Mail and Save to File

System).

Cron Expression Enter a Cron expression to schedule a job. For a description of the fields
used in Cron expressions and examples of how to use them, see "Cron
Expressions" on page 359.

Description A description of the scheduled job.

Ends Select one of the following options:
« Never. Do not specify an end date.

« Until. Choose the date and time by which you want the action to stop
running.

HPE Universal CMDB (10.31) Page 441 of 572



Modeling Guide
Chapter 9: Reports

Ul Element (A-2) Description

Formats

Note: This element is not relevant if you define a report to run only
once.

Note: Available only when defining a schedule for running reports.

Select the format for the report. Available when you select the Mail or Save

to File System options under Actions.

The available options are:

Excel. The report data is formatted as an .xlIs (Excel) file that can be
displayed in a spreadsheet.

PDF. The report data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

CSV. The report data is formatted as a comma-separated values (CSV)
text file that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options
from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value. In Linux, you can
specify the list separator in the application that opens the CSV file.

XML. The report data is formatted as an XML file that can be opened in
a text or XML editor.

Direct Link. Send an email containing the report data as a direct link.
(Only relevant for the Mail option.)

Locale Select the language for the report.

Name The name of the scheduled job.

Repeat Select one of the following actions:

« Once. Activates ajob only once.

« Interval. Runs ajob on the basis of a fixed interval. You can select an

HPE Universal CMDB (10.31)

interval of minutes, hours, days, or weeks.
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Ul Element (A-2)

Repeat every

Repeat on

Report

Send to

Server Time

Description
« Day of Month. Runs ajob every month on the selected dates.

« Weekly. Runs a job on aweekly basis. Select the day or days on which
you want the action to run.

« Monthly. Runs ajob on a monthly basis. Select the month or months in
which you want the job to run.

« Yearly. Runs ajob on a yearly basis.

« Cron. Use a Cron expression to schedule a job. For a description of the
fields used in Cron expressions and examples of how to use them, see,
"Cron Expressions" on page 359.

(Appears only when you select Interval or Yearly.) Select a value for the
interval between successive runs.

For example, if you select Yearly and then 2, the job runs every second
year.

(Appears only when you select Day of Month, Weekly, or Monthly.)
Select the days or dates on which to run the job.

For example, if you select Monthly and then January and July, the job
runs on the specified date and time in January and July.

Enables you to select the Topology or Custom report you want to run.
Opens the Select Report dialog box.

Note: Available only when defining a schedule for running reports.

Define the recipients who can automatically receive scheduled reports
through mail. Click the Open Address Book '* ' button to open the

Message Recipients dialog box and select an mail recipient.

You can use the Add, Edit, and Delete buttons in the Message Recipients
dialog box to modify the mail list.

Note: The recipients that appear in the Message Recipients dialog
box are updated with the email recipients defined in the Recipients
Manager Page in the HPE Universal CMDB Administration Guide.

The exact server time according to the client's time zone.
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Ul Element (A-2) Description
Starts Choose the time and date when you want the job to begin running.
Time Zone Set the required time zone.

Service Discovery Errors Report

This report enables you to uncover specific problems that Data Flow Management encounters during a
run, for example, incorrect credentials.

To access Select Managers > Modeling > Reports. In the Custom Reports pane, do
one of the following:

« Click the Create New Report || button and select Service Discovery

Errors Report.
« Under Discovery Status:
o Double-click Service Discovery Errors Report.

o Right-click Service Discovery Errors Report and select Create New
Report.

o Select Service Discovery Errors Report, and drag it onto the right

pane.
Important « Choose which columns to display by clicking the Select Columns button.
information « Hide a column by right-clicking its header and selecting Remove Column.
« Hide empty columns by right-clicking a header and selecting Remove
Empty Columns.
« Change the order of columns by dragging and dropping a column header.
Relevant tasks "How to Generate a Custom Report" on page 356
See also « Discovery Progress Dialog Box in the HPE Universal CMDB Data Flow

Management Guide

« Ermor Messages Overview in the HPE Universal CMDB Developer
Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element

(A-Z) Description

<Shortcut
Menu>

<Toolbar>
Generate

Service
Discovery reports.

Activities

Severity

Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
For details, see "IT Universe Manager Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.
Click to generate a list of errors.

Select the Service Discovery activities for which you want to generate error

Select the types of error to display. For error definitions, see Error Severity Levels

in the HPE Universal CMDB Developer Reference Guide.

Note: You can select multiple error types.

Time range

Select a time frame over which to display the errors. The system automatically

provides the start and end dates in the Date from and Date until boxes.

Note: If you select Custom, you can manually configure a start and end date

in the Date from and Date until boxes.

The generated report includes the following elements (listed alphabetically):

Ul Element (A-2)

Cl Type

Error Message

Error Summary

Job

Probe

Related IPs

Related Node
Severity

Time Error Reported

Trigger CI

HPE Universal CMDB (10.31)

Description

The CIT of the trigger ClI.

The detailed error message.

A brief summary of the error.

The job for which the error was reported.

The Data Flow Probe that reported the error.

IPs known to be related to the trigger ClI.

The node that is related to the trigger CI.

The error severity level (Warning, Error, Fatal Error).
The time the error was reported.

The trigger Cl on which the error was reported.

Page 445 of 572



Modeling Guide
Chapter 9: Reports

Software Utilization Report

This report displays all the installed software on the current machine with utilization data.

Group By: | Application Mame |+
Scope: Last Morth v

Show Insfocus Lilization Only

o

Software Utilization Report 2 Installed Softwares On

Display Lahel DiscoverediWendor Version Softwarelangu... | ... | ... | UsagePerc
@ Active Perl Artive State Software 583 Englizh I - |
@ FileZilla Cliert GhU 331 Englizh o 0 o
@ Firefiox hozilla 3EB Englizh o o0 o
@ HF &z=zet Marager Application Designer Hewlett-Packard 5.20 English o 0 o
@ HP Aszet Manager client Hewlett-Packard .20 English o o n
@ HP DDM Invertary Aoent Hewlett-Packard 9.30.000 Englizh o 0 3F:
@ Irternet Explorer Micro=oft 50 English o 0 0o
@ Jawa 2 Rurtime Environment Oracle (Sun Microsystems) 15019 SE Englizh o o0
@ Jawa 2 SDK Oracle (Sun Microsysterms) 142 14005 SE English o 0o | 3F®
@ Jawa 2 SDK Qracle (Sun Microsystems) 15019 SE English o o n
@ Jawa 5E Rurtime Environment Oracle 1.60_22 Englizh o 0 1283

To access  Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Click the Create New Report | button and select Software Utilization
Report.

« Under Inventory:
o Double-click Software Utilization Report.
o Right-click Software Utilization Report and select Create New Report.

o Select Software Utilization Report, and drag it onto the right pane.

Important The top level of the report displays the number of installed applications for each
information = software type. You can drill down to view utilization data on specific software
applications.

Use the Select Columns [ button to select the attributes to display in the report.

When the report is grouped by Application Name or Vendor Name, a column called
Installed On is available at the level of installed applications (after drilling down). The
column displays the location where the software is installed and provides a clickable
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Relevant
tasks

link to the node.

When the report is grouped by Related Node, a column called Installed Software is
available, which displays the number of installed applications on that node. It also
provides a clickable link to drill down and display the applications' details.

Applications with no utilization data do not appear in the report.

"How to Generate a Custom Report" on page 356

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z)

Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.

<Shortcut
Menu>

<Toolbar>

Group By

Scope

Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
For details, see "IT Universe Manager Shortcut Menu" on page 231.

For details, see "Report Toolbar Options" on page 456.

Select the method for displaying the data. The available options are:

« Application Name
o Vendor Name

o Related Node

Select the scope of the report. The available options are:
« Last Month. Displays applications with utilization data in the last month.
« Last Quarter. Displays applications with utilization data in the last quarter.
« Last Year. Displays applications with utilization data in the last year.

« All. Displays all applications with utilization data.

Show Infocus  Select this check box to configure the report to display only the utilization data
Utilization Only | for the time that an application was in focus (when it was in the foreground).

When the check box is cleared, the report displays utilization data for the time
that an application was running (even when it was in the background).
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Solaris Zone Report

This report displays information about Solaris zones. Solaris zones are isolated virtual environments
running applications on one physical host machine.

[ = - & - Show Clinstances of: | Unix (2) | &Mt q
zolaris_zones 2 bid-zolaris

Device Zone Name | Operatin.__ | Status | Update Time
@ 005056BESET A, _my-zane my-Zone] installed Thu Apr 19 20121016 AM IDT
@ twilightZone twilightZone rLnninGg Thu Apr 19 2012 10:16 AM IDT

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Right-click Solaris Zone Report and select Create New Report.

« Click the Create New Report III button and select Solaris Zone Report.
« Double-click Solaris Zone Report.

« Select Solaris Zone Report and drag it onto the right pane.

Important The top level of the report displays information on the Solaris zones. Click the number

information  in the Non-global Zone Count column to drill down to the next layer, which displays
information on the non-global zones that are hosted on the global zone. In the second
layer, you can click the number in the Network Devices column to drill down to the
next layer and view information about the network devices available to this zone.

Use the Select Columns ! button to select the attributes to display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
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Ul Element (A-

Z) Description

Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.

Topology Report

This report displays the topology of a view in report format.

To access

Important
information

Relevant
tasks

Select Modeling > Reports. In the Topology Reports pane, select the required
report from the tree.

Every view in UCMDB can be displayed in report format. You define the settings for
the report in the Report tab of the view in Modeling Studio.

Templates can be opened in Reports also. You can edit the template parameters and
save the instance as a view.

"How to View a Topology Report" on page 355

User interface elements are described below:

Ul
Element
(A-2)

<Bar
graph/Pie
chart>

<Toolbar>

Reset

Description

Each segment of the pie chart/column in a bar graph represents a Cl on the selected
level of the view.

Click aslice/bar to drill down to the next level, if one exists. You can also display the
information in table format.

When you hold the mouse over the relevant segment/bar, a tooltip indicates the number
of instances found for that CIT, the percentage of the pie it represents (when viewing
the information in pie chart format), and the CIT or CIT attribute the slice/bar
represents.

For details, see "Report Toolbar Options" on page 456.

Resets the template parameters to their original values.

Note: Only relevant for templates.
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Ul
Element
(A-2) Description

Save As Click to save the instance as a template-based view with the selected parameter
View values.

Note: Only relevant for templates.

View Change Report

This report displays the changes to Cls or relationships, in a selected view. This can help with possible
troubleshooting issues related to these Cls. For example, the changes in a Cl may enable you to
conclude that these changes are the cause of the problem. By the same token, the source of the
troubleshooting issue could be related to expected changes which failed to occur.

Time range: | Last day || Date from: | Wed Mar 3 2010 05:46 PM IST ¥ | Date until: | Thu Mar 4 2010 05:48 PM IST |
View: | NetworkTopo... ¥ [ [ s Include information based on (&) CMDB () View

Cl Changes | Relationship Changes

fy Pl o SRINEEREY

Display Label | Class Name Attribute Name | New Va
- 16 5870 Olabm1 k21 Windows Discovered OsName Windows 2003+
= 165570 0labm1t21 Windows Discovered OsVersion 5237480
— 16.59 .70 O¥abrmi k21 Windows Host Operating System Installation type | Server Erterprise
— 16.59 .70 Olabrmi k21 Windows Host Operating System Release 3790
= 16 5870 Olabm1 k21 Windows Windows Service Pack 20
= 165570 0labm1t21 Windows Host is Desltop Falze =
— 16.59 60 Owmbtol 6 Windows Memory Size 2,048
= 16 5560 0wmbto16 Windows Discovered OsName Windows 2003 R2

To access  Select Modeling > Reports. In the Custom Reports pane, do one of the following:

« Click the Create New Report III button and select View Change Report.
« Under Change:

o Double-click View Change Report.

o Right-click View Change Report and select Create New Report.

o Select View Change Report, and drag it onto the right pane.

Important Only those Cls whose properties are marked as Managed appear in the report. For
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information = details, see "Add/Edit Attribute Dialog Box" on page 494.
View Change reports display:
« Changes on only Cls that exist in the view.

« Changes that occurred in a selected Cl and all children of the Cl that are related by
the relationship specified in the Change Report link name infrastructure setting.
The default value of this setting is an empty value, (managed_relationship), that
enables you to track changes of all relationship attributes that are not marked as
Not Tracked in History.

To change the Cls displayed in the generated report, go to Managers >
Administration > Infrastructure Settings and edit the following settings:

o Select Change Report link name to retrieve Cls that are linked by the
selected calculated relationship. Change the value of the setting to the name of
the relationship as it appears in the Name box (not the Display Name box) in
the Details page of the selected relationship in the Cl Type Manager. For
details, see "Details Page" on page 504.

o Select Change Report link qualifier to retrieve Cls that are defined with a
qualifier. Change the value of the setting to the name of the required qualifier.
For information about qualifiers, see "Qualifiers Page" on page 509.

« Cls with a Composition relationship that were added to, or removed from, a CI.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below:

Ul
Element
(A-2) Description

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu. For
Menu> details, see "IT Universe Manager Shortcut Menu" on page 231.

<Toolbar> Fordetails, see "Report Toolbar Options" on page 456.
Date from = Configure a start date and time for the report.
Date until = Configure an end date and time for the report.

Time Select a time frame over which to display the changes. The system automatically
range provides the starting and ending dates in the Date from and Date until boxes.
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ul

Element

(A-2) Description
Note: If you select Custom, you can manually configure a starting and ending
date in the Date from and Date until boxes.

View Select the view for which you want to review changes. Opens the Select Cl/View

dialog box. For details, see "Working with the C| Selector" on page 129.

Cl Changes Tab

For information on the Cl Changes tab, see "C| Changes Tab" on page 379.

Relationship Changes Tab

For information on the Relationship Changes tab, see "Relationship Changes Tab" on page 380.

VMware Host Report

This report displays information about the VMware hosts (VMware ESX servers) and the VMware
virtual machines hosted on the ESX servers.

{5l Wiware Host Reporti® = |
B @ - B - [ s clisoresedt ol =1 a

wiwmare _hosts 3» artarial

Device | V11 Name [vi1 ope... | V1Y UUID VM Status
@ administ-331954 win2k34rench A00cdel2£4h2-3602-9792 261 5c48517a2 powered On
@ Jacky win-2k3 Wit 2k 3-x 4239h2dd-dadd-3e 7649997 a8 2d0620a powverec] O
@ hpadrmin-5169f3d win 2k 3-german SE49426 9657 -4d72-6h3a-c7h7d51 5d50d poweredd On
@ jacky win-2k3 win2k3- Zxy S00c4] 7319200823 dh37-ad83e daf 747 poweredd On

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Right-click VMware Host Report and select Create New Report.
« Click the Create New Report |;| button and select VMware Host Report.

« Double-click VMware Host Report.

« Select VMware Host Report and drag it onto the right pane.

Important The top level of the report displays information on each of the VMware hosts detected
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information  in the system. Click the number in the VM Count column to drill down to the next layer
and view detailed information about all of that host's VMware virtual machines.

Use the Select Columns [ button to select the attributes to display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.

VMware Virtual Center Report

This report displays information about Virtual Centers, which manage the physical servers (VM hosts)
and the virtual machines (VMs) they are running as a single, logical pool of resources.

i Wiiware Wirtua, . enter Reportd* = |
| = - ‘F_LI = Show Clinstances of: |-.Iare EZX Server (4) "'l ﬁ I =t Q

wiual certers = pile

Device | Server | Wi Count | Version | Platform | Model
% haikall Whivware ESx] 3 500463512 baremetal_hypervisor hip warkstation w5200
% hurat Whiveare ESX E 350153575 baremetal_bypervisar higr warkstation ns200
% ontariod Wiiware ESX 4 3601535875 baremetal_hypervisor hipy workestation w200
% michgan Whiveare ESx 5 2360153875 barermetal_hypervisor higr workstation <wg200

To access | Select Managers > Modeling > Reports. In the Custom Reports pane, do one of
the following:

« Right-click VMware Virtual Center Report and select Create New Report.

« Click the Create New Report £ button and select VMware Virtual Center
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Report.
« Double-click VMware Virtual Center Report.

« Select VMware Virtual Center Report and drag it onto the right pane.

Important | The top level of the report displays information on the Virtual Centers. Click the
information number in the VMware Host Count column to drill down to the next layer, which
displays information on each of the VMware hosts in that Virtual Center.

In the second layer, you can click the number in the VM Count column to drill down to
the next layer and view detailed information about all of that host's VMware virtual
machines.

Use the Select Columns ¥ button to select the attributes to display in the report.

Relevant "How to Generate a Custom Report" on page 356
tasks

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description

<Breadcrumbs> Displays the levels through which you have navigated to get to the current level.
Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

<Shortcut Right-click a Cl in the report to access the IT Universe Manager shortcut menu.
Menu> For details, see "IT Universe Manager Shortcut Menu" on page 231.
<Toolbar> For details, see "Report Toolbar Options" on page 456.

Zone-Based Discovery Errors Report

This report enables you to uncover specific problems that Data Flow Management encounters while
running activities in the selected Management Zones, for example, incorrect credentials.

To access Select Modeling > Reports. In the Custom Reports pane, do one of the
following:

« Click the Create New Report|;| button and select Zone-Based Discovery

Errors Report.
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« Under Discovery Status:
o Double-click Zone-Based Discovery Errors Report.

o Right-click Zone-Based Discovery Errors Report and select Create
New Report.

o Select Zone-Based Discovery Errors Report, and drag it onto the right

pane.

Important « Choose which columns to display by clicking the Select Columns I putton.

information
« Hide a column by right-clicking its header and selecting Remove Column.

« Hide empty columns by right-clicking a header and selecting Remove Empty
Columns.

« Change the order of columns by dragging and dropping a column header.
Relevant tasks "How to Generate a Custom Report" on page 356

See also « "Discovery Progress Dialog Box" in the HPE Universal CMDB Data Flow
Management Guide

« "Error Messages Overview" in the HPE Universal CMDB Developer
Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

<Toolbar> For details, see "Report Toolbar Options" on the next page.

Activity Select the type of discovery activity for which to display errors. To display all types
Type of discovery activity errors, select All.

Management Select the Management Zones for which to display errors. You can select all

Zones Management Zones, or specific Management Zones.
Generate Click to generate the report.
Severity Select the types of error to display. For error definitions, see "Error Severity Levels"

in the HPE Universal CMDB Developer Reference Guide.

Note: You can select multiple error types.

Time range  Select atime frame over which to display the errors. The system automatically
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Ul Element
(A-Z) Description

provides the start and end dates in the Date from and Date until boxes.

Note: To manually customize the Date from and Date until values, select
Custom from the Time Range list.

The generated report includes the following elements (listed alphabetically):

Ul Element (A-Z) Description

Cl Type The CIT of the trigger CI.

Error Message The detailed error message.

Error Summary A brief summary of the error.

Job The job for which the error was reported.
Probe The Data Flow Probe that reported the error.
Related IPs IPs known to be related to the trigger Cl.
Related Node The node that is related to the trigger CI.
Severity The error severity level (Warning, Error, Fatal Error).
Time Error Reported The time the error was reported.

Trigger CI The trigger Cl on which the error was reported.

Report Toolbar Options

This section describes the toolbar options for the Report pane.

Ul Element (A-2) Description

‘ [51 Report Parameters | Displays the parameters that are defined for the report.
G Save Report. Saves the selected report.
[y Report Properties. Opens the Report Properties dialog box, which enables

you to set the report title, subtitle, and format.
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Ul Element (A-2) Description

(C) Schedule Report. Opens the Schedule Report dialog box, which enables
you to define a job that:

« Schedules the generation of a report

« Specifies one or more formats in which to send the report, and the report's
recipients

« Specifies the recurrence of the job

For more information on the Schedule Report dialog box, see "Schedule
Report/Snapshot Dialog Box" on page 440.

Note: This option is only available before you generate a report or when
you open a saved report.

= Send Mail. Opens the Send Mail dialog box. You can send an email
containing the generated report in various formats, or as a direct link. For
details on the various formats, see "Report Toolbar Options" on the previous

page.
Select one or more of the available formats for the generated report to be sent

as attachments to an email recipient.

Note:

« Required fields are marked with an asterisk.

« Inthe Send Mail dialog box, the From field is populated with the
email address defined in the user details for the current user. If no
email is defined for the current user, the default email address of the
customeris used.

=) Archive Report. Enables you to save the report results in the database.
After the report is archived, the Archive Report 2 putton appears next to

the report name.

Note: Enabled only for Topology and Gold Master reports.

= Generate Direct Link. Creates a direct link to the specific location on the
server of the selected report, or to the data that you have exported as a
specific format.
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Ul Element (A-2) Description
|§| Export Report.

Enables you to select the format for previewing and exporting the report. The
available options are:

o CSV. Thereport data is formatted as a comma-separated values (CSV)
text file that can be displayed in a spreadsheet.

Note: Forthe CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options from
the Control Panel, and on the Numbers tab ensure that the commais
defined as the List Separator value. In Linux, you can specify the list

separator in the application that opens the CSV file.
« PDF. The report data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

o XLS. The report data is formatted as an .xIs (Excel) file that can be
displayed in a spreadsheet.

Note: Forlarge reports, you can reduce the time required for
exporting the report by setting a fixed column size using the Column
Size For XLS Export setting in the Infrastructure Settings Manager.

« XML. The report data is formatted as an XML file that can be openedina
text or XML editor.

Tip: To extract HTML code from the report:
o Open the file in an HTML editor

o Copy the relevant table into the target file

[ Assign Tenants. Opens the Assign Tenants dialog box which enables you to
assign tenants to the selected custom report.

Note:

« This option is only available for saved reports.
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Ul Element (A-2)

[ih] Bar Chart

&% Pie Chart
EH Table

|§J

Description
| « This option is only available when multi-tenancy is enabled.

Manage Security. Enables you to assign permission for the report to specific
roles or to add the report to selected resource groups.

Note: This option is only available for saved reports.
Bar Chart. Displays the generated report as a bar chart.
Pie Chart. Displays the generated report as a pie chart.
Table. Displays the generated report in tabular format.

Show Short Labels. Toggles between displaying the chart labels
minimal/maximum information.

| Note: This option is available only for pie charts.
Show Legend. Toggles between hiding and displaying the chart's legend.

Note: This option is available only for pie charts.

Slice chart. Toggles between displaying the pie chart with exploded and
unexploded segments.

Note: This option is available only for pie charts.

Expand All. Expands the tree structure.
Collapse All. Collapses the tree structure.
Delete from CMDB. Deletes the selected Cl from the CMDB.

Properties. Opens the Configuration Item Properties dialog box for the
selected Cl.

Refresh. Refreshes the report tree.

Select Columns. Enables you to select the columns you want to display in
the report. For details, see "Select Columns Dialog Box" on page 568.

Sort Column Content. Enables you to set the sort order of the selected
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Ul Element (A-2)

<breadcrumbs>

<Generated
report>

Find

Description
column's content.

Find. Toggles between displaying and hiding the Find utility.

Find the next occurrence of the phrase/Find the previous occurrence
of the phrase. Enables you to move to the next or previous result of the
search for the string entered in the Find field.

Highlights all occurrences of the phrase. Highlights all occurrences in the
Cl tree of the string entered in the Find field.

Generate Report. Enables you to generate the selected report.

Note: This button appears disabled prior to defining the report
parameters.

Displays the levels through which you have navigated to get to the current
level. Appears horizontally across the top of the chart.

Note: Each level in the list of breadcrumbs is a clickable link.

Displays the active generated report.

Enter a search name or a portion of a search name in the Find field to locate it
in the list.

Reports on Non-English Locales — Notes and

Limitations

« Universal CMDB does not support custom report names that contain more than 50 multi-byte

characters.

« Ifareport is created in one language locale and sent by email from another language locale, the

report contains system information in the languages of the server and the original locale.

« If areport file name contains multi-byte characters (for example, in Japanese, Chinese, or Korean)

and the report is sent as an email attachment, the name becomes unreadable.
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« When exporting a Cl instance to a PDF file, multi-byte characters (such as Japanese, Chinese,
Korean, and so on) may not be displayed properly in the PDF file.

« When saving a snapshot of a topology report, the name can have a maximum of 25 non-English
characters.
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This chapter includes:

Impact Analysis Manager OVEIVIEW . . ... 462
How to Define an Impact Rule —Workflow .. 463
Impact Analysis Manager User Interface ... . 465

Impact Analysis Manager Overview

Impact Analysis Manager enables you to define the interdependencies between components in your IT
infrastructure to simulate how infrastructure changes (for example, a new software installation or
upgrade) can impact your system.

By creating Impact rules based on TQL queries, you can determine the true origin of a problem and its
business impact. Each Impact rule you define is attached to a specific Impact Analysis TQL query. For
more information about TQL queries, see "Topology Query Language" on page 14.

You define Impact rules to specify a causal relationship between two or more Impact Analysis query
nodes. Define one query node as the trigger, or the query node that represents the changes you want to
make to the system, and another query node as the one that is impacted. After the causal relationship
is established, Impact Analysis Manager enables you to determine the effect of the changes occurring
in root cause query nodes.

You then run the Impact rules in IT Universe Manager to simulate how the changes impact your system
and discover the root causes of the changes (for details, see "Run Impact Analysis Dialog Box" on
page 244). This enables you to evaluate and handle accordingly, the possible implications of any
action, update, new deployment, or a failure of the service delivery.

A simulated change in an impacted CI can alter the Cl's map status, which is manifested through an
addition of a status icon to the Cl's symbol. The Topology Map displays the statuses of the trigger Cls
as well as all statuses of the Cls that are impacted by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see "Show Impact Pane" on page
248.

You can then generate a report displaying the following:
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o Clsinthe system that are impacted by the changes.

« Trigger Cls (the Cls that represent the changes you want to make to the system).

« Cls that belong to a specific business service.

How to Define an Impact Rule - Workflow

This section describes how to define an Impact rule whereby a change in CPU operation impacts the

node to which it is connected.

This task includes the following steps:

o "Create an Impact Analysis TQL Query" below

« "Define an Impact Rule" on the next page

1. Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact Analysis TQL and then
add the TQL query nodes and relationships that define the query.

Select Managers > Modeling > Impact Analysis Manager to open the Impact Analysis
Manager. For details about how to create an Impact Analysis TQL query, see "New Impact

Rule/Impact Rule Properties/Save As Impact Rule Wizard" on page 476. For details about how to
add query nodes and relationships to a query, see "How to Add Query Nodes and Relationships to

a TQL Query" on page 25.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition
relationship. The TQL query results must comply with the direction of the arrows.

(W

ol

=
=
]

| Compaosition
-

Cpu
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Note: AnlImpact Analysis TQL query is subject to certain validation restrictions. For
details, see "Troubleshooting and Limitations — Topology Query Language" on page 93.

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the
query nodes. Define one query node as the trigger, or the query node that represents the changes
you want to make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node and select Define
Impacted to open the Impacted Query Nodes dialog box. Select the query node you want the
trigger query node to impact. Then click the Add button to open the Impact Rules Definition dialog
box to set conditions for defining impacted query nodes. For details about how to define an Impact
rule, see "Impact Rules Definition Dialog Box" on page 475.

Note: The change state option in the Impact rule definition is no longer relevant for Impact
Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under
which the simulated change in the system is triggered. The Severity area defines the severity
of the impact on the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal state,
the node is impacted. Since the severity is set to 100% of the trigger's severity, the severity of
the node is the same as the severity of the CPU, which is determined when Impact Analysis
is run.
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Description: | |

1| rCenditicns

State: | operation |v |

Operatar: | Mot equal |" |

Value comparison: | Marrmal |v |

() Pange % = %

) Fixed severity:
(®) Severity relative to trigaer severity (%)

In the resulting TQL query, an upward arrow appears next to the query node defined as the
trigger query node and a downward arrow appears next to the query node defined as the

impacted query node.

Composition

‘;'+

Cpu

Note: To retrieve the Impact Analysis results, you must run the Impact rule in IT
Universe Manager. For details, see "How to Retrieve Impact Analysis Results —

Scenario" on page 203.

Impact Analysis Manager User Interface

This section includes (in alphabetical order):

Details Dialog BOX ... ..

Impact Analysis Manager Page ... ...
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Impacted Query Nodes Dialog BoOX ... .. 474
Impact Rules Definition Dialog Box ... ... .. 475
New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard ........................... 476

Details Dialog Box

This dialog box displays the new Impact rule you created in the Impact Rules Definition dialog box.

To access In the Impact Analysis Manager, click Next in the Impacted Query Nodes dialog
box.

Relevant "How to Define an Impact Rule — Workflow" on page 463

tasks

See also « "Impact Analysis Manager Overview" on page 462

« "Impact Analysis Manager User Interface" on the previous page

User interface elements are described below:

Ul Element (A-

Z) Description

Description The description of the new Impact rule.

State The category you chose from the State list in the Impact Rules Definition dialog

box.

Impact Analysis Manager Page

This page enables you to define Impact rules.

To access | Select Impact Analysis Manager from the Navigation Menu or select Managers >
Modeling > Impact Analysis Manager.

Important = When selecting query nodes to function as Impact Analysis triggers, they must
information comply with certain restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 93.

Relevant "How to Define an Impact Rule — Workflow" on page 463
tasks
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See also « "Impact Analysis Manager Overview" on page 462

« "Impact Analysis Manager User Interface" on page 465

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and Impact rules. Each Impact rule

is associated with a TQL query.

Important You can create your own Impact rules, or work with the default rules provided with

information your Universal CMDB installation.

The predefined folders are provided for the default Impact rules; you can modify these
folders, or add additional folders according to your organization's requirements.

You can drag and drop Impact rules or folders to move them from one folder to

another.

User interface elements are described below:

Ul Element (A-Z)
£

HPE Universal CMDB (10.31)

Description

New Folder. Creates a new folder.

New. Creates an Impact rule. Opens the New Impact Rule
Wizard.

Delete. Deletes the selected folder or Impact rule.

Refresh. Refreshes the data content of the hierarchical tree
structure that may have been modified by other users.

Save. Saves the Impact rule to the CMDB. (Enabled only
when a new Impact rule is created or when changes are made
to an existing one.)

Properties. Opens the Impact Rule Properties Wizard.
Enables you to change the description of the rule.

Assign Tenants. Opens the Assign Tenants dialog box
which enables you to assign tenants to the impact rule.

Note: This button is only available when multi-tenancy is
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Ul Element (A-2) Description
enabled.
Manage Security. Enables you to assign the selected impact

rule to specific roles or resource groups.

Preview. Generates a preview of the results of the selected
Impact rule.

@| Export To XML. Enables you to export an Impact rule to an
XML file.

|E| Import From XML. Enables you to import XML files that

contain saved Impact rules to the Impact Analysis Manager.
Represents a folder.

@ Represents an Impact rule.

<Impact Rules tree> Displays the existing Impact rules in tree format.

Note: Only Impact rules appear in the tree. TQL queries
of type Impact Analysis (created in the Modeling Studio)
do not appear.

The following options are available by right-clicking a folder or Impact rule:

Ul Element
(A-2) Description
Assign Opens the Assign Tenants dialog box which enables you to assign tenants to the
Tenants selected impact rule.
Note: This option is only available when multi-tenancy is enabled.
Delete Delete the selected folder or Impact rule.
Export To Displays a standard Save As dialog box, enabling you to save the Impact rule as
XML an XML script. This option can be used to move an Impact rule from one

workstation to another, provided the related TQL query is also relocated.

Import From Imports XML files that contain saved Impact rules to Impact Analysis Manager.
XML
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Ul Element
(A-Z)

Manage
Security

New
New Folder
Preview

Properties
Rename
Folder

Save

Save As

Editing Pane

Description

Assign the selected impact rule to specific roles or resource groups.

Creates an Impact rule. Opens the New Impact Rule Wizard.
Creates a new folder.
Generates a preview of the results of the selected Impact rule.

Opens the Impact Rule Properties Wizard. Enables you to change the description
of the rule.

Rename the folder.

(Enabled only when a new Impact rule is created or when changes are made to an
existing one.) Saves the Impact rule to the CMDB.

Displays the Save As Impact Rule Wizard, enabling you to create new Impact
rules based on an existing query.

This area displays the selected Impact rule, which consists of query nodes that are defined in the TQL
query and the relationships between them.

Important
information

Relevant
tasks

See also

« When you select a folder in the Impact Rules pane, the editing pane is empty.

« When you select an Impact rule in the Impact Rules pane, the editing pane
displays the selected rule, which consists of TQL query nodes that are defined in
the TQL query and the relationships between them.

"How to Add Query Nodes and Relationships to a TQL Query" on page 25

When selecting query nodes to function as Impact Analysis triggers, they must
comply with certain restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 93.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-

Z) Description

Indicates a trigger query node. Located to the right of the trigger query node's
icon.

Indicates an impacted query node. Located to the right of the impacted query
node's icon.

Indicates query nodes that are both impacted and trigger query nodes.

<Main Menu> For details, see "Main Menu" on page 163.
<Query Node> A component from which TQL queries are built.
<Relationship> The entity that defines the relationship between two query nodes.

<Shortcut For details, see "Shortcut Menu Options" on page 33.
menu options>

<Toolbar> For details, see "Toolbar Options" on page 167.
<Tooltip> Hold the cursor over a query node or relationship to view its tooltip.
The tooltips contain the following information:
« Element name. The name of the query node.

« CI Type. The CIT of the query node as defined in the Cl Type Manager. For
details, see "C| Type Manager" on page 481.

« Definitions of the selected query nodes and relationships. The attribute
conditions, as described in "Query Node/Relationship Properties Dialog Box"
on page 72.

« Names of the trigger and the impacted query nodes. This is only relevant
if the query node over which the cursor is hovering is the trigger query node.

Cl Type Selector

This area displays a hierarchical tree structure of the Cl Types found in the CMDB.

Important = The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager, and
information Trigger TQL Editor.
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To create or modify a TQL query, click and drag query nodes to the Editing pane and
define the relationship between them. Your changes are saved to the CMDB. For
details, see "How to Add Query Nodes and Relationships to a TQL Query" on page
25.

Note: The number of instances of each CIT in the CMDB is displayed to the right
of each CIT.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24

o "How to Create a Pattern View" on page 269

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements (A-Z) Description

< Add CI Type to Map. Moves the selected Cl type to the Editing pane.
|§| Refresh. Refreshes the Cl type tree.

|§| Search. Searches for the Cl type entered.

|E| Expand All. Expands all subtrees within the Cl type tree.

|E| Collapse All. Collapses the subtrees within the Cl type tree.

<Search window>  Enterthe name or part of a name of a Cl type for which to search.

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-clicking a
Cl Type:

Menu Item Description

Add Cl Type  Select to add the selected Cl type to the Editing pane.
to Map

Go to Cl Type Takes you directly to the selected ClI type in CIT Manager.
Definition
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Menu Item Description
Show CIT Opens the CIT Instances window, which displays all instances of the selected
Instances CIT. For details, see "Cl Instances Dialog Box" on page 65.

Advanced Pane
This area displays the properties, conditions, and cardinality for the selected query node and

relationship.

Important The Advanced pane appears in the lower part of the window in the following managers
information and user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator * appears next to the tabs that contain data.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks o "How to Define an Enrichment Rule — Scenario” on page 529
« "How to Define a TQL Query" on page 24
« "How to Create a Pattern View" on page 269

« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:

ul Description
Elements
(A-Z)

ik If the window is not wide enough to display all the tabs, use the left and right arrows to

move to the required tab.

Click Show List to display a list of the available tabs for the current module. You can
select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attributes Tab" on page 74.

Cardinality = Cardinality defines how many query nodes you expect to have at the other end of a
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Ul
Elements
(A-Z)

Data
Sources

Details

Edit

Element
Layout

Element
Type

Enrichment
Rules

Description

relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see "Cardinality Tab" on page 76.

Displays the data sources set for the selected query node.
Note: This tab appears only in the Modeling Studio.

Displays the following information:
« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in
the Modeling Studio.

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not
visible. In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its
children are displayed in the topology map. A red mark indicates that only the
selected Cl appears. This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or relationship. It lists the
attributes selected to be included in the query results (when Specific Attributes is
selected as the attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element Layout Tab" on page 82.

| Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or relationship. For details,
see "Element Type Tab" on page 80.

| Note: This tab appears only in the Modeling Studio.

Displays the Enrichment rule defined for the selected query node or relationship. If the
Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see
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ul Description
Elements
(A-Z)

"Query Node/Relationship Definition Dialog Box" on page 551.

| Note: This tab appears only in Enrichment Manager.

Impacted Indicates which query node is impacted by the changes that occur in the selected
Query trigger query node. If required, you can click Edit to open and modify the Impacted
Nodes Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" below.

| Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Selected Displays the element instances that are used to define what should be included in the
Identities TQL query results. For details, see "Identity Tab" on page 85.

Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is the trigger Impact Analysis
query node and which query nodes are impacted by the changes that occurred in the system.

To access | Right-click the query node or relationship that functions as a trigger and select Define
Impacted. The Impacted Query Nodes dialog box opens to display the query nodes in
the TQL query.

Important Before creating the TQL query, you must know which query node in the query is the
information | trigger Impact Analysis query node and which are impacted by the changes
beforehand. The definition is performed here.

Relevant "How to Define an Impact Rule — Workflow" on page 463
tasks
See also « "Impact Analysis Manager Overview" on page 462

« "Impact Analysis Manager User Interface" on page 465

User interface elements are described below :
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Ul Element

(A-Z) Description

Impacted Contains a list of the Impact Analysis query nodes in the Impact rule. Select the
Query query nodes to be impacted by the trigger query node. Click Next to view details for

Nodes pane the selected query node.

Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query nodes, define the scope of the
trigger conditions, and define the severity of the impact.

To access | Inthe Impact Analysis Manager, click Add on the Details page of the Impacted Query
Nodes dialog box.

Important « Inthe Conditions area, set conditions for defining impacted query nodes. When
information this condition is met, the simulated change in the system is triggered.

For example, you can define an Impact Analysis condition that states that the
operational state of the query node is other than Normal. When the operational
state of the query node instance changes and is no longer Normal, the condition is
met and the simulated changes in the system are triggered.

« Inthe Scope area, define how many instances of the trigger query node should
fulfill the conditions for triggering the changes in the system.

You can apply the trigger conditions to a single instance of a trigger query node, to
a certain percentage of the trigger instances, or to all of them.

For example, you can define that impact is calculated when at least 10% of the
system’s nodes are down.

« Inthe Severity area, define the severity of the Impact Analysis impact.

Relevant "How to Define an Impact Rule — Workflow" on page 463
tasks
See also « "Impact Analysis Manager Overview" on page 462

« "Impact Analysis Manager User Interface" on page 465

User interface elements are described below :
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Ul Element

(A-Z) Description

All All instances should fulfill the conditions.

Any One instance or more should fulfill the conditions.

Description = A description of the Impact rule you are defining.

Fixed Define afixed severity level for every system change generated. Then, select the
severity required severity level from the list.
Function Select Function (displayed when you selected the All and Range options in the

Scope area) to define a severity level for the system changes, as a function of the
severity levels of all the trigger query node instances that are included in the range.
From the list, select either Average or Max.

For example, if you select Average, the severity level of the system changes is the
average severity of all the trigger instances.

Operator Select the required operator. For a list of the operators you can use for defining an
attribute condition, see "Attribute Operator Definitions" on page 38.

Range A certain percentage of all instances should fulfill the conditions. For example, if you
enter a range of 50% to 100%, the changes are triggered when 50% or more of the
instances meet the conditions.

Severity Select Severity relative to trigger severity (%) (displayed when you selected the
relative to Any option in the Scope area) to define a severity level for each system change that
trigger is relative (as a percentage) to the severity of the trigger event.

severity (%)

Enter the percentage in the box provided.

State Choose the required state. The states that appear in the list are the states that are
defined in the State Manager. For details, see "State Manager" in the HPE Universal
CMDB Administration Guide.

Value Select the required attribute.
comparison

New Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard

This wizard enables you to create or modify an Impact rule.
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To access « To create an Impact rule, right-click anywhere in the Impact Rules pane and click

New or click the New |"_-'-| button.

« Tomodify an Impact rule, right-click an Impact rule in the Impact Rules pane and
select Properties.

« Tocreate a new Impact rule based on an existing query, right-click an Impact rule
in the Impact Rules pane and select Save As.

Important « Any major change made to the TQL query after creating an Impact rule causes the
information system to delete the rule. These changes include deleting a root cause or
impacted query node or changing the Min and Max relationship definitions. For
details, see "Cardinality Tab" on page 76.
« Minor changes, such as adding a query node to the TQL query, do not cause the
deletion of the rule.
« The Impact Analysis TQL query that serves as the basis of the Impact rule, is
subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations — Topology Query Language" on page 93 . If the TQL query is not valid,
it cannot be used for the creation of an Impact rule.
Relevant "How to Define an Impact Rule — Workflow" on page 463.
tasks
Wizard The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
Map contains:
"Impact Rule General Attributes Page" below > "Impact Rule Base Query Page" on
the next page > "Impact Rule Groups Page" on page 479
See also « "Impact Analysis Manager Overview" on page 462

« "Impact Analysis Manager User Interface" on page 465

Impact Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Impact rule.

Important « TheImpact Analysis TQL query that serves as the basis of the Impact rule, is

information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations — Topology Query Language" on page 93. If the TQL query is not valid,
it cannot be used for the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
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creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule
Wizard" on page 476.

« By default, this wizard is set to display a Welcome page. You can choose not to
display the Welcome page by changing the user preferences. For details, see
"User Preferences Dialog Box" on page 92.

Wizard The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard" on
map page 476 contains:

"Impact Rule General Attributes Page" > "Impact Rule Base Query Page" >
"Impact Rule Groups Page"

Seealso "IT Universe Manager" on page 180

User interface elements are described below:

Ul Element

(A-2) Description

Rule (Optional) Enter a description of the Impact rule.
Description

Rule Name @ Enter a unique name for the Impact rule.

The rule name cannot contain any of the following characters: \/: " <>|% ?. The final
character cannot be a blank space.

Note: If the Impact rule name is either empty, contains a name used by another
Impact rule, or uses invalid characters, the Next and Finish buttons are disabled.

Impact Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Impact rule is
based. You can use an existing query or create a new query.

Important « TheImpact Analysis TQL query that serves as the basis of the Impact rule is

information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations — Topology Query Language" on page 93. If the TQL query is not valid,
it cannot be used for the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule
Wizard" on page 476.

HPE Universal CMDB (10.31) Page 478 of 572



Modeling Guide
Chapter 10: Impact Analysis Manager

Wizard The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
map contains:

"Impact Rule General Attributes Page" > "Impact Rule Base Query Page" >
"Impact Rule Groups Page"

See also "IT Universe Manager" on page 180

User interface elements are described below :

Ul Element (A-2) Description

Base the Impact rule Select this check box if you want to base the Impact rule on a new TQL
on a new query query. The query results are based on the attributes defined for the new
TQL query.

Base the Impact rule Select this check box if you want to base the Impact rule on an existing
on an existing query TQL query. Select the required Impact Analysis TQL query from the drop-

down list.
Base Query (Optional) Enter a description of the TQL query.
Description
Base Query Name Enter a unique name for the Impact Analysis TQL query.
If you selected the Base the Impact rule on an existing TQL option,
select the Impact Analysis TQL query on which you want to base the rule.
Save a new query Select to save a new TQL query based on your Impact rule definition.

based on the current

definition Note: This field only appears in the Save As Impact Rule wizard.

Impact Rule Groups Page

This wizard page enables you to define where you can run Impact rules.

Important « The Impact Analysis TQL query that serves as the basis of the Impact rule, is

information subject to certain validation restrictions. For details, see "Troubleshooting and
Limitations — Topology Query Language" on page 93. If the TQL query is not valid,
it cannot be used for the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule
Wizard" on page 476.
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« By default, this wizard is set to display a Completion page after clicking Next on
this page. You can choose not to display the Completion page by changing the
user preferences. For details, see "User Preferences Dialog Box" on page 92.
Wizard The "Impact Rule Groups Page" contains:
ma
P "Impact Rule General Attributes Page" > "Impact Rule Base Query Page" > "Impact
Rule Groups Page"

See also "IT Universe Manager" on page 180

User interface elements are described below :

Ul Element (A-Z) Description

<Impact Rule Displays the available bundles. Select the bundle(s) in which to include this
bundles> Impact Rule.

For new Impact rules, the UCMDB: Rule will run within UCMDB
application option is selected by default.
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This chapter includes:

Cl Types Overview

Cl Type Attributes

Cl Type Relationships

Deprecated Cl Types

System Type Manager

How to Create a Cl Type

How to Create a Relationship Type

How to Create a Calculated Relationship Type

How to Create List and Enumeration Definitions ... ... .. ..

View Descriptions for Cl Types and Relationships

Cl Type Manager User Interface

Note to HPE Software-as-a-Service customers: The data in Cl Type Manager can be viewed
but not edited.

Cl Types Overview

A configuration item (Cl) can represent hardware, software, services, business processes, or any

component of your IT infrastructure. Cls with similar properties are grouped under a Cl type (CIT). Each

CIT provides a template for creating a Cl and its associated properties.

Every Cl must belong to a Cl type. The following are the main categories of CITs:

« Business Element. CITs that correspond to the logical elements of your business, such as
processes and organizational groups.

« IT Process Record. CITs that correspond to changes that occur in your IT infrastructure.
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o Monitor. CITs that handle incoming metrics collected from your business universe.

« Location. CITs that correspond to the location of devices and business organizations or people
supporting a function.

« Party. CITs that correspond to an active entity such as a person or organization.
o CI Collection. A logical collection of Cls.

« Infrastructure Element. CITs that correspond to the physical elements (hardware and software)
installed in your business environment.

The CITs are arranged in a tree structure under these categories in the Cl Types pane. You can browse
the CI Type model by expanding the tree in the Cl Types pane. The CIT selected in the left pane is
displayed in the topology map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on defining new ClITs, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 503.

Cl Type Attributes

Every Cl type has attributes which define it, such as name, description, and default value. The CITs
grouped under other CITs in the CI Type tree inherit attributes from the higher-level CITs.

When you define a new Cl type, you first select a Base Configuration Iltem Type from a list of existing
CITs. Your new CIT inherits the attributes of the existing CIT. You can then set the attributes for the
new CIT. You edit the attributes of an existing CIT by selecting a CIT from the tree in the Cl Types
pane and selecting the Attributes tab of the topology map. For details on CIT attributes, see "Attributes
Page" on page 505.

This section includes the following topics:

« "CI Type ldentification Methods" below

o "Cl Type Naming" on page 484

ClI Type Identification Methods

Every Cl created is given an automatically generated global ID, which is used to distinguish different
instances of the same ClI type. UCMDB provides identification methods which enable you to set
conditions under which two Cl instances are defined as identical, and are consequently merged into a
single instance. For example, the By key attributes method involves defining Cls with certain
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matching attributes to be identical. You can also select additional identification methods as described
in "Details Page" on page 504.

If you select the By key attributes option, you can designate one or more of the CIT's attributes as key
attributes, which are used as identifiers of the CIT. When you define an instance of a CIT, the CIT's
key attributes are mandatory fields for Cls of that type. You can assign as many key attributes as you
want to a given CIT. If you do not assign a key attribute when defining a new CIT or changing the
identification method of an existing CIT to By key attributes, you must select the ABSTRACT _
CLASS qualifier on the Qualifier page of the wizard.

You can change or remove the key attributes of an existing CIT if the key attribute values for all
instances of that CIT are unique. Similarly, you can change the identification method to By key
attributes only if the key attribute values for all instances of that CIT are unique. If the selected
changes result in multiple instances of a CIT with identical key attribute values, an error message
indicates that the action is not permitted, as the CIT instances would be merged.

If you select other identification methods, you cannot define key attributes for the CIT, but it retains the
key attributes of its parent CIT. These key attributes are mandatory fields for Cls of that type and they
should not be removed. For those identification methods, there are no restrictions on the qualifiers
selected.

Note: If the child classes should not use the key attributes defined by the parent classes, this can
be achieved by overriding the attribute for the child class.

Here is an example:

Suppose for class Load Balancing Cluster a new key attribute (ID_ATTRIBUTE) with attribute
name description is added. Then, for class Load Balancing Cluster the following attribute
override is added. This can be seen in JMX console, listResources and enter CM_CLASS, and
then select loadbalancecluster.

<Attribute-Override is-partially-override="true" name="description " is-
factory="false">
<Attribute-Qualifiers>
<Attribute-Qualifier name="ID_ATTRIBUTE" is-factory="false">
<Data-Items/>
</Attribute-Qualifier>
<Attribute-Qualifier name="INDEX" is-factory="false">
<Data-Items/>
</Attribute-Qualifier>
</Attribute-Qualifiers>
</Attribute-Override>

Class MS NLB Cluster is a subclass of Load Balancing Cluster and will inherit description
attribute as being a key attribute.
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If the identification rule for class MS NLB Cluster should not contain the description attribute,
then a new override should be done (but not partially).

To achieve this, the class definition of MS NLB Cluster should be open from JMX console:

1. Onthe UCMDB Server, go to JMX Console > UCMDB:service=URM Services >
listResources.

Enter customer ID. (Default: 1)
In the value field, enter CM_CLASS and click Invoke.

On the returned result page, locate and select ms_nlb_cluster.

o ~ w0 DN

In the Resource XML text box, locate the <Attribute-Overrides> section and enter the
following:

<Attribute-Override name="description
<Attribute-Qualifiers>
<Attribute-Qualifier name="INDEX" is-factory="false">
<Data-Items/>
</Attribute-Qualifier>
</Attribute-Qualifiers>
</Attribute-Override>

is-factory="false">

6. Click the Save resource button.

Then after server restart, class MS NLB Cluster will not have description attribute as being a
key attribute. This can be seen from the Cl Type Manager module on the Details tab for the MS
NLB Cluster class. In a similar way this can be achieved for other classes where the key attribute
qualifier should not be inherited.

Identification is also relevant for Cls of sibling Cl types, if at least one of the Cl types inherits its
identification method from the common ancestor CIT. For example, the Cl types Router and Switch
Router are sibling Cl types, descendants of the ancestor CIT Node. If at least one of them has
Inherited from parent as the identification method, then Cls of the two types could be merged if the
identification criteria are met. In such a case, the Cl type of the merged Cl is that of the sibling that was
most recently updated. If one of the Cls had attributes that do not exist in the CI type of the merged Cl,
they are filtered out of the merged CI.

Cl Type Naming

Entity names in Universal CMDB for CMDB-based applications follow the conventions described
below:
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« CIT attributes values. All primitive types are supported: long, double, float, string, and so on.

o CIT attributes values-type string. All special characters are supported. The maximum length is
4000 characters.

o CIT name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore (_). Note also:
o Thefirst character must not be a number.

o The name field is case sensitive, but you cannot use the same name with different cases for
different CITs.

o The maximum length is 200 characters.

o CIT attribute name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore ().
Note also:

o The first character may be a number.
o The attribute name field is not case sensitive.
o The maximum length is 200 characters.

« CIT attribute length. The total length of all the attribute values in one CIT cannot exceed 8K bytes
due to a Microsoft SQL Server limitation. This limitation is relaxed under certain circumstances. For
details, see http://msdn.microsoft.com/en-us/library/ms186981.aspx.

Cl Type Relationships

A relationship defines the link between two Cls. Relationships represent the dependencies and
connections between the entities in your IT environment. When you select relationships or calculated
relationships in the drop-down box in the Cl Types pane, the topology map displays all the valid
instances of CITs linked by the selected relationship. For details about calculated relationships, see
"Using Calculated Relationships" on page 98.

The same attributes defined for CITs are also defined for relationships. You can also assign key
attributes for relationships but it is not required. For details on defining new relationship types, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 503.

Deprecated Cl Types

CITs and relationships that are scheduled to be removed in a subsequent product version are known as
deprecated CITs. Such CITs appear in the user interface in strikethrough font. You can hold the pointer
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over a deprecated CIT to display a tooltip with information about it, including which CIT replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or higher is selected for
the topology map.

Deprecated CITs appear in the CIT tree in Modeling Studio; however, it is not recommended to use
them in building new TQL queries and views. In place of a deprecated CIT, use the CIT indicated in the
tooltip as its replacement. Deprecated CITs do not appear in out-of-the-box queries and views.

CIT attributes which are scheduled to be removed are deprecated attributes. They also appear in
strikethrough font in the user interface.

The following image displays a TQL query containing a deprecated CIT:

%ﬁﬂtainment
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—— Composition
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System Type Manager

System Type Manager enables you to create a predefined list whose values define an attribute type.
For more information, see "System Type Manager Dialog Box" on page 525.

You can create the following attribute types:

« List. Enables you to create a predefined list of values, for example, Location.

« Enumeration. Enables you to create a predefined list of values, as well as assign each value a
color. Enumerations are designed to be used as severity value lists by states. For details, see
"State Manager" in the HPE Universal CMDB Administration Guide.

Severity lists are used for:

o Retrieving Impact Analysis results in IT Universe Manager. For details, see "IT Universe
Manager" on page 180.

o Creating an Impact rule. For details, see "Impact Analysis Manager" on page 462.

You can use both List and Enumeration values for:
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« Editing the attributes of a CIT. For details, see "How to Create a Cl Type" below.

« Defining an attribute condition for a TQL query node or relationship. For details, see "Query
Node/Relationship Properties Dialog Box" on page 72.

How to Create a Cl Type
This task describes the process you follow to create a CIT using the Create Cl Type wizard.

This task includes the following steps:

"Prerequisites" below

o "Define the CI Type" below

» "Set the Cl Type Attributes" below

« "Assign Qualifiers to the CI Type" on the next page
« "Assignanlcontothe Cl Type" on the next page

o "Customize the CI Type Menu" on the next page

» "Define the CI Type Default Label" on the next page

« "Define the Matching Rules" on the next page

—_

Prerequisites

From the CI Type Manager, select Cl Types from the list box in the Cl Types pane. Then click
New E to start the Create Cl Type Wizard.

2. Define the Cl Type

Enter the name, description, and base configuration item type for the new Cl type and select an
identification method for it. For details, see "Details Page" on page 504.

3. Set the Cl Type Attributes

Edit the attributes of the new Cl type. For details, see "Attributes Page" on page 505.

Note: List and Enumeration definitions are created in the System Type Manager. If required,
you can create additional List and Enumeration definitions. For details, see "How to Create
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List and Enumeration Definitions" on page 491.

4. Assign Qualifiers to the Cl Type

Assign qualifiers to the definition of the new ClI type. For details, see "Qualifiers Page" on page
5009.

5. Assign an Icon to the Cl Type

Select anicon to assign to the new Cl type. For details, see "lcon Page" on page 512.

6. Customize the Cl Type Menu

Select the menu items and commands to appear in the shortcut menu for the new Cl type. For
details, see "Attached Menu Page" on page 514.

7. Define the CI Type Default Label

Define the attributes to appear in the Cl type label. For details, see "Default Label Page" on page
516.

8. Define the Matching Rules

If necessary, define the matching rules for the new CI type. For details, see "Matching Rules
Page" on page 518.

Note: This step is only relevant for customers running Universal CMDB Configuration
Manager.

How to Create a Relationship Type

This task describes the process you follow to create a relationship type using the Create Relationship
wizard.

This task includes the following steps:
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» "Prerequisites" below

« "Define the Relationship" below

» "Set the Relationship Attributes" below

« "Assign Qualifiers to the Relationship" below
« "Customize the Relationship Menu" below

« "Define the Relationship Default Label" below

1. Prerequisites

From the Cl Type Manager, select Relationships from the list box in the Cl Types pane. Then

click New |i| to start the Create Relationship Wizard.

2. Define the Relationship

Enter the name, description and base CI type for the new relationship. For details, see "Details
Page" on page 504.

3. Set the Relationship Attributes

Edit the attributes of the new relationship. For details, see "Attributes Page" on page 505.

Note: List and Enumeration definitions are created in the System Type Manager. If required,
you can create additional List and Enumeration definitions. For details, see "How to Create
List and Enumeration Definitions" on page 491.

4. Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 509.

5. Customize the Relationship Menu
Select the menu items and commands to appear in the shortcut menu for the new relationship. For

details, see "Attached Menu Page" on page 514.

6. Define the Relationship Default Label
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Define the attributes to appear in the relationship label. For details, see "Default Label Page" on
page 516.

How to Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship type using the Create
Calculated Relationship wizard.

This task includes the following steps:
« "Prerequisites" below
o "Define the Calculated Relationship" below

« "Assign Qualifiers to the Relationship" below

« "Add Required Triplets" below

1. Prerequisites

From the Cl Type Manager, select Calculated Relationships from the list box in the Cl Types

pane. Then click New |L| to start the Create Calculated Relationship Wizard.

2. Define the Calculated Relationship

Enter the name, description and base Cl type for the new calculated relationship. For details, see
"Details Page" on page 504.

3. Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on
page 509.

4. Add Required Triplets

Add the required triplets. For details, see "Triplets Page" on page 511.
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How to Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration definitions.

This task includes the following steps:

o "Create a List Definition" below

¢ "Create an Enumeration Definition" below

1. Create a List Definition

You can create a List definition of predefined values. For example, a List definition called
Location might contain:

o New York
o Boston
o Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 519.

2. Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a color for each value on
the list. For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 519. For
an example of an Enumeration definition, see "How to Create an Enumeration Definition —
Workflow" below.

How to Create an Enumeration Definition — Workflow

The following steps describe how to create an Enumeration definition.
| Note: To retrieve the required results, you must follow each step in this task.
To create an Enumeration definition:

1. Select Managers > Modeling > Cl Type Manager.

2. From the Main Menu, select Cl Types > System Type Manager to open the System Type
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Manager dialog box.

3. Click the Add = button to open the Create List Definition dialog box.

Note: Alternatively, you can select Managers > Administration > State Manager and then
click the New Enumeration button to open the Create Enumeration Definition dialog box.

4. Select Enumeration.
5. Inthe Name box, enter the required name.
6. (Optional) In the Display Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented
0 Green Normal

1 Orange Major

2 Red Critical

7. Click the Add | button to create a new row.
8. Inthe Value box, enter Normal, in the Key box, enter @, and in the Color section, select Green.
9. Click the Add [ button to create another row.
10. Inthe Value box, enter Major, in the Key box, enter 1, and in the Color section, select Orange.
11. Click the Add || button to create another row.

12. Inthe Value box, enter Critical, in the Key box, enter 2, and in the Color section, select Red.

The following image shows the Enumeration Definition section after the changes:
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Create Enumeration Definition

MName: | Oper_States |
Display Name: | |
Type: () List (® Enumeration
Enumeration Definition
E
Normal
| | maior
Critical Walue: | Critical |
Key: |2 |
r Color
(0 @ Green
(O @ Light Ofive
O o Yelow
) = Orange
® @ Red
8 Gray

13. Click OK to save your changes.

View Descriptions for Cl Types and Relationships

You can view a complete list of available Cl types in tree format in the left pane of Cl Type Manager.
You can search incrementally for a specific Cl type as described in "C| Type Manager Page" on page
499. To see a description for a particular Cl type, select it from the tree and hold the pointer over the
icon which corresponds to it in the Topology Map. A tooltip containing a description of the Cl type is
displayed.

For relationships, select Relationships in the left pane and search incrementally by the first letter of
the relationship. Select the relationship you want and hold the pointer over its icon in the Topology Map
to display a tooltip containing a description of the relationship.

For detailed information on ClI types and relationships, you can generate the UCMDB CI Types and
Relationships Information PDF. For details, see "Export Selected CITs to PDF Dialog Box" on page
524. Alternatively, you can access the UCMDB Class Model Reference by clicking the View UCMDB

#
Class Model -==* button on the ClI Types pane toolbar.
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Cl Type Manager User Interface

This section includes (in alphabetical order):

Add/Edit Attribute Dialog Box
Add/Remove Relationship Dialog Box
Cl Type Manager Page
Create Configuration Item Type/Relationship/Calculated Relationship Wizard .................... 503
Create/Update List/Enumeration Definition Dialog Box
Export Selected CITs to Excel Dialog Box ... . ... ... 522
Export Selected CITs to PDF Dialog Box

System Type Manager Dialog BoX ... ...l 525

Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to edit an existing attribute of a
CIT.

To access  Inthe Cl Type Manager, select the Attributes tab, then click the Add [ button, or

select an attribute and click the Edit button or double-click the attribute.

Important In Edit mode, fields that cannot be changed are disabled. For Cl types with instances,
information some fields cannot be edited. For details, see "Attributes Page" on page 505.

Relevant « "How to Create a Cl Type" on page 487

tasks « "How to Create a Relationship Type" on page 488
See also « "Cl Types Overview" on page 481
o "Cl Type Attributes" on page 482
Details Tab

User interface elements are described below:

HPE Universal CMDB (10.31) Page 494 of 572



Modeling Guide
Chapter 11: Cl Type Manager

Ul Element
(A-2) Description
Attribute Enter a unique name for the new attribute. Only the following characters are
Name permitted: a-z, A-Z, 0-9 and underscore (_). Note also:
« The first character may be a number.
« The attribute name field is not case sensitive.
« The maximum length is 200 characters.
Attribute Select one of the following options:
Type - N
« Primitive. Choose from one of the following field types: boolean, bytes, date
number, double number, float number, integer, list of integers, list of
strings, long number, string, xml.
« Enumeration/List. Contains alist of Enumerations and Lists defined in the
System Type Manager. For details, see "System Type Manager" on page 486.
This option enables you to define an attribute with a predefined value. For example,
a location attribute might be defined by a location list containing the following
values: Singapore, Paris, New York.
Default Enter or select a default value for the attribute. The options for the Default Value field
Value vary depending on the attribute type you selected.
Note:
o The Default Value field is available only when the Default Value Policy
check box is selected.
« If you select the Primitive attribute types 1ist of integersorlist of
strings, you can enter multiple values.
Default Select the check box to specify whether the attribute will have a default value.
Value
Policy

Description Enter a description for the new attribute. The description can be up to 2,048
characters long.

Note: This field is optional.

Display Enter a name for the new attribute to identify it in Universal CMDB.
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Ul Element

(A-2) Description

Name Note: This field is optional.

Scope Select the scope of the new attribute (the class model to which it belongs).

Value Size Enter a value for the maximum physical size of the new attribute. (Enabled for bytes
and string only).

Advanced Tab

User interface elements are described below:

Ul Element
(A-2) Description

Asset Data = Select to display the attribute value in the Asset Report.
Comparable Select to enable this attribute to be used for comparing compound Cls.

Discovery When selected, results sent from the Probe are trimmed. That is, leading and trailing
Auto Trim spaces and tabs are trimmed, so that there are no white spaces at the beginning or at
the end of the result.

Discovery If selected, when attributes of type STRING exceed the size limit, Discovery

Auto truncates the value. For details, see Server-Side Data Normalization in the HPE

Truncate Universal CMDB Data Flow Management Guide.

Editable Select to enable future editing of the attribute. Only attributes that are marked as
Editable (or ones that have values) are displayed in the Properties tab in IT Universe
Manager.

Index Select to accelerate the attribute retrieval performance. This option is recommended

for attributes that are used frequently in search conditions. For example, IP address
is usually an index attribute of a node.

Lower Case When this option is selected, the attribute value appears in lower case.

Managed This designation is only relevant for users of HPE Universal CMDB Configuration
Manager.

Note:
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Ul Element
(A-2) Description

« When this qualifier is selected for a given attribute, the attribute appears as a
visible column in the ClI Instances dialog box. For details, see "Cl Instances
Dialog Box" on page 65.

« Managed is not relevant for attributes of the type list of integers or list of
strings.

Not Tracked @ Select to exclude this attribute from History storage.
for History

Password When this option is selected, the attribute value appears as asterisks (a hidden

value).

Required Select to define this attribute as a required one, if its value is required for the creation
of the CIT.

Static Select to define this attribute as static.

Unique When this option is selected, different instances of this Cl type must have unique
values.

Upper Case When this option is selected, the attribute value appears in upper case.

Use Update For details on this qualifier, see "The Use Update Value Policy Qualifier" on page 23.
Value
Policy

Visible Select to display this attribute in the Properties tab in IT Universe Manager.

UCMDB Browser Qualifiers

User interface elements are described below:

Ul Element
(A-Z) Description

CMS Browser Select to enable this attribute to be editable in the UCMDB Browser.
Editable

CMS Browser Select to enable this attribute to be searchable in the UCMDB Browser.
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Ul Element
(A-2) Description

Searchable

CMS Browser Select to enable this attribute to be viewed in the UCMDB Browser.

Visible
The Visible in preview mode field determines whether the attribute is displayed

in preview mode of the UCMDB Browser.

The Properties group assignment field determines the group in the properties
widget where the attribute is displayed.

Hide in When CMS Browser Visible is selected, select Hide in Modeling to prevent the
Modeling attribute from appearing in the Assisted Modeling feature in the UCMDB Browser.
Hide in Select to enable this attribute to be excluded from exported search results in the
Export Search UCMDB Browser.

Results

Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships between CITs, which define
their physical or logical connections.

To access | Inthe Cl Type Manager, right-click a CIT or two CITs and select Add/Remove
Relationship.

Important When adding a relationship between two CITs, select the two CITs to be linked by
information holding the CTRL key and clicking the CIT names. Then right-click one of them and
select Add/Remove Relationship.

See also o "CIl Types Overview" on page 481

« "CIl Type Relationships" on page 485

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<query node1 to query Select the relationships to add in the direction of the first query node to
node2> the second.

<query node2 to query Select the relationships to add in the direction of the second query
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Ul Element (A-Z)

node1>

Description

node to the first.

Relationship Name A list of the possible relationships.

Cl Type Manager Page

This page enables you to view the information in the Cl Type model, which contains the definitions of

all configuration item types (CITs) defined in the system and the relationships that define the

connections between them. Each CIT has its own attributes, as well as the attributes inherited from its

parent CIT.

To access Sel

ect Cl Type Manager from the Navigation Menu or select Managers > Modeling

> Cl Type Manager.

Important Cl Type Manager consists of the following panes:

information

Relevant .
tasks .
See also .

CIl Types. Displays a hierarchical list of Cl Types and relationships. The number
appearing next to the CIT indicates the number of instances of that CIT which
exist in the CMDB.

Topology Map. Displays a topology map of the CITs and relationships in the
system.

"How to Create a Cl Type" on page 487

"How to Create a Relationship Type" on page 488

"How to Create a Calculated Relationship Type" on page 490
"Cl Types Overview" on page 481

"Cl Type Attributes" on page 482

"Cl Type Relationships" on page 485

"Deprecated Cl Types" on page 485

"View Descriptions for Cl Types and Relationships" on page 493

"Cl Type Manager User Interface" on page 494

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

B2 New. Opens the Create Configuration Item Type Wizard which enables you to
define a new Cl type. For details, see "Create Configuration ltem
Type/Relationship/Calculated Relationship Wizard" on page 503.

Delete. Deletes the selected Cl type or relationship. This option is only
available for Cl types that have no children and no instances.

Note:

« When you delete a Cl type or relationship, all resources dependent on
that ClI type or relationship are also deleted. When you click Delete,
the Confirm Delete dialog box displays links for each type of
dependent resource. Click the links to display the dependent
resources. The dependent resources can include queries, views,
reports, Enrichments, or Impact rules.

« Deleting a Cl type that is part of the out-of-the-box Class Model may
disable UCMDB’s licensing mechanism. Disabling of the license
mechanism will result in restricted access to UCMDB. Access to
UCMDB will only be granted after the impacting Class Model changes
are reverted. To troubleshoot these issues, refer to the UCMDB
licensing log.

|§| Refresh. Refreshes the data content of the hierarchical tree structure that may
have been modified by other users.

(=] Save. Saves the changes made to a Cl type.

Import From XML. Enables you to import CITs from an external file.

E| Export To XML. Enables you to export a CIT as an XML file. Use this option
to move CITs from one server to another.

|§| Export Class Model. Enables you to export a CIT. Choose the export format.
The available options are:

« PDF. The table data is exported in PDF format.

« XLS. The table data is formatted as an .xlIs (Excel) file that can be
displayed in a spreadsheet.

View UCMDB Class Model. Opens the Class Model Reference, which

Y
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Ul Element (A-2)

<ClI
Type/Relationship
Box>

<Editing Pane>

Description

contains information on all packages, Cl types, and relationships in the class

model.

Select one of the following options:

Cl Types. Display the Cl types in the CIT model.
Relationships. Display the relationships in the CIT model.

Calculated Relationships. Display the calculated relationships in the CIT
model.

The following tabs are available:

Dependencies. Displays the Cl Type model in a topology map, including
the CITs and the relationships between them. The name of the selected ClI
type or relationship appears in the border at the top of the pane. When you
point to a CIT, a tooltip displays the display name of the CIT and its
description.

Details. Enables you to edit the basic information about the Cl type
selected in the left pane. For details, see "Details Page" on page 504.

Attributes. Enables you to edit the attributes of the selected CIT. For
details, see "Attributes Page" on page 505.

Qualifiers. Enables you to assign qualifiers to the selected CIT. For
details, see "Qualifiers Page" on page 509.

Triplets. Enables you to create a calculated relationship. For details, see
"Triplets Page" on page 511. This tab appears only for calculated
relationships.

Icon. Enables you to assign an icon to the selected CIT. For details, see
"lcon Page" on page 512. This tab does not appear for relationships.

Attached Menu. Enables you to customize the shortcut menu of a Cl by
adding menu items and commands (for example, ping, run a program, open
a URL). The customized menu is displayed when you right-click a CI
instance in IT Universe Manager. For details, see "Attached Menu Page"
on page 514.

Default Label. Enables you to define attributes that appear in the CIT
label. You can include more than one attribute by using the function
buttons. For details, see "Default Label Page" on page 516.
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Ul Element (A-Z) Description

<Main Menu>
<Toolbar>

Cl Types Pane

« Matching Rules. Enables you to define matching rules for use in
Universal CMDB Configuration Manager. For details, consult the
Configuration Manager documentation. This tab does not appear for
relationships and only appears when UCMDB is running with Configuration
Manager.

For details, see "Main Menu" on page 163.
For details, see "Toolbar Options" on page 167.

A hierarchical tree structure of the Cl Type model containing the inheritance
relationships among CITs, and displaying the number of instances of each CIT
inthe CMDB. All CITs included in the Cl Type model are classified as either a
CIT or a relationship. You can drill down and view the relationships and
neighbors of the selected CIT in the topology map. You can search in the list of
CITs or relationships using the Incremental Search by entering the first letter
of the CIT or relationship repeatedly until you reach the required selection. You
can also search for a CIT or relationship by entering its full name.

Shortcut Menu

CIl Type Manager includes the following options available by right-clicking a Cl type in the CI Types

pane or the Dependencies map:

Ul Element
(A-Z)

Add/Remove
Relationship

Delete
Selected
Item

Description

Opens the Add/Remove Relationship dialog box, which enables you to add or
remove relationships from CITs. For details, see "Add/Remove Relationship Dialog
Box" on page 498.

Deletes the selected Cl type. This option is only available for Cl types that have no
children and no instances.

Note: When you delete a Cl type or relationship, all resources dependent on
that Cl type or relationship are also deleted. When you select Delete Selected
Item, the Confirm Delete dialog box displays links for each type of dependent
resource. Click the links to display the dependent resources. The dependent

resources can include queries, views, reports, Enrichments, or Impact rules.

HPE Universal CMDB (10.31) Page 502 of 572



Modeling Guide

Chapter 11: Cl Type Manager

Ul Element

(A-2)

Export To
XML

New

Show CIT
Instances

Description

Enables you to export a CIT as an XML file. Use this option to move CITs from one
server to another.

Opens the Create Configuration Item Type Wizard which enables you to define a
new ClI type. For details, see "Create Configuration ltem
Type/Relationship/Calculated Relationship Wizard" below.

Opens the Show All Instances dialog box, which displays all instances of the
selected CIT. For details, see "Cl Instances Dialog Box" on page 65.

Create Configuration Item Type/Relationship/Calculated
Relationship Wizard

This wizard enables you to define a new configuration item type or relationship.

To
access

Relevant
tasks

Wizard
map

See also

Click a Cl type or relationship in the topology map or Cl Types pane of the Cl Type

Manager and select New or click the New |J button in the CI types pane.

"How to Create a Cl Type" on page 487
"How to Create a Relationship Type" on page 488

"How to Create a Calculated Relationship Type" on page 490

The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"

contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon Page" >

"Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

"Cl Types Overview" on page 481

o "CI Type Attributes" on page 482

"Cl Type Relationships" on page 485

The Create Configuration Iltem Type wizard includes the following pages:

« "Details Page" on the next page

« "Attributes Page" on page 505

HPE Universal CMDB (10.31)

Page 503 of 572



Modeling Guide
Chapter 11: Cl Type Manager

» "Qualifiers Page" on page 509

« "Triplets Page" on page 511

» "lcon Page" on page 512

« "Attached Menu Page" on page 514
« "Default Label Page" on page 516

« "Matching Rules Page" on page 518

Details Page

This wizard page enables you to enter basic information about the new Cl type you are defining.

Important | For general information about the Create Configuration Item Type Wizard, see
information | "Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on
the previous page.

Wizard The "Create Configuration Iltem Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lIcon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below:

Ul Element

(A-2) Description

Base CI Select a base CIT for the CIT you are creating. The new CIT inherits the base CIT's
Type attributes.

Note: This field only appears in the Create Cl Type Wizard. It is not relevant
when editing an existing CIT in the Details tab of Cl Type Manager.

Created By The user who created the new CIT.
Note: This field is optional.
Description = A description for the new CIT. The description can be up to 2,048 characters long.

Note: This field is optional.
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Ul Element

(A-Z) Description

Display The name of the CIT as it appears in the Universal CMDB interface.
Name

Note: This field is optional.

Identification Every new CI defined has an identification based onits CMDB ID and global_id
properties. You can set an additional identification method for instances of the
selected CIT. The following options are available:

« By key attributes. Select attributes from the Available Attributes pane and
move them to the Selected Attributes pane. These attributes are defined as the
CIT's key attributes. CIT instances with matching values for all of the key
attributes are merged into a single instance.

« By identification rule. Click the Edit button to define an XML identification
rule. For an example of an XML identification rule, see How to Create an
Identification Rule Document in the HPE Universal CMDB Data Flow
Management Guide.

« Inherited from parent. The CIT uses the same identification method as its
parent CIT.

« No identification. No additional identification method.

Note: Forrelationships, only the By key attributes option is available.

Name The unique name of the new CIT. Only the following characters are permitted: a-z,
A-Z, 0-9 and underscore (_). Note also:

o The first character must be a-z or A-Z.

« The name field is case sensitive, but you cannot use the same name with
different cases for different CITs.

« The maximum length is 200 characters.

Scope Select the scope of the new CIT (the class model to which it belongs).

Attributes Page
This wizard page enables you to edit the attributes of the Cl type.

Important For each attribute, there are columns which display its name, display name, type,
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information

Wizard
map

description and default value. There are also columns for each attribute qualifier. A
check mark indicates that the qualifier is selected.

Click the Edit button to edit attribute details and qualifiers. For Cl types with
instances, some qualifiers cannot be modified, as displayed in the Qualifier can be
modified when there are CIT instances column. If a qualifier is modified for a
selected attribute for a Cl type with instances, the attribute of each Cl instance is
changed accordingly (for example, if the Visible attribute is selected, the
Clinstances become visible in IT Universe Manager).

The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
contains:

"Details Page" > "Attributes Page" >"Qualifiers Page" > "Triplets Page" > "lcon
Page"> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2)

&

2]

<Attributes>

Qualifier can be
modified when there
Description are CIT instances

Add. Enables you to define a new attribute. For details, N/A
see "Add/Edit Attribute Dialog Box" on page 494.

Edit. Opens the Edit Attribute dialog box. For details, see N/A
"Add/Edit Attribute Dialog Box" on page 494.

Note: If you modify an attribute belongingtoa CIT's
parent, the text turns light blue. If you modify an
attribute belonging to the CIT itself, the text remains
dark blue.

Delete. Deletes the selected attribute. This option is only N/A
active for newly defined attributes.

Reset. Resets the attribute settings after editing a pre- N/A
existing attribute.

Select Columns. Enables you to select the columns to N/A
appear using the Select Columns dialog box. For details,
see "Select Columns Dialog Box" on page 568.

Displays all attributes associated with the new CIT. N/A
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Qualifier can be
Ul Element modified when there
(A-Z) Description are CIT instances

Attributes appearing in black are ones that the new CIT
inherits from the base CIT. Attributes appearing in dark
blue are ones that are private to this CIT and its
descendants. Attributes appearing in light blue are inherited
ones that have been modified for the new CIT.

Asset Data Indicates whether the attribute value is displayed in the Yes
Asset Report. For details see "Asset Report" on page 367.

Note: When this qualifier is selected for a given
attribute, the attribute appears as a visible columniin
the Cl Instances dialog box. For details, see "Cl
Instances Dialog Box" on page 65.

CMS Indicates whether this attribute is editable in the Yes
Browser UCMDB Browser.

Editable

CMS Indicates whether this attribute is searchable in the Yes
Browser UCMDB Browser.

Searchable

CMS Indicates whether this attribute is visible in the UCMDB Yes
Browser Browser.

Visible

Comparable Indicates whether this attribute is to be used for comparing = Yes
compound Cls. For details, see "Compare Cls Report" on
page 387. The changes in the value of such an attribute are
saved in the History.

Note: When this qualifier is selected for a given
attribute, the attribute appears as a visible columnin
the Cl Instances dialog box. For details, see "Cl
Instances Dialog Box" on page 65.

Default The default value for the attribute. This value appears when = N/A
Value the new CIT is defined and there is no runtime value for the
attribute.
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Ul Element
(A-Z)

Description

Discovery
Auto Trim

Discovery
Auto
Truncate

Display
Name

Editable

Index

Key

Lower Case

Managed

Description
A description of the attribute.

Indicates whether the results sent from the Probe are
trimmed.

Indicates whether the auto-truncate feature for attributes of
type STRING is enabled.

The attribute name that appears in the Universal CMDB
interface.

Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that
have values) are displayed in the Properties tab in IT
Universe Manager.

Indicates whether the attribute has been defined as an
index attribute, which enables you to accelerate the
attribute retrieval performance.

This option is recommended for attributes that are used
frequently in search conditions. For example, IP address
is usually an index attribute of a node.

Indicates whether the attribute is defined as a key attribute.

Note: This column s only relevant when By key
attributes is selected as the identification method.

Indicates whether to keep the attribute value in lower case.

This designation is only relevant for users of HPE
Universal CMDB Configuration Manager.

Note: When this qualifier is selected for a given
attribute, the attribute appears as a visible columnin
the Cl Instances dialog box. For details, see "Cl
Instances Dialog Box" on page 65.

HPE Universal CMDB (10.31)

Qualifier can be
modified when there
are CIT instances

N/A

Yes

Yes

N/A

Yes

Yes

Yes

Yes

Yes
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Ul Element
(A-Z)

Name

Not Tracked
for History

Required

Static

Type

UDM Scope

Unique

Upper Case

Visible

Description

The actual name of the attribute (compare to Display
Name). The name must be in English.

When this qualifier is selected for a given attribute, the
attribute is not monitored by History.

Indicates whether this attribute is defined as a required
one, whose value is required for the creation of the CIT.

Indicates whether this attribute is defined as static.
The type of the attribute.

Indicates whether the attribute is included in the UDM
class model.

Indicates whether this attribute is defined as unique, for
which different instances of this Cl type must have unique
values.

Indicates whether to keep the attribute value in upper case.

Indicates whether this attribute is displayed in the
Properties tab in IT Universe Manager.

Qualifiers Page

This wizard page enables you to assign qualifiers to a Cl type definition.

Important
information

Wizard
map

Qualifier can be
modified when there
are CIT instances

N/A

Yes

Only if the attribute in
the instances is not
empty

No
N/A

No

No

Yes

Yes

Qualifiers enable you to define added attribute definitions to the CIT. In the Qualifiers

list, select the required qualifiers using the Add buttons to move your selections to

the Configuration Item Type Qualifiers list. You can make multiple selections by

holding the CTRL key.

The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"

contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon

Page"> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

2)

=

<Configuration

Item Type
Qualifiers>

<Qualifiers>

ABSTRACT_
CLASS

BLE_LINK_
CLASS

CONTAINER

HANDLER

HIDDEN_
CLASS

ITU_HIDDEN_

CLASS

MAJOR_APP

MODELING_

HPE Universal CMDB (10.31)

Description

Moves all qualifiers to the Configuration Item Type Qualifiers list.

Adds the selected qualifier to the Configuration Item Type Qualifiers list.
Select multiple qualifiers by holding the CTRL key.

Removes the selected qualifier from the Configuration Item Type Qualifiers
list.

Removes all qualifiers from the Configuration Item Type Qualifiers list.

To define a new, custom qualifier, enter the qualifier name in the text box and
click Insert. The qualifier appears in the Configuration Item Type Qualifiers
list.

The list of qualifiers that define attributes of the new CIT. For example, you can
use a qualifier to define a CIT as abstract, which means that you cannot create
instances from it.

The list of available qualifier options.

You cannot create instances of this CIT.

Relevant for HP Business Service Management only.

This qualifier is assigned to relationships that signify a containment relationship,

such as Membership, Composition, Containment.

Relevant for HPE Business Service Management only.

Instances of this CIT do not appear anywhere in the application.

Instances of this CIT do not appear in the topology map application.

Cl types that are assigned this qualifier appear in the Application Breakdown

custom report. For details, see "Application Breakdown Report" on page 364.

Enables a CIT to act as a model in the Modeling Studio. For details, see
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Ul Element (A-
Z)

ENABLED

NETWORK_
DEVICES

PM_SUSPECT

READ_ONLY_
CLASS

RECURSIVE_
DELETE

SERVICE_
MODEL

STRONG_

CONTAINMENT

Description

"Business Cl Models" on page 259.

Note: This qualifier can only be selected for Cl types that are descendants
of the Cl type Configuration Item.

A qualifier common to all the Cl types that represent a network device. It can be
used for TQL queries related to network devices and serves as a replacement for
Cl types inaquery.

Relevant for HP Business Service Management only.

This CIT cannot be edited.

Relevant for relationships. When the CI at one end of a relationship is deleted,
the system checks the Cl at the other end of the relationship. If it is not related to
any other Cls, it is also deleted.

Note: This qualifier appears only in the qualifier list in Modeling Studio.

Relevant for the UCMDB Browser. Only Cl Types that have this qualifier are
available in the UCMDB Browser as a service, and may be used to create
Service Models in the UCMDB Browser.

Relevant for relationships. Indicates that the root_container attribute of end2 is
assigned the ID of end1.

Triplets Page

This wizard page enables you to create a calculated relationship. Each row on the Triplets page

represents one of the allowed steps in the path leading from the source Cl to the target Cl in the

topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important
information

« This page is displayed if you select Calculated Relationships in the drop-down
box in the Cl Types pane.

« Fordetails about calculated relationships, see "Using Calculated Relationships"

HPE Universal CMDB (10.31)
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« For general information about the Create Configuration Item Type Wizard, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard"

on page 503.
Wizard The "Create Configuration Iltem Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page"> "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

See also "Using Calculated Relationships" on page 98

User interface elements are described below:

Ul Element

(A-2) Description

Add. Enables you to define the allowed steps in a path in the topology graph leading
from the source Cl to the target Cl in the calculated relationship. Opens the Add
Triplet dialog box. For details, see "Add Triplet Dialog Box" on page 62.

|§| Edit. Enables you to edit the triplet. Opens the Edit Triplet dialog box. For details,
see "Add Triplet Dialog Box" on page 62.

g Delete. Deletes a selected triplet.

Relationship The required relationship connecting the two query nodes.

Relationship The source and target of a relationship.

Direction
« = Thedirection is from source to target.
o = Thedirection is from target to source.
Source The required source query node.
Target The required target query node.
lcon Page

This wizard page enables you to select anicon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

Important | Each CIT is displayed with a default icon. However, you can attach different icons to
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information the same CIT when certain conditions apply. For example, you can associate
different icons with the same CIT when one of its attribute values changes.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page"> "Triplets Page" > "lcon
Page" >"Attached Menu Page" >"Default Label Page" > "Matching Rules Page"

User interface elements are described below:

Ul Element (A-Z) Description

L

o Add Icon Function. Adds a row.

Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.

g Remove Icon Function. Removes the selected row.
Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.
Attributes Select an attribute to determine the icon assigned to the CIT.
Change the Enables you to assign an icon for each attribute value. For example,

Configuration Item Type you could define two values for the City attribute: if City=London, one
icon according to its icon is displayed. If City=Beijing, anothericon is displayed.

attribute value
Note: If you change the icon of a CIT that appears in an existing

view, the CIT's icon is not updated in the view.

Configuration Item Type Select the group to which the CIT belongs.

Main Icon

Icon Select anicon to associate with the value you entered in the Value
column.

Value Enter a value corresponding to the attribute you selected. You can add

a new line for each value you enter.
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Attached Menu Page

This wizard page enables you to customize the shortcut menu of a Cl by adding menu items and
commands (for example, ping, run a program, open a URL). The customized menu is displayed when

you right-click a Cl instance in IT Universe Manager.

Important

information

Wizard
map

If a CIT does not have a method defined specifically for it, the CIT inherits all the
menus from its parent CIT or the nearest ancestor that does have a method defined

forit.

If you create or modify a menu, the change occurs only in the specific CIT that is
being edited.

The "Create Configuration Item Type/Relationship/Calculated Relationship
Wizard" contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below:

Ul Element

(A-2)

<Tree>

Command

HPE Universal CMDB (10.31)

Description

Select a menu item from the tree and click the button. A new entry appears under the
selected item.

Click to remove a menu item.

Click to move a selected menu item up in the menu.
Click to move a selected menu item down in the menu.
Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the default menu
items.

To connect to a specific location on the World Wide Web, select URL, and enter the
exact Intermet address, for example, http://www.hp.com/go/software. (Available
only if you select the URL command type option.)

Note: If you use a variable in the Command field, use the format command
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Ul Element
(A-Z)

Description

Existing
Method

Icon

Menu Item
Name

Method

Method
Name

New Method

Parameters

Require
user
confirmation

Separator

HPE Universal CMDB (10.31)

Description

name %1 and define the CIT attributes as described in "Parameters" below. The
parameter values replace %1 according to their order in the list. For example, %1
is replaced by the first parameter in the list, %2 is replaced by the second
parameter in the list, and so on.

Enter a description for the method. (This is for internal use only and does not appear
in the menu.)

Select to choose a command from a list of defined methods inherited from the IT
Universe CIT and all its ancestors.

Select the icon to appear next to the menu option in the shortcut menu.
Note: This field is optional.

Enter a name for the new menu item as it should appear in the menu.

Enables you to add a command to the menu.

Note: To create a method and not override the existing method, it is
recommended to create a new menu item and place the new method there.

Enter a name for the command.

Select to add an action (for example, ping) to the menu item.

To add attributes to the command or URL, click the Add Parameter button and
select the attribute from the list.

To delete an existing entry, select it and click the Remove Parameter button.

Note: Parameters are not relevant when Inner Process is selected.
Select the check box for users to confirm access to a menu item before the item is

displayed.

To place a separator between two menu items:

Click OK to place a separator underneath the selected menu option.
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Ul Element
(A-Z) Description
Shortcut Press any key combination to create a shortcut for the menu item, for example,

CTRL+h.
Note: This field is optional.

Sub-Menu Select to create a sub-menu under the selected menu option.

SJ CI Hiskory
Mok

| ote L\@j ] Add th?lie
Delet

Ry Dekle Sub-rmenu

[, Mew Related CI < Manu
Actions ]

Type Choose a command type:

« URL. Opens a web page to the specified URL. Enter the URL of a Web page for
the command to open in the URL box.

« Inner Process. Triggers an internal Universal CMDB action. Select an action
from the drop-down list of actions.

« Execute. Triggers an executable action. Enter an executable command in the
Executable box.

Note: Inthe Executable box, enter only the name of the executable file (for
example, notepad.exe). Do not enter a path to the executable file. A path
cannot execute a program.

Note: After making changes to a Cl type in an older version of UCMDB (for example, UCMDB
version 9.05), when upgrading UCMDB to the latest version, some new functionality may be
missing from the shortcut menu for Cls of that type orits descendants in IT Universe Manager. In
that case, edit the attached menu for that Cl type and add the missing functionality.

Default Label Page

This wizard page enables you to define attributes that appear in the Cl type label. You can include more
than one attribute by using the function buttons.

Important You build a label by selecting attributes in the Cl Type Attributes pane and adding
information them to the Format pane, using the operators in the Format pane to connect them.
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Wizard
map

The label appears as the title under a Cl of the new CI Type. The label definition can
be customized to include different attribute values. For example, if the function label
of the node CIT is composed of hostname and network, the displayed label is:
serverl 10.0.65.0.

Labels can also be created using regular expressions.

The "Create Configuration Iltem Type/Relationship/Calculated Relationship Wizard"
contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "Icon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page" on
the next page

User interface elements are described below:

Ul

Element
(A-2)

=

Q

&

Description

Add selected attribute. Adds the selected attribute to the Format pane.

Parentheses. Adds parentheses to the formatted text (use in conjunction with the other
functions).

And. Places an AND operator between two attributes in the formatted text. For
example, network_netaddr&network_domain displays the network address and the
domain of a query node.

Or. Places an OR operator between two attributes in the formatted text.

Regular Expression. Adds a regular expression (using regular expression syntax) to
the label definition. The structure of the entry is (v1, v2, v3), where v1 represents the
selected attribute, v2 represents the regular expression itself (which divides the value
into groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of a first name, a space, and
a surname, the regular expression would be (name, (\S*)(\s*)(\S*), 3), which
indicates that the surname can be used for the name attribute in the default label.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 571.

Undo. Reverses the last change you made.
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ul
Element
(A-2) Description
2 Redo. Repeats the last action you took.
@ Clear. Clears the Format pane.
|§| Restore Default. Restores the default settings.

Cl Type Displays the available options of attributes to be included in the CIT label.
Attributes

Cl Type Displays the attributes that you select to appear in the CIT label.

Label
Definiti For example, to label a node by its host name and operating system, choose the host_
efinition
hostname and host_os attributes. The CIT label is host1l UNIX.
Format

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight it and press the
Delete key.

Matching Rules Page

This wizard page enables you to define matching rules for comparable attributes for use in Universal
CMDB Configuration Manager.

Important This page is only relevant when Configuration Manager is installed. For details on
information matching rules, refer to the Configuration Manager documentation.

Note: You can activate the Matching Rules page manually by setting the Enable
Configuration Manager Matching Rules setting to true in the Infrastructure
Settings Manager.

Wizard The "Create Configuration Item Type/Relationship/Calculated Relationship Wizard"
map contains:

"Details Page" > "Attributes Page" > "Qualifiers Page" > "Triplets Page" > "lcon
Page" > "Attached Menu Page" > "Default Label Page" > "Matching Rules Page"

User interface elements are described below:
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Ul Element
(A-Z)

>

Comparable

Attributes

Matching
Rule
Priorities

Required
Matching
Attributes

Description

Moves the selected comparable attributes to the Matching Rule Priorities pane or
the Required Matching Attributes pane. Select multiple attributes by holding the
CTRL key.

Removes the selected attribute from the Matching Rule Priorities pane or the
Required Matching Attributes pane.

Moves all attributes to the Matching Rule Priorities pane or the Required Matching
Attributes pane.

Removes all attributes from the Matching Rule Priorities pane or the Required
Matching Attributes pane.

Sets the order of the matching rules using the up and down buttons.

A list of all the attributes of the selected Cl type with the comparable qualifier
selected.

The attributes selected are used by Configuration Manager, according to the priority
defined, to determine if the matching rule is satisfied.

The values of the selected attributes of component Cls must match to satisfy the
Configuration Manager matching rule, when comparing between composite Cls.

Wildcards cannot be used when specifying a required matching attribute. If an exact
match is not found, component Cls are not compared.

Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition. The List or Enumeration

definition you have created appears in the System Type Manager dialog box, where you can edit it if

required (for details, see "System Type Manager Dialog Box" on page 525).

To access

Important
information

Click the Add | button in the System Type Manager dialog box.

You can access the Create/Update Enumeration Definition dialog box from the State
Manager as well. For details, see State Manager in the HPE Universal CMDB
Administration Guide.
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Relevant « "How to Create List and Enumeration Definitions" on page 491

tasks « "How to Create an Enumeration Definition — Workflow" on page 491

See also « "System Type Manager" on page 486

« "System Type Manager Dialog Box" on page 525

User interface elements are described below:

Ul Element

(A-Z) Description

Display Enter the name you want to appear in the list of System Type Definitions. If you
Name leave this field empty, the entry in the Name field is used.

Enumeration = Enables you to create a predefined list of values, as well as assign each value a
color. For details, see "Enumeration Definition Area" on the next page.

List Enables you to create a predefined list of values. For details, see "List Definition
Area" below.
Name Enter a unique name for the definition.

List Definition Area

This area enables you to create a predefined list of values.

To access Select List in the Create List/Enumeration Definition dialog box.
Important For example, a Location attribute might be defined by a location list containing
information the following values:

« New York

« Boston

« Baltimore

The following elements are included (unlabeled elements are shown in angle brackets):
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Ul
Element
(A-Z) Description

i Add. Adds a List definition. Double-click inside the row and either select a date from the
calendar that appears (if you chose the type Date) or type the required value.

Remove. Deletes the selected List definition.
n Sort. Sorts the list in alphabetical order.

Type Choose one of following field types:
« Date
« Double
« Integer
« Long

» String

Enumeration Definition Area
This area enables you to create a list from a predefined list of values (similar to List), with capabilities

such as assigning a color for every value.

To access  Select Enumeration in the Create List/Enumeration Definition dialog box.

Important Enumerations are designed to be used as severity value lists by states. You can use
information Enumerations for lists that require key values.

Note:

« If an existing enumeration definition is designated as a default value fora CIT
attribute, you cannot change its value.

« If you change the value of an existing enumeration definition, all Cl instances
of that CIT that include attributes with the selected value, are reset to the
default value for that attribute.

See also "How to Create an Enumeration Definition — Workflow" on page 491

User interface elements are described below:
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Ul
Element

(A-Z) Description

o Add. Adds an Enumeration definition.

Remove. Deletes the selected Enumeration definition.

Color Select a color that indicates the severity level.

Note: Gray is only enabled when you create an Enumeration of the type Admin.

Key Type a number to create an enumeration that describes a severity list for a category.

Assign key values according to the following rules:

The list of key values must always begin with zero (0). (Zero represents the Normal
state.) Otherwise, it does not appear in the State Manager (for details, see State
Manager in the HPE Universal CMDB Administration Guide).

The list must always be numbered consecutively.

For an example of an Enumeration definition, see "How to Create an Enumeration

Definition — Workflow" on page 491.

Value Type a value, either a string or a number, for example, Red ormy value. The value
appears in the tooltip for the Cl in IT Universe Manager.

Export Selected CITs to Excel Dialog Box

This dialog box enables you export selected Cl types to an Excel report.

To access

Important
information

In the CI Type Manager, click the Export Class Model |ﬂ| button and select Export
Selected CITs to Excel.

You can select a CIT and a relationship to serve as the root Cl type and root
relationship for the report. If you do not select a CIT or relationship, the default values
are used. The root CIT and root relationship are independent of each other.

The report displays the root CIT and all its descendant CITs. The report contains the
following pages:

« CIT Hierarchy. Displays the CITs under the root CIT in tree format with links to
their attributes.
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See also

Relationship Hierarchy. Displays the relationships under the root relationship in
tree format with links to their attributes.

CIT Attributes. Displays the name, type, description and display level for the CIT
attributes of each CIT under the root CIT.

Relationship Attributes. Displays the name, type, description and display level
for the relationship attributes of each relationship under the root relationship.

Valid Relationships. Displays all the valid relationships for each CIT under the
root CIT.

Enumerations. Displays all the enumeration definitions from the System Type
Manager. (Not dependent on the root CIT or root relationship.)

Lists. Displays all the list definitions from the System Type Manager. (Not
dependent on the root CIT or root relationship.)

You can select the pages you want to display in the report.

o "CIl Types Overview" on page 481
« "View Descriptions for Cl Types and Relationships" on page 493

o "Universal Data Model (UDM) Overview" on page 560

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z)

Root
Cl Type

Root
Relationship

Select pages
to display

Description

Click the ellipsis |E| button to select a CIT to serve as the root Cl type. If you do not

select a CIT, the default root Cl type used . To change the default value, edit the
Object root setting in Infrastructure Settings Manager.

Click the ellipsis 2| button to select a relationship to serve as the root relationship. If

you do not select a relationship, the default root relationship used. To change the
default value, edit the Link root setting in Infrastructure Settings Manager.

Select the pages to display in the report (select the check boxes for all the required
pages). The following options are available:

« CIT Worksheets. Includes the CIT Hierarchy and the CIT Attributes

worksheets.

« Relationship Worksheets. Includes the Relationship Hierarchy and

Relationship Attributes worksheets.
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Ul Element
(A-Z) Description

« Valid Relationships Worksheet. Includes the Valid Relationships worksheet.

« Type Definition Worksheets. Includes the Enumerations and Lists
worksheets.

Export Selected CITs to PDF Dialog Box

This dialog box enables you export selected Cl types to a PDF report.

To access In the CI Type Manager, click the Export Class Model |ﬂ| button and select

Export Selected CITs to PDF.

Important The output of this dialog box is the UCMDB CI Types and Relationships
information Information PDF, describing the Universal Data Model.

See also o "Cl Types Overview" on page 481
« "View Descriptions for Cl Types and Relationships" on page 493

« "Universal Data Model (UDM) Overview" on page 560

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

All Data Select to display all the information on the selected CITs.

Changes Select to display only the changes in the selected CITs from the previous data
Only model.

CITs Click the ellipsis ==/ button to select CITs to export.

Filter Select to filter the attributes in the report by qualifiers. Enter the required qualifiers

attributes by  in the box. The report displays only the attributes with the selected qualifiers.
qualifiers

Relationships Click the ellipsis | button to select relationships to export.

Show Select the scope of the selected CITs and relationships:

Properties . .
o UDM. Includes CITs and relationships from the UDM.
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Ul Element
(A-Z) Description

o CMS. Includes only CITs and relationships used in the CMS
Show Select to include qualifier information in the exported report.
Qualifiers
Show Select to include relationship information in the exported report.

Relationships

Show Valid Select to include valid link information in the exported report. The valid link section
Links displays all the valid relationships for the selected CITs.

System Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the Create List/Enumeration
Definition dialog box.

To access In the CI Type Manager, click the Cl Types menu and select System Type
Manager.

Relevant « "How to Create List and Enumeration Definitions" on page 491

tasks

« "How to Create an Enumeration Definition — Workflow" on page 491

See also o "Cl Types Overview" on page 481

« "System Type Manager" on page 486

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
i Add. Enables you to create a predefined list whose values define an attribute
type. You can create a definition for the following attribute types:
« List definition.
« Enumeration definition.
For a description of these attribute types, see "Create/Update List/Enumeration
Definition Dialog Box" on page 519.
2l Edit. Enables you to edit an existing definition. For details, see "Create/Update
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Ul Element (A-
Z) Description

List/Enumeration Definition Dialog Box" on page 519.

@ Delete. Deletes an existing definition. Select the system type definition you want
to delete and click the Delete button.

<System Type | The list of Enumeration and List definitions created in the System Type Manager.
Definitions>
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This chapter includes:

Enrichment Manager OVerVieW ... 527
How to Define an Enrichment Rule—Scenario ........ . ... ... ... ... 529
How to Add Enrichment Query Nodes and Relationships to an Enrichment TQL Query ........... 533
How to Define a Tenant AssociationRule ... ... . ... .. ... 534
Enrichment Manager User Interface ... ... .. . 535

Enrichment Manager Overview

Enrichment rules can be used for several purposes:

« Adding new Cls and relationships to the CMDB.
« Deleting specific Cl instances from the CMDB.

« Updating the attribute values of specific Cl instances in the CMDB.

Enrichment query nodes and relationships differ from other query nodes and relationships in that they
are conceptual deductions that represent real relationships and Cls that cannot be discovered
automatically by the discovery process.

Enrichment query nodes and relationships are created as part of a TQL query, whose other TQL query
nodes are regular ones, meaning TQL query nodes that already exist in the CMDB. For more
information about TQL queries, see "Topology Query Language" on page 14.

The following example displays a regular query node of type Node linked to a Websphere AS
Enrichment query node by an Enrichment Composition relationship.
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Enrichment £
- % ,3 e
query node
Websphere AS

) *
Enrichment + Compaosition
relationship ‘\[ )
Existing query node =

MNode

Containment

!

m

IpAddress

By placing an Enrichment query node within a TQL query context, the query receives data from its
attributes, and uses it to insert new information into the CMDB.

When you create Enrichment rules, the following results can occur:

- The CMDB is enlarged. Add Enrichment query nodes and relationships that are currently not
included in the CMDB.

The following Enrichment rule example displays a regular Windows query node (that already exists in
the CMDB) connected to a Log File Enrichment query node by an Enrichment Composition

relationship.

Enrichment B

 —— +
query node

Lag File
+ Composition
Existing query nodg —4—788 lﬁi
Windows

This Enrichment rule states that for every Windows Cl instance that is found in the CMDB, a new
Log File Cl instance is created, and linked to the Windows CI with a Composition relationship.

« Specific Cl instances are deleted from the CMDB. For an example, see "How to Define an
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Enrichment Rule — Scenario" on the next page.

o The values of Cl attributes are updated. Use an Enrichment rule to update the attributes of a Cl
that already exists in the CMDB.

The following Enrichment rule example illustrates that a regular Windows query node (that already
exists in the CMDB) has been updated with an Enrichment rule.

@a

Windows

This Enrichment rule states that every Windows CI found in the CMDB is updated with the attribute
value defined in the Enrichment rule.

How to Define an Enrichment Rule — Scenario

This task describes how to create the following Enrichment rule:

AnIP Address Cl is connected to two identical Node Cls: one Node Cl is identified by its IP address
and the other is identified by its lowest MAC address. For every such instance, delete the Node ClI that
is identified by its IP address from the CMDB.

Note: To reach the required result, you must implement each one of the following steps.
This task includes the following steps:

« "Create an Enrichment TQL Query" below
« "Define the Query Node of Type Node that Is Identified by its Lowest MAC Address" on page 531
« "Define the Query Node of Type Node that is Identified by its IP Address" on page 531

« "Define the Enrichment Rule" on page 532

1. Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment rule and then add the
regular TQL query nodes and relationships that define the query.

Note: You can add Enrichment query nodes and relationships only after at least one regular
query node has been added to the query.
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Select Managers > Modeling > Enrichment Manager. For details about how to create an
Enrichment TQL query, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 544. For details about how to add query nodes and relationships
to a query, see "How to Add Query Nodes and Relationships to a TQL Query" on page 25.

You can add query nodes of a federated Cl type to the Enrichment TQL query, but if the actions
defined in the Enrichment rule affect those query nodes, their source is automatically set to
UCMDB when you save the rule. You cannot update or delete a federated query node or a
relationship to or from a federated query node.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the Network folder) is
created in Enrichment Manager.

Rule Mame: | doubleHosts1

Rule Description: | Delete incomplete host

Rule is Active

The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules pane.

= Ngtwnrk
F doubleHosts

[@_5] doubleHosts1

& Update_Broadcast_IP

In this Enrichment TQL query, an IP Address query node is linked to two query nodes of type
Node by a Containment relationship. The query results must comply with the direction of the
arrows.
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Mode_2 Mode
Containgnent_2

Cantainment

il

Ipaddress

Note: A TQL query is subject to certain validation restrictions. For details, see
"Troubleshooting and Limitations — Topology Query Language" on page 93.

2. Define the Query Node of Type Node that Is Identified by its Lowest MAC
Address

At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click the
required query node of type Node, select Query Node Properties to open the Query Node
Properties dialog box. Then define an attribute condition in the Attribute tab. For details on how to
define an attribute condition, see "Query Node/Relationship Properties Dialog Box" on page 72.

Example of an Attribute Condition Definition that Identifies the Node by its Lowest
MAC Address:

In the Attribute tab, this attribute condition definition identifies the required Node by its lowest
MAC address.

o Attribute name — Node is Complete
o Operator — Equal

o Value — True

3. Define the Query Node of Type Node that is Identified by its IP Address

At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click the
required query node of type Node, and select Query Node Properties to open the Query Node
Properties dialog box. Then define two attribute conditions in the Attribute tab. For details on how
to define an attribute condition, see "Query Node/Relationship Properties Dialog Box" on page 72.

Example of an Attribute Condition that Enables a Node to Be Identified by its IP
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Address:

This attribute condition is the first attribute condition you need to define in the Attribute tab to
enable the query node of type node to be identified by its IP Address.

Attribute name — Node is Complete
Operator — Equal
Value — False

This is the second attribute condition you need to define in the Attribute tab to enable the
query node of type node to be identified by its IP address.

Attribute name — Node is Complete
Operator — Is null

Value — Value cannot be changed

4. Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of type Node that are
identified by their IP addresses. From the toolbar, select Enrichment mode. In the Enrichment
Rules pane, select the doubleHosts1 Enrichment rule. Then right-click the query node of type
Node that is identified by its IP address and select Delete Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that all node instances
that have identical attribute and cardinality settings are removed from the CMDB. The
Enrichment query now looks like this.

e E

Mode Mode_2
Cnntainment\' /Cnntainment}
IpAddress
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How to Add Enrichment Query Nodes and
Relationships to an Enrichment TQL Query

This section describes how to add Enrichment query nodes and relationships to an Enrichment TQL
query in Enrichment Manager.

To add Enrichment query nodes and relationships to a TQL query:

1.

From the tree in the Enrichment Rules pane, select the Enrichment rule to which you want to add
Enrichment query nodes and relationships or create a new one. For details, see "New Enrichment
Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard" on page 544.

From the Query/Enrichment drop-down at the top of the page, select Enrichment Mode.

Guery Mode

Enrichment Mocle | b
Enrichment Mode

From the tree displayed in the Cl Type Selector, click and drag the query nodes you want to
function as an Enrichment query node on to the editing pane. These are the TQL query nodes that

are included in the query. Added Enrichment query nodes are displayed by an added E indicator.
Note: You can add more than one Enrichment query node to a rule.

Link the Enrichment query node to an existing TQL query node or query nodes, to provide the
Enrichment query node with the needed context for its operation.

The following are the Enrichment rule validations:

o You must link the new Enrichment query node to at least one of the existing TQL query nodes
in the rule.

o Enrichment query nodes can only be linked to one another with an Enrichment relationship.

o If the new Enrichment query node must be contained (according to its CIT definition) in another
query node, you must use the Composition relationship to connect this Enrichment query
node to an existing TQL query node.

o You cannot link an Enrichment query node to a TQL query node that is hidden.
To add a relationship between two query nodes, do one of the following:

o Select the required query nodes by holding the CTRL key and clicking the TQL query nodes,
right-click and select Add Relationship.
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o Click the Create Relationship I% button and draw a line between the required query nodes.

Added Enrichment relationships are displayed by an added E| indicator.

The Add Relationship dialog box opens. For details, see "Add/Edit Relationship Dialog Box" on
page 53.

6. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Tenant Association Rule

The following task describes how to define a Tenant Association rule.

| Note: This task is only relevant when multi-tenancy is enabled.

1.

Run the New Tenant Association Rule Wizard

In Enrichment Manager, click the small arrow next to the New Enrichment Rule " putton and

select New Tenant Association Rule. Enter the general attributes and base query information on
the wizard pages. For details, see "New Tenant Association Rule/Tenant Association Rule
Properties/Save As Tenant Association Rule Wizard" on page 548.

Note: Make sure to select the Rule is Active check box on the Rule General Attributes page
of the wizard to activate the rule.

Build the Rule Query

If you are basing your Tenant Association rule on a new query, build the query by dragging the
required CITs onto the canvas and inserting the required relationships.

Update the Owner Tenant of a Selected Query Node

Right-click the query node to be updated by the Tenant Association rule and select Update Owner
Tenant. The Update Owner Tenant dialog box opens. Select the method by which to update the
owner tenant (By value or By attribute) and select the required parameters for that option. Click
OK. For details, see "Update Owner Tenant Dialog Box" on page 556.

Note: You can update the owner tenant of more than one query node in the rule.
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4. Update the Consumer Tenants of a Selected Query Node

Right-click the query node to be updated by the Tenant Association rule and select Update
Consumer Tenants. The Update Consumer Tenants dialog box opens. Select the method by
which to update the consumer tenants (By value or By attribute) and select the required
parameters for that option. Click OK. For details, see "Update Consumer Tenants Dialog Box" on
page 555.

Note:
o You can update the consumer tenants of more than one query node in the rule.

o You can update both the owner tenant and the consumer tenants of the same query node
in a single Tenant Association rule.

5. Save the Rule

Click Save |@| to save the Tenant Association rule. The rule runs according to the frequency

defined by its priority.

Enrichment Manager User Interface

This section includes (in alphabetical order):

Enrichment Manager Page ... . 536
New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard ........... 544

New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant Association

RuUle Wizard ... 548
Query Node/Relationship Definition Dialog BOX .. .. ... . 551
Query Node Definition — Advanced Attribute Dialog Box ... ... .. 554
Update Consumer Tenants Dialog BoX ... . 555
Update Owner Tenant Dialog BoxX ... i 556
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Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are based on a specific TQL
query, can be used for several purposes, including:

« Adding new Cls and relationships to the CMDB.
« Deleting specific Cl instances from the CMDB.
« Updating the attribute values of specific Cl instances in the CMDB.

To access | Select Enrichment Manager from the Navigation Menu or select Managers >
Modeling > Enrichment Manager.

Important = Enrichment Manager has two modes in which you can work. Always check the
information Enrichment/Query mode list on the toolbar to verify the currently selected mode.
Relevant "How to Define an Enrichment Rule — Scenario” on page 529
tasks , i

"How to Define a Tenant Association Rule" on page 534

See also « "Enrichment Manager Overview" on page 527

« "Enrichment Manager User Interface" on the previous page

Enrichment Rules Pane

This area displays a hierarchical tree structure of predefined folders and Enrichment rules. Each
Enrichment rule is associated with a TQL query.

Important = You can create your own Enrichment rule, or work with the out-of-the-box (factory)
information = Enrichment rules provided with your Universal CMDB installation.

The default folders are provided for the out-of-the-box queries. You can modify these
folders, or add additional folders according to your organization's requirements.

You can drag and drop Enrichment rules or folders to move them from one folder to
another.

User interface elements are described below:
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Ul Element
(A-Z)

&

Description

New Folder. Creates a new folder.
New. Creates an Enrichment rule. Opens the New Enrichment Rule wizard.

Note: In a multi-tenancy environment, click the small arrow to the right of the
button to display the options. New Enrichment Rule opens the New
Enrichment Rule wizard. New Tenant Association Rule opens the New
Tenant Association Rule wizard.

Delete. Deletes the selected folder or Enrichment rule.

Refresh. Refreshes the data content of the hierarchical tree structure that may have
been modified by other users.

Save. Saves the Enrichment rule to the CMDB. (Enabled only when an Enrichment
rule is created or when changes are made to an existing one.)

Properties. Opens the New Enrichment Rule/Properties wizard. Enables you to
change the description and the activation state of the Enrichment rule.

Preview. Generates a preview of the results of the selected Enrichment rule.
Note: This button is not available when multi-tenancy is enabled.

Represents a folder.

Represents an Enrichment rule.

Represents a Tenant Association rule.

Note: This icon is only relevant when multi-tenancy is enabled.

<Enrichment Displays the existing Enrichment rules in tree format.

Rule tree>

Note: Only Enrichment rules appear in the tree. TQL queries of type
Enrichment (created in the Modeling Studio) do not appear in the tree.

The following elements are available by right-clicking a folder or Enrichment rule:
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Ul Element
(A-Z)

Delete

Export To
XML

Import
From XML

New
Enrichment
Rule

New Folder

New Tenant
Association
Rule

Preview

Properties
Rename
Folder

Save

Save As

Editing Pane

Description
Deletes the selected folder or Enrichment rule.

Displays a standard Save As dialog box, enabling you to save the Enrichment rule as
an XML script. This option can be used to move an Enrichment rule from one
workstation to another, provided the related TQL query is also relocated.

Imports XML files that contain saved Enrichment queries to the Enrichment Manager.

Creates an Enrichment rule. Opens the New Enrichment Rule wizard.

Creates a new folder.

Creates a Tenant Association rule. Opens the New Tenant Association Rule wizard.

Generates a preview of the results of the selected Enrichment rule.

Opens the New Enrichment Rule/Properties wizard. Enables you to change the
description and the activation state of the rule.

Renames the folder.

(Enabled only when a new Enrichment query is created or when changes are made to
an existing one.) Saves the Enrichment rule to the CMDB.

Displays the Save As Enrichment Rule wizard, enabling you to define a new name
and description for a query. This option can be used for creating a new Enrichment
rule based on an existing one.

This area enables you to create and define Enrichment query nodes and relationships.

Important
information

« When you select a folder in the Enrichment Rules pane, the editing pane is empty.
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Relevant
tasks

See also

« When you select an Enrichment rule in the Enrichment Rules pane, the editing

pane displays the selected rule, which consists of TQL query nodes that are
defined in the TQL query and the relationships between them, and the Enrichment
query nodes and relationships that are created and added to the rule.

The Enrichment Manager has two modes in which you can work: Enrichment
mode and Query mode.

The mode in which you are working determines the options that appear in the
shortcut menu. For details, see the editing pane description below.

You can calculate the number of instances that were created as a result of an
Enrichment rule and remove the instances created from an Enrichment rule from
the CMDB. For details, see "Additions Count" on page 167 and "Remove
Enrichment Results" on page 173.

"How to Define an Enrichment Rule — Scenario" on page 529

For details on how to create a TQL query, see "How to Add Query Nodes and
Relationships to a TQL Query" on page 25.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

[+]
[

Enrichment Mode |+

Guery Mode
Enrichment Mode

Query and

Description

Indicates an added Enrichment query node or relationship.

Indicates a query node or relationship that has been deleted from the
CMDB.

Indicates an updated query node or relationship.

The Enrichment Manager has two modes in which you can work:
Enrichment mode and Query mode.

Working in:

Enrichment mode » Query mode enables you to define regular (non-Enrichment)

relationships and query nodes and add them to the TQL query you
defined.

« Enrichment mode enables you to define Enrichment relationships and
query nodes and add them to the TQL query you defined.
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Ul Element (A-2)
<Main Menu>
<Query Node>
<Relationship>

<Shortcut menu>
options

<Toolbar>

<Tooltips>

Cl Type Selector

Description

For details, see "Main Menu" on page 163.

A component from which TQL queries are built.

The entity that defines the relationship between two query nodes.

For details, see "Shortcut Menu Options" on page 33.

For details, see "Toolbar Options" on page 167.

Hold the cursor over a query node or relationship to view its tooltip.
The tooltips contain the following information:
« Element name. The name of the query node.

« CI Type. The CIT of the query node as defined in the Cl Type Manager.
For details, see "Cl| Type Manager" on page 481.

« Definitions of the selected query nodes and relationships. The
attribute conditions, as described in "Query Node/Relationship
Properties Dialog Box" on page 72.

This area displays a hierarchical tree structure of the Cl Types found in the CMDB.

Important The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager, and

information = Trigger TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane and
define the relationship between them. Your changes are saved to the CMDB. For
details, see "How to Add Query Nodes and Relationships to a TQL Query" on page

25.

Note: The number of instances of each CIT in the CMDB is displayed to the right
of each CIT.

Relevant « "How to Define an Impact Rule — Workflow" on page 463

tasks

o "How to Define an Enrichment Rule — Scenario” on page 529
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« "How to Define a TQL Query" on page 24

« "How to Create a Pattern View" on page 269

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements (A-Z) Description

< Add CI Type to Map. Moves the selected Cl type to the Editing pane.

(4]

Refresh. Refreshes the Cl type tree.

= Search. Searches for the Cl type entered.
=] Expand All. Expands all subtrees within the Cl type tree.
=) Collapse All. Collapses the subtrees within the CI type tree.

<Search window> Enter the name or part of a name of a Cl type for which to search.

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-clicking a
Cl Type:

Menu Item Description

Add CIl Type  Select to add the selected Cl type to the Editing pane.
to Map

Go to Cl Type Takes you directly to the selected Cl type in CIT Manager.

Definition
Show CIT Opens the CIT Instances window, which displays all instances of the selected
Instances CIT. For details, see "Cl Instances Dialog Box" on page 65.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and
relationship.

Important = The Advanced pane appears in the lower part of the window in the following managers
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information and user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query Editor in DFM.

A small green indicator * appears next to the tabs that contain data.

Relevant « "How to Define an Impact Rule — Workflow" on page 463
tasks « "How to Define an Enrichment Rule — Scenario" on page 529
« "How to Define a TQL Query" on page 24
« "How to Create a Pattern View" on page 269

« "How to Create a Template" on page 270

« "How to Create a Perspective" on page 272

User interface elements are described below:

Ul Description
Elements
(A-Z)

A If the window is not wide enough to display all the tabs, use the left and right arrows to

move to the required tab.

Click Show List to display a list of the available tabs for the current module. You can
select a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For
details, see "Attributes Tab" on page 74.

Cardinality Cardinality defines how many query nodes you expect to have at the other end of a
relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to
between one and three IP Addresses. For details, see "Cardinality Tab" on page 76.

Data Displays the data sources set for the selected query node.

Sources
Note: This tab appears only in the Modeling Studio.

Details Displays the following information:
« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in
the Modeling Studio.
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Ul
Elements
(A-Z)

Edit

Element
Layout

Element
Type

Enrichment
Rules

Impacted
Query
Nodes

Qualifiers

Description

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not
visible. In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its
children are displayed in the topology map. A red mark indicates that only the
selected Cl appears. This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or relationship. It lists the
attributes selected to be included in the query results (when Specific Attributes is
selected as the attributes condition). It also lists the excluded attributes and any
selected qualifiers for attributes. For details, see "Element Layout Tab" on page 82.

| Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or relationship. For details,
see "Element Type Tab" on page 80.

| Note: This tab appears only in the Modeling Studio.

Displays the Enrichment rule defined for the selected query node or relationship. If the
Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see
"Query Node/Relationship Definition Dialog Box" on page 551.

Note: This tab appears only in Enrichment Manager.

Indicates which query node is impacted by the changes that occur in the selected
trigger query node. If required, you can click Edit to open and modify the Impacted
Query Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on
page 474.

Note: This tab appears only in Impact Analysis Manager.

Displays the qualifier conditions defined for the query node or the relationship. For
details, see "Qualifier Tab" on page 84.
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Ul
Elements
(A-Z)

Selected
Identities

Description

Note: This tab appears only in Enrichment Manager and Impact Analysis
Manager.

Displays the element instances that are used to define what should be included in the

TQL query results. For details, see "Identity Tab" on page 85.

New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access

Important
information

To create a new Enrichment rule, right-click anywhere in the Enrichment Rules
pane and click New Enrichment Rule or click the New Enrichment Rule |;|

button.

To modify an existing Enrichment rule, right-click an Enrichment rule in the
Enrichment Rules pane and select Properties.

To create a new Enrichment rule based on an existing query, right-click an
Enrichment rule in the Enrichment Rules pane and select Save As.

When creating a new Enrichment rule, bear in mind that the application does not
allow you to make any changes in the TQL query that are necessary for the rule.
These changes include the following:

o Deleting, from the Enrichment TQL query, the query nodes or relationships
connected to the Enrichment query node, causing a query node to become
unattached to any relationship.

o You cannot change the cardinality definition to 0 (not required) of a query node
or relationship that is used in an Enrichment rule. For details on relationship
cardinality, see "Query Node/Relationship Properties Dialog Box" on page 72.

An Enrichment TQL query that serves as the basis for Enrichment rules, is subject
to certain validation restrictions. For details, see "Troubleshooting and Limitations
— Topology Query Language" on page 93. If the TQL query is not valid, you cannot
saveit.
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Relevant "How to Define an Enrichment Rule — Scenario” on page 529

tasks

Wizard The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule
map Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also « "Enrichment Manager Overview" on page 527
« "Enrichment Manager User Interface" on page 535

« "Topology Query Language" on page 14

Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Enrichment rule.

Important « An Enrichment TQL query that serves as the basis for Enrichment rules is subject

information to certain validation restrictions. For details, see "Troubleshooting and Limitations
— Topology Query Language" on page 93. If the TQL query is not valid, you cannot
saveit.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on the previous page.

« By default, this wizard is set to display a Welcome page. You can choose not to
display this page by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 92.

Wizard The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule
map Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 14

User interface elements are described below:

Ul Element

(A-2) Description

Rule (Optional) Enter a description of the rule.
Description
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Ul Element

(A-Z) Description

Rule is (Optional) Select this option to activate the rule in the system as soon as it is saved.
Active

Default: Not selected.

Note:

« If an active Enrichment rule is deactivated (by clearing the Rule is Active
check box), all changes that occur in the CMDB relating to the rule are
deleted from the system. When you deactivate an Enrichment rule, a red X
appears next to the Enrichment rule in the Enrichment Rules pane.

« Toreactivate the rule, right-click the rule in the Enrichment Rules pane and
select Properties. In the General Attributes page, select Rule is Active.

Rule Name @ Enter a unique name for the Enrichment rule. The rule name cannot contain any of the
following characters: \/ : " <> | % ?. The final character cannot be a blank space.

Note: If the rule name is either empty, contains a name used by another
Enrichment rule, or uses invalid characters, the Next and Finish buttons are

disabled.
Update When this option is selected, the Enrichment rule updates the Last Access Time
Last property of the Cls it affects. When the check box is cleared, the Enrichment rule
Access does not update the attribute and therefore does not perform touch on those Cls. This
Time ensures that the Enrichment rule does not affect the aging of the relevant Cls.

Note:

« For out-of-the-box Enrichment rules, this option is selected by default.

« Fornew Cls created by the Enrichment rule, the Last Access Time property
is updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Enrichment rule is

based.

Important « An Enrichment TQL query that serves as the basis for Enrichment rules, is subject
information to certain validation restrictions. For details, "Troubleshooting and Limitations —
Topology Query Language" on page 93. If the TQL query is not valid, you cannot
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Wizard
map

See also

save it.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 544.

« By default, this wizard is set to display a Completion page after clicking Next on
this page. You can choose not to display the Completion page by changing the
user preferences. For details, see "User Preferences Dialog Box" on page 92.

The "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule
Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page™

"Topology Query Language" on page 14

User interface elements are described below:

Ul Element (A-Z) Description

Base the

Select this check box if you want to base the Enrichment rule on a new TQL

Enrichment rule | query. The TQL results are based on the attributes defined for the new TQL

on anew query  query.

Base the

Select this check box if you want to base the Enrichment rule on an existing

Enrichment rule | TQL query. Select the required Enrichment TQL query from the drop-down list.

on an existing

query

Base Query
Description

Base Query
Name

Base Query
Priority

Note: You cannot base an Enrichment rule on a TQL query that contains
complex class conditions.

(Optional) Enter a description of the TQL query.

Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an existing TQL option,
select the Enrichment TQL query on which you want to base the rule.

Select a priority level for the new TQL query (Low, Medium, High, or Express).
This setting determines how often the query is rerun automatically by the
system to include updated information from the CMDB.

Save a new query Select to save a new TQL query based on your Enrichment rule definition.

based on the

current definition

Note: This field only appears in the Save As Enrichment Rule wizard.
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New Tenant Association Rule/Tenant Association Rule
Properties/Save As Tenant Association Rule Wizard

This wizard enables you to create or modify a Tenant Association rule.

To access « Tocreate a new Tenant Association rule, right-click anywhere in the Enrichment
Rules pane and click New Tenant Association Rule or click the down arrow

next to the New |;| button and select New Tenant Association Rule.

« Tomodify an existing Tenant Association rule, right-click a Tenant Association
rule in the Enrichment Rules pane and select Properties.

« Tocreate a new Tenant Association rule based on an existing query, right-click a
Tenant Association rule in the Enrichment Rules pane and select Save As.

- , .
Important ¢z denotes an active Tenant Association rule.

information . o o
5 denotes an inactive Tenant Association rule.

Note:

« This wizard is only available when multi-tenancy is enabled.

« A TQL query that serves as the basis for Tenant Association rules is subject
to certain validation restrictions. For details, see "Troubleshooting and
Limitations — Topology Query Language" on page 93. If the TQL query is not
valid, you cannot save it.

Relevant « "How to Define a Tenant Association Rule" on page 534

tasks « Multi-Tenancy Workflow in the HPE Universal CMDB Administration Guide
Wizard The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
map Tenant Association Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also « "Topology Query Language" on page 14
« Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide

« Tenant Association Rules in the HPE Universal CMDB Administration Guide
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Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Tenant Association rule.

Important « An Enrichment TQL query that serves as the basis for Enrichment rules is subject

information to certain validation restrictions. For details, see "Troubleshooting and Limitations
— Topology Query Language" on page 93. If the TQL query is not valid, you cannot
saveiit.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 544.

« By default, this wizard is set to display a Welcome page. You can choose not to
display this page by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 92.

Wizard The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
map Tenant Association Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page"

See also "Topology Query Language" on page 14

User interface elements are described below:

Ul Element

(A-Z) Description

Rule (Optional) Enter a description of the rule.

Description

Rule is (Optional) Select this option to activate the rule in the system as soon as it is saved.
Active

Default: Not selected.

Note:

« Ifanactive Tenant Association rule is deactivated (by clearing the Rule is
Active check box), all changes that occur in the CMDB relating to the rule are
deleted from the system. When you deactivate a Tenant Association rule, a
red X appears next to the rule in the Enrichment Rules pane.

« Toreactivate the rule, right-click the rule in the Enrichment Rules pane and
select Properties. On the General Attributes page, select Rule is Active.
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Ul Element
(A-Z) Description

Rule Name Enter a unique name for the Tenant Association rule. The rule name cannot contain
any of the following characters: \/ : " <>| % ?. The final character cannot be a blank
space.

Note: If the rule name is either empty, contains a name used by another Tenant
Association rule, or uses invalid characters, the Next and Finish buttons are

disabled.
Update When this option is selected, the Tenant Association rule updates the Last Access
Last Time property of the Cls it affects. When the check box is cleared, the Tenant
Access Association rule does not update the attribute and therefore does not perform touch on
Time those Cls. This ensures that the Tenant Association rule does not affect the aging of

the relevant Cls.

Note:

« Forout-of-the-box Tenant Association rules, this option is selected by default.

« Fornew Cls created by the Tenant Association rule, the Last Access Time
property is updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Tenant
Association rule is based.

Important « An Enrichment TQL query that serves as the basis for Enrichment rules, is subject

information to certain validation restrictions. For details, "Troubleshooting and Limitations —
Topology Query Language" on page 93. If the TQL query is not valid, you cannot
saveit.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 544.

« By default, this wizard is set to display a Completion page after clicking Next on
this page. You can choose not to display the Completion page by changing the
user preferences. For details, see "User Preferences Dialog Box" on page 92.

Wizard The "New Tenant Association Rule/Tenant Association Rule Properties/Save As
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map Tenant Association Rule Wizard" contains:

"Rule General Attributes Page" > "Rule Base Query Page™

See also "Topology Query Language" on page 14

User interface elements are described below:

Ul Element (A-Z)

Base the Tenant
Association rule
on a new query

Base the Tenant
Association rule
on an existing

query

Base Query
Description

Base Query Name

Base Query
Priority

Save a new query
based on the
current definition

Description

Select this check box if you want to base the Tenant Association rule on a
new TQL query. The TQL results are based on the attributes defined for the
new TQL query.

Select this check box if you want to base the Tenant Association rule on an
existing TQL query. Select the required TQL query from the drop-down list.

(Optional) Enter a description of the TQL query.

Enter a unique name for the TQL query.

If you selected the Base the Tenant Association rule on an existing TQL
option, select the TQL query on which you want to base the rule.

Select a priority level for the new TQL query (Low, Medium, High, or
Express). This setting determines how often the query is rerun automatically
by the system to include updated information from the CMDB.

Select to save a new TQL query based on your Tenant Association rule
definition.

Note: This field only appears in the Save As Tenant Association Rule
wizard.

Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query node/relationship. The key attributes and

the required attributes of the selected query node appear in bold.

To access | Right-click a query node or relationship when in Enrichment mode (select

HPE Universal CMDB (10.31) Page 551 of 572



Modeling Guide

Chapter 12: Enrichment Manager

Important
information

Relevant
tasks

See also

Enrichment from the Query/Enrichment drop-down list at the top of the Enrichment
Manager page) and select Update Relationship/Query Node.

Use an Enrichment rule to update the value of Cl attributes in the CMDB, or to add
data to attributes that currently do not have values. You can use this option, for
example, for simultaneously adding a note to all Cl instances.

You must fill in the value of the key attributes and the required attributes of the
Enrichment query node. The method you use to define these values determines the
number of instances created.

If you enter a dynamic value, you can create numerous instances. For example,
entering the dynamic value of a host_key for the CIT Node or an IP address attribute
forthe CIT IpAddress.

"How to Define an Enrichment Rule — Scenario" on page 529

« "Enrichment Manager Overview" on page 527

« "Enrichment Manager User Interface" on page 535

Attributes Area

User interface elements are described below :

Ul
Element

(A-2) Description

Name The attribute name.

Type The field type of the selected attribute.

Value The value as defined in one of the following:

The Value box in the Set Attributes area.
The combination of the values in the By Attribute boxes in the Set Attributes area.

The Value column if you selected Simple in the Type column in the Query Node
Definition - Advanced Attribute dialog box.

The combination of the values in the Value column and the column to the right of the
Value column if you selected By Attribute in the Type column in the Query Node
Definition - Advanced Attribute dialog box.
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Set Attributes Area

User interface elements are described below :

Ul Element
(A-Z)

Advanced

By
Attribute

RegExp
Group

Regular
Expression

Value (in
the Set
Attributes
area)

Description

Define an attribute value using the Query Node Definition - Advanced Attribute dialog
box.

EL Advanced. Opens the Advanced Attribute dialog box.
|Q| Clear. Clears the Value column in the Attributes area.

Note: This element is only active when an attribute of the field type string is
selected.

Define an attribute using attributes from other query nodes in the TQL query.

« Inthe box to the left, select the required query node.

« Inthe box to the right, select the query node’s required attribute.

|ﬁ| Apply. Adds the selected attribute definition to the Value column in the Attributes

area.
|9| Clear. Clears the Value column in the Attributes area.

(Appears only when you select an attribute of the field type string.) Enter the group
number only if you are adding a regular expression using regular expression syntax.
This is the part of the regular expression pattern to focus on when creating the
attribute. A set of parentheses () constitutes a group.

(Appears only when you select an attribute of the field type string.) Add a regular
expression using regular expression syntax. Enter the regular expression pattern.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 571.

Define a constant value. Enter the required value in the Value box or select a value
from the Value list.

|ﬂ| Apply. Adds the value definition to the Value column in the Attributes area.

|9| Clear. Clears the Value column in the Attributes area.
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Query Node Definition — Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes of the type String using
simple or complex expressions. You can also create complex expressions using regular expression
format.

To Select an attribute of the type string in the Query Node Definition dialog box. Select
access Advanced and then click the Advanced button.

Relevant  "How to Define an Enrichment Rule — Scenario" on page 529
tasks

See also | « "Enrichment Manager Overview" on page 527

« "Enrichment Manager User Interface" on page 535

User interface elements are described below :

Ul Element

(A-Z) Description

+ Add. Enables you to define an attribute value using simple or complex expressions.
Creates a new entry in the Type column. Click the new entry and select either
Simple or By Attribute. For details, see the description for the Type column below.

g Delete. Deletes the selected attribute value.

[ Up. Moves a selected row up.

™ Down. Moves a selected row down.

Advanced (This list is only available if you select By Attribute in the Type column.) Click the
Value entry inside the box and select the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp (This list is available only if you select By Attribute in the Type column.) Click
Group inside the RegExp Group column, click the (S button, and enter the group

number in the Value for RegExp Group dialog box that opens. This is the part of the
regular expression pattern to focus on when creating the attribute. A set of
parentheses () constitutes a group.

Regular (This list is only available if you select By Attribute in the Type column.) Click
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Ul Element
(A-Z) Description

Expression  jnside the Regular Expression column, click the —_— button, and enter the

regular expression pattern in the Value for Regular Expression dialog box that opens.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 571.

Type Click the entry inside the Type column and select one of the following options:

« Simple. Define a constant value using a simple expression.

« By Attribute. Define an attribute using attributes from other query nodes in the
TQL.

Default is: Simple

Use first Use the first attribute value listed in this dialog box that is not empty.

attribute

with value

Value « Ifyou select Simple in the Type column, click inside the Value column, click the

] button, and enter the required value in the Value for Simple dialog box.

Note: If you define an attribute value using only one Simple expression, the
Value column cannot be empty.

« Ifyou select By Attribute in the Type column, click inside the Value column and
select the required value from the list.

Update Consumer Tenants Dialog Box

This dialog box enables you to define a rule for updating the consumer tenants of a CI.

To access In Enrichment Manager, select Enrichment Mode. Right-click the required query
node in the Tenant Association rule and select Update Consumer Tenants.

Important | This dialog box is only available when multi-tenancy is enabled.
information

Relevant "How to Define a Tenant Association Rule" on page 534
tasks
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See also « Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide.

« Tenant Association Rules in the HPE Universal CMDB Administration Guide

User interface elements are described below:

Ul Element (A-2)

Append selected
value to original

Get attribute
value from

Override original
value

Select nodes

Select tenant

Update consumer
tenants

Description

When this option is selected, the consumer tenants selected are appended to
the original consumer tenants of the updated query node.

Select the tenancy attribute of the selected query nodes to apply to the
updated query node. The options are:

« Owner Tenant attribute. Applies the owner tenants of the selected query
nodes as the consumer tenants of the updated query node.

« Consumer Tenants attribute. Applies the consumer tenants of the
selected query nodes as the consumer tenants of the updated query node.

Note: This element is only relevant when By Attribute is selected.

When this option is selected, the consumer tenants selected replace the
original consumer tenants of the updated query node.

Move the selected query nodes from the Available Nodes pane to the Selected
Nodes pane using the arrow buttons.

| Note: This element is only relevant when By Attribute is selected.

Move the selected tenants from the Available Tenants pane to the Selected
Tenants Pane using the arrow buttons.

| Note: This element is only relevant when By Value is selected.

Select a method for updating the consumer tenants. The available options are:
« By Value. Select tenants directly from the available tenants.

« By Attribute. Select other query nodes in the rule. The updated query node
is assigned the consumer tenants of the selected query nodes.

Update Owner Tenant Dialog Box

This dialog box enables you to define a rule for updating the owner tenant of a Cl.
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To access In Enrichment Manager, select Enrichment Mode. Right-click the required query
node in the Tenant Association rule and select Update Owner Tenant.

Important | This dialog box is only available when multi-tenancy is enabled.

information

Relevant "How to Define a Tenant Association Rule" on page 534

tasks

See also « Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide.

« Tenant Association Rules in the HPE Universal CMDB Administration Guide

User interface elements are described below:

Ul Element (A-
Z) Description

Select tenant Select a tenant from the drop-down list.

Note: This element is only relevant when By Value is selected.

Select owner Select a query node from the drop-down list.
tenant from

Note: This element is only relevant when By Attribute is selected.

Update owner = Select a method for updating the owner tenant. The available options are:

tenant . .
« By Value. Select a tenant directly from a drop-down list.

« By Attribute. Select another query node in the rule. The updated query node is
assigned the owner tenant of the selected query node.
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Automated Service Modeling provides the ability to automatically map the complexity of critical
business services and business applications, starting from an entry point for the service (usually the
URL of the service). You can use the UCMDB Browser to easily create a model of a particular service
(starting from the service’s URL) or enterprise application (using existing out-of-the-box discovery
content). You can select an entry point to perform a top-down discovery, or model multiple applications
that have already been discovered. The process is simplified and put in the control of the service
owner.

Automated Service Modeling automatically discovers and models service maps, and provides the
following capabilities:
« A service model that is maintenance-free, and appears in near real time.

« The ability to accurately discover the service in a top-down manner, and to see the map update
automatically.

« The ability to take advantage of existing integrations and infrastructure.

« The ability to prioritize discovery problems in the context of a service.

« The ability to contact a UCMDB administrator in case of advanced discovery errors.
« Constant tracking of dynamic changes in a business service’s infrastructure.

« The ability to quickly identify the impact of changes to Cls in complex environments.
« The ability to define service border rules.

Once you have created a service map, you can interact with it by showing or hiding layers of
associated data (servers, historical changes, virtualization, networking, or storage topologies).

You can find more details about the Automated Service Modeling feature in the following sections:
« Business Service Discovery in the HPE Universal CMDB Data Flow Management Guide: This
section introduces the service discovery user interface and how to run service discovery.

o Mapping Consumer-Provider Dependencies in the HPE Universal CMDB Developer Reference
Guide: This section contains all the behind-the-scene information for developers' reference.

« Service Modeling in the HPE Universal CMDB Browser User Guide: This section describes how
to work with Automated Service Modeling from the UCMDB Browser.
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This chapter includes:

Universal Data Model (UDM) OVEerVIeW . . ... e 560

Universal Data Model (UDM) Overview

The Universal Data model (UDM), provides the information model that enables HP Software products
to integrate using a common language. The UDM provides the vocabulary in the form of Cl types and
the relationships between them, and their attributes. This vocabulary and the artifacts derived from it
are used to enable integrations in an enterprise environment, to enable faster design and deployment,
and to facilitate ease of maintenance and integration evolution. The UDM is applied to many
management products and solutions, including Universal CMDB and its integrations.

You can generate the UCMDB CI Types and Relationships Information PDF, which provides
information on specific Cl Types and Relationships in the UDM. For details, see "Export Selected CITs
to PDF Dialog Box" on page 524. You can also find a UDM Powerpoint document on the HP Live
Network oraccess the UCMDB Class Model Reference by selecting Help > UCMDB Class Model.
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Chapter 15: Exporting the UCMDB Data Model
toa UML Tool

This chapter includes:

Export to UML Tool — OVeIVIEeW ... 561
How to Export the Class Model ... ... L 561
How to Convert XML of a Selected Part of the Class Model ......................................... 562
Export to UML Tool UserInterface ... 563
Tool PIUG-IN INPUL 565

| Note: Currently, Altova UModel versions 2008 and 2009 are supported.

Export to UML Tool — Overview

The Export to UML tool enables you to export selected sections of the UCMDB class model to a format
compatible with UML tools, and to view the model as a UML diagram.

The input for the tool is the UCMDB class model XML file retrieved by the JMX service
UCMDB:service=Class Model Services/
exportClassModelToXmil().

Note: To access the JMX console, enter the following address in your browser: http://<server_
name>:8443/jmx-console, where <server_name> is the name of the machine on which
Universal CMDB is installed.

How to Export the Class Model
This task describes how to use the Export Class Model to UML tool wizard.

This task includes the following steps:

« "Prerequisites" on the next page

« "Runthe UML Tool" on the next page
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« "View the Exported File in Altova" below

1. Prerequisites
Set up the tool by extracting the following zip file to any location:

<Volume>:\hp\UCMDB\UCMDBServer\tools\ExportClassModel.zip

2. Run the UML Tool

You use the Export Class Model to UML wizard to choose the CIT and its attributes to be exported
to the UML tool.

For details on working with the Export to UML wizard, see "Export Class Model to UML Wizard"

on the next page.

3. View the Exported File in Altova
a. InAltova, select File > Import From XMI File.
b. Select the XMl file. The class model entry appears in the Model Tree pane.

c. Right-click the entry and select Show in new diagram > Content. Click OK.

How to Convert XML of a Selected Part of the Class
Model

This task describes how to use the custom plug-in to convert the XML of a selected part of the class
model to the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java class, it must implement
the ITransformToUML (ExportToUML.jar) interface; the transformToUML() method receives an
XML string as a parameter and returns a byte array that is written to the output file.

For details on the custom plug-in input, see "Tool Plug-in Input" on page 565.

This task includes the following steps:

« "Activate the Plug-in Using a Java Class" on the next page

« "Activate the Plug-in Using an XSLT Text File" on the next page
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Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in the ExportToUML
directory, as follows:

<ConverterToUML>

<Name><display name></Name>

<Class><fully qualified class name></Class>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "How to Export the Class
Model" on page 561.

Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML and is written to the output
file.

Add the display name and full path of the XSLT file to the config.xml file in the ExportToUML directory,
as follows:

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full path_of the XSLT_file></XsltFile>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "How to Export the Class
Model" on page 561.

Export to UML Tool User Interface

This section includes:

Export Class Model to UML Wizard ... ... 563

Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported to the UML tool.

To access  Browse to the location where you extracted the tool. Right-click
ExportClassModel.jar in the ExportClassModel directory. Select Open With >
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Java 2 Platform SE binary.

Important By default the tool opens the ClassModel.xml file in the ExportClassModel directory.
information = You open other files through the File > Open Class Model File menu.

Relevant "How to Export the Class Model" on page 561

tasks

Wizard The Export Class Model to UML wizard contains:

map "Export Class Model to UML Wizard" on the previous page > "Select Valid
Links" below > "Export Selected Items" on the next page

See also « "Export to UML Tool — Overview" on page 561

o "Tool Plug-in Input" on the next page

User interface elements are described below:

Ul Element (A-Z) Description

File Displays a list of XML files. Open the file that contains the class model.

Select Attributes = Select the attributes to be displayed in the UML tool.
Pane

The attributes of the selected CIT are displayed in this pane. The attributes are
colored as follows:

« Attributes inherited from the parent CIT are black.

« Attributes specific to this CIT are dark blue.

Select Cl Types The CITs displayed here are retrieved from the ClassModel.xmil file.
Pane
Select the CIT and its sub nodes to be exported to the UML tool.

Use the buttons to select or clear all subindex.

Select Valid Links

This wizard page enables you to select links that can be used between two CITs.

Important General information about the wizard is available in "Export Class Model to UML
information Wizard" on the previous page.

Wizard map The Export Class Model to UML wizard contains:

"Select Valid Links" > "Export Selected Items"
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User interface elements are described below:

Ul Element

(A-2) Description

Removes the filter from the list of CITs.

Filter by Enables you tofilter the list of valid links. You can filter the list of CITs and you can

sort the list by CIT or relationship.

Export Selected Items

This wizard page enables you to export the selected CITs and their attributes to the UML tool.

Important General information about the wizard is available in "Export Class Model to UML
information Wizard" on page 563.
Wizard map The Export Class Model to UML wizard contains:

"Select Valid Links" > "Export Selected Items"

User interface elements are described below:

Ul Element
(A-2) Description
Export Click to browse to the UML file, in XMI format, to which you want to add the UCMDB

CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid links message is displayed in
the Select Valid Links page.

Tool Plug-in Input
The input for the plug-in is an XML string (selected classes/attributes/valid links) in the following form:

<?xml version="1.0" encoding="IS0-8859-1"?>
<Class-Model>
<Class class-name="hostresource" display-name="Host Resource"
visibility="public">
<Attribute name="isvirtual" display-name="Is Virtual"
visibility="public"/>
<Attribute name="city" display-name="City" visibility="public"/>
</Class>
<Class class-name="host_node" display-name="Computer" visibility="public">
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<Derived-From class-name="host"/>
</Class>
<Class class-name="vax" display-name="VAX" visibility="public">
<Attribute name="root_actualdeletionperiod" display-name="Actual
Deletion Period" visibility="public"/>
<Attribute name="data_allow_auto_discovery" display-name="Allow CI
Update" visibility="public"/>
<Derived-From class-name="host_node"/>
</Class>
<Class class-name="host" display-name="Host" visibility="public">
<Attribute name="host_iscomplete" display-name="Host Is Complete"
visibility="public"/>
<Attribute name="host_isroute" display-name="Host Is Route"
visibility="public"/>
<Attribute name="host_hostname"” display-name="Host Name"
visibility="public"/>
<Attribute name="host_os" display-name="Host Operating System"
visibility="public"/>
</Class>
<Class class-name="unix" display-name="Unix" visibility="public">
<Derived-From class-name="host_node"/>
</Class>
<Valid-Link ID="host_member_host" display-name="Member"
visibility="public">
<Endl class-name="host"/>
<End2 class-name="host"/>
</Valid-Link>
<Valid-Link ID="host_container_f_hostresource" display-name="Container
link" visibility="public">
<Endl class-name="host"/>
<End2 class-name="hostresource"/>
</Valid-Link>
</Class-Model>
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Chapter 16: Working with Tables

This chapter includes:

Columns UserInterface .. ... .. 568

Columns User Interface

This section includes (in alphabetical order):

Select Columns Dialog BoX ... .. 568

Sort Column Content Dialog BOX ... ... ... 569

Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in displaying. You can hide a
column or display a hidden column.

To access  Cjick the Select Columns [ button. This button appears above every tableina

report.

Important The order of the columns in the list in the Visible Columns pane determines the order

Information = of the columns displayed in the table. To change the order of table columns, move
them to the required position using the up and down arrow buttons or by dragging a
column to a new location.

The following elements are included:

Ul Element
(A-2) Description
> Displays a column. Moves the selected column from the Available Columns pane
to the Visible Columns pane.
< Hides a selected column. Moves the selected column from the Visible Columns

pane to the Available Columns pane.

L

Displays all hidden columns. Moves all the columns from the Available Columns
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Ul Element

(A-Z) Description
pane to the Visible Columns pane.

£ Hides all columns. Moves all the columns from the Visible Columns pane to the
Available Columns pane.

M Moves a selected column up in the list in the Visible Columns pane.

A Moves a selected column down in the list in the Visible Columns pane.

Available The columns in this pane do not appear in the table.

Columns

Visible The columns in this pane are visible in the table.

Columns

Sort Column Content Dialog Box

This dialog box enables you to set or change the sort order for the entries displayed in a table.

To access Click the Sort Column Content =T button.

Important « To sort a table by one column:

Information Move the column name from the Available Columns to the Sorted Columns

list. Select the name and decide whether to sort in ascending (upward triangle) or
descending (downward triangle) order by clicking the relevant button.

« To sort a table by more than one column:

Move the column names from the Available Columns to the Sorted Columns
list. For each column, decide whether to sort in ascending or descending order.

« To change the order in which columns are sorted:

In the Sorted Columns list, select an entry, and click the Up or Down arrow to
change the order. (Entries higher in the list are sorted before entries lower in the
list.) A number is displayed in the table's column headers.

Note: Only columns that are displayed can be sorted. For details on how to
define which columns are displayed in the table and in which order, see "Select

Columns Dialog Box" on the previous page.

The following elements are included:
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Ul
Element
(A-2) Description
> Moves the selected column from the Available Columns pane to the Sorted
Columns pane. You can double-click the selection to perform the same procedure.
< Moves the selected column from the Sorted Columns pane to the Available
Columns pane.
2 Moves all the columns from the Available Columns pane to the Sorted Columns
pane.
£ Moves all the columns from the Sorted Columns pane to the Available Columns
pane.
Yo Moves the selected column up or down in the list to increase or decrease its priority in
establishing the sort order.
£ e Enables you to sort the column content in ascending or descending order.

In the Sorted Columns pane, select a column name and click the ascending or
descending button.

Available The columns whose content is not sorted.

Columns

Note: You can select multiple columns.
Sorted The columns whose content is sorted in either ascending or descending order.
Columns
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This chapter includes:

Examples of Regular Expressions

Examples of Regular Expressions

« Enter a regular expression to define an IP address (aa.yy.zz.mm):

To: In the First Field Enter:
Create label by aa (LY

Create label by yy CLDECT)

Create label by zz CLIATDE)

Create label by mm T

In the Second Field Enter:

« Enter a regular expression to create the label by the first or last letters of the selected attribute:

To:

Create label by the first letter
Create label by the last letter
Create label by the first two letters

Create label by the last two letters

HPE Universal CMDB (10.31)

In the First Field Enter:

()
("))
(%)
("))

In the Second Field Enter:

1

2
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Send documentation feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Modeling Guide (Universal CMDB 10.31)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to cms-doc@hpe.com.

We appreciate your feedback!
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